# Table of Contents

**About the Release Notes**...............................................................................................................................................1  
  What’s Included in the Release Notes.................................................................1  
  Your Feedback Matters.................................................................................1  

**Release Notes Changes**...........................................................................................................................................2  

**Feature Summary and User Impact**.................................................................7  
  Salesforce........................................................................................................7  
  Force.com......................................................................................................16  

**Salesforce**..................................................................................................................................................................26  
  Browser Enhancements....................................................................................26  
  Updates to Translated Terminology...............................................................28  
  Usage-based Entitlements Now Displayed in Setup—Beta..............................28  

**Chatter**...................................................................................................................................................................30  
  Salesforce Communities—Generally Available..............................................30  
  Publisher Actions............................................................................................56  
  Chatter Topics—Generally Available..............................................................60  
  Upgrading Hashtag (#) Topics to Chatter Topics.............................................66  
  Improved Trending Topics...............................................................................67  
  Improved Topics on Profiles..........................................................................67  
  Feeds................................................................................................................68  
  Additional Enhancements...............................................................................70  
  Chatter API.....................................................................................................73  

**Sales**......................................................................................................................................................................78  
  Activities.........................................................................................................78  
  Forecasts.........................................................................................................79  
  Opportunities..................................................................................................82  
  Price Books.....................................................................................................84  
  Salesforce for Outlook.....................................................................................87  
  Tasks.................................................................................................................94  
  Additional Sales Enhancements......................................................................96  

**Service**...................................................................................................................................................................99  
  Case Feed.......................................................................................................99  
  Chatter Answers...............................................................................................100  
  Customer Portal...............................................................................................103  
  Entitlement Management...............................................................................106  
  Ideas...............................................................................................................107  
  Salesforce Knowledge....................................................................................113  
  Live Agent......................................................................................................118
### Analytics
- Fine-Grained Sharing for Report and Dashboard Folders...........................................................................131
- View Dashboards in Salesforce Touch on iPhone Devices........................................................................136
- Dashboards in Chatter 4.0 for iPhone and iPad Devices.............................................................................140
- Sticky Dashboard Filters.................................................................................................................................140
- Scatter Charts Default Dashboards Behavior................................................................................................141
- External Users Can View Reports and Dashboards in Communities..............................................................142

### Mobile
- Salesforce Mobile Apps Overview......................................................................................................................143
- Salesforce Touch...................................................................................................................................................145
- Chatter for Android – Version 3.3 Generally Available...................................................................................160
- Chatter for iPhone and iPad – Version 4.1 Generally Available.......................................................................161
- Salesforce Mobile Rebrand................................................................................................................................162

### Data.com
- Data.com Product Suite Overview.......................................................................................................................164
- Data.com...............................................................................................................................................................166
- Data.com Clean.....................................................................................................................................................169
- Data.com Social Key—Beta................................................................................................................................180

### Site.com
- Name and Behavior Changes for User Roles......................................................................................................188
- IP Restrictions—Generally Available..................................................................................................................188
- Custom Widgets.....................................................................................................................................................189
- Authorizing Site.com Pages for Communities..................................................................................................190
- Branded Site.com Pages for Communities..........................................................................................................190
- Current Community User Information.................................................................................................................191

### Force.com
- Improved Setup User Interface..............................................................................................................................192
- Developer Console Redesign..............................................................................................................................194
- Force.com Canvas—Generally Available...........................................................................................................196
- Permission Sets....................................................................................................................................................205
- Sharing.................................................................................................................................................................207
- Search..................................................................................................................................................................213
- Formulas..............................................................................................................................................................214
- Security...............................................................................................................................................................215
- My Domain........................................................................................................................................................218
- Sandboxes...........................................................................................................................................................218
- Change Sets and Deployment.............................................................................................................................220
- Visualforce..........................................................................................................................................................221
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apex Code</td>
<td>227</td>
</tr>
<tr>
<td>API</td>
<td>245</td>
</tr>
<tr>
<td>ISVForce</td>
<td>258</td>
</tr>
<tr>
<td>Additional Force.com Enhancements</td>
<td>277</td>
</tr>
<tr>
<td>Critical Updates</td>
<td>283</td>
</tr>
<tr>
<td>Other salesforce.com Products</td>
<td>285</td>
</tr>
<tr>
<td>Help and Training</td>
<td>286</td>
</tr>
</tbody>
</table>
About the Release Notes

The Release Notes are a comprehensive user guide for the latest release of Salesforce. Unlike a traditional release notes document that includes only a simple list of enhancements, the Salesforce Release Notes give you everything you need to get up and running with the new features and enhancements in the latest release.

What’s Included in the Release Notes

For every new major enhancement, the Release Notes provide:

• A brief, high-level description of the functionality
• Implementation tips to help you get started with setup and administration
• Best practices to help you maximize the benefit
• Complete end-to-end instructions

For each feature set, Additional Enhancements sections provide a list and brief description of every other enhancement or functional change included in the latest release.

Let the Release Notes be your guide to success with the latest release from salesforce.com!

Your Feedback Matters

We know how important the Release Notes, online help, and documentation are to your company’s success with Salesforce. To continually improve the content we deliver to you, we want to know what works and what doesn’t. Let us know!

• Feedback forms—Every HTML documentation page, both in the online help and in our developer guides at Developer Force, includes a feedback form for you to submit your suggestions, corrections, and feedback about the documentation. Let us know what you think!
• IdeaExchange—We’re listening to your ideas too. Summer ’13 includes some of your top ideas. Visit IdeaExchange for a complete list of ideas coming in Summer ’13.

Want to be notified whenever we publish new documentation or make significant updates to existing documentation? Follow us on Twitter: @salesforcedocs.
Welcome to the Release Notes Change Log. Anything that’s changed with each new iteration of the release notes is right here, with the newest updates at the top.

<table>
<thead>
<tr>
<th>Date</th>
<th>What’s New</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 2013</td>
<td>Chatter for iPhone and iPad – Version 4.1 Generally Available</td>
<td>Chatter for iPhone and iPad v4.1 is now generally available.</td>
</tr>
<tr>
<td>August 21, 2013</td>
<td>Contact, Account, and Lead Profile Image Visibility</td>
<td>Profile images from Facebook or Twitter for contacts, accounts, or leads may be visible even if you are not currently logged in to those services.</td>
</tr>
<tr>
<td>July 19, 2013</td>
<td>Chatter for Android – Version 3.3 Generally Available</td>
<td>Chatter for Android v3.3 is now generally available.</td>
</tr>
<tr>
<td>July 17, 2013</td>
<td>Environment Hub—Pilot</td>
<td>Minor editing changes to the section on adding new linked users to the Environment Hub.</td>
</tr>
<tr>
<td>July 10, 2013</td>
<td>Support for JWT HMAC Removed</td>
<td>Noted that the OAuth 2.0 JSON Web Token (JWT) token flow no longer supports HMAC SHA256.</td>
</tr>
<tr>
<td>July 10, 2013</td>
<td>See Shared Activities Reflected in Custom Reports</td>
<td>Clarified that not all reports show secondary as well as primary contacts on an activity, but only reports based on the Activities with Contacts custom report type.</td>
</tr>
<tr>
<td>July 3, 2013</td>
<td>New and Changed Objects</td>
<td>Deleted incorrect entry stating that the IsSplit field had been removed from the Opportunity object.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Updated API Endpoint Changes</td>
<td>Added more information on API endpoint changes, including details if using My Domain and a sandbox.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Chatter API</td>
<td>The Message Segment: Hash Tag and the Message Segment: Text request bodies support multiple word hash tags. You no longer need to surround multiple word hash tags with square brackets.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Public Knowledge Base for Mobile Devices</td>
<td>The Public Knowledge Base 2 package on the AppExchange now includes a site map feature for search engine optimization and a mobile deployment option.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Follow Button on Record Feed</td>
<td>Added information about the new location of the Follow button on record detail pages.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Visual Workflow Runtime Behavior for Empty String and Null Values</td>
<td>Added information about flow runtime enhancements that may change the behavior of Decision and Assignment elements.</td>
</tr>
<tr>
<td>June 26, 2013</td>
<td>Improved Setup User Interface</td>
<td>Added note that if the improved Setup user interface is disabled in a Trialforce source organization, it will also be disabled in any organization created from the Trialforce source organization.</td>
</tr>
<tr>
<td>June 19, 2013</td>
<td>Other Notes on Activities</td>
<td>In Salesforce Help, updated description of operations that aren’t supported in certain triggers.</td>
</tr>
<tr>
<td>June 19, 2013</td>
<td>Help and Training</td>
<td>Added link to the video “Forecast Accurately With Collaborative Forecasts.”</td>
</tr>
<tr>
<td>Date</td>
<td>What's New</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>June 19, 2013</td>
<td>Salesforce Communities—Generally Available and Help and Training</td>
<td>Added link to the video “Setting Up Your Salesforce Community.”</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Consolidated Limits for Asynchronous Apex</td>
<td>Added a note to point out that scheduled Apex jobs now appear also on the Apex Jobs page.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Chatter API</td>
<td>The page parameter for the User Conversations (/chatter/users/userId/conversations) and User Messages (/chatter/users/userId/messages) resources was incorrectly documented as an integer. It is now correctly documented as a string and has the correct description.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Help and Training</td>
<td>Added link to the video “How to Merge Contacts in Salesforce.”</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Updated API Endpoint Changes</td>
<td>Added more information regarding the new API endpoint changes.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Enabling the Improved Setup User Interface</td>
<td>Added note that the improved Setup user interface can't be enabled when the new user interface theme is disabled.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Editions table for My Domain</td>
<td>The editions table was corrected to read Unlimited, Enterprise, Developer, Professional, and Group Editions.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>HTML5 and Output Tag Generation Options</td>
<td>Revised the description of reduced HTML “tidying” for Visualforce pages set to docType=&quot;html-5.0&quot;. Tidying is still performed, but in a more relaxed fashion.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>HTML Editor Upgrade for Text Area (Rich) Fields</td>
<td>Expanded the description of the updated rich text editor to provide details of the improved Insert Link function.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Field History Tracking Deletion</td>
<td>Updated the description of salesforce.com's field history tracking deletion policy.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>Add and Customize Actions in the Chatter Publisher</td>
<td>Updated the list of supported objects for publisher actions.</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>New and Changed Objects</td>
<td>Added information on field visibility changes in the following objects when Communities is enabled:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Task</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Lead</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Opportunity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• User</td>
</tr>
<tr>
<td>June 12, 2013</td>
<td>New and Changed ConnectApi Classes</td>
<td>There are two new ConnectApi.ChatterGroups.setTestSearchGroups methods to match the two existing searchGroups methods.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There are three new ConnectApi.ChatterUsers.setTestSearchUsers methods to match the three existing searchUsers methods.</td>
</tr>
<tr>
<td>June 5, 2013</td>
<td>New and Changed ConnectApi Classes</td>
<td>There are two new ConnectApi.ChatterFavorites.setTestGetFeedItems methods to match the two existing getFeedItems methods.</td>
</tr>
<tr>
<td>Date</td>
<td>What's New</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>June 5, 2013</td>
<td>Changes to Case Feed Feed Items</td>
<td>Removed the “Changes to Feed Filters” section, as the changes described no longer apply.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Describe Layouts</td>
<td>Moved resource information about layouts from Publisher Quick Actions section to its own section.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Help and Training</td>
<td>Added links to the videos, “Splitting Credit across Your Sales Team” and “Activating Your Computer.”</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>HTML Editor Upgrade for Text Area (Rich Fields)</td>
<td>The editor for rich text area fields was updated.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Clarification of Data.com product names</td>
<td>The Data.com product suite includes Data.com Prospector and Data.com Clean, and each has a Corporate and Premium version.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Salesforce Mobile Rebrand</td>
<td>Salesforce Mobile is now Salesforce Classic for Android™, BlackBerry® and iPhone® devices.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Chatter in Apex—Generally Available</td>
<td>Added a link to the Chatter in Apex video.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Creating Proxy Signups for OAuth and API Access</td>
<td>Minor changes to the procedure for creating a proxy signup.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Multi-Provider Single Sign-On and New Login Page Look and Feel</td>
<td>Added that the features are available after June 15, 2013.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>AuthProvider Metadata Type</td>
<td>Removed because it was previously released.</td>
</tr>
<tr>
<td>May 22, 2013</td>
<td>Tips for Reducing Formula Size</td>
<td>Added this tipsheet to the Help and Training section.</td>
</tr>
<tr>
<td>May 17, 2013</td>
<td>DKIM Signing of Outbound Email</td>
<td>Removed information about this feature. The feature isn't part of the Summer '13 release.</td>
</tr>
<tr>
<td>May 17, 2013</td>
<td>Salesforce Communities—Generally Available</td>
<td>Added a link to the Getting Started With Salesforce Communities guide.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Twitter Profiles in Salesforce Touch</td>
<td>Added screen shots for iPhone and iPad.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Analyzing Data Quality with Data.com Data Assessments</td>
<td>Clarified the instructions for getting the Data.com Data Assessments AppExchange package for your organization.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Help and Training</td>
<td>Added the Help and Training section, which includes the Chatter Topics video.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Additional Sharing Enhancements</td>
<td>Updated the description for Asynchronous Recalculation of Sharing Settings.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Viewing Records Offline with Salesforce Touch (Pilot)</td>
<td>Clarified when stored data is cleared from the Salesforce Touch downloadable app.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Publisher Quick Actions</td>
<td>Corrected URI format to services/data/v28.0/quickActions/.</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td>Search Layouts</td>
<td>Corrected URI format to services/data/v28.0/search/layout/?q=Account, Contact, Lead, Asset.</td>
</tr>
<tr>
<td>Date</td>
<td>What's New</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>May 15, 2013</td>
<td><strong>Partner Portal Users Can See Customer Portal Users From the Same Account</strong></td>
<td>Added sections to clarify that when external user sharing is enabled, partner portal and customer portal users under the same account can see each other.</td>
</tr>
<tr>
<td>May 8, 2013</td>
<td><strong>Site.com isn’t available on Sandbox</strong></td>
<td>Removed the entry about Site.com being available on Sandbox.</td>
</tr>
<tr>
<td>May 8, 2013</td>
<td><strong>Salesforce Communities—Generally Available</strong></td>
<td>In the “Communities License Types” section, clarified levels of access to Content for users with and without a Salesforce CRM Content feature license.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the “Who Can See What in Communities” section, added information to clarify what users see when accessing the My Settings menu in the global header, depending on the type of user and whether the organization has enabled the improved Setup user interface.</td>
</tr>
<tr>
<td>May 1, 2013</td>
<td><strong>New Classes and Methods for Publisher Actions</strong></td>
<td>Added method descriptions for Chatter Publisher Action classes.</td>
</tr>
<tr>
<td>May 1, 2013</td>
<td><strong>Salesforce Communities—Generally Available</strong></td>
<td>Removed link to the Getting Started With Salesforce Communities guide. This guide will be available with the Summer ’13 release.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Forecast Using Quantities</strong></td>
<td>Removed reference to default display selector for data source. This option isn’t part of the Summer 13 release.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Old Bookmarks Continue to Work When Moving to My Domain</strong></td>
<td>Added a description of the Administrator’s choices for handling page requests that don’t use the new domain name.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>More Rules Available in Change Sets</strong></td>
<td>Added an entry stating Auto-Response Rules, Escalation Rules, and Assignment Rules are now available in change sets.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>New Option in Case Feed Setup</strong></td>
<td>Added information about requirements for using custom actions in Case Feed for organizations that have publisher actions enabled and opt to use the advanced page layout editor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added information about changes to the Case Details page in Case Feed for organizations that have publisher actions enabled and opt to use the advanced page layout editor.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Creating Proxy Signups for OAuth and API Access</strong></td>
<td>Added a new section on this feature.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Chatter Topics</strong></td>
<td>All Chatter Topics features are available within 24 hours after the Summer ’13 release.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Salesforce Communities—Generally Available</strong></td>
<td>Noted that you can’t disable the “View Global Header” permission in standard profiles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added more detail about membership to the “Adding Members to Your Community” section.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>New and Changed ConnectApi Classes</strong></td>
<td>ConnectApi.ChatterFavorites.addRecordFavorite is a new method that adds a topic as a favorite.</td>
</tr>
<tr>
<td>Date</td>
<td>What's New</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>SOAP API</strong></td>
<td>Added <code>DescribeQuickActionListResult</code> and <code>DescribeQuickActionListItemResult</code>.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Record Type Description Text Now Wraps</strong></td>
<td>Added information about a change to the <code>Description</code> field on record types.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>New and Changed ConnectApi Output Classes</strong></td>
<td>Removed the <code>ConnectApi.ChatterGroupSummary.groups</code> property.</td>
</tr>
<tr>
<td>April 24, 2013</td>
<td><strong>Add and Customize Actions in the Chatter Publisher</strong></td>
<td>Added information on the recommended maximum number of actions to include in each publisher for the best user experience.</td>
</tr>
</tbody>
</table>
**Feature Summary and User Impact**

Summer ’13 has features that immediately affect all users after the release. You may want to communicate these changes to your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit from the new functionality.

When will you start seeing Summer ’13 changes on your instance? The best way to find out is to check the Major Release Schedule section of the Salesforce trust site at trust.salesforce.com/trust/maintenance/.

These release notes describe the new and modified features available in this release. For visibility into known salesforce.com issues, please refer to the Known Issues Site.

This table summarizes the Summer ’13 features and their impact on users. Review the feature details for the applicable Salesforce editions.

### Salesforce

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser Enhancements</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Updates to Translated Terminology</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Usage-based Entitlements Now Displayed in Setup—Beta</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
</tbody>
</table>

### Chatter

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salesforce Communities:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Salesforce Communities—Generally Available</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Publisher Actions:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add and Customize Actions in the Chatter Publisher</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>New Feed Tracking Option with Publisher Actions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tasks in Feeds Settings (Chatter Tasks)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replaced by Publisher Actions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Topics:</strong> (all Chatter Topics features available within 24 hours after the Summer ’13 release)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chatter Topics—Generally Available</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adding Topics to Posts</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing Details About a Topic</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adding a Topic as a Favorite</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing All Topics</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Viewing the Topics Groups Are Talking About</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Removing Topics from Posts</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deleting Topics</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Topics Reporting</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Topics Privacy</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Upgrading Hashtag (#) Topics to Chatter Topics</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Improved Trending Topics</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Improved Topics on Profiles</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td><strong>Feeds:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find in Feed: Searching in a Specific Feed</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Updated Menu for Bookmarking or Deleting Posts</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>New and Updated Feed Filters for Chatter Page and Record Pages</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Follow Button on Record Feed</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>New Preview Links</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td><strong>Additional Enhancements:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Summary and User Impact

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do More with Chatter Email Replies</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile and Contact Information Updates</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enhanced Profile Page Layout—Pilot</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chatter Desktop Version 3.2</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Organization-Wide Search in Chatter Messenger</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Style Enhancements for Chatter List Views</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>API Enhancements:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chatter API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Sales

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activities</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relate More Contacts to Activities</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>See Shared Activities Reflected in Custom Reports</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shared Activities Works More Smoothly with Email to Salesforce</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Notes on Activities</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Forecasts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Using Quantities</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Quotas Based on Quantity</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a Forecasting Quotas and Forecasting Items Custom Report Type</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Find Display Options More Easily</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Opportunities</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introducing Opportunity Splits</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Partner Portal</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updates to Partner Portal User Management and Delegated Administration</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Public Field on Events and Tasks Now Applies to Partner Users in Communities</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partner Portal Users Can See Customer Portal Users From the Same Account</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Price Books</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customizable Price Books</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Easier Access to Price Books</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updates to Price Books Archiving</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Salesforce for Outlook</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Emails to Multiple Records with the Salesforce Side Panel</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Emails to Multiple Records without the Salesforce Side Panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manually Select Items to Sync</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search for More Kinds of Records in the Salesforce Side Panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Cases Related to Contacts in the Salesforce Side Panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tasks</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Publisher Actions Replace Chatter Tasks</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Social Accounts, Contacts, and Leads</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contact, Account, and Lead Profile</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Visibility on page 98</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td><strong>Case Feed</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Option in Case Feed Setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changes to Case Feed Feed Items</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Chatter Answers</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chatter Answers for Everyone</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Associate Chatter Answers with Salesforce Communities</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Chatter Answers Tab for Internal Users</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Designate a Public Group as a Customer Support Agents Group</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Reputation Points Assigned by Zone</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Username Format Throughout a Zone</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Customize Chatter Answers User Profiles in Salesforce Communities</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Chatter Answers Supersedes Answers</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td><strong>Customer Portal</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updates to Customer Portal User Management and Delegated Administration</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Visible in Self-Service Field on Events and Tasks Renamed to Public</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Behavior of Available for Customer Portal Checkbox on Custom Objects Changes if Communities is Enabled</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Customer Portal Users Can See Partner Portal Users From the Same Account</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td><strong>Entitlement Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Multiple Versions of Entitlement Processes</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Increased Limit for Entitlement Processes</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td><strong>Ideas</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encourage Idea Creation and Sharing in Salesforce Communities</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Encouraging Innovation with Idea Reputation</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Organize Ideas with Zones</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>API Access to Photos for Ideas and Comments</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Upload Photos to ChatterProfile with a Visualforce Component</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Setting Page Layouts for Ideas</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Add Apex Triggers to Idea Comments</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>View the Number of Ideas Submitted to an Idea Theme</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Add File Attachments to Ideas</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Community Nickname Field Renamed to Nickname</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td><strong>Salesforce Knowledge</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge One—Beta</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Smart Article Links</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Set Article Fields as Required</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Links to Draft Articles</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>New UPDATE Clauses to Report on Article Searches and Views</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Metadata API Access to Salesforce Knowledge Languages</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
<td>![ ]</td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Public Knowledge Base for Mobile Devices</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>Live Agent</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>New Live Agent Sessions Page</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Live Agent Sessions Reporting</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>New Live Chat Transcript Events Options</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Live Agent Supervisor Page</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Multiline Text Input Available in Live Agent Chat Window</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>On-Demand Email-to-Case</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>On-Demand Email-to-Case: Change to Thread ID Handling</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Open CTI</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>Open CTI: New Methods</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Service Cloud Console</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>Updated User Interface</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>New Keyboard Shortcuts</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Refresh Specific Tabs</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Service Cloud Console Integration Toolkit: New Methods</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Turn On Highlights Panels and Interaction Logs</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Tasks Available for Push Notifications</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
<tr>
<td>Social Customer Service</td>
<td></td>
<td></td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
</tr>
<tr>
<td>Social Persona and Social Post Objects—Pilot</td>
<td>![ ](</td>
<td>background-color: #e0e0e0;</td>
<td>)</td>
<td>![ ](</td>
</tr>
</tbody>
</table>
### Analytics

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fine-Grained Sharing for Report and Dashboard Folders (available within 24 hours after the Summer ‘13 release)</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>View Dashboards in Salesforce Touch on iPhone Devices</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Dashboards in Chatter 4.0 for iPhone and iPad Devices</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Sticky Dashboard Filters</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Scatter Charts Default Dashboards Behavior</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>External Users Can View Reports and Dashboards in Communities</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
</tbody>
</table>

### Mobile

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salesforce Touch</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Chatter for Android – Version 3.3 Generally Available</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Chatter for iPhone and iPad – Version 4.1 Generally Available</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
<tr>
<td>Salesforce Mobile Rebrand</td>
<td><img src="check.png" alt=" " /></td>
<td></td>
<td><img src="check.png" alt=" " /></td>
<td><img src="check.png" alt=" " /></td>
</tr>
</tbody>
</table>
## Feature Summary and User Impact

### Data.com

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data.com Prospector</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Limit What Users Can Do with Data.com Search Results</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data.com Usage Report</td>
<td></td>
<td></td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>Expanded Metro Area List in Data.com Location Selector</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Fields in Data.com Export Files</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data.com Clean</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D&amp;B DUNSRight Matching is GA</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule and Run a Full Sync with Your Next Accounts Clean Job</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analyze Your Organization’s Data Quality with a Data.com Data Assessment</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selecting a Matching Account Record from Data.com</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select a Different Data.com Match for a Salesforce Account Record</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Streamlined and Enhanced Clean Job History</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Correct Calculation for Update Rate</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data.com Social Key (Beta in Summer ’13)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data.com Social Key Overview</td>
<td>☑</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Site.com

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name and Behavior Changes for User Roles</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Restrictions—Generally Available</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Widgets</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Authorizing Site.com Pages for Communities</td>
<td>✅</td>
<td>Users must have Communities enabled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Branded Site.com Pages for Communities</td>
<td>✅</td>
<td>Users must have Communities enabled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Community User Information</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Force.com

### Critical Updates

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS Identity Confirmation Requirement</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Summary and User Impact

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apex <code>addError</code> Method Default Behavior Change</td>
<td>[ ]</td>
<td></td>
<td>[ ]</td>
<td></td>
</tr>
<tr>
<td>Require Secure Connections (HTTPS)</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Major Force.com Enhancements

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup User Interface</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Improved Setup User Interface</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Developer Console</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Developer Console New Look and Feel</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apex Code Completion</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highlighting in the Source Code Editor</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Force.com Canvas</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Force.com Canvas—Generally Available</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(available within 24 hours after the Summer '13 release)</td>
<td>[ ]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Permission Sets

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Types in Permission Sets</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Sharing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Sharing Overview</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Granting Access to Internal User Records</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Search

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing SharePoint Data via Sunlight Search — Beta</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Formulas

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner Fields in Custom Formulas</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Formula Editor Now in Monospace Font</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkbox Formulas</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Security

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Enhancements</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connected Apps Enhancements</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSRF Protection</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi-Provider Single Sign-On</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
<tr>
<td>New Login Page Look and Feel (Available after June 15, 2013.)</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for JWT HMAC Removed</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inbound Two-Way SSL/TLS—Pilot</td>
<td></td>
<td></td>
<td></td>
<td>✅</td>
</tr>
</tbody>
</table>
## My Domain

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users.</th>
<th>Automatically visible to all administrators.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Domain Subdomain Availability</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Old Bookmarks Continue to Work When Moving to My Domain</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Sandboxes

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users.</th>
<th>Automatically visible to all administrators.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sandbox Templates—Generally Available</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sandbox User Interface Enhancements</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Settings Copied to All Sandbox Types</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Change Sets and Deployment

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users.</th>
<th>Automatically visible to all administrators.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Process Deployment Enhancements</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Summary and User Impact

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher Actions Available in Packages and Change Sets</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>More Rules Available in Change Sets</td>
<td></td>
<td>✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User References Transfer during a Deployment</td>
<td></td>
<td></td>
<td>✅</td>
<td></td>
</tr>
</tbody>
</table>

### Visualforce

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualforce Pages and Components Sort Order</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upload Photos to ChatterProfile with a Visualforce Component</td>
<td></td>
<td></td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>support:clickToDial Component</td>
<td></td>
<td>✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>profileId Attribute for chatteranswers:registration Component</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTML5 and Output Tag Generation Options</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OAuth 2.0 Authentication for JavaScript Remoting</td>
<td></td>
<td>✅</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configurable Timeout for JavaScript Remoting Requests</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSRF Protection for Objects That Override the Standard Delete Link with a Visualforce Page</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relaxed Compile-Time Checking of Custom Component Attribute Names</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Apex Code

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chatter in Apex—Generally Available</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consolidated Limits for Asynchronous Apex</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Methods Defined in Test Classes</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Classes and Methods</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DML Operations Support Before Mock Callouts in Test Methods</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triggers for</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ChatterAnswersActivity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apex Web Services Endpoint Change</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Versioned Changes</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### API

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>API Endpoint Changes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOQL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increased Query Size Limit for SOQL</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPDATE VIEWSTAT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional Comparison Operators Supported For Primary Key Fields</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FOR VIEW and FOR REFERENCE SOQL Clauses</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Summary and User Impact

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOSL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increased Limit for SOSL Query Results</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increased Query Size Limit for SOSL</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPDATE TRACKING</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UPDATE VIEWSTAT</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>REST</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assignment Rule Header for REST API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recently Viewed Items Resource for REST API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Layouts for REST API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Publisher Quick Actions for REST API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Layouts for REST API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional APIs</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOAP API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metadata API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tooling API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ISVforce

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment Hub—Pilot</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Installing Managed Packages using the API</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Packaging Connected Apps</td>
<td>✅</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Summary and User Impact

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Signups using the API—Generally Available</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Creating Proxy Signups for OAuth and API Access</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

### Additional Force.com Enhancements

<table>
<thead>
<tr>
<th>Feature</th>
<th>Automatically visible to all users. No setup required.</th>
<th>Automatically visible to all administrators. No setup required.</th>
<th>Not automatically visible. Feature is available but requires some setup.</th>
<th>Contact salesforce.com to enable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Import Wizard — Pilot</td>
<td>✔</td>
<td></td>
<td></td>
<td>Not automatically enabled for Enterprise and Unlimited Edition organizations.</td>
</tr>
<tr>
<td>Custom State and Country Picklists—Beta</td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Force.com App Menu Label Changes</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updates to the Buttons and Links Page</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field History Tracking Deletion</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Time Zones</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parenthetical Currency Conversion Now Optional</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field Level Security Defaults “On” for New Custom Fields in Schema Builder</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record Type Description Text Now Wraps</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contract Fields Enabled for Workflow Time Triggers</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Automatically visible to all users. No setup required.</td>
<td>Automatically visible to all administrators. No setup required.</td>
<td>Not automatically visible. Feature is available but requires some setup.</td>
<td>Contact salesforce.com to enable this feature.</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>HTML Editor Upgrade for Text Area (Rich) Fields</td>
<td>[✔️]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Domain Management</td>
<td></td>
<td></td>
<td></td>
<td>[✔️]</td>
</tr>
<tr>
<td>New CNAME Requirement for Sites</td>
<td></td>
<td></td>
<td></td>
<td>[✔️]</td>
</tr>
<tr>
<td>Visual Workflow Runtime Behavior for Empty String and Null Values</td>
<td></td>
<td></td>
<td></td>
<td>[✔️]</td>
</tr>
</tbody>
</table>
Browser Enhancements

Salesforce now supports Apple® Safari® 6.x on Mac OS X.

Supported Browsers

Browsers

Salesforce supports these browsers.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Microsoft® Internet Explorer® versions 7, 8, 9, and 10 | If you use Internet Explorer, we recommend using the latest version. Apply all Microsoft software updates. Note these restrictions.  
- The Compatibility View feature in Internet Explorer isn’t supported.  
- The Metro version of Internet Explorer 10 isn’t supported.  
- Internet Explorer 7 and 8 aren’t supported for the Developer Console.  
- Internet Explorer 10 isn’t supported for the Service Cloud console.  
- Internet Explorer 7 isn’t supported for Open CTI.  
- Internet Explorer 7 isn’t supported for Salesforce CRM Call Center built with CTI Toolkit version 4.0 or higher.  
- Internet Explorer 7 isn’t supported for Force.com Canvas.  

For configuration recommendations, see “Configuring Internet Explorer” in the Salesforce Help. |
<p>| Mozilla® Firefox®, most recent stable version | Salesforce.com makes every effort to test and support the most recent version of Firefox. For configuration recommendations, see “Configuring Firefox” in the Salesforce Help. |
| Google Chrome™, most recent stable version | Google Chrome applies updates automatically; salesforce.com makes every effort to test and support the most recent version. There are no configuration recommendations for Chrome. Chrome isn’t supported for the Console tab or the Add Google Doc to Salesforce browser button. |
| Google Chrome Frame™ plug-in for Microsoft® Internet Explorer® 6 and 7 | Supported plug-in for Internet Explorer 6 and 7 only. Google Chrome Frame applies updates automatically; Salesforce supports only the most recent version. For configuration recommendations, see “Installing the Google Chrome Frame™ Plug-In for Microsoft® Internet Explorer” in the Salesforce Help. |</p>
<table>
<thead>
<tr>
<th>Browser</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Apple® Safari® versions 5.x and 6.x on Mac OS X | There are no configuration recommendations for Safari. Apple Safari on iOS isn’t supported.  
• Safari isn’t supported for the Service Cloud console.  
• Safari isn’t supported for Salesforce CRM Call Center built with CTI Toolkit versions below 4.0. |

## Recommendations and Requirements for All Browsers

- For all browsers, you must enable JavaScript, cookies, and SSL 3.0.
- Salesforce.com recommends a minimum screen resolution of 1024 x 768 for the best possible user experience. Screen resolutions smaller than 1024 x 768 may not display Salesforce features such as Report Builder and Page Layout Editor properly.
- Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience malfunctions or inconsistent behavior with Chatter, disable all of the Web browser's plug-ins and extensions and try again.

Certain features in Salesforce—as well as some desktop clients, toolkits, and adapters—have their own browser requirements. For example:

- Internet Explorer is the only supported browser for:
  ◊ Standard mail merge (We don’t support Google Chrome Frame™ plug-in for Internet Explorer because the ActiveX controls required for mail merge are supported in Internet Explorer only.)
  ◊ Installing Salesforce Classic on a Windows Mobile device
  ◊ Connect Offline
- Firefox is recommended for the enhanced page layout editor.
- Browser requirements also apply for uploading multiple files on Chatter.

## Discontinued or Limited Browser Support

As of Summer ’12, salesforce.com discontinued support for Microsoft® Internet Explorer® 6. Existing features that have previously worked in this browser may continue to work through 2014. Note these support restrictions.

- Internet Explorer 6 isn’t supported for:
  ◊ Chatter
  ◊ Global search
  ◊ Answers
  ◊ Cloud Scheduler
  ◊ The new user interface theme
  ◊ Quote Template Editor
  ◊ Service Cloud console
  ◊ Salesforce Knowledge
  ◊ Live Agent
  ◊ Forecasts
  ◊ Chatter Answers
Updates to Translated Terminology

We’ve updated some terminology, including tab and field names for our Arabic, Czech, Brazilian Portuguese, Danish, Dutch, Finnish, German, Hebrew, Swedish, and Thai language users. For each term, we provide the English version and the corresponding previous and new translations. You can find the complete list of term changes in knowledge article number 000176440 (URL: https://help.salesforce.com/apex/HTViewSolution?urlname=Summer-13-Updates-to-Translated-Terminology&language=en_US) on the salesforce.com Customer Support site.

These terminology changes are available to all organizations. To keep your current tab and field labels, system administrators can change the name back using our rename tabs and labels functionality. For more information, see “Renaming Tab and Field Labels” and “Considerations for Renaming Tab and Field Labels” in the online help or contact Customer Support.

For more information about supported languages, see “What languages does Salesforce support?” in the Salesforce Help.

Usage-based Entitlements Now Displayed in Setup—Beta

System administrators can see which usage-based entitlements their organization is allowed to use, and how much of each usage-based entitlement they can use each month.

Available in: Enterprise and Unlimited editions

Note: This release contains a beta version of usage-based entitlements that is production quality but has known limitations.

A usage-based entitlement is a resource that your organization can use on a per-month basis, such as the allowed number of logins to a Partner Community.

Some entitlements are persistent. These entitlements give your organization a set number of the resource, and the amount allowed doesn’t change unless your contract is changed. For example, if your company purchases monthly subscriptions for 50 members to access a Partner Community, you can assign up to 50 individuals the ability to log into the community as many times as they want.

Other entitlements are not persistent; these work like credit. Your organization can use up to the amount allowed of that entitlement each month. The start and end of the month is determined by your contract, rather than following a calendar month. For example, if your company purchases 50 monthly logins for a Partner Community, on January 15 your organization has a pool of 50 logins. Each time someone logs in, one login is used up. On February 15, no matter how many you used in the previous month, the pool is refreshed and 50 logins are available through March 14.
Salesforce.com supports displaying usage-based entitlements related to Communities and Force.com App subscriptions.

To see usage-based entitlements that your organization has access to, from Setup, click **Company Profile > Company Information** and see the Usage-Based Entitlements related list.
Salesforce Communities—Generally Available

Watch a Demo: Setting Up Your Salesforce Community (5:59 minutes)

Salesforce Communities are public or private, branded spaces for your employees, customers, and partners to connect.

Communities are a great way to share information and collaborate with people outside your company who are key to your business processes, such as customers or partners.

You can use Communities to:

- Drive more sales by connecting your employees with your distributors, resellers, and suppliers
- Deliver world-class service by giving your customers one place to get answers
- Manage social listening, content, engagement, and workflow all in one place

You can create multiple communities within your organization for different purposes. For example, you could create a customer support community to reduce support costs, or a channel sales community for partner deal support, or you could have a community specifically dedicated to an upcoming event.

Communities may contain a subset of features and data available in your internal Salesforce organization and can be customized to use your company branding. In addition, you can choose which members from your company and which customers, partners, or other people outside your company can join.

Communities live inside your organization and are easily accessed from a drop-down menu in the top left corner of Salesforce. Use this menu to switch between your communities and your internal Salesforce organization.

Note: Salesforce Communities are available in Salesforce Touch, but they don’t include all features of the full site. For more information, see Salesforce Touch Differences from the Full Salesforce Site.

For detailed information on setting up Salesforce Communities, see Getting Started With Salesforce Communities.

You can customize communities to meet your business needs, including:

- Choosing which members from your company and which customers, partners, or other people outside your company can join
- Selecting which Salesforce features to include
- Applying your company’s branding so that the community is recognizable
- Enabling your employees, customers, and partners to collaborate on Chatter and business processes (records)
- Enabling login options based on SAML for single sign-on for people outside your company
- Enabling users to self register for a community so that the administrator isn’t responsible for adding users

In addition to the standard out-of-box customizations, you can perform many advanced customizations including:

- Creating public pages in your community that don’t require login
- Customize error pages
• Creating a custom login page for external users of your community

**Impact on Customer Portal and Partner Portal Users**

Starting in Summer ’13, the partner portal and Customer Portal are no longer available for organizations that aren’t currently using these portals. We’re encouraging new customers to try Communities.

Existing organizations continue to have full access and may continue to use their portals or transition to Communities. Contact your Salesforce Account Executive for more information.

Organizations that continue to use their portals should be aware of some changes that affect portal behavior.

For information on changes to the partner portal, see:

• Updates to Partner Portal User Management and Delegated Administration
• Public Field on Events and Tasks Now Applies to Partner Users in Communities

For information on changes to the Customer Portal, see:

• Updates to Customer Portal User Management and Delegated Administration
• Visible in Self-Service Field on Events and Tasks Renamed to Public
• Behavior of Available for Customer Portal Checkbox on Custom Objects Changes if Communities is Enabled

**Communities Licenses**

Communities introduces the following new licenses:

• Customer Community
• Partner Community

The Customer Community license is similar to a High Volume Customer Portal license and is well-suited for business-to-consumer communities with large numbers of external users. The Partner Community license is similar to a Gold Partner license and is well-suited for business-to-business communities, such as a partner community.

In addition to the new licenses, Communities supports all internal and portal licenses including existing Customer Portal, Authenticated Website, and partner portal licenses. Communities doesn’t support the Chatter External license.

The following table shows which standard Salesforce features are available with each license type.

<table>
<thead>
<tr>
<th></th>
<th>Customer Community</th>
<th>Partner Community</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Read Only access to their own account</td>
<td></td>
</tr>
<tr>
<td>Contacts</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Read Only access to their own contact</td>
<td></td>
</tr>
<tr>
<td>Assets</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Cases</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Can create and manage their own cases</td>
<td></td>
</tr>
<tr>
<td>Customer Community</td>
<td>Partner Community</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>Leads</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Opportunities</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Chatter (People, Groups, Feeds, Files)</td>
<td>✅</td>
<td>✅</td>
</tr>
<tr>
<td>Chatter Answers</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Ideas</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td>✅ Read Only</td>
<td>✅ Read Only</td>
</tr>
<tr>
<td>Mobile</td>
<td>✅ Read Only</td>
<td>✅ Read Only</td>
</tr>
<tr>
<td>Content (without a Salesforce CRM Content feature license)</td>
<td>✅ View Only</td>
<td></td>
</tr>
<tr>
<td>Reports &amp; Dashboards</td>
<td>✅ Read Only</td>
<td>✅ Read Only</td>
</tr>
<tr>
<td>Activities</td>
<td>✅</td>
<td>✅ Read Only</td>
</tr>
<tr>
<td>Campaigns</td>
<td>✅ Read Only</td>
<td>✅ Read Only</td>
</tr>
<tr>
<td>Email</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Delegated Administration</td>
<td>✅</td>
<td>✅</td>
</tr>
<tr>
<td>Roles and Sharing</td>
<td>✅</td>
<td></td>
</tr>
<tr>
<td>Custom Objects</td>
<td>✅ 10 custom objects per license</td>
<td>✅ 10 custom objects per license</td>
</tr>
</tbody>
</table>

### Best Practices for Setting Up Communities

Successful communities require actively engaged members. Here are some tips to create a successful community:

- Make sure the right people have access. Membership is based on profile or permission set. To include people from outside your company in a community, you’ll need to assign them profiles or permission sets that have access to the community.
- Customize your community so that it resembles your company brand. You want customers, partners, and other members from outside your company to recognize your brand when they enter your community.
• Add only the tabs necessary for your community members. Don’t include extra tabs for features that won’t be used.
• Select a landing tab that will be useful for community members since it is the first thing members see when they log in. Choose to use a Home tab similar to your internal Salesforce organization, the Chatter tab with a personalized name, a custom Visualforce tab, or a custom tab created using Site.com.
• Allow stakeholders to preview the community before you publish it. This allows you to get their feedback, and you can take advantage of having early members who can post, comment, and share records so that members enter an active community from their first login.
• Designate a moderator for each community. Moderators can monitor the community on a regular basis to engage members, spark conversations and keep them going, ensure that users have access to appropriate records, remove spam, and more.
• Designate a user friendly community domain. By default, we use Force.com, but you can customize the URL using Custom Domain. Contact Salesforce.com for information on enabling Custom Domain.
• Create a mobile client for your users. You can use Salesforce Touch, but will need to create a custom client if branding is essential.

Enabling Salesforce Communities

Available in: Unlimited, Developer, Enterprise Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable Communities:</td>
</tr>
<tr>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Enabling Communities changes the user interface for every user in your organization. Specifically, it:
• Introduces a new global header for every user in your organization, regardless of whether or not they’re in a community. Note that you can hide it by disabling the “View Global Header” permission on custom profiles. You can’t disable this permission on standard profiles. However, disabling it hides the drop-down menu for switching between communities. Ensure that your users are aware of the new header before enabling Communities.
• Enables the new user interface theme, which updates the look and feel of Salesforce.

Note: Once you enable Communities, you can’t turn it off.

If your organization’s access to Communities is suspended for non-payment of fees due, all of your communities are taken offline, including those in Preview status. When Communities is enabled again, all communities are in Offline status. You can publish these communities, but can’t return them to Preview status.

1. From Setup, click Customize > Communities > Settings.
2. Select **Enable Communities**.

3. Select a domain name to use for your communities, then click **Check Availability** to make sure it’s not already being used.

   We suggest that you use something recognizable to your users, such as your company name. Although the domain name is the same for all communities, you create a unique URL for each community during the creation process. For example, if your domain is `UniversalTelco.force.com` and you’re creating a customer community, you can designate the URL as `UniversalTelco.force.com/customers`.

   !important: Keep in mind that you can’t change the domain name after you save it.

You can designate a completely custom domain by entering it in on the Domain Management page. From Setup, click **Domain Management > Domains**.

4. Click **Save**.

You can now create communities.

### Setting the Default Number of Community Roles

Set the default number of roles created when adding partner accounts to communities.

| Available in: Unlimited, Developer, Enterprise Editions |

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set the number of default roles: “Customize Application”</td>
</tr>
</tbody>
</table>

If your community is set up with Partner Community user licenses, this setting applies. By setting the number of partner roles, you can limit the number of unused roles, which can improve performance. The limit is three roles; the system default is one.

For example, if three partner roles are currently created when an account is enabled for your community—Executive, Manager, and User—but you need only the User role for new accounts, you can reduce the number to one role.

To set the number of roles:

1. Click **Customize > Communities > Settings**.
2. Set the **Number of partner roles** per partner account.
3. Click **Save**.

The number of roles for existing partner accounts isn’t affected by this setting.

### Enabling Super User Access in Communities

Enable super user access so that partner users in communities can access additional records and data.

| Available in: Unlimited, Developer, Enterprise Editions |

---

Salesforce Communities—Generally Available
If your community is set up with Partner Community user licenses, this setting applies.

Granting super user access to external users in your community lets them access additional data and records, regardless of sharing rules and organization-wide defaults. Super users have access to data owned by other partner users belonging to the same account who have the same role or a role below them in the role hierarchy. Super user access applies to cases, leads, custom objects, and opportunities only, but external users have access to these objects only if you exposed them using profiles or sharing and added the tabs to the community during setup.

1. Click Customize > Communities > Settings.
2. Select Enable Partner Super User Access.
3. Click Save.

You can now assign super user access.

To disable super user access, deselect Enable Partner Super User Access. If you re-enable this feature, all users who were assigned super user access before the feature was disabled will automatically get super user access again.

### Creating Communities

**Available in:** Unlimited, Developer, Enterprise Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create, customize, or publish a community:</td>
</tr>
</tbody>
</table>

1. To start creating communities, click Customize > Communities > Manage Communities, then click New Community.
2. Enter a community name.

   **Note:** If you’re creating multiple communities, keep in mind that community names may be truncated in the global header drop-down menu. Users can see up to 32 characters of the name, and the Preview and Offline status indicators count toward that number. Make sure that the visible part of the name is distinctive enough for users to distinguish between multiple communities.

3. Enter a description.
4. Enter a unique value at the end of the URL field.

   This value is appended to the domain you entered when enabling communities to create a unique URL for this community. For example, if your domain is UniversalTelco.force.com and you’re creating a customer community, you can designate the URL as UniversalTelco.force.com/customers.

   **Note:** You can create one community in your organization that doesn’t have a custom URL.

   You can change your community name and URL after the community is published, but users won’t be redirected to the new URL. If these changes are necessary, be sure to inform your community members before making the change.
5. Click **Create**.
   The community is created in Preview status.

6. On the confirmation page, click **Edit** to customize your community.

   **Important:** When you create a community, your profile is automatically added to the list of profiles that have access. As a result, all users in your organization with this profile can log in to the community once it’s Published. If you don’t want all users with your profile to have access, you can remove the profile and give yourself access through a different profile or permission set.

### Adding Members to Your Community

**Available in:** Unlimited, Developer, Enterprise Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create, customize, or publish a community: “Create and Manage Communities”</td>
</tr>
</tbody>
</table>

Manage community membership by adding profiles and permission sets during the setup process. Using profiles and permission sets, you can:

- Easily grant or remove access for groups of users. Once you add a profile or permission set, all users assigned to that profile or permission set become members of the community.
- Enforce a membership policy. New users added to a profile or permission set that is already associated with a community automatically gain access.

Permission sets allow added flexibility for adding members. You can grant community access to a subset of users from the same profile, without needing to clone the profile.

Standard, Chatter, and portal profiles can be added to communities; Chatter customers, from private groups with customers, can’t be added to communities even if they’re assigned permission sets that are associated with communities.

**Note:** Profiles and permission sets associated with communities can’t be deleted from Salesforce. You must remove the profiles or permission sets from the communities first.

1. Click **Customize > Communities > Manage Communities**, then click **Edit** next to the community name.
2. Click **Members**.
3. To add profiles:
   a. To filter profiles, select a profile type from the drop-down menu. To search for a specific profile, enter a search term and click **Find**.
      Search returns profiles for the selected filter.
   b. Select the user profiles you want to allow access to your community. Press CTRL to select multiple profiles.
   c. Click **Add**. To remove a profile, select it and click **Remove**.
      If you remove a profile from a community, users with that profile lose access to the community, unless the users are assigned permission sets or other profiles that are still part of the community. Their posts and comments still appear.
4. To add permission sets:
   a. To search for a specific permission set, enter a search term and click **Find**.
   b. Select the permission sets you want to allow access to your community. Press CTRL to select multiple permission sets.
   c. Click **Add**.

   If you remove a permission set from a community, users with that permission set lose access to the community, unless the users are associated with profiles or other permission sets that are still part of the community. Their posts and comments still appear even after they lose access.

5. Click **Save**.

   If the community is *Published* and *welcome emails are enabled*, users with the profiles or permission sets you added receive a welcome email. The welcome email includes a username and a change password link if it is sent to an external user who hasn’t logged in to a portal or community yet.

   When the community is *Published*, welcome emails are sent and the community is discoverable by members. When a community is in *Preview* status, only members with the login URL can view the community. If a community is *Offline*, only users with the “Create and Manage Communities” permission can access it through the Community menu, regardless of membership.

   There are additional options for granting access to your community:
   - Enable self-registration so that external users can register on their own
   - Enable authentication providers, such as Facebook, so that external users can log into the community without creating an account

   For more information, see **Customizing Communities Login**.

---

**Adding Tabs to Your Community**

Available in: **Unlimited, Developer, Enterprise** Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create, customize, or publish a community:</td>
</tr>
</tbody>
</table>

After you identify the features you want your community members to see, you can expose those features by choosing the corresponding tabs during setup. Remember that profiles control access to tabs, so some tabs you choose may be hidden for profiles associated with the community. In that case, you’ll need to manually expose the tabs in the profile so that those users can see the tabs in the community.

Keep in mind that the tabs you enable should be required for the type of activity you’re performing in this community, whether it be sharing accounts and opportunities with your partners or sharing cases and solutions with customers who need support. You don’t want to clutter your community with tabs that users don’t really need.

**Note:** Chatter Free users in your community won’t see any tabs except the Chatter tab.

1. Click **Customize > Communities > Manage Communities**, then click **Edit** next to the community name.
2. Click Tabs.
3. Select the tabs to include in your community from the Available Tabs list. Press CTRL to select multiple tabs.
4. Click Add to add the tab. To remove a tab, select it in the Selected Tabs list and click Remove.
5. Click Up or Down to change the order that the tabs display.
   The tab at the top of the list is the landing tab for the community. When users access the community, it will be the first tab they see.

   Note: If any user doesn’t have access to the landing tab and Chatter is disabled, we show them the Home tab. If Chatter is enabled, we show the Chatter tab.

6. Click Save.

### Branding Your Community

<table>
<thead>
<tr>
<th>Available in: Unlimited, Developer, Enterprise Editions</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create, customize, or publish a community: “Create and Manage Communities”</td>
</tr>
</tbody>
</table>

Customize the look and feel of your community by adding your company logo, colors, and copyright. This ensures that your community matches your company's branding and is instantly recognizable to your community members.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Branding.
3. Use the lookups to choose a header and footer for the community.
   The files you’re choosing for header and footer must have been previously uploaded to the Documents tab and must be publicly available. The header can be .html, .gif, .jpg, or .png. The footer must be an .html file. The maximum file size for .html files is 100 KB combined. The maximum file size for .gif, .jpg, or .png files is 20 KB. So, if you have a header .html file that is 70 KB and you want to use an .html file for the footer as well, it can only be 30 KB.

   The header you choose replaces the Salesforce logo below the global header. The footer you choose replaces the standard Salesforce copyright and privacy footer.
4. Click Select Color Scheme to select from predefined color schemes or click the text box next to the page section fields to select a color from the color picker.

   Note that the colors selected impact your community login page as well.

<table>
<thead>
<tr>
<th>Color Choice</th>
<th>Where it Appears</th>
</tr>
</thead>
</table>
| Header Background| Top of the page, under the black global header. If an HTML file is selected in the Header field, it overrides this color choice.  
Top of the login page. |
| Page Background  | Background color for all pages in your community, including the login page.    |
Customizing Communities Login

Customize the look and feel of your community login page, from the logo and footer to login options for external users.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

To create, customize, or publish a community: “Create and Manage Communities”

The colors used on the login page are inherited from the community branding color scheme. You can customize these other elements of the page.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Login Page.
3. Upload a logo for the community login page header.
   The file can be .gif, .jpg, or .png. The maximum file size is 100 KB. Images larger than 250 pixels wide or 125 pixels high aren't accepted. Uploading a logo automatically creates a Communities Shared Document Folder on the Documents tab and saves the logo there. Once created, you can't delete the folder.
   The header logo displays at the top left of the login page.
4. Enter custom text for the community login page footer, up to a maximum of 120 characters.
   The footer displays at the bottom of the login page.
5. Choose the login options to make available to external users on the community login page.
   External users are users with Community, Customer Portal, or partner portal licenses.

<table>
<thead>
<tr>
<th>Login Options for External Users</th>
<th>What Displays on the Login Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username and password to log in to Organization Name</td>
<td>The option to log in using the username and password that the user was assigned for the community. This is the default login option.</td>
</tr>
<tr>
<td>Login Options for External Users</td>
<td>What Displays on the Login Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAML for single sign-on</td>
<td>The option to <strong>Log In with Single Sign-On</strong> using the user’s SAML single sign-on identity.</td>
</tr>
<tr>
<td>This option is available only if your organization has successfully set up both of the following.</td>
<td>If you have enabled multiple SAML single sign-on options, each login button displays labeled with the SAML configuration’s Name field.</td>
</tr>
<tr>
<td>• SAML settings for single sign-on, which enables login to Salesforce using your corporate identity provider.</td>
<td></td>
</tr>
<tr>
<td>• A custom Salesforce domain name, which changes the application URLs for all of your pages, including login pages. Contact Support if you need to enable My Domain.</td>
<td></td>
</tr>
<tr>
<td>You can offer users multiple SAML single sign-on options if you <strong>Enable Multiple Configs</strong> from Setup, in Security Controls &gt; Single Sign-On Settings. If you already had SAML enabled and you then enable multiple SAML configurations, your existing SAML configuration is automatically converted to work with multiple additional configurations.</td>
<td></td>
</tr>
<tr>
<td>External authentication providers</td>
<td>The option to log in using credentials from an external service provider such as Facebook®, Janrain®, or Salesforce.</td>
</tr>
<tr>
<td>These options are available if you enable them from Setup, in Security Controls &gt; Auth. Providers.</td>
<td></td>
</tr>
<tr>
<td>Self-registration</td>
<td>A <strong>Not a member?</strong> link that directs external users to the self-registration page.</td>
</tr>
<tr>
<td>Rather than relying solely on community administrators to add members, you can <strong>Allow external users to self-register.</strong> When your organization enables Communities, a default set of self-registration Visualforce pages and associated Apex controllers are created.</td>
<td></td>
</tr>
<tr>
<td><strong>Important:</strong> You must specify in the default controller which profiles, roles (required for external users with partner portal or Partner Community licenses), and account the self-registration process should assign users to. The self-registration feature won’t work until you specify these details.</td>
<td></td>
</tr>
</tbody>
</table>

6. **Click Save.**

Your selected login options will be visible to all users on the login page. However, they’re valid only for external users. Internal users who try to use these options will get a login error. They must use the link that directs employees to **Log in here** and log in with their Salesforce username and password.
Customizing Communities Email

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed
To create, customize, or publish a community: “Create and Manage Communities”

You can customize email sender information, Chatter email branding, and templates in your community emails. You can perform customizations in either the user interface or the Network object in Salesforce APIs.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Emails.
3. Enter custom values for the email sender’s name and address to replace the default values.

   Note: If you change the sender’s email address, we send a verification email to the new address. The change is pending, and we continue to use the existing address while we await verification. The requested address doesn’t take effect until you click the confirmation link in the email, which is valid for 72 hours. If verification is already pending for a new email address and you specify a different new address, we retain the latest value and use that for verification.


   Important: Both a logo and email footer text are required. Keep in mind that:
   - All Chatter emails display the Chatter logo and salesforce.com information by default unless you replace them with your organization’s own logo and information.
   - If you previously customized the logo or footer text and want to restore the default values, use the API to set these fields to null.

   a. Choose a logo to replace the default Chatter logo.
      The logo must be an existing document in the Documents tab and must be marked Externally Available Image. Images with a maximum size of 150 x 50 pixels on a transparent background work best.

   b. Enter custom text to replace the default footer text, up to a maximum of 1,000 characters.
      The default text includes salesforce.com’s name and physical address. We strongly recommend including your organization’s physical address to comply with applicable anti-spam laws.

   c. Click Preview before saving to make sure your changes display properly in a sample Chatter email.
      If your web browser blocks popup windows, you won’t be able to view the preview window.

5. Select Send welcome email to send email to users when they’re added to the community.

   Welcome emails are sent when:
   - A community changes from Preview status to Published status. Emails are not sent when a community is in Preview or Offline status.
   - An administrator adds a new profile or permission set to a Published community.
   - A user is assigned a profile or permission set that is part of a Published community.
6. Use the default email templates or use the lookups to select different templates for welcome emails to new community members, forgotten password emails, and notification emails about reset passwords. If your organization uses email templates to submit case comments, you can select a template (none is provided by default). You can customize any default template.

**Note:** If you customize the contents of an email template, we recommend that you use the `!Community.Url` merge field. This custom merge field populates the unique URL for a community, ensuring that emails to users contain URLs with the correct parameters and direct users to the appropriate community to log in or change a password.

7. Click Save.

Another way to customize community emails is to use these fields on the API Network object:

- **CaseCommentEmailTemplateId**—ID of the email template used when submitting a comment on a case.
- **ChangePasswordEmailTemplateId**—ID of the email template used when notifying a user that their password has been reset.
- **EmailFooterLogoId**—ID of the Document object that displays as an image in the footer of community Chatter emails.
- **EmailFooterText**—Text that displays in the footer of community Chatter emails.
- **EmailSenderAddress**—Read only. Email address from which community emails are sent.
- **EmailSenderName**—Name from which community emails are sent.
- **ForgotPasswordEmailTemplateId**—ID of the email template used when a user forgets their password.
- **NewSenderAddress**—Email address that has been entered as the new value for EmailSenderAddress but has not been verified yet. After a user has requested to change the sender email address and has successfully responded to the verification email, the NewSenderAddress value overwrites the value in EmailSenderAddress. This becomes the email address from which community emails are sent.

- ◊ If verification is pending for a new email address and you set NewSenderAddress to null, this cancels the verification request.
- ◊ NewSenderAddress is automatically set to null after EmailSenderAddress has been set to the new verified address.
- ◊ If verification is pending for a new email address and you specify a different new address for this field, only the latest value is retained and used for verification.

- **OptionsSendWelcomeEmail**—Determines whether a welcome email is sent when a new user is added to the community.
- **WelcomeEmailTemplateId**—ID of the email template used when sending welcome emails to new community members.
Publishing Communities

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed
To create, customize, or publish a community: “Create and Manage Communities”

Publishing a community makes it visible to members. If you want to customize it further after publishing, you can do so while the community is published or take the community offline. Keep in mind that once you publish, everything in the community is visible to members. Be sure to finish all major customizations while in Preview status.

**Note:** If welcome emails are enabled, an email with a link to the community is sent to each member when the community is published. For any members from outside the company who don’t have a password or use single sign-on, the welcome email includes a link to set their password and security question.

An external user with access to multiple communities within one organization uses the same login credentials for all communities.

1. Go to the Community settings page:
   a. Click Customize > Communities > Manage Communities.
   b. Click Customize next to the community name.
2. Click Publish.
   Your community is online.

Communities Statuses

Available in: Unlimited, Developer, Enterprise Editions

Communities can have one of the following statuses.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Customization of the community isn’t complete and it has never been published. Once you publish, you can’t go back to Preview status. Users with “Create and Manage Communities” can access communities in Preview status if their profile or permission set is associated with the community. They can also share a link to these communities with users whose profiles or permission sets are associated with the community. No welcome emails are sent even if Send welcome email is selected. <strong>Note:</strong> If your organization’s access to Communities is suspended for non-payment of fees due, all of your communities are taken offline, including those in Preview status. When Communities is enabled again, all communities are in Offline status. You can publish these communities, but can’t return them to Preview status.</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Offline  | The community was previously Published but was taken offline. You may want to take a community offline if you need to:  
|          | • Add or remove members  
|          | • Add, remove, or change the order of tabs  
|          | • Change the color scheme  
|          | • Change the community URL  
|          | Users with “Create and Manage Communities” can still access the setup for Offline communities regardless of membership. Members see an error page if they attempt to access Offline communities, but they still appear in the drop-down as Community Name (Offline). |
| Published | The community is published and available to members. Welcome emails are sent to new members if Send welcome email is selected. |

Navigating to Communities

Available in: Unlimited, Developer, Enterprise Editions

You can easily switch between working in your internal organization and collaborating with customers or partners in communities. When your organization turns on Communities, you see a new global header unless your administrator has chosen to hide it.

The menu on the left side lets you switch between communities and your internal organization.

- To access communities from within your organization, click next to Organization Name in the drop-down and select the community you want to switch to.
- To return to your internal organization, click next to Community Name in the drop-down and select your organization name.

Internal users who aren’t members of any community just see the company name. External users see the drop-down menu only if they belong to more than one community.

You can work in more than one community at a time if you open each one in a different browser tab.
Switching between your internal organization and your communities doesn’t have to disrupt your workflow. We automatically return you to the page where you were last working, so you can pick up right where you left off.

**Note:** If your organization is in the process of setting up My Domain but hasn’t finished deployment of the new custom domain, switching from a community to your internal organization directs you to the Salesforce login page instead. This can happen when you’ve logged in using a My Domain URL that has been registered but not yet deployed. Once your domain is deployed, selecting your organization in the drop-down directs you to the internal organization as expected.

The **Your Name** menu on the right side contains links to edit your contact information and log out. For internal users, it also contains a link to Help & Training and may also contain links to Setup and other tools depending on user permissions and enabled features.

## Advanced Customization of Your Community’s Look and Feel

After you set up the basic aspects of your community, there are many options for advanced customization:

- Add a search box to your custom header
- Create a custom domain and URL for your community
- Rename the Chatter tab
- Use a custom login page
- Add public pages that don’t require authentication
- Perform advanced customizations using Force.com Sites
- Perform advanced customizations using Site.com

## Site.com and Force.com Sites in Communities

Each community includes two associated sites—a Force.com Sites and a Site.com site—that let you make advanced customizations to your community. Using either site, you can create branded, publicly available landing and marketing pages, or add private custom pages that only community members can access.

To create custom pages, you can easily access your Force.com Sites and Site.com sites from the Manage Communities page in Setup.
To return to your community:

- From Force.com Sites, use the link on the top of the site detail page.
- From Site.com, use the drop-down navigation menu at the top of Site.com Studio.

**Site.com**

Aimed at less technical users, Site.com is a Web content management system (CMS) that provides an intuitive drag-and-drop environment to customize your community's pages. Site.com makes it easy to build dynamic, data-driven Web pages quickly and edit your content in real time. There’s no code required (although you can add custom code if you need to) but familiarity with CSS and HTML helps.

- Design pixel-perfect, branded community pages, as well as personalized pages that display authenticated user information.
- Create private pages that only community members can access.
- Build and iterate quickly using reusable page elements.
- Use ready-made forms to create web-to-lead forms or gather customer feedback.
- Create data-driven pages, such as product catalogs or other listings, using your organization’s data.

**Force.com Sites**

Suitable for developers with experience using Visualforce, Force.com Sites lets you to build custom pages and Web applications by inheriting Force.com capabilities including analytics, workflow and approvals, and programmable logic. So if you are looking to create sites programmatically using Apex and APIs, Force.com Sites is the product for you.

- Create public, branded pages that anyone can access.
- Leverage Visualforce to create private pages that you can add as a tab within your community.
- Write your own controllers, or extensions to controllers, using Apex code.
- Create custom login or self-registration pages.
- Build dynamic web applications, such as an event management application.

**Features At a Glance**

Take a look at this table to learn more about what you can do in each site.
<table>
<thead>
<tr>
<th>Available Features</th>
<th>Site.com</th>
<th>Force.com Sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public pages</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Authenticated pages*</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Visualforce pages</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Out-of-the-box login, error, and self-registration pages</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Drag-and-drop UI</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Reusable page elements</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Branding*</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Pixel-perfect designs</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Access to your data</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Readymade forms</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>CMS</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Programmatic page creation (using Apex, APIs, and controllers)</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Web applications</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Analytics, reports, and workflows</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

*Available in Site.com for Communities users only

**Sharing Personal Contact Information within Communities**

Users can specify how much of the contact information from their profile is visible to external users, such as customers and partners, and guest users viewing publicly accessible pages that don't require login.

When interacting with other community members, it's important to balance being visible and accessible with protecting your personal contact information. You may not want to show your job title, phone numbers, and other contact details outside of your internal organization. Your customers and partners may not want other customers and partners viewing all of their contact information.

Use either the user interface or API to control visibility. In the global header, click **Your Name > Edit Contact Info** to edit your contact information and visibility settings. Some fields allow up to three levels of visibility, while others allow fewer.

- Employees—Only members from the internal organization can view.
- External—Members from the internal organization and external members, such as customers and partners, can view. External users are users with Community, Customer Portal, or partner portal licenses.
• Public—Anyone can view, including guest users viewing publicly accessible pages that don’t require login. Guest users can access public Site.com and Force.com sites, and public pages in Communities, via the Guest User license associated with each site or community.

In the API, setting a field to `true` on the User object makes it visible to the type of user indicated in the field name (external or guest users).

Consider these tips about the visibility of your contact information.

• Your chosen settings apply to every community you’re a member of.
• When a user is restricted from viewing a contact information field, there are differences in what’s displayed in the user interface versus the API.

◊ In the user interface, the restricted field is hidden from your profile everywhere that it usually displays in a community. If your organization displays your profile information on custom Visualforce pages, the field still displays, but with the value `#N/A`.
◊ In the API, a field set to `false` returns the value `#N/A`.
• Information in hidden fields on a profile is not searchable by other partners and customers in the community, but is searchable by users in the company's internal organization.

**Default Visibility Settings for Contact Information**

This table summarizes the default visibility settings for contact information and your options for restricting visibility.

<table>
<thead>
<tr>
<th>Contact Information</th>
<th>Default Visibility</th>
<th>Where to Set in User Interface</th>
<th>Options for Restricting Visibility</th>
<th>API Controls on User Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Public</td>
<td>Go to Your Name &gt; Edit Contact Info, then click About</td>
<td>None—always visible to everyone unless your administrator customizes what displays using Visualforce or Site.com</td>
<td>N/A</td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nickname</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>External</td>
<td>Go to Your Name &gt; Edit Contact Info, then click About</td>
<td>Employees, external, or public</td>
<td>UserPreferencesShowTitleToExternalUsers UserPreferencesShowTitleToGuestUsers</td>
</tr>
<tr>
<td>Profile photo</td>
<td>External. Users without access see the stock photo.</td>
<td>On your profile page, click Update under your photo (or Add Photo if you haven’t added a photo yet), then select Show in communities</td>
<td>External or public</td>
<td>UserPreferencesShowProfilePicToGuestUsers</td>
</tr>
</tbody>
</table>

**Note:** When the guest user preference is set to `true`, the job title field is visible to external members even if the external member preference is set to `false`. 
<table>
<thead>
<tr>
<th>Contact Information</th>
<th>Default Visibility</th>
<th>Where to Set in User Interface</th>
<th>Options for Restricting Visibility</th>
<th>API Controls on User Object</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>with publicly accessible pages</td>
<td>Employees, external, or public</td>
<td>Note: For each pair of preferences controlling the visibility of a field, when the guest user preference is set to true, the field is visible to external members even if the external member preference is set to false.</td>
</tr>
<tr>
<td>City</td>
<td>Employees</td>
<td>Go to Your Name &gt; Edit Contact Info, then click Contact</td>
<td>Employees or external</td>
<td>UserPreferencesShowCityToExternalUsers</td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowCityToGuestUsers</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowCountryToExternalUsers</td>
</tr>
<tr>
<td>Country</td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowCountryToGuestUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowPostalCodeToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowPostalCodeToGuestUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowStateToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowStateToGuestUsers</td>
</tr>
<tr>
<td>All other fields</td>
<td>Employees</td>
<td>Go to Your Name &gt; Edit Contact Info, then click Contact or About</td>
<td>Employees or external</td>
<td>UserPreferencesShowEmailToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowFaxToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowManagerToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowMobilePhoneToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowStreetAddressToExternalUsers</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>UserPreferencesShowWorkPhoneToExternalUsers</td>
</tr>
</tbody>
</table>

**Who Can See What in Communities**

*Available in: Unlimited, Developer, Enterprise Editions*

Communities contain various types of users who require varying levels of access. What a user sees depends upon their user type and which tabs the administrator selects when creating the community. The behavior outlined below also does not take into account updates to your sharing model or user sharing.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Administrator or Salesforce user with “Create and Manage Communities” permission</th>
<th>Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)</th>
<th>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage communities in Salesforce</td>
<td>Can create, customize tabs and branding, add or remove members, and publish or take offline. User must also have the “Customize Application” permission to create or customize communities.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Global Header</td>
<td>The drop-down in the global header shows a list of communities the user created or has access to. Also links back to their internal organization. Can access setup for all communities regardless of status. Can see communities in Preview status.</td>
<td>The drop-down in the global header shows a list of communities the user created or has access to. Also links back to their internal organization. Can’t access communities in Offline status. Can see communities in Preview status if a link is provided.</td>
<td>Can’t access communities in Offline status. Can see communities in Preview status if a link is provided.</td>
</tr>
<tr>
<td>Your Name menu in Global Header</td>
<td>Same as in internal organization.</td>
<td>Same as in internal organization.</td>
<td>Can see a My Settings menu, an Edit Contact Info menu, and a Logout link. For external users, the My Settings menu opens an overlay where they can update location settings, security settings, email settings, and approved connections. These settings apply across all communities that users have access to. This overlay is different from the My Settings page that other internal users see if the organization has enabled the improved Setup user interface.</td>
</tr>
<tr>
<td>Salesforce Online Help</td>
<td>Can see Salesforce Online Help.</td>
<td>Standard Salesforce user sees Salesforce Online Help. Chatter Free user sees Chatter help.</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>Administrator or Salesforce user with “Create and Manage Communities” permission</td>
<td>Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)</td>
<td>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>People</td>
<td>Can see everyone else in the community and vice versa.</td>
<td></td>
<td>Can see all members’ First Name, Last Name, and Nickname fields and profile photos, but can only see additional contact information fields that members have chosen to show to external users. By default, Title is shown while all other fields are not. In people hovers, user sees Title, Work Phone, and Mobile Phone fields only if the member has chosen to show them.</td>
</tr>
<tr>
<td>Profiles and people hovers</td>
<td>Can see all contact information fields (such as Title, Work Phone, and Email) on all community members’ profiles. In people hovers, user always sees members’ Title, Work Phone, and Mobile Phone fields.</td>
<td></td>
<td>Can see all members’ First Name, Last Name, and Nickname fields and profile photos, but can only see additional contact information fields that members have chosen to show to external users. By default, Title is shown while all other fields are not. In people hovers, user sees Title, Work Phone, and Mobile Phone fields only if the member has chosen to show them.</td>
</tr>
<tr>
<td>Records (such as accounts, leads, opportunities)</td>
<td>Can see records they have access to (based on sharing rules) across all communities and their internal organization.</td>
<td>Standard Salesforce user sees records they have access to (based on sharing rules) across all communities and their internal organization. Chatter Free user doesn’t have access to records.</td>
<td>Can see records they have access to (based on sharing rules and permissions) across all communities.</td>
</tr>
<tr>
<td>Dashboards and Reports</td>
<td>Can view and create dashboards and reports</td>
<td>Users with Partner Community or partner portal licenses can view dashboards and reports for objects and records that have a private sharing model AND to which the user has access to, regardless of the current community. Users with Customer Portal or Customer Community licenses don’t have access to dashboards and reports.</td>
<td></td>
</tr>
<tr>
<td>User Lookups on records</td>
<td>Can see all users across all communities and their internal organization.</td>
<td>Can see users who are members of all communities that the user is also a member of, and other external users associated with the same external account. Users with partner portal licenses also see the owner of the portal account.</td>
<td></td>
</tr>
</tbody>
</table>
External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)

Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)

External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)

The Recently Viewed Users list in the lookup shows all users accessed across all communities.

Salesforce Knowledge Articles

Salesforce Knowledge User License, Read permission on the article type, and visibility on the category.

Salesforce Knowledge User License, Read permission on the article type, and visibility on the article’s category.

Visibility on the article’s category.

Chatter Visibility

Salesforce Administrator

Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)

Salesforce Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.

Regardless of the current community, users see files they own, that are shared with them directly, that they have access to in a library, or that are posted to a record they have access to.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.

Regardless of the current community, users see files they own, that are shared with them directly, that they have access to in a library, or that are posted to a record they have access to.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups for that community and join them, but can’t see groups from other communities they belong to or their internal organization.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.

Regardless of the current community, users see files they own, that are shared with them directly, that they have access to in a library, or that are posted to a record they have access to.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.

Regardless of the current community, users see files they own, that are shared with them directly, that they have access to in a library, or that are posted to a record they have access to.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.

Regardless of the current community, users see files they own, that are shared with them directly, that they have access to in a library, or that are posted to a record they have access to.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Regardless of the current community, users see files they own, that are shared with them directly, or that they have access to in a library. Portal users see files posted to records they have access to, unless the record post was marked “Internal Only”.

Within a community, user can see all groups in the community and join them, but can’t see groups from other communities they’re a member of.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Can create new groups. In groups user is a member of, can post, comment, post files or links, or share someone else’s post.

Administrators can also control whether users in the organization and external users can create new groups through the “Create and Own New Chatter Groups” user permission.

Files posted to groups and shared with an entire community can only be viewed in that community.
<table>
<thead>
<tr>
<th></th>
<th><strong>Salesforce Administrator</strong></th>
<th><strong>Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)</strong></th>
<th><strong>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Profiles</td>
<td>Can see profiles for all members in the current community.</td>
<td>Can see profiles for all members in the current community. Cannot see profiles of users in the internal organization. Profile visibility enforces user sharing.</td>
<td></td>
</tr>
<tr>
<td>Recommendations</td>
<td>User gets people, group, file, and record recommendations for the current community only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activity and Influence</td>
<td>Can see activity statistics and influence for the current community.</td>
<td>Can see activity statistics and influence for the current community. All activity on records, such as posts and comments, is counted in the user’s internal organization and not in the community where the activity occurred.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All activity on records, such as posts and comments, is counted in the user’s internal organization and not in the community where the activity occurred.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email Notifications</td>
<td>Email notification preferences are set by community. Within a community, users can control their Chatter email notifications in their personal settings. Can control email notifications for their internal organization from <strong>Your Name &gt; My Settings &gt; Chatter &gt; Email Notifications</strong>. Within a community, all users can control group email notifications on each group’s page. Chatter personal email digests and group digests are not supported in Communities.</td>
<td>Email notification preferences are set by community. Within a community, standard Salesforce user can control their Chatter email notifications in their personal settings. Can control email notifications for their internal organization from <strong>Your Name &gt; My Settings &gt; Chatter &gt; Email Notifications</strong>. Chatter Free user can control Chatter emails for their communities under <strong>Your Name &gt; My Settings &gt; Email Settings</strong>. The chosen settings apply to the current community. Within a community, all users can control group email notifications on each group’s page. Chatter personal email digests and group digests are not supported in Communities.</td>
<td>Email notification preferences are set by community. Within a community, external users can control their Chatter email notifications under <strong>Your Name &gt; My Settings &gt; Email Settings</strong>. Portal users can also control group email notifications on each group’s page. Chatter personal email digests and group digests are not supported in Communities.</td>
</tr>
<tr>
<td></td>
<td>Salesforce Administrator</td>
<td>Salesforce Community Member (all Salesforce licenses including Chatter Free and Chatter Only)</td>
<td>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Topics</td>
<td>Can see hashtag topics and Chatter topics, including topics in feeds, the topics list, topic detail pages, Trending Topics, and Recently Talked About topics for the current community only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Favorites</td>
<td>Can add search, topic, and list view favorites in the current community.</td>
<td>Can add only topic favorites in the current community.</td>
<td></td>
</tr>
</tbody>
</table>

**Feeds Visibility**

The following table shows what each kind of user can do or see in Chatter Feeds within a community.

<table>
<thead>
<tr>
<th></th>
<th>Salesforce Administrator</th>
<th>Salesforce Community Member</th>
<th>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post on a record</td>
<td>Can post on any records within the community.</td>
<td>Can post on any records within the community to which the user has access.</td>
<td>Can post on any records within the community to which the user has access.</td>
</tr>
<tr>
<td>Bookmark a post</td>
<td>Can bookmark posts within the current community. The Bookmarked feed only contains posts from the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mention someone</td>
<td>Can mention people specific to the current community. User can’t mention an external user on an internal post.</td>
<td>Can mention people specific to the current community.</td>
<td></td>
</tr>
<tr>
<td>Share a post (repost)</td>
<td>Can share a post only in the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add topics to a post</td>
<td>Can add hashtag topics and Chatter topics to any posts within the current community. Topics are specific to the current community and can’t be accessed from another community.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Search Visibility**

Search behavior in communities varies slightly from the search in the internal organization. If Chatter is enabled in your organization, global search and feed search are automatically enabled in communities. If Chatter isn’t enabled in your organization, sidebar search is enabled. Chatter-specific items can only be searched via global search or feed search. Search results respect sharing rules for all items by default. The following table describes what each type of user in a community can see in search results.
<table>
<thead>
<tr>
<th>Search Results For</th>
<th>Administrator</th>
<th>Salesforce Community Member</th>
<th>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</th>
</tr>
</thead>
<tbody>
<tr>
<td>People Users</td>
<td>People specific to the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Information in hidden fields on a profile is not searchable by other partners and customers in the community, but is searchable by users in the company’s internal organization.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Portal users can’t search for users in the community when sidebar search is enabled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>Groups specific to the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files</td>
<td>Visibility in the current community:</td>
<td>Visibility in the current community:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Owned files</td>
<td>• Owned files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Files shared with the user in a public or private group</td>
<td>• Files shared with the user in a public or private group</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Files shared with the entire community</td>
<td>• Files shared with the entire community</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Visibility in any community:</td>
<td>Visibility in any community:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Files posted on accessible records and record feeds</td>
<td>• Files posted on accessible records and record feeds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Salesforce CRM Content library files that the user has access to</td>
<td>• Salesforce CRM Content library files that the user has access to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Files owned by a user are always visible in search results for that user, regardless of how they were uploaded.</td>
<td>Files owned by a user are always visible in search results for that user, regardless of how they were uploaded.</td>
<td></td>
</tr>
<tr>
<td>Topics</td>
<td>Topics specific to the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feeds</td>
<td>Feed posts and comments from within the community where the search is performed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Global search returns information from all feed contexts. Contextual feed search returns information from within the context where the search is performed, such as from the feed on a user’s profile, a record, or a group. To find information in the feeds in a different community, search from within that community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Auto-Complete</td>
<td>Recently accessed items specific to the current community.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Records (accounts, contacts, leads, and so on)</td>
<td>Full visibility for all items across all communities and your internal organization.</td>
<td>Visibility for all items the user has access to through their user profile or</td>
<td></td>
</tr>
<tr>
<td>Search Results For</td>
<td>Administrator</td>
<td>Salesforce Community Member</td>
<td>External Community Member (Customer Portal, Partner Portal, Partner Community, or Customer Community license)</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------</td>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lookup searches on records</td>
<td>Full visibility for all items across all communities and your internal organization.</td>
<td>Visibility for all items the user has access to through their user profile or permission sets across all communities and your internal organization.</td>
<td>Visibility for all items the user has access to through their user profile or permission sets across all communities.</td>
</tr>
<tr>
<td>Salesforce Knowledge Articles</td>
<td>Salesforce Knowledge User License, Read permission on the article type, and visibility on the category.</td>
<td>Salesforce Knowledge User License, Read permission on the article type, and visibility on the article’s category.</td>
<td>Visibility on the article’s category.</td>
</tr>
</tbody>
</table>

**PUBLISHER ACTIONS**

**Add and Customize Actions in the Chatter Publisher**

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

The Chatter publisher is the tool at the top of each feed that lets users post comments and polls and share files and links. With publisher actions, we’ve made the publisher more useful and more flexible. The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including Post, File, Link, and Poll.

**Actions Overview**

Actions let users do more in Chatter, like create records directly in the feed. There are two general types of actions: create actions and custom actions.

- **Create actions** let users create records. They’re different from the New button on object tabs and the Quick Create and Create New features on the home page. Create actions respect your validation rules and field requiredness, and you can choose each action’s fields.
- **Custom actions** are Visualforce pages with functionality you define. For example, you might create a custom action to let users write comments longer than 1000 characters.

For both types of actions, you can create either object-specific actions or global actions.
• Object-specific create actions let users create records that are automatically associated with related records. For example, you might set up an object-specific action on account to allow users to create contacts. If a user creates a contact on the detail page for Acme, Inc., that contact will automatically be associated with Acme.

When a user creates a record using an object-specific create action, a feed item for that record appears:

◊ In the feed for the record on which the new record was created.
◊ As the first entry in the feed for the new record.
◊ In the Chatter feed of the user who created the record.
◊ In the user profile feed for the user who created the record.
◊ In the Chatter feed of any users who follow the record on which the new record was created.
◊ In the Chatter feed of any users who, through custom triggers or auto-follow rules for new records, automatically follow the new record.

• Object-specific custom actions let users interact with or create records that have a relationship to an object record. The Visualforce page for an object-specific custom action must include the standard controller for the relevant object. For example, if you want to create a custom action that lets users import a contact’s Twitter profile and add that information to a contact record, you need to use the standard contact controller.

• Global create actions let users create object records, but there’s no automatic relationship between the record that’s created and any other record. You can add global actions to page layouts for the home page, the Chatter tab, and object detail pages.

• Create a global custom action for tasks that don’t require users to interact with or create records that have a relationship to a specific object. Visualforce pages you want to use as global custom actions can’t use standard controllers. For example, if you want to create a custom action that lets users enter a street address and see a map, the local time, and the local weather, create a Visualforce page that doesn’t use any of the standard controllers, and add it as a custom global action.

**Customizing Actions and Action Layouts**

You can customize actions in several ways based on the needs of your users and your business.

• You can create different actions for different record types. For example, if you have two record types for cases—one for critical cases and one for non-critical cases, each with different fields and each available to a certain group of agents—you can create a Case action for each, specify the fields you want to include in each, and add each to the publisher on page layouts for the right group of agents.

• In the action layout editor, you can choose which fields appear for each action. For example, a Post action has one large text area for user input. An object-related create action, on the other hand, must include many fields in order for the record to be created properly. The action layout editor is based on the functionality of the page layout editor. It lets you drag fields from the palette onto the action layout, rearrange the fields in the order you want, and remove fields.

• You can set predefined values for certain fields to help ensure consistency, and to help make it faster and easier for users to create records. You set predefined values from an action’s detail page.
If you predefine values for fields on object records created through an action, you don’t need to add those fields to the action layout. For example, on an action that lets users create opportunities, you might set Prospecting as the predefined value for the Stage field. All new opportunities created through that action will automatically be assigned to the prospecting stage.

**Customizing the Publisher with the Page Layout Editor**

The page layout editor has a new Actions category in the palette and a new Chatter Feed section on the layout. You can use the page layout editor to customize the actions in the publisher for each object type and page layout. You can drag actions from the palette to the Chatter Feed section of the page layout and order them as you wish.

For example, for account detail pages, you might include Post, File, and create actions for contact, lead, entitlement, case, and opportunity in the publisher for Page Layout A, while for Page Layout B you might include only Post, File, Link, and create Contact.

If you include five or more actions, three are shown and the rest are added to the More menu in the Chatter publisher. Because adding too many actions can cause the page to load slowly, we recommend including no more than nine actions total in each publisher, including any standard actions.

**Setting Up Publisher Actions**

**Available in:** Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set up publisher actions:</td>
</tr>
</tbody>
</table>

1. Enable feed tracking for any objects for which you want to be able to use publisher actions.
2. Enable publisher actions.
3. Create actions.
   - To create object-specific actions, in Setup, click Customize > Object > Buttons, Links, and Actions, and then click New Action.
   - To create global actions, in Setup, click Create > Global Actions, and then click New Action.
4. Use the action layout editor to choose the fields that appear for the action. For details, see “Customizing Publisher Actions with the Action Layout Editor” in the online help.
5. Use the page layout editor to add the action to the publisher on the page layouts you choose. For details, see “Customizing Chatter Publisher Actions Using the Advanced Page Layout Editor” in the online help.

For more information on setting up publisher actions, check out the Publisher Actions Implementation Guide.

**Supported Objects**

You can create object-specific actions on these objects:

- Account
- Campaign
- Case
- Contact
- Custom objects
- Lead
- Opportunity

You can create actions that let users create these kinds of records:

- Account
- Campaign
- Case
- Contact
- Contract
- Custom objects
- Event (without invitees)
- Lead
- Opportunity
- Task

*Note:* When you create an object-specific action, you can choose as a target object only event, task, or any object that has a parent-child or lookup relationship to the host object.

**Enabling Publisher Actions**

*Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions*

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable actions in the publisher: “Customize Application”</td>
</tr>
</tbody>
</table>

Enabling publisher actions lets you add actions you’ve created to Chatter publishers on the home page, Chatter tab, and record detail pages. With this setting enabled, you can also customize the order in which all actions appear, including Post, File, Link, and Poll.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Enable Publisher Actions.
4. Click Save.
New Feed Tracking Option with Publisher Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

When you enable publisher actions, a new option, *All Related Objects*, appears on the feed tracking page for account, campaign, case, contact, custom objects, lead, and opportunity. This option lets users view feed activity for objects that have a parent-child or lookup relationship to the host object. For example, if you select *All Related Objects* on account, users viewing the feed on an account record will see activity for related accounts, cases, contacts, contracts, entitlements, events, opportunities, and tasks.

For organizations that use Case Feed, *All Related Objects* is automatically selected on case when publisher actions is enabled.

For more information on publisher actions, see “Setting Up Publisher Actions” and “Publisher Actions Overview” in the online help.

Tasks in Feeds Settings (Chatter Tasks) Replaced by Publisher Actions

The Tasks in Feeds settings (Chatter Tasks) are no longer available. For information on how to re-create Chatter Tasks features, see *Publisher Actions Replace Chatter Tasks* on page 94.

Chatter Topics—Generally Available

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter topics help you organize your feed and discover people and groups with similar interests. Add topics to posts to associate them with other posts on the same subject and to increase their visibility.

- Add topics immediately after posting, using our powerful suggestions.
- Add topics to anyone’s post at any time in any feed.

Using the topic detail page:

- Easily see all posts with the same topic in a single feed.
- Discover people and public groups in your organization that are talking about the same topics you’re interested in.

Curious what topics people are talking about in your organization? On the Chatter page, see your organization’s Trending Topics, and click ✦ Topics on the left side of the page to see all the topics in your organization. Search for specific topics using global search, and drill down to profile and group detail pages to see which topics specific people and groups are talking about.

In addition to these new features, we’re upgrading your hashtag (#) topics by merging them with the new Chatter topics. Read on to learn more about Chatter topics and how we improved hashtag topics, trending topics, and topics on profiles.
Adding Topics to Posts

Add topics to posts to organize them or to increase their visibility. You can add topics to your own posts immediately after posting, or you can add topics to any posts at any time directly in the feed.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note: All topic names appear in the topics list and all topic names and descriptions are searchable, including topics used solely in private groups or on records.

1. In the top corner of the post, click 📆.
2. Click Add topics or Edit topics.
3. In the topic editor, start typing your text. As you type, you can pick a topic from the list of suggestions, or keep typing to create your own unique topic. To add more than one topic, type a comma after each topic.
   Commas (,) and closing square brackets (] ) automatically end a topic. Other punctuation, symbols, and separators are supported in topic names.
4. When you're done adding topics, click Done or press ENTER.

The topics you add become links to the topic detail pages.

Viewing Details About a Topic

View a topic detail page to see the topic description and a feed that includes updates about the topic, even from people you don't follow and public groups you aren't a member of.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To open a topic detail page, click a topic or hashtag. On the topic detail page, you can:

- Add a post directly to the topic feed. Your followers automatically see the post, and you can even add the post to a group you're a member of. Because you added the post on the topic feed, the topic is automatically added to your post.
- Edit the topic name and description. Next to Description, click 📊. Anyone can edit topic names and descriptions, but you can only change the capitalization of topic names.
  Note: Topic names and descriptions are not private, even those that appear solely in private groups and on records. Posts with topics have the same security and privacy as those without topics.
- Scan the feed to learn more about a topic and to discover which people (including those you don't follow) and public groups (including those you aren't a member of) are interested and knowledgeable about it.
- Click Add to Favorites to add the topics to your favorites on the Chatter page.
- See the number of people who recently talked about this topic. This includes people who added the topic to an update and people who commented on a post with the topic.
• If available, find out more about a topic using the lists on the right side.

  **Related Topics**
  Other topics that were added together with the current topic.

  **Recent Files**
  Files you have access to that were most recently posted to the topic feed.

  **Groups Talking**
  Public groups and groups you’re a member of that most recently used the topic.

---

**Adding a Topic as a Favorite**

Add a topic as a favorite to quickly see the latest on the topics you’re interested in.

**Available in:** Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click a topic.
2. On the topic detail page, click **Add to Favorites**.
   The favorite name is the same as the topic name.

Alternatively, you can click ✫ in the topic list view to add a topic to your favorites.

**Tip:** When viewing a topic favorite, you can click the topic name at the top of the feed to go directly to the topic detail page.

---

**Viewing All Topics**

Use the topics list to discover the topics that people are talking about in your organization. All topic names appear in this list, including topics used solely in private groups or on records.

**Available in:** Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: [Discover and Organize with Chatter Topics](https://www.salesforce.com) (3:41 minutes)

To view the topics list, on the left side of the Chatter page, click ✨ **Topics**.

In the topics list, you can:

• Click a topic name to see the topic detail page.
• Click ✫ to add a topic to your favorites on the Chatter page.
• **Filter the list of topics** to narrow down what you’re looking for.
• Search for topics by name.

   **Tip:** Use global search to search topic names and descriptions.

---

### Filters for Sorting the Topics List

Use the topic filters to narrow the topics list to your favorite topics or topics you use, and then sort the topics by the number of people talking about them or alphabetically by name.

<table>
<thead>
<tr>
<th>Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions</th>
</tr>
</thead>
</table>

On the **Topics list**, under Show, you can filter the topics.

**All**
- All topics that have been added to posts in your organization

**My Favorites**
- Topics you added to your favorites

**Topics I Use**
- Topics you added to posts and topics on posts that you commented on

Within the topics you filtered, you can sort by the following columns.

**People Talking About This**
- Sorts by the number of people talking about the topic. This includes:
  - The number of people adding the topic to updates
  - The number of people commenting on posts with the topic

**Name**
- Sorts alphabetically by the topic name.

---

### Viewing the Topics Groups Are Talking About

<table>
<thead>
<tr>
<th>Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions</th>
</tr>
</thead>
</table>

The topics that a group is talking about appear on the group detail page in the Recently Talked About section. This section helps people understand which topics a group is knowledgeable about or interested in. These are the topics most frequently and recently added to group posts over the last two months. You can see up to five topics, with the most frequently and recently added topic appearing first. If a group isn’t using topics, the Recently Talked About section doesn’t appear until the group starts using topics more frequently. Click a topic in this section to see the topic detail page.
Removing Topics from Posts

Remove a topic from a post if it no longer applies.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can remove topics from posts in the feed; however, you can’t remove hashtag topics and you can’t delete topics. Before you remove a topic from a post, consider whether you or someone else added it. Someone else may be tracking the update with topics you’re not aware of.

1. In the top corner of the post, click ☐.
2. Click Edit topics.
3. Click ✗ next to the topic you want removed from the post.
4. Click Done or press ENTER.

Removing a topic from a post removes the post from the topic feed on the topic detail page.

Deleting Topics

Administrators can delete topics using the Chatter API or the SOAP API.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To delete topics:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Chatter administrators can’t restrict the topics people use in their updates, but they can delete topics using the Chatter API or the SOAP API. Because topic names and descriptions are not private, administrators might want to delete topics for compliance reasons or to remove inappropriate content. When deleting topics, consider these points.

- Topics are hard deleted. They aren’t sent to the Recycle Bin.
- Deleted topics are removed from search results, the topics list, all posts, Recently Talked About topics, Related Topics, and your users’ favorites. Deleted topics are removed from Trending Topics after the next calculation.
- Deleted topics are not blacklisted. Users can reintroduce a topic after it’s been deleted.
Topics Reporting

You can now create a new custom report type for topics that shows how your organization is using topics. Topic reports include all topics, even those that appear solely in private groups and on records. When defining this custom report type, choose the Topics primary object and select from the following fields:

- **Created Date**—Date the topic was created
- **Description**—Description of the topic
- **Name**—Name of the topic
- **Name: Network**—Name of the community to which the topic belongs. This field is only available if Salesforce Communities is enabled in your organization.
- **TalkingAbout**—Number of people talking about the topic, based on factors such as topic additions and comments on posts with the topic

Topics Privacy

Topic names and descriptions are not private, even those that appear solely in private groups and on records. Posts with topics have the same security and privacy as those without topics.

<table>
<thead>
<tr>
<th>User interface element</th>
<th>Shows all topics</th>
<th>Doesn’t show topics used solely in private groups and on records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topics list</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Topic search results</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Topic reports</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Related Topics on the topic detail page</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Recently Talked About topics on group detail pages</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Recently Talked About topics on profiles</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Trending Topics on the Chatter page</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Topic suggestions when adding topics to a post</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
Upgrading Hashtag (#) Topics to Chatter Topics

With the general availability of topics, we’re merging hashtag topics with the new Chatter topics. As part of the rollout, existing hashtag topics in your organization will be changed in these ways:

- Topics (without the hashtag) are added to:
  - Every post with a hashtag topic
  - The top-level post of every comment with a hashtag topic

  For example, if you included the hashtag topic #UniversalPaper in a comment under your coworker’s post, the topic UniversalPaper will be added to your coworker’s post.

- A topic detail page is created for every hashtag topic. Click a hashtag topic (or its corresponding topic) to see the topic detail page.

- Hashtag topics are exposed without the hashtags, including those used solely in private groups or on records, in:
  - The topics list
  - Topic search results
  - Topic reports
  - Recently Talked About topics on group detail pages
  - Related Topics on topics detail pages

  Hashtag topics (without the hashtags) still appear in Trending Topics on the Chatter page and in Recently Talked About topics on profile pages; however, for privacy reasons, these two sections do not include topics used solely in private groups or on records.

  **Note:** Although hashtag topics are exposed in new places, the posts and comments that include them are subject to the same security and privacy as before.

This table summarizes the changes to hashtag topics in Summer ‘13.
Chatter

**Improved Trending Topics**

You asked for it! This enhancement is from an idea on the IdeaExchange.

**Available in:** Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Trending Topics area on the Chatter tab shows the topics being discussed right now in Chatter. A trending topic is not solely based on popularity and usually relates to a one-time or infrequent event that has a spike in activity, such as a conference or a project deadline.

With Summer ’13, we improved the calculation for Trending Topics by considering new signals, such as the number of comments and likes on posts with topics and a comparison of the historical and current usage of a topic. For privacy reasons, Trending Topics don’t include topics used solely in private groups or record feeds.

You can see improved Trending Topics after your users start using the new topics more frequently.

**Improved Topics on Profiles**

**Available in:** Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Previously, the Topics I Use Most section was included on profile pages. With Summer ’13, this section has been renamed to Recently Talked About. It now considers new signals, such as how recently you and others added topics to your posts and to posts you commented on. You can see up to five topics, with the most frequently and recently added topic appearing first. For privacy reasons, Recently Talked About topics don’t include topics used solely in private groups or record feeds.
Note: Immediately after the release, profile pages no longer show the Topics I Use Most section. However, the new Recently Talked About section might not appear on profile pages until your users start using the new Chatter topics more frequently.

FEEDS

Find in Feed: Searching in a Specific Feed

Use feed search to find information in a feed in a specific context. This feature was previously available only for group feeds and has been expanded to include more contexts in Summer ’13.

Available in: **Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer** Editions

You asked for it! This enhancement is from an **idea** on the IdeaExchange.

You can search for information in feeds on a user’s profile, a record, in a public or private group (if you’re a member), and on the Chatter and Home tabs. A contextual feed search is helpful when you want to confirm or check if something was once discussed in that specific feed.

1. Click above the feed to look for information in that feed. For example, use the feed search on a group’s page to find information in that group.

2. Type your search terms and press **ENTER** or click .
You can search for hashtag topics, mentions, and files posted in the feed, or refine your search using wildcards, operators, and quotation marks to match on exact phrases.

Tip: To search for hashtag topics with multiple words, use brackets after the hashtag and around the words. For example, to find all instances of #Universal Paper, type #[universal paper] in the search box.

Search results display with matching terms highlighted. Filters or sorting criteria used in the feed apply to feed search results as well.

Click to clear your search results and return to the feed.

Feed search behavior may vary slightly depending on where you perform the search.

- Feed search is not supported for feeds on list views or topic feeds.
- You can only search feeds you have access to via sharing rules.
- On the Chatter tab, feed search results are also limited by your feed type selections. For example, if you select the To Me feed type, and select additional filters and sorting criteria, all of those criteria apply to the feed search results.
- Feed search results are limited to the posts that are accessible from the context you search within. For example, if you search the feed on a user’s profile, the results include the posts and comments accessible from the user’s profile. This includes both the posts and comments shared by or with the user.
- Feed search returns matches for file or link names shared in posts, but not in comments.
- Record field changes aren’t included in record feed search results.

**Updated Menu for Bookmarking or Deleting Posts**

We changed the way you bookmark or delete a post. Bookmarking, removing a bookmark, or deleting a post is now available from a drop-down menu (✓) at the top right corner of the post. Use this same menu to edit or add topics to posts. For more information, see Adding Topics to Posts on page 64.

**New and Updated Feed Filters for Chatter Page and Record Pages**

We renamed the What I Follow filter to All Updates and added a Fewer Updates filter to the drop-down filters above your feed on Chatter page and the record pages.

The All Updates filter works the same way as the What I Follow filter and it is the default filter on the Chatter page. The All Updates filter displays all posts and comments from people and records you follow, and groups you’re a member of in your feed. The Fewer Updates filter is new. It hides system-generated record posts that have no comments from your Chatter feed and your record feeds.

System-generated posts are updates that Salesforce automatically generates when someone creates a new record or changes a tracked field on a record. For example, let’s say you’re following the Acme account. The account executive for Acme creates a new opportunity. Later, the account executive also changes a tracked field on the Acme account. In both cases, Salesforce automatically generates an update about each change and posts the updates in your Chatter feed and the feed on the Acme account detail page. The Fewer Updates filter hides these system-generated posts in your feed, unless someone has commented on the posts. If you want to see the system-generated posts, select the All Updates filter.
Depending on how many records you follow, and the level of activity on those records, there could be a large number of system-generated updates in your feed. If you’re not interested in these kind of posts, you can now use the Fewer Updates filter to hide them.

**Follow Button on Record Feed**

We moved the Follow button on record detail pages to the record feed to further streamline our design across all of the Chatter feeds.

To follow a record, click ![Show Feed] at the top of the record detail page, then click ![Follow].

**New Preview Links**

In Summer ’13, we’ve added more previews for linked content:

- bloomberg.com
- box.com
- engadget.com
- en.wikipedia.org
- google.com/finance
- huffingtonpost.com
- marketwatch.com
- npr.com
- scribd.com

The previews are powered by Embed.ly, a third-party service, and include thumbnails, descriptions, and video players for links to videos. We don’t share any content, user, organization, or account data with Embed.ly. We only share the URLs that are on the domain whitelist. Additionally, all of our URL requests pass through a Salesforce proxy, meaning Embed.ly never receives calls directly from the client and therefore doesn’t have information about who’s making the URL request.

**ADDITIONAL ENHANCEMENTS**

**Do More with Chatter Email Replies**

*Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions*

We enhanced email replies so that you can do even more directly from your email. Now, when you receive certain Chatter emails, you can reply to bookmark posts, follow and unfollow people, and unlike posts that you previously liked. Here’s a summary of everything you can do and important considerations when replying by email.
### Action | Type of Email | Text to Include in Your Reply | Limits |
--- | --- | --- | --- |
Bookmark a post | Someone posted to your profile or a group, mentioned you in a post, or shared your post | bookmark | N/A |
Comment on a post | Someone posted, commented on your post, also commented after you, or mentioned you in a post or comment | The text of your comment | 1,000 characters maximum. Replies that exceed the limit are truncated to the first 1,000 characters. |
Follow someone | Someone posted, commented on your post, also commented after you, or mentioned you in a post or comment | follow | N/A |
Like a comment | Someone commented on your post or also commented after you | like or +1 | N/A |
Like a post | Someone posted to your profile or a group, mentioned you in a post, or shared your post | like or +1 | N/A |
Respond to a Chatter message | Someone sent you a message | The text of your response | 10,000 characters maximum. Replies that exceed the limit are truncated to the first 10,000 characters. |
Unfollow someone | Someone posted, commented on your post, also commented after you, or mentioned you in a post or comment | unfollow | N/A |
Unlike a post | Someone posted, commented on your post, or also commented after you on a post that you previously liked | unlike or –1 | N/A |

Consider these tips when sending email replies.

- Replies must be sent from the email address specified on your profile. If you use email aliases or email forwarding services that send replies from a different email address, your replies won’t be processed.
- Replies to bookmark, like or unlike, and follow or unfollow must contain only the single word or exact text, such as like (case insensitive) or +1. If you include extra white spaces or the original message that some email applications automatically include, we ignore them and process the reply as a like, bookmark, etc. However, if you include any other text in the body, such as Like! or Like this?, we process your reply as a comment rather than a like, bookmark, etc.
- If replies contain your personal email signature, the signature text is treated as part of your comment. Default signatures inserted by mobile devices, such as Sent from my iPhone, are automatically removed from replies. Before replying, delete custom signatures and any extra text you don’t want posted to Chatter.
• Attachments in replies are ignored.
• Before replying, check the email address that displays in the To field of your email. Valid addresses contain tokens, or long character strings, both before and after the @ symbol, such as w8t27apy1@j321imd9gbs.d8rx.d.chatter.nal.salesforce.com. Some email applications may automatically use the From address from the original email, reply@chatter.salesforce.com, which is not a valid address for receiving replies. If you see this shortened address in the To field of your reply email, replace it with the valid reply-to address in the email header information. For example, in an application such as IBM® Lotus Notes®:

1. Open the original email.
2. Click View > Show > Page Source.
3. In the Reply-To section, copy the email address that looks like:
w8t27apy1@j321imd9gbs.d8rx.d.chatter.nal.salesforce.com.
4. Paste the reply-to address in the To field of your reply email.

Profile and Contact Information Updates

We've enhanced the profile page to streamline editing of information in the Contact and About Me sections, and to add options for users in organizations that have enabled Salesforce Communities. Here's what's changed.

• When you click in the Contact or About Me sections, you now see a single dialog box instead of separate dialog boxes for each section. You can switch between tabs to edit your About information and Contact information.
• If your organization has enabled Communities:
  ◊ There's an additional way to access the new consolidated dialog box. In the global header, click Your Name > Edit Contact Info to edit your contact information and visibility settings. The visibility settings allow you to control how much of your contact information is visible to external members in communities, such as customers and partners, and guest users, who can view publicly accessible sites or pages that don't require login.
  ◊ When uploading or editing your profile photo, you can select the Show in communities with publicly accessible pages checkbox to make the photo visible to guest users viewing publicly accessible sites or pages that don't require login.

Enhanced Profile Page Layout—Pilot

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

An enhanced version of the Profile page is now available through a pilot program. Besides a visual redesign, administrators can customize user profile information and add Connected Apps from partners to the Profile page. Visualforce customizations are also supported. For information on enabling the enhanced version of the Profile page, contact salesforce.com.
Chatter Desktop Version 3.2

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Chatter Desktop 3.2 release (April ‘13), continues to deliver more enhancements that help you collaborate efficiently outside your web browser. You can now use Chatter Desktop to:

- Configure desktop alerts for new feed posts and comments
- Configure Chatter Desktop to always display in the foreground
- Delete feed posts if you have access
- Post in all public groups

In addition, this release supports scrolling and active links in group descriptions and addresses bugs related to negative like counts, names displayed twice for likes, and broken hash tag topic links.

Organization-Wide Search in Chatter Messenger

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

Search and chat with any online Chatter user instead of just the people you follow. Type any name in the search box at the top of the chat list or click ![search](search_icon.png) from an active chat window to search for people in your organization.

Style Enhancements for Chatter List Views

Chatter list views have a cleaner look with improved spacing and font styling. You’ll see these style changes in lists across Chatter, including people, groups, files, and topics.

Chatter API

Summer ’13 (Chatter API version 28.0) contains enhancements to Chatter API resources, request bodies, and response bodies. In addition, Chatter in Apex is now generally available.

- Chatter in Apex—Generally Available
- New and Changed Resources
- New and Changed Request Bodies
- New and Changed Response Bodies
Chatter in Apex—Generally Available

Chatter in Apex exposes many Chatter API resources as Apex classes in the ConnectApi namespace. Use Chatter in Apex to build Chatter integrations and custom UIs without making HTTP callouts.

Important: Changes and additions to Chatter in Apex are now documented with the other Apex code enhancements. The complete Chatter in Apex documentation is now in Apex Code Developer's Guide.

New and Changed Resources

- Batch is a new resource that you can use to create a request body with a batch of up to 25 sub-requests and send them to the server in a single request. The response bodies and HTTP statuses for every request in the batch are returned within a single response body. The resource is /connect/batch.
- All the Feeds resources except the Topics feed now have a q parameter that you can use to search a feed in a GET request. Specify keywords to search for in the body and comments of feed items in a feed. Before this release, the only feed you could search was the Record feed.
- The Feed-Items Query resource (/chatter/feed-items?q=searchTerm) has a new sort parameter. Use it to specify the sort order of the results. Possible values are CreatedDateDesc (default) and LastModifiedDateDesc.
- Feed-Items Topics is a new resource that associates new and existing topics with a feed item. This resource can also be used to remove topics from a feed item. The resource is /chatter/feed-items/feedItemId/topics.
- The List of Favorites resource (/chatter/feeds/favorites.getUserId) has a new POST request parameter, targetId, that specifies a topic to add to favorites.
- Topics Feed URL is a new resource that returns a URL to the feed-items for a specified topic. The resource is /chatter/feeds/topics/topicId.
- Topics Feed Items is a new resource that returns all the feed items for a specified topic. The resource is /chatter/feeds/topics/topicId/feed-items.
- Group Topics is a new resource that provides up to five topics most recently used in the specified group. The resource is /chatter/groups/groupId/topics.
- The Groups resource, /chatter/groups/groupId, now supports the PATCH method. Send a PATCH request with a Group Input request body or request parameters to update the “Information” section of a group. In the Web UI, the “Information” section is above the “Description” section. If the group is private, this section is visible only to members. This resource now returns a Group Detail response body instead of a Group response body.
- List of Topics is a new resource that provides a list of the organization’s topics. The resource is /chatter/topics.
- Topic is a new resource that provides information about a specified topic. Use this resource to get information about a topic, to update a topic’s description, and to change the capitalization of a topic name. Administrators can use this resource to delete topics. The resource is /chatter/topics/topicId.
- Topic Files is a new resource that returns information about the five files posted most recently to the specified topic. The resource is /chatter/topics/topicId/files.
- Topic Groups is a new resource that returns information about the five groups that most recently contributed to the specified topic. The resource is /chatter/topics/topicId/groups.
- Related Topics is a new resource that provides topics related to the specified topic. The resource is /chatter/topics/topicId/relatedtopics.
- Topics Suggestions is a new resource that provides suggested topics for a specified string of text or feed item. The resource is /chatter/topics/suggestions.
• The Trending Topics resource (/chatter/topics/trending) now returns only the top five trending topics for your organization.
• The page parameter for the User Conversations (/chatter/users/userId/conversations) and User Messages (/chatter/users/userId/messages) resources was incorrectly documented as an integer. It is now correctly documented as a string and has the correct description.
• User Topics is a new resource that provides up to five topics most recently used by the specified user. The resource is /chatter/users/userId/topics.
• The User Information resource (/chatter/users) has a new searchContextId parameter. Use this parameter for @mention completion. Passing a feed item ID for searchContextId matches users already mentioned in the thread earlier in the returned collection. When using this parameter, you can’t query more than 500 results and you can’t use wildcards in the search term.
• The User Information resource (/chatter/users) now always returns a User Detail response body in the user property of the User Page response body. The fields that the context user is not allowed to see are set to null. (In versions earlier than 28.0, the user can contain a User Summary or a User Detail property.)
• These resources are not supported because Communities doesn’t support private messages:
  ◊ /connect/communities/communityId/chatter/users/userId/conversations/
  ◊ /connect/communities/communityId/chatter/users/userId/conversations/conversationId
  ◊ /connect/communities/communityId/chatter/users/userId/conversations/conversationId/mark-read
  ◊ /connect/communities/communityId/chatter/users/userId/conversations/unread-count
  ◊ /connect/communities/communityId/chatter/users/userId/messages
  ◊ /connect/communities/communityId/chatter/users/userId/messages/messageId

These resources are supported without /connect/communities/communityId section of their URLs. For example, this resource is legal: /chatter/users/userId/conversations/.

New and Changed Request Bodies

• Batch Input is a new request body that contains a collection of Batch Request Input request bodies. Use this request body with the /connect/batch resource.
• Batch Request Input is a new request body that contains a Chatter API resource URL, an HTTP method to use with that resource, an optional rich input body, and optional binary attachment information.
• Feed Favorite Input has a new property, targetId, that identifies a topic.
• Group Information Input is a new request body that contains a Group Input request body. Use this request body with the /chatter/groups/groupId resource to update the “Information” section of a group.
• Group Input is a new request body with two properties, text and title, that contain the text and title of the “Information” section of a group. In the Web UI, this section is above the “Description” section. If the group is private, the “Information” section is visible only to members.
• Message Segment Input: Hash Tag recognizes multiple word hash tags.
• Message Segment Input: Text recognizes multiple word hash tags.
• Topic Input is a new request body. Use this request body with the /chatter/topics/topicId resource to change the capitalization of a topic name or update a topic description.
New and Changed Response Bodies

- Approval Post Template Field is a new response body that describes a field in an approval post template. It has the following properties: displayName, displayValue, and record.
- The Batch Results response body has a new hasErrors property that indicates whether one of the results in the results set is an HTTP status code in the 400 or 500 range.
- The Comments response body and the Feed Item response body have a new relativeCreatedDate property that contains the created date in a relative, localized format that’s perfect for displaying on a mobile device or tablet: for example, “17m ago” or “Yesterday.”
- The Community response body has a status property with three possible values. One of those values, Active, has been changed to Live.
- The Favorite response body has a new target property that references a topic when applicable.
- The Favorite response body’s type property now includes a topic value.
- The Features response body has the following new properties:
  - chatterTopics—indicates whether Chatter topics are enabled
  - defaultCurrencyIsoCode—when the Features multiCurrency property is false, this property indicates the ISO code of the default currency
  - multiCurrency—indicates whether the user’s organization uses multiple currencies
  - publisherActions—indicates whether publisher actions are enabled
- The Feed Item response body has a new topics property that returns a Topics Collection response body for a specified feed item.
- The Feed Item type property has a new CreateRecordEvent value, which indicates that a record was created using the publisher.
- The Feed Item type property has a new CollaborationGroupUnarchived value, which indicates that an archived group was unarchived.
- The Feed Item Attachment: Approval response body has a new postTemplateFields. The property contains a collection of Approval Post Template Field response bodies.
- The Feed Item Attachment: Basic Template response body has a new linkRecordId property. If linkURL refers to a Salesforce record, linkRecordId contains the ID of the record..
- The Feed Item Attachment: Basic Template response body subtype property is not supported in 28.0. The property contains None for clients using an older API version.
- Feed Item Topics is a new response body containing a canAssignTopics property and a topics property that contains a collection of topics.
- The File response body now includes a parentFolder property that is reserved for future use.
- The Group response body no longer has a fileCount property. The property is now in the Group Detail response body.
- Group Detail is a new response body containing the properties of the Group response body and a new information property that contains a Group Information response body. It also contains a fileCount property that returns the number of files posted to the group.
- Group Information is a new response body with a text and a title property that contain the “Information” section of the group. In the Web UI, this section is above the “Description” section. If the group is private, this section is visible only to members.
- The Group Page groups property now returns a collection of Group Detail response bodies instead of a collection of Group response bodies.
- The Message Segment: Hashtag response body has a new topicUrl property that is the URL for the topic.
- The Organization Summary response body has been removed. The two properties it contained were also in the Organization response body, which still exists.
- The Topic response body has these new properties:
createDate—ISO8601 date string, for example, 2011-02-25T18:24:31.000Z

description—Description of the topic

id—18-character ID of the topic

talkingAbout—Number of people talking about this topic over the last two months, based on factors such as topic additions and comments on posts with the topic

- The Topics Collection response body was previously available but was omitted from the documentation.
- Topic Suggestion is a new response body that returns new and existing topic suggestions.
- Topic Suggestion Collection is a new response body that returns a collection of Topic Suggestion response bodies.
- The userType property in the User Detail and User Summary response bodies has a new ChatterOnly value for Chatter Free users.
- The User Settings response body has a new currencySymbol property containing the currency symbol to use for displaying currency values. Applicable only when the multiCurrency property of the Features response body is false.
- The User Settings response body has a new userDefaultCurrencyIsoCode property containing the ISO code for the default currency. Applicable only when the multiCurrency property of the Features response body is true.
- The User Summary response body has a new isInThisCommunity property. The value is true if the user is in the same community as the context user; the value is false otherwise.
ACTIVITIES

Relate More Contacts to Activities

Previously, Shared Activities contacts were limited to 10. The new limit of 50 contacts per event or task helps you track activities more accurately.

See Shared Activities Reflected in Custom Reports

Reports based on the Activities with Contacts custom report type are more complete, showing all contacts related to an activity instead of just the primary contact.

Shared Activities Works More Smoothly with Email to Salesforce

Email to Salesforce can create up to 50 email activities for each email it receives. If Shared Activities is enabled, Email to Salesforce can relate up to 50 contacts to each email task record. It no longer creates a separate email task record for each contact.
Other Notes on Activities

Operations that aren’t supported in certain triggers
When a user saves an activity in the user interface, before and after triggers set to do any of the following aren’t supported:
• Modifying the whoId (Name) field, if Shared Activities is enabled
• Modifying or adding an activity relation through the TaskRelation or EventRelation object, if Shared Activities is enabled
• Modifying or adding an invitee relation on a group event through the Invitee object, whether or not Shared Activities is enabled

API requirement for Visualforce pages displaying Shared Activities events
If a Visualforce page uses the standard controller to display Shared Activities events, use API 26.0 or later. If you use an earlier API version, the page does not display.

Custom logos in meeting requests
We clarified the guidelines for uploading a custom logo and including it in meeting requests. See “Guidelines for Adding a Custom Logo to Meeting Requests” in the Salesforce Help.

FORECASTS

Forecast Using Quantities

| Available in: Professional, Enterprise, Unlimited, and Developer Editions |

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable Forecasts users:</td>
</tr>
<tr>
<td>“Manage Users”</td>
</tr>
<tr>
<td>AND</td>
</tr>
<tr>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Note: This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Now you can forecast by quantity as well as revenue! Depending on your organization’s settings, you can forecast by quantity, revenue, or both. Quantity forecasts roll up based on an opportunity’s quantity field, while revenue forecasts roll up based on an opportunity’s amount field.
**Note:** If you disable a revenue or quantity option after it’s been selected, all related quota and adjustment information is purged.

Follow these steps to select an option for your organization.

1. From Setup, click **Customize > Forecasts > Settings**.
2. Under Data Source, select **Revenue**, **Quantity**, or both.

If you enable both revenue and quantity for use in your organization, only one option is available to view on a page at a time. However, users can toggle between views by clicking ▼ next to Amounts in *Currency Type* or *Quantity (Units)* and selecting a data source.

When you enable quantity, forecast managers can adjust quantity-based forecasts in the same manner in which they adjust revenue-based forecasts.

### Add Quotas Based on Quantity

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable Forecasts users:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>To manage quotas:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Note:** This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

If your organization uses quotas, you can now add quotas based on quantity amounts as well as revenue amounts. API access is required to use quotas. The quota-related fields are available beginning with API version 28.0.

**Tip:** To learn more about enabling and loading quotas when using Forecasts, see *Enabling Quotas in Forecasts* in Help.
Create a Forecasting Quotas and Forecasting Items Custom Report Type

Available in: Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use Forecasts:</td>
</tr>
<tr>
<td>To view the Reports tab:</td>
</tr>
<tr>
<td>To create, edit, and delete reports:</td>
</tr>
</tbody>
</table>

Note: This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Now you can create another Forecasts custom report type to see a team’s quota attainment. Use both Forecasting Quotas and Forecasting Items to create the custom report type. Then, for example, when you create the report, include a team’s quotas and forecasted revenue for closed forecasts and create a formula field to display the quota percentage attained.

Find Display Options More Easily

Available in: Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use Forecasts:</td>
</tr>
</tbody>
</table>

Note: This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

To update the display currency on a forecast, click ▼ next to Amounts in Currency Type or Quantity (Units). Previously, you clicked Display Settings to change the display currency.

Additionally, Display Settings has been renamed Display Options.
OPPORTUNITIES

Introducing Opportunity Splits

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Enterprise, Unlimited, and Developer Editions

Does your sales organization need to split credit for opportunities? With Summer ‘13, now you can! Opportunity Splits lets users split credit across opportunity team members. Multiple people working on an opportunity can roll their individual sales credits into quota and pipeline reports for the entire team.

There are two types of opportunity splits.

Revenue splits provide credit to team members who are directly responsible for revenue that an opportunity generates. Revenue splits must total 100% of the opportunity amount.

Overlay splits provide credit to team members who work on an opportunity but aren’t directly responsible for generated revenue. Because these splits aren’t limited by the opportunity amount, they can total any percentage (sometimes exceeding 100%).

Tip: As an administrator, you can create custom reports that include opportunity split data. Note, however, that opportunity splits aren’t currently rolled up to sales territories or forecasts.

Enable Team Selling and Opportunity Splits

User Permissions Needed

| To enable team selling and opportunity splits: | “Customize Application” |

Team selling and opportunity splits go hand in hand, so you must enable opportunity teams and then enable splits.

Be aware that enabling Opportunity Splits changes existing opportunity records in your organization.

- The opportunity owner is included on each opportunity team. Because the Opportunity Owner role is essential for splits, you can’t remove it.
- Newly created opportunity split records include a default entry for the owner, who receives 100% of revenue splits.

A script applies these changes after you enable Opportunity Splits. The script temporarily disables triggers, workflows, and validation rules for opportunity team records, mass reassignment of opportunity team members, and mass transfer of accounts and opportunities. If your organization has a lot of opportunities, the script may take several hours. While it’s running, you can still perform other tasks in Salesforce. Automated email notifications keep you up to date on the script’s status.

1. From Setup, click Customize > Opportunities > Opportunity Teams.
2. Click Settings.
3. Select Enable Team Selling, and click Save.
4. Select the opportunity page layouts that will display the new Opportunity Team related list.
5. To ensure that users with customized page layouts see the related list, select Append to users’ personal related list customization.
6. Click Save.
7. Click Customize > Opportunities > Opportunity Teams > Opportunity Splits.
8. Select Enable Opportunity Splits.

Tip: To better reflect your business process, you can disable revenue or overlay splits, or enter unique labels for them. To customize these items at any time, return to the Opportunity Splits setup page, and click Edit.

9. Select the same page layout options you chose for opportunity teams.
10. Click Save.

Now that you’ve enabled Opportunity Splits, every newly created opportunity in your organization automatically includes them.

**Share Sales Credit with Opportunity Splits**

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add and view splits for opportunity team members:</td>
</tr>
<tr>
<td>“Edit” on opportunities</td>
</tr>
<tr>
<td>AND</td>
</tr>
<tr>
<td>Owner of opportunity record, or above owner in organization hierarchy</td>
</tr>
</tbody>
</table>

When your users are ready to create splits, the process is simple.

1. Open an existing opportunity or create a new one. The opportunity owner is automatically included in the opportunity team and assigned a 100% revenue split by default.
2. In the Opportunity Split related list, click Edit Opportunity Splits.
3. Add appropriate opportunity team members, and adjust their split percentages. Revenue splits must total 100%, but overlay splits can total any percentage.
4. Click Save.
Price Books

Customizable Price Books

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

<table>
<thead>
<tr>
<th>To view setup options:</th>
<th>“View Setup and Configuration”</th>
</tr>
</thead>
<tbody>
<tr>
<td>To customize your organization:</td>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Price books are now customizable! With Summer ’13, you can customize fields, page layouts, record types, and much more. Let’s look at some of the ways your users can take advantage of these enhancements. For example:

- Your organization may have several types of custom price books that are aimed at different markets, such as domestic and international. By creating a custom picklist called “Market” that lists these two values, users can instantly define which market each price book applies to.
- Users may have seasonal price books that come into effect during certain times of the year. Now, using custom date fields, users can specify the start and end dates during which the price book is active.
- You can set triggers to send emails automatically when a price book becomes active, ensuring your sales team is always up to date.
- To address the business needs of your different business divisions, you can set up specific page layouts for product teams or groups within your organization.
- Users can generate accurate reports based on the new custom fields you add, and filter their list views.

To customize price books:

1. From Setup, click Customize > Price Books.

2. Click a menu item to:
- Add custom fields and track field history.
- Create page layouts to display price book data.
- Apply validation rules to improve data quality.
- Define Apex triggers.
- Create field sets to group price book fields.
- Create and maintain record types.
- View price book limits.

In addition, users can now see whether price books are standard or customized when they create filtered reports and list views that include the Is Standard Price Book field.

**Note:** Price books don’t support roll-up summary fields. In addition, price books aren’t available as related lookups from other objects.

---

# Easier Access to Price Books

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To edit tab settings:</td>
</tr>
<tr>
<td>To view the Price Books tab:</td>
</tr>
</tbody>
</table>

As part of our price books enhancements in Summer ’13, we added a new Price Books tab to make it easier for users to access their price books. They can still navigate to price books from the Products tab, which now redirects them to the new Price Books tab instead. We hope your users like it!
For existing organizations, you’ll need to enable the Price Books tab for your users. For new organizations, we enabled the tab for you.

To enable the Price Books tab for existing organizations:

1. From Setup, click **Manage Users > Profiles**.
2. If you use the:
   - Enhanced profile user interface—In Find Settings, enter *Price Books*, select it from the list, and click **Edit**.
   - Original profile user interface—Click **Edit**, then scroll to the Tab Settings section.
3. Select **Default On** for the Price Books tab setting and save your changes.

### Updates to Price Books Archiving

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view the Price Books tab:</td>
</tr>
<tr>
<td>To edit price books:</td>
</tr>
</tbody>
</table>

Previously, when users tried to delete custom price books that had associated records, they were directed to an error page that gave them the option to archive the price books. Now, users can archive custom price books directly from the price book details page using a new **Archive** button.

### Considerations for Archiving Price Books

Before users archive their price books, it’s good to understand all options for handling price books that users no longer need.

<table>
<thead>
<tr>
<th>Users can</th>
<th>Under what circumstances?</th>
<th>What if users want to get them back?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivate</td>
<td>Regardless of whether price books include associated records.</td>
<td>No problem. Users can reactivate price books.</td>
</tr>
<tr>
<td>Delete</td>
<td>Only if price books don’t include associated records.</td>
<td>Users can restore deleted price books from the Recycle Bin.</td>
</tr>
<tr>
<td>Archive</td>
<td>With caution, regardless of whether price books include associated records. If users archive price books, the associated records will still include the archived price books, but users can’t access them.</td>
<td>Sorry, but there’s no way to restore archived price books.</td>
</tr>
</tbody>
</table>
Salesforce for Outlook Enhancements

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

To install Salesforce for Outlook:
- Assigned to an active configuration AND
- Valid data set for each object being synced

To change sync folders:
- Your Outlook profile set as the default in your Mail Settings

In our last release, we announced the general availability of the Salesforce Side Panel for Microsoft® Outlook®. With it, Microsoft Windows® users can view and work with Salesforce records directly in Outlook. And for Summer ’13, we’re excited to tell you about improvements we’ve made to the side panel, which will help your users become even more efficient as they complete their Outlook and Salesforce integration tasks.

But even if your users haven’t yet had the advantage of working in the Salesforce Side Panel, they can still benefit from some of our latest improvements to Salesforce for Outlook.

<table>
<thead>
<tr>
<th>Users can now</th>
<th>Available to all users</th>
<th>Available to only side panel users</th>
<th>Learn about it in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add emails to multiple contacts</td>
<td>✓</td>
<td></td>
<td>Enable Shared Activities</td>
</tr>
<tr>
<td>Selectively sync individual contacts, events, and tasks</td>
<td>✓</td>
<td></td>
<td>Manually Select Items to Sync</td>
</tr>
<tr>
<td>Search for and add emails to any Salesforce records that allow activities</td>
<td>✓</td>
<td></td>
<td>Search for More Kinds of Records in the Salesforce Side Panel</td>
</tr>
<tr>
<td>See cases related to contacts in their emails</td>
<td>✓</td>
<td></td>
<td>View Cases Related to Contacts in the Salesforce Side Panel</td>
</tr>
</tbody>
</table>

Let’s Get Ready

Among your tasks, it’ll be important for you to urge your users to install Salesforce for Outlook v2.2.0 or later, so they can dig in to the new features quickly. Here are the tasks you’ll complete to get your users working more efficiently.
1. To give your users the option to add emails to multiple contacts, enable Shared Activities. If you haven’t already enabled Shared Activities, we recommend you first read about the feature in the online help.

2. Urge all users to download and install Salesforce for Outlook v2.2.0 or later.

3. After you’ve enabled Shared Activities for your organization and your users have installed Salesforce for Outlook, you’ll have happier and more productive users!

**Enable Shared Activities**

Users can add emails to multiple Salesforce contacts, and to one other record with which users can associate tasks, such an account, a lead, or a case. This requires your organization to have Shared Activities enabled.

After you enable Shared Activities, it can take up to 48 hours for the process to finish, depending on the volume of activities for your organization. During this process, users can continue working with tasks and events.

1. From Setup click **Customize > Activities > Activity Settings**.
2. Select **Allow Users to Relate Multiple Contacts to Tasks and Events**.
3. Click **Submit**.
Add Emails to Multiple Records with the Salesforce Side Panel

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

<table>
<thead>
<tr>
<th>Available in: Professional, Enterprise, Unlimited, and Developer Editions</th>
</tr>
</thead>
</table>

**User Permissions Needed**

<table>
<thead>
<tr>
<th>To display the Salesforce Side Panel in Outlook:</th>
<th>“Side Panel”</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add Outlook emails to Salesforce records:</td>
<td>“Email to Salesforce” AND “Add Email”</td>
</tr>
<tr>
<td>To add email attachments to Salesforce:</td>
<td>“Always save email attachments” in Email to Salesforce settings</td>
</tr>
<tr>
<td>To add emails to multiple contacts:</td>
<td>“Allow Users to Relate Multiple Contacts to Tasks and Events” in Activity Settings</td>
</tr>
</tbody>
</table>

Watch a Demo: 🎥 Using the Salesforce Side Panel to Work with Records in Microsoft® Outlook® (2:18 minutes)

If you’ve enabled Shared Activities, users can add emails to multiple Salesforce contacts, and to one other record with which users can associate tasks. Here’s how.

1. Select an email.
2. Click next to the Salesforce contacts of their choice. Users can select multiple contacts, as well as one other record with which users can associate tasks, such as an account, a lead, or a case. If users select another record other than a contact, the side panel prompts users to either replace the record they originally selected, or cancel the replacement.

3. Keep track of the records they've added the email to.

Add Emails to Multiple Records without the Salesforce Side Panel

User Permissions Needed

<table>
<thead>
<tr>
<th>To add Outlook emails to Salesforce:</th>
<th>“Email to Salesforce” AND “Add Email”</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add email attachments to Salesforce:</td>
<td>“Always save email attachments” in Email to Salesforce settings</td>
</tr>
</tbody>
</table>

If you've enabled Shared Activities, and you have users who don't yet use the Salesforce Side Panel, the Add Emails feature now automatically adds emails to multiple contacts. Here's how.

1. Select an email.
2. Click Add Emails. Salesforce for Outlook automatically adds the email to the related Salesforce records.

   If Salesforce can't find any contacts that match the ones in the email's From, To, and Cc fields, users can manually assign the emails in My Unresolved Items.

Manually Select Items to Sync

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.
The automatic sync method is pretty convenient, but for some users, syncing all of their contacts, events, and tasks is overkill. So we’ve added the option for users to manually select the items to sync between Outlook and Salesforce. Regardless of the sync method users choose, the regular sync cycles still occur.

Here’s the setting users will see when they install Salesforce for Outlook v2.2.0 or later.

If users select Manual, they’ll select an Outlook category for each item they want to sync. Here’s how.

1. Select items to sync. Users can select multiple items by pressing CTRL while clicking the items they want to sync.
2. Right-click a selected item, then select **Categorize > Sync with Salesforce**. The items will sync automatically during the next sync cycle.

**Search for More Kinds of Records in the Salesforce Side Panel**

Users will also discover that the search feature just got a lot better. We’ve improved search results so they now include any kinds of related Salesforce records with which users can associate tasks—not just contacts, accounts, opportunities, and leads. Search results can also include custom objects. To have custom objects appear in your users search results, the objects need to include Allow Activities, which you can see below.

1. From Setup, click **Create > Objects**. Click **Edit** next to the object you want to appear in search results.
2. Verify the Allow Activities setting is selected.

In addition, the DELETE key and copy and paste functions are now active for the search feature.

**View Cases Related to Contacts in the Salesforce Side Panel**

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

Now your users will see cases related to the contacts that appear in the side panel. This helps sales professionals stay informed about any potential problems that their leads or customers are experiencing with your company.
Added Security Requirements for the Salesforce Side Panel

If users click links in the Salesforce Side Panel, but aren’t yet logged in to Salesforce in their browsers, they’ll see a prompt to log in. Here’s how.
1. Users click any link in the Salesforce Side Panel, which opens their browser to the Salesforce log in page.
2. They'll then log in to Salesforce. Done!

Support for Syncing Salesforce Tasks Using Custom Forms in Outlook

If your users create tasks with a custom form in Outlook, Salesforce for Outlook syncs their Salesforce tasks to Outlook using that custom form. Previously, the sync process used the standard task form. Users need to make sure, however, that they store their custom task form in the default Tasks folder, and not in a subfolder.

TASKS

Publisher Actions Replace Chatter Tasks

We heard your feedback: Creating tasks right in the Chatter feed for a record is faster and easier, but it could be more flexible. And seeing some tasks in Chatter feeds is useful—but too many tasks can overwhelm a feed. Now, using the publisher actions feature, you can customize task creation and the related feed items to improve support for your organization's workflow.

Note the following about the replacement of Chatter Tasks with publisher actions.

- Users no longer see an option to create tasks at the top of a record detail page unless you re-create it using the publisher actions feature.
- Feed items are no longer generated for tasks unless you use the publisher actions feature. Existing task feed items are not affected.
- The Tasks in Feeds settings (on the Chatter Settings page) are no longer available.
• The publisher actions feature includes all the functionality of Chatter Tasks (and more).

**Tasks are More Flexible and Useful**
Here's how publisher actions improve on Chatter Tasks.

**Flexible fields**
The task publisher includes more default fields, and you can change or add to them, for example to support validation rules.

**Different actions for different kinds of objects**
You can create different actions for different kinds of objects. For example, if you enable actions for tasks with accounts but not files, users can create tasks on the detail pages of all account records (but not file records) they can access.

**Flexibility in feeds**
Feeds can include all tasks or just tasks created in the publisher. They can include updates to existing tasks, or only new tasks. See New Feed Tracking Option with Publisher Actions on page 60.

**Control using page layouts**
Display of the publisher and the corresponding tasks in feeds (who sees them, and on what objects) is controlled through page layouts.
Re-Create Chatter Tasks Features Using Publisher Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

| To create tasks: | “Edit Tasks” |

Chatter Tasks is no longer available. However, if you enabled Chatter Tasks features in Spring ’13 and want to re-create them, follow these overall steps to set up publisher actions. From Setup:

1. Be sure feed tracking is enabled in Chatter Settings for each object.
2. Click Customize > Chatter > Settings and enable the publisher actions feature.
3. Click Customize > Object Name > Buttons, Links, and Actions. Create an action on the object, selecting Task as the target object. Optionally, customize the task fields using the action layout editor. Repeat for each object.
4. On the Page Layouts page for each corresponding object, add the task action you’ve created to the object’s publisher by dragging the action into the box under Chatter Feed. Save the layout.

The task publisher now appears in the feeds of the objects you’ve added it to, and new tasks appear in those records’ feeds. For more information, see Add and Customize Actions in the Chatter Publisher on page 56.

ADDITIONAL SALES ENHANCEMENTS

Updates to Partner Portal User Management and Delegated Administration

**Note:** Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities. Contact your Salesforce Account Executive for more information.

Permissions and Fields Renamed

The following permissions and fields have been renamed to work across portals and communities. These fields have changed regardless of whether you enable Communities.

<table>
<thead>
<tr>
<th>New Value</th>
<th>Old Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage External Users</td>
<td>Manage Partners</td>
<td>User permission</td>
</tr>
<tr>
<td>Manage External Account</td>
<td>Work With Portal (on account)</td>
<td>Field label</td>
</tr>
<tr>
<td>Manage External User</td>
<td>Work With Portal (on contact)</td>
<td>Field label</td>
</tr>
<tr>
<td>Delegated External User Administrator</td>
<td>Delegated Portal User Administrator</td>
<td>User permission</td>
</tr>
</tbody>
</table>
Delegated Administration Available to Additional Licenses

Users with the following user licenses can now manage external users, if they have the Manage External Users permission:

- Force.com - One App
- Salesforce Platform
- Chatter Only

Delegated Administrators Can Manage Partner Portal Users and Customer Portal Users

Starting in Summer '13, external users with the “Delegated External User Administrator” permission can manage both partner portal and Customer Portal users under the same account. The delegated administrator can only manage users who have one of the profiles in their Delegated External User Profiles related list and are under the same account.

Public Field on Events and Tasks Now Applies to Partner Users in Communities

The Visible in Self-Service checkbox on activities has been renamed to Public.

If Communities is enabled, this setting now applies to partner users. Specifically, tasks or events marked Public are visible to any external user in the community, as long as the user has access to the record the task or event was created on. If tasks or events aren’t marked Public, only internal users and the task owner can see it.

Also, when a partner user tries to retrieve events or tasks using the API, the partner user can retrieve events and tasks only if they created the event or task OR if the event or task is public.

The Public field doesn’t apply to partner users in partner portals; they continue to see all tasks and events.

Partner Portal Users Can See Customer Portal Users From the Same Account

If your organization has an account with both partner portal and Customer Portal users, and external user sharing is enabled, those users will be able to see each other. External user sharing is enabled by default for organizations with Communities enabled. For more information, see User Sharing.

Retirement of Connect for Lotus Notes

We want to remind you that at the end of June 2013, we’ll discontinue the availability of and support for Connect for Lotus Notes. We understand that this decision may cause a disruption for your users. But we strongly believe that this will allow us to deliver other features that will provide greater value to your users and our entire community.

If you have questions about our discontinued availability of and support for Connect for Lotus Notes, please contact salesforce.com Customer Support.
Contact, Account, and Lead Profile Image Visibility

Profile images from Facebook or Twitter for contacts, accounts, or leads may be visible even if you are not currently logged in to those services.

If you have previously logged in to Facebook or Twitter and associated a Facebook or Twitter account with a Salesforce.com contact, account, or lead, the profile image will remain viewable even if you are no longer logged in. You can also view a Facebook or Twitter profile image if it was associated with a contact, account, or lead by another user. This change does not affect profile images from other social networks.
New Option in Case Feed Setup

Available in: **Enterprise, Unlimited, and Developer** Editions

If your organization has enabled the publisher actions feature, you now have the option of using the advanced page layout editor to choose the actions that appear in the Case Feed publisher. (This option is selected by default for new Salesforce organizations that use Case Feed, and for organizations that enable Case Feed after the Summer ’13 release.)

When you use the advanced page layout editor to configure the Case Feed publisher, you’ll notice these differences:

1. The actions list appears at the top of the publisher. You can no longer position the actions list to the left of the publisher.
2. The Answer Customer action has been divided into its two component actions: Email and Portal.
3. The publisher actions list has a different look from what you’re used to seeing in Case Feed: it now looks more like the Chatter publisher on other pages.
4. The four standard Chatter actions—Post, File, Link, and Poll—automatically appear in the publisher layout, and they replace the Write Case Note action. You can change the sequence of these actions and remove any you don’t need.
5. The Feed View/Details drop-down list replaces the View Case Detail action.

In addition:

- Custom actions you previously added to the Case Feed publisher aren’t automatically available. You need to create new custom actions and add them to the publisher, and these actions must use `publisher.js` rather than `interaction.js`.
- The Case Detail page expands to full width, making it easier to see all of your related lists and other information.

For more information, see “Configuring the Case Feed Publisher Using the Advanced Page Layout Editor” in the online help and **Add and Customize Actions in the Chatter Publisher** on page 56.
Changes to Case Feed Feed Items

Available in: **Enterprise, Unlimited, and Developer** Editions

Enable Publisher Actions to Continue Seeing Feed Items for Related Objects

Summer ’13 introduces the publisher actions feature, which, like Case Feed, lets users do more in feeds, and gives administrators more control over the actions that appear in the publisher. Publisher actions includes a new option, **All Related Objects**, in feed tracking settings for account, campaign, case, contact, custom objects, lead, and opportunity. This option lets users view feed activity for objects that have a parent-child or lookup relationship to the host object.

The All Related Objects option replicates the behavior you’re used to seeing in Case Feed: when you’re viewing the feed for a case, you see feed items for object records related to that case, such as events and entitlements. In order to continue seeing this behavior, you need to enable publisher actions. When you do, the All Related Objects option is automatically selected for cases.

If you don’t enable publisher actions, you’ll see only feed items for activity on the case you’re viewing, not for activity on related objects.

**Learning More**

For more information on publisher actions, see “Setting Up Publisher Actions” and “Publisher Actions Overview” in the online help.

**CHATTER ANSWERS**

Chatter Answers for Everyone

Chatter Answers is available in: **Enterprise, Developer, and Unlimited** Editions.

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable Chatter Answers:</td>
</tr>
</tbody>
</table>

Chatter Answers is available for all Sales Cloud and Service Cloud organizations starting with the Summer ’13 release. Chatter Answers is a self-service support community where users can post questions and receive answers and comments from other users or your support agents. Chatter Answers brings together Cases, Questions and Answers, and Salesforce Knowledge articles in a unified experience.

**Note:** Some older portal licenses might not support Chatter Answers. Contact salesforce.com if Chatter Answers isn’t available automatically within your organization in Summer ’13.
Associate Chatter Answers with Salesforce Communities

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

To associate Chatter Answers with Salesforce Communities: “Customize Application”

Now you can associate Salesforce Communities with Chatter Answers to host Chatter Answers and authenticate users. Edit the visibility of Chatter Answers within your organization by showing the zone in a specific Chatter community, in a specific portal, all portals, or internally to your organization. If you associate a Chatter community with Chatter Answers, then the Q&A tab can be enabled for that community. Enabling Chatter Answers for a Chatter community disables any site or portal associations for that zone.

To associate Chatter Answers with Salesforce Communities, choose a Chatter community from the Visibility section of the Zone Edit page.

Chatter Answers Tab for Internal Users

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Internal users and administrators can view and use Chatter Answers from a tab within the Sales Cloud or the Service Cloud console. The Q&A tab provides the same view of Chatter Answers zones as portals and sites, so internal users don’t have to log into a portal or site to view Chatter Answers activity. The Q&A tab makes it easier for moderators and administrators to monitor and manage activity within Chatter Answers zones. The Q&A tab is available when Chatter Answers is enabled.

Designate a Public Group as a Customer Support Agents Group

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

To define a Customer Support Agents Group: “Customize Application”

Specify which users will act as customer support agents in a Chatter Answers zone. When agents post an answer in Chatter Answers, a headset icon appears next to his or her username and the hover details include “Customer Support.” This visual differentiation between agents and users helps everyone better understand the active participants within the Chatter Answers zone. In addition, agents show only a first name to the community and don’t include a reputation in the hover details. If portal users are included in the public group selected as a Customer Support Agents Group, they will not appear as agents. It’s a best
practice to add a Customer Support Agents Group to each zone. Adding a Customer Support Agents Group, even if the group is empty, avoids all internal users displaying as agents.

To specify which users appear as agents within a zone, select the public group for the Customer Support Agents Group on the Zone Edit page under Chatter Answers Settings.

**Reputation Points Assigned by Zone**

<table>
<thead>
<tr>
<th>Chatter Answers is available in:</th>
<th>Enterprise, Developer, and Unlimited Editions.</th>
</tr>
</thead>
</table>

**Note:** Starting with the Summer ’13 release, Chatter Answers “communities” have been renamed to “zones.”

Starting in the Spring ’13 release, Chatter Answers calculates points toward a user’s reputation on a per-zone basis. For example, a user who is a member of different zones will have different reputation values in each zone based on his or her activity in that zone.

**Username Format Throughout a Zone**

<table>
<thead>
<tr>
<th>Ideas zones available in:</th>
<th>Professional, Enterprise, Unlimited, and Developer Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answers zones available in:</td>
<td>Enterprise, Unlimited, and Developer Editions</td>
</tr>
<tr>
<td>Chatter Answers zones available in:</td>
<td>Enterprise, Unlimited, and Developer Editions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or edit a zone:</td>
</tr>
</tbody>
</table>

**Note:** Starting with the Summer ’13 release, Chatter Answers “communities” have been renamed to “zones.”

Select how the username for Ideas, Chatter Answers, and Answers users appears throughout a zone in their posts and replies. You can specify how usernames will appear in a zone in the Username Format field on the Zone Edit page.

Select one of the following username formats for a zone:

- First Name + Last Name. For example, John Smith.
- First Initial + Last Name. For example, J Smith.
- First Name + Last Initial. For example, John S.
- Zone Nickname. For example, Matterific1234.
**Customize Chatter Answers User Profiles in Salesforce Communities**

Chatter Answers is available in: **Enterprise**, **Developer**, and **Unlimited** Editions.

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To customize Chatter Answers user profiles:</td>
</tr>
</tbody>
</table>

Use your own customized Visualforce page for users’ profiles for Chatter Answers on a public site. Click on a user’s username to view their profile.

To set the profile page, select an existing Visualforce page for the **Custom Profile Page** field on the Chatter Answers Settings page. You must have **Visible without authentication** set for the zone in order for the user profile pages to be used.

**Chatter Answers Supersedes Answers**

Answers is no longer available for enablement. Now you can use Chatter Answers, a self-service support community where users can post questions and receive answers and comments from other users or your support agents. Chatter Answers brings together Cases, Questions and Answers, and Salesforce Knowledge articles in a unified experience. If your organization already uses Answers, it will continue to be available.

**CUSTOMER PORTAL**

**Updates to Customer Portal User Management and Delegated Administration**

**Note:** Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to Communities. Contact your Salesforce Account Executive for more information.

**Permissions and Fields Renamed**

The following permissions and fields have been renamed to work across portals and communities. These fields have changed regardless of whether you enable Communities.
<table>
<thead>
<tr>
<th>New Value</th>
<th>Old Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage External Users</td>
<td>Manage Partners</td>
<td>User permission</td>
</tr>
<tr>
<td>Manage External Account</td>
<td>Work With Portal (on account)</td>
<td>Field label</td>
</tr>
<tr>
<td>Manage External User</td>
<td>Work With Portal (on contact)</td>
<td>Field label</td>
</tr>
<tr>
<td>Delegated External User Administrator</td>
<td>Delegated Portal User Administrator</td>
<td>User permission</td>
</tr>
<tr>
<td>Convert External User Access Wizard</td>
<td>Convert Portal User Access Wizard</td>
<td>Sharing Tool</td>
</tr>
</tbody>
</table>

**Permission Changes for External User Management**

When your enable Communities in your organization, the permissions required to manage customers users have changed. Customer users include users with Customer Community or Customer Portal licenses.

<table>
<thead>
<tr>
<th>Action</th>
<th>Requirements with Communities Enabled</th>
<th>Requirements without Communities Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create customer users:</td>
<td>“Manage External Users” OR “Edit Self-Service Users”</td>
<td>“Edit Self-Service Users”</td>
</tr>
<tr>
<td>To see and use the Manage External User drop-down button on Contacts:</td>
<td>“Manage External Users” OR “Edit Self-Service Users” AND “Read” on the account associated with the customer user</td>
<td>“Edit Self-Service Users” AND “Read” on the account associated with the customer user</td>
</tr>
<tr>
<td>To view the Log in as option in the Manage External Users drop-down button:</td>
<td>“Manage External Users” OR “Edit Self-Service Users” AND “Edit” on the account associated with the customer user</td>
<td>“Edit Self-Service Users” AND “Edit” on the account associated with the customer user</td>
</tr>
</tbody>
</table>

**Delegated Administration Available to Additional Licenses**

Users with the following user licenses can now manage external users, if they have the Manage External Users permission:

- Force.com - One App
- Salesforce Platform
- Chatter Only
Delegated Administrators Can Manage Partner Portal Users and Customer Portal Users

Starting in Summer ‘13, external users with the “Delegated External User Administrator” permission can manage both partner portal and Customer Portal users under the same account. The delegated administrator can only manage users who have one of the profiles in their Delegated External User Profiles related list and are under the same account.

Visible in Self-Service Field on Events and Tasks Renamed to Public

The Visible in Self-Service checkbox on activities has been renamed to Public.

If your organization has enabled Communities, tasks or events marked Public are visible to any external user in the community, as long as the user has access to the record the task or event was created on. If a task or event isn’t marked Public, only internal users and the task owner can see it.

Additionally, if Communities is enabled, this field now applies to partner users too. See Public Field on Events and Tasks Now Applies to Partner Users in Communities.

The existing behavior for Customer Portal users hasn’t changed.

Behavior of Available for Customer Portal Checkbox on Custom Objects Changes if Communities is Enabled

If you turn on Communities in your organization, the Available for Customer Portal checkbox on custom objects no longer appears and all custom objects are available for use in your communities. If, before enabling Communities, you had a Customer Portal and custom objects that didn’t have the Available for Customer Portal checkbox selected, those objects become available for use in your Customer Portal.

While the custom objects are available for use in your community or Customer Portal, keep in mind that you still need to perform some setup so that they will appear. To make a custom object appear, you must set the custom object permissions so that users have the appropriate access, set the tab visibility to Default On, and add the tab to the community or Customer Portal.

Customer Portal Users Can See Partner Portal Users From the Same Account

If your organization has an account with both partner portal and Customer Portal users, and external user sharing is enabled, those users will be able to see each other. External user sharing is enabled by default for organizations with Communities enabled. For more information, see User Sharing.
Entitlement Management

Create Multiple Versions of Entitlement Processes

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Note: Entitlement versioning is currently available through a pilot program. For information on enabling entitlement versioning in your organization, contact salesforce.com.

Entitlement versioning lets you make changes to existing entitlement processes, even if they’re assigned to active entitlements and cases. This can be useful if the business rules behind your entitlement processes change, for example, or if you need to create multiple versions of the same entitlement process that have only minor differences. With entitlement versioning, you don’t need to create entirely new processes; you can simply create new versions of existing ones.

When you create a new version of an entitlement process, you can change any of the following:

- Name
- Description
- Whether the process is active
- Whether the version is the default
- Entry criteria
- Exit criteria

You can also add notes about the version. This makes it easy to differentiate between multiple versions of the same process, especially if they have the same name.

On new versions of entitlement processes that are currently in use, you can add new milestones, but can’t edit existing ones.

On new versions of processes that aren’t currently in use, you can both add new milestones and edit existing ones.

Once you’ve created a new version of an entitlement process, you can choose to apply it to all entitlements and cases assigned to the previously used version, or only to new entitlements and cases.

For more information, see “Creating New Versions of Entitlement Processes” in the Salesforce online help.

Increased Limit for Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

In Summer ’13, we’ve increased the number of entitlement processes each organization can create from 20 to 1000.
IDEAS

Encourage Idea Creation and Sharing in Salesforce Communities

Add your Ideas users to Salesforce Communities to take advantage of new ways to collaborate.

| Available in: Professional, Enterprise, Unlimited, and Developer Editions |

User Permissions Needed

To customize Ideas settings for Salesforce Communities: “Customize Application”

Create more engagement and collaboration around Ideas as you enable your customers to post and comment on Ideas right from their Salesforce Communities home page. Adding Ideas to Salesforce Communities lets your users reap the benefits of a vibrant, creative partnership between community members. Communities are customizable, public or private spaces for employees, customers, and partners to collaborate on best practices and business processes. When you enable Ideas in Salesforce Communities, you give your community members the ability to create ideas and idea themes and have a dialog around them. You can create public communities that let your customers or partners exchange ideas, as well as private internal communities that are specific to your employees.

Moderating and managing ideation communities can be assigned to internal community members, depending on their privileges. Internal users can moderate both internal and external communities because they have access to internal communities as well as any public communities that they have permission to access.

To organize your community into smaller groups, you can create zones within a community that reflect special interests, product groupings, or types of customers. Zones are shared by the Ideas, Answers, and Chatter Answers applications, allowing you to view and create zones from those locations. For example, if you’re a computer manufacturer you can create a community named Laptop Products and another named Desktop Products. Within each of those communities, you can create zones that are specific to different aspects of the products.

Community members have visibility into different zones based on their user profiles:

- Internal users with permission to see Ideas can see all zones in the default Chatter community. If internal users sign in to a Chatter community, they see only those zones associated with that community.
- Chatter community users see the zones associated with the community they’re signed in to.
- Portal users can see the zones associated with their portal.
- Portal users with access to both a portal and a Chatter community can see the zones associated with the portal or community that they are currently signed in to.
- Users who are accessing the portal or community through an API can access all zones that they have access to in all contexts.
- Global searches in the internal application performed by internal users return results from all ideas that are available within the organization. Searches performed by all other users in Salesforce Communities return results from the ideas that are available within the community.
Encouraging Innovation with Idea Reputation

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Reward the most influential and innovative members of your Ideas community by acknowledging their participation and contribution to the community. By enabling Reputation in Ideas, and then choosing level names and thresholds, you let users earn points and ratings that reward and encourage frequent, meaningful activity in the community. As community members engage more frequently, they improve the overall quality of ideas, which means that everyone reaps the benefits of a vibrant, creative partnership with your customers.

Users are awarded points for many activities including:

- Creating an idea
- Receiving a comment on their idea
- Receiving an upvote on their idea
- Commenting on someone else’s idea

Reputation points are calculated separately for each zone, and for the cumulative activity within the entire organization. Users who participate in different zones will have different reputation values for each zone based on their activity in that zone. When users are logged into the internal application, their reputation score is based on their participation in all zones to which they belong.

Ideas comes with the following pre-defined reputation levels that apply to all zones and to the internal application. Using the API, reputation levels and points can be added or edited to reflect the levels of participation in your community.

<table>
<thead>
<tr>
<th>Name</th>
<th>Points per Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Observer</td>
<td>0 – 99</td>
</tr>
<tr>
<td>Contributor</td>
<td>100 – 399</td>
</tr>
<tr>
<td>Influencer</td>
<td>400 – 1499</td>
</tr>
<tr>
<td>Thought Leader</td>
<td>1500+</td>
</tr>
</tbody>
</table>

Reputation levels are available through the API and can be displayed in custom Ideas implementations. To add or edit reputation level names, points per level, or other attributes of a reputation in any of your zones, use the IdeaReputation and IdeaReputationLevel objects in the API. You can create up to 25 different reputation levels for each zone.

Note: Reputation for Ideas is available using the API starting with Summer '13. Once the feature is enabled in Setup, Salesforce tracks reputation from that point. To calculate historical user activity data created before Summer '13 so that it can count toward reputations, contact Salesforce.com.
Organize Ideas with Zones

Available in: Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or edit a zone:</td>
</tr>
</tbody>
</table>

**Note:** Starting with the Summer ’13 release, Ideas “communities” have been renamed to “zones.”

Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and questions. Use zones to organize your community into smaller groups, by creating zones within the community that reflect special interests, product groupings, or types of customers. Zones are shared by the Ideas, Answers, and Chatter Answers applications, allowing you to view and create zones from those locations.

Users see zones and content are associated with the context defined by their user profile. You can display a zone to the following types of users:

- Internal users with permission to see Ideas can see all zones in the default Chatter community. If internal users sign in to a Chatter community, they see only those zones associated with that community.
- Chatter community users see the zones associated with the community they’re signed in to.
- Portal users can see the zones associated with their portal.
- Portal users with access to both a portal and a Chatter community can see the zones associated with the portal or community that they are currently signed in to.
- Users who are accessing the portal or community through an API can access all zones that they have access to in all contexts.
- Global searches in the internal application performed by internal users return results from all ideas that are available within the organization. Searches performed by all other users in Salesforce Communities return results from the ideas that are available within the community.

API Access to Photos for Ideas and Comments

Using the API, developers now can access an Ideas user’s first name, profile photo, and thumbnail photo, enabling them to create a customized view of Ideas and Idea Comments.

In Spring ’13, the following fields have been added to the Ideas and IdeaComment objects.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreatorFullName</td>
<td>URL of the user’s profile photo.</td>
</tr>
<tr>
<td>CreatorName</td>
<td>Name of the user who posted the idea or commented on the idea.</td>
</tr>
</tbody>
</table>
New Navigation to Create Validation Rules for Idea Comments

The option to create validation rules for comments posted to an idea has been moved. Previously, the option to create validation rules for comments was found under the Ideas node. Starting with Spring ’13, from Setup, click Customize > Ideas > Idea Comments > Validation Rules to create validation rules for comments.

Upload Photos to ChatterProfile with a Visualforce Component

Summer ’13 introduces a new Visualforce component, chatter:userPhotoUpload that lets users upload a photo to their Chatter profile page. Using this Visualforce component, you can create a custom page that lets users in your Ideas community upload a profile picture in either a cropped format or as a full image.

To use this component, you must enable Chatter in the organization. Users must belong to either Standard User, Portal User, High Volume Portal User, or Chatter External User profiles.

Setting Page Layouts for Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

To set the layout of a Ideas custom field: “Customize Application”

When you create a custom field for Ideas, you can add it to the Additional Information section that appears on the Post Idea and Idea Detail pages.

You can specify the order in which a custom field appears in the Additional Information section as well as remove a custom field from these pages without permanently deleting the field from the system. Although it’s possible to move standard fields onto the page layout, by default they already appear in the Idea Detail section at the top of the page and their order is not customizable. However, you can drag the Status field to the Additional Information section to have the status of an idea appear in the page layout.

Note: The label for the Additional Information section can’t be edited.

To set the page layout of a custom Ideas field:
1. From Setup, click **Customize > Ideas > Page Layouts**.
2. Click **Edit**.
3. Select a custom field from the box on the right and drag it to the Additional Information section. Custom fields appear in the order they are placed in the Additional Information section.
4. To display an idea's status to zone members, select the **Status** field and drag it to the Additional Information section.
5. To let users add files to ideas, select the **Attachments** field and drag it to the Additional Information section. Make sure you've set field-level security for your users.
6. Click **Save**.

**Add Apex Triggers to Idea Comments**

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To define Apex triggers:</td>
</tr>
<tr>
<td>To manage Ideas communities:</td>
</tr>
</tbody>
</table>

A trigger is a set of Apex code that fires at a particular time in the lifecycle of a record. You can add Apex triggers to comments in Ideas to better manage ideas in your community.

With Summer ’13, you can use triggers on idea comments to perform actions such as:

- Send an email notification to the moderator or other user when a comment is left on an idea.
- Send an email notification to the user with the contents of their comment.
- Notify the moderator when a specified number of comments is reached for an idea.
- Prevent posting of comments with specific words.

**View the Number of Ideas Submitted to an Idea Theme**

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions

Now you can view the number of ideas that users have submitted to an idea theme. The **Submitted Ideas** field shows the number of ideas that have been posted to an idea theme.
Note: Merged ideas don’t appear in the list of submitted ideas on the Idea Themes detail page and aren’t counted in the Submitted Ideas field.

Add File Attachments to Ideas

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

To enable attachments for ideas: “Customize Application”

Give your users the power to post detailed ideas by attaching files. With Summer ’13, administrators can set field-level security and then add the Attachment field to the page layout for the Post Idea and Idea Detail pages.

Users can attach all supported file types, including Microsoft® PowerPoint® presentations and Excel® spreadsheets, Adobe® PDF files, image files, audio files, and videos. The maximum attachment size is determined by your organization.

We’ve also created a new Apex method, URL.getFileFieldURL that lets you retrieve the download URL for file attachments in custom implementations of Ideas.

Community Nickname Field Renamed to Nickname

In Summer ’13, the Community Nickname field on a user’s detail page is renamed to Nickname. A nickname is the name used to identify a user in a community.
Salesforce Knowledge

Knowledge One—Beta

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

A redesign of the Salesforce Knowledge Article tab is available in beta. The new tab displays all your Salesforce Knowledge articles and any of your external data sources, such as Microsoft® SharePoint®. This new Knowledge tab merges functionality of the old Articles tab and the Article Management tab and uses federated search to search all your resources at once. To enable the new tab for your users, add the Knowledge Tab permission to their profiles or permission sets.

To add the Knowledge Tab permission to a profile:

1. From Setup, click Administration Setup > Manage Users > Profiles
2. Click the profile you want to add the Knowledge Tab permission to.
3. Click Edit.
4. Under General User Permissions, check Knowledge Tab.
5. Click Save.

To add the Knowledge Tab permission to a permission set:

1. From Setup, click Administration Setup > Manage Users > Permission Sets
2. Click the permission set you want to add the Knowledge Tab permission to.
3. In the settings search bar, enter Knowledge.
4. Select Knowledge Tab from the list of suggestions.
5. Under Knowledge Management, check the Enabled check box for Knowledge Tab.
6. Click Save.

Once the new Knowledge tab is available for your users, you’ll need to define your external data sources. Your external data sources appear under your articles both in the search results and the left-side panel.

Note: External data sources are also available in beta. Log a salesforce.com support ticket to enable your external objects.

On the new Knowledge tab, you can:

1. Search for published information in Salesforce Knowledge and your external data sources on page 114.
2. Depending on the source you are searching, filter by language, data category, article status, article type, and article validation. Click Reset to return all filters to their default setting.
   • When All is selected, you can filter by language and data category, depending on what your organization supports.
   • When Articles is selected you can filter by:
     ◊ Article status: Online (published articles), Draft (non-published articles), and Draft Translations (non-published translations)
     ◊ Article type: Values depend on those created in your organization
Data category: Values depend on those created in your organization
Language: Values depend on those supported in your organization
Article Validation: No Filter (all articles), Not Validated (articles that are not validated), Validated (validated articles)

• When an external source is selected, there are no filters and the general article information displayed is controlled by your external object search layout.

3. View published information by clicking on the article or external source title. Below the title you can find general article information such as: new article indication, article number, article type, validation status, last published date, article view comparison, and article rating comparison.

4. Sort by:
• Published Date
• Best Rating
• Most Viewed
• Title: A to Z
• Title: Z to A

5. Create a new article. Select the article type from the drop down list.

---

Searching on the New Knowledge Tab

To find an article or external resource, enter your keywords in the search bar at the top of the page.

1. Enter your search terms in the Search box. You can use search wildcards and operators in your search terms.
2. Click the search icon or press Enter on your keyboard.
3. Optionally, select filters to refine your search results.
Smart Article Links

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Previously, links in Salesforce Knowledge articles to other Salesforce Knowledge articles were hard coded, causing broken links when the linked article’s URL_Name was changed.

With Summer ’13, links to Salesforce Knowledge articles are easy to create in a rich text field. It will also automatically create the right url based on channel, add site prefix for PKB and correct community name for community portal.

To create a smart link to another article in a rich text field:

1. Highlight the content where you’d like to place the link.
2. Select Protocol <other>.
3. Enter the article URL as: /articles/[language]/[articleType]/[URLName].

For example, an English article in a multiple language knowledge base, of article type FAQ, with a URL Name of About-Passwords the article URL is /articles/en_US/FAQ/About-Passwords. Add language only if your Salesforce Knowledge base supports multiple languages.

Important: Smart links are based on the channels they are in. Therefore, you can’t add a URL to an article in another channel.

When the URL Name of the linked article is changed, Salesforce Knowledge automatically updates the article’s URL based on the channel, adds the site prefix for a public knowledge base, and adds the community name for the community portal.

Note:

- You can have up to 100 links to different Salesforce Knowledge articles in one rich text field.
- When you convert a rich text area field to a long text area field, links are displayed as link reference numbers, not URLs.

Set Article Fields as Required

In Summer ’13, you can set a Date, Date/Time, Text, Text Area, and Text Area (Long) field as required so a user must enter a value when creating an article. When editing or creating an Article Type field, simply select Always require a value in this field in order to save a record.

Links to Draft Articles

Previously, when an article was in draft status, its link (/articles/[type]/[uriname]) returned a “Data Not Found” error. Now, links to draft articles are supported for internal users with the Manage Articles permission. This means articles bookmarked while published retain their link when unpublished and in draft status. Also, article writers can create links in rich text fields from one draft article to another.
New UPDATE Clauses to Report on Article Searches and Views

There are new UPDATE clauses in SOQL and SOSL to report on Salesforce Knowledge article searches and views.

In SOQL, the UPDATE VIEWSTAT clause allows developers to use the API to update an article's view statistics. You can use this syntax to increase the view count for every article you have access to online:

```
SELECT Title FROM FAQ__kav
WHERE PublishStatus='online' and
Language = 'en_US' and
KnowledgeArticleVersion = 'ka230000000PCiy'
UPDATE VIEWSTAT
```

In SOSL, both UPDATE TRACKING and UPDATE VIEWSTAT were added.

- The UPDATE TRACKING clause allows developers to use the API to track the keywords used in the Salesforce Knowledge article search.

  You can use this syntax to track a keyword used in Salesforce Knowledge article search:

  ```
  FIND {Keyword}
  RETURNING KnowledgeArticleVersion (Title WHERE PublishStatus="Online" and language="en_US")
  UPDATE TRACKING
  ```

- The UPDATE VIEWSTAT clause allows developers to use the API to update an article's view statistics.

  You can use this syntax to increase the view count for every article you have access to online in US English:

  ```
  FIND {Title}
  RETURNING FAQ__kav (Title WHERE PublishStatus="Online" and language="en_US" and
  KnowledgeArticleVersion = 'ka230000000PCiy')
  UPDATE VIEWSTAT
  ```

Metadata API Access to Salesforce Knowledge Languages

In Summer ’13, developers have access through the Metadata API to the list of languages (KnowledgeLanguageSettings) enabled for their Salesforce Knowledge base and their settings (KnowledgeLanguage). The languages field is available on the knowledgesettings object and provides a list of languages enabled for Salesforce Knowledge.

KnowledgeLanguageSettings contains the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>language</td>
<td>KnowledgeLanguage</td>
<td>Represents the metadata used to manage settings for the languages enabled for Salesforce Knowledge.</td>
</tr>
</tbody>
</table>

Each KnowledgeLanguage field type contains the following fields.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>active</td>
<td>boolean</td>
<td>Indicates whether the language is enabled (true) or not (false).</td>
</tr>
<tr>
<td>defaultAssignee</td>
<td>string</td>
<td>The default assignee for articles in the language.</td>
</tr>
<tr>
<td>defaultAssigneeType</td>
<td>KnowledgeLanguageLookupValueTypeDef (enumeration of type string)</td>
<td>Indicates the default assignee type. Valid values are:</td>
</tr>
<tr>
<td>defaultReviewer</td>
<td>string</td>
<td>The default reviewer for articles in the language.</td>
</tr>
<tr>
<td>defaultReviewerType</td>
<td>KnowledgeLanguageLookupValueTypeDef (enumeration of type string)</td>
<td>Indicates the default reviewer type. Valid values are:</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>The code for the language name, for example: English is en. See “What languages does Salesforce support?” in the Salesforce online help for a list of supported languages and their codes.</td>
</tr>
</tbody>
</table>

**Public Knowledge Base for Mobile Devices**

Salesforce.com updated the Public Knowledge Base package on the AppExchange including a site map feature for search engine optimization and a mobile deployment option. Now you can provide your knowledge articles to users or customers anytime, anywhere using your organization’s existing knowledge base.

Before installing and configuring Public Knowledge Base, make sure:

- Salesforce Knowledge is set up in your organization. Refer to the Salesforce Knowledge Implementation Guide for detailed information.
- The Translation Workbench is set up in your organization. See “Setting Up the Translation Workbench” in the Salesforce Help.

To install the Public Knowledge Base package, go to [https://login.salesforce.com/packaging/installPackage.apexp?p0=04tE00000008qar](https://login.salesforce.com/packaging/installPackage.apexp?p0=04tE00000008qar) on the AppExchange and click Get It Now. Follow the instructions in the installation guide provided on the AppExchange detail page.
New Live Agent Sessions Page

Live Agent is available in: Developer Edition organizations created after June 14, 2012
Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

In Summer ’13, we added a Live Agent sessions page to make it easy for your users to find information about support agents’ activities while they’re online.

From the Live Agent Sessions tab, users can:

- See a list of recently viewed session records.
- Create a list of information about chat sessions—for example, the names of the agents involved in the session, agents’ login times, and agents’ logout times.
- Change information in a session record by clicking Edit next to a record in a list.

  Note: You can edit custom fields on a Live Agent session record, but you can’t edit standard fields.

Administrators can customize Live Agent sessions according to your business needs. From Setup, click Customize > Live Agent > Live Agent Sessions. From here, you can:

- Customize the fields that appear on a session page.
- Create validation rules for the fields that appear on a session page to prevent users from saving incorrect data in those records.
- Define triggers to prompt actions for session records, such as updating another record automatically once a new session record is stored.
- Create record types for different session records.
- Edit page layouts for session records.
- Customize buttons and links for sessions.
- See a list of limits that apply to sessions in your organization.
Live Agent Sessions Reporting

Live Agent is available in: **Developer** Edition organizations created after June 14, 2012
Live Agent is available for an additional cost in: **Enterprise** and **Unlimited** Editions

In Summer '13, we’ve made it possible to run reports on Live Agent chat sessions to view data about your agents’ activity while they support customers. You can now create a custom report type for Live Agent sessions and build the reports using the Report Builder. These reports include data for all of the chats that occurred during a specific Live Agent session.

You can customize Live Agent session reports to include any of the following fields:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent: Full Name</td>
<td>Name of the agent associated with the session.</td>
</tr>
<tr>
<td>Chat Requests Assigned</td>
<td>Number of chat requests assigned to an agent.</td>
</tr>
<tr>
<td>Chat Requests Declined (Manually)</td>
<td>Number of chat requests declined manually by an agent.</td>
</tr>
<tr>
<td>Chat Requests Declined (Push Timeout)</td>
<td>Number of chat requests that timed out while assigned to an agent.</td>
</tr>
<tr>
<td>Chat Requests Engaged</td>
<td>Number of chats in which an agent was engaged during the session.</td>
</tr>
<tr>
<td>Created By: Full Name</td>
<td>Full name of the creator of the session record.</td>
</tr>
<tr>
<td>Created Date</td>
<td>Date the session record was created.</td>
</tr>
<tr>
<td>Last Modified By: Full Name</td>
<td>Full name of the person who last modified the session record.</td>
</tr>
<tr>
<td>Last Modified Date</td>
<td>Date the session record was last modified.</td>
</tr>
<tr>
<td>Live Agent Session ID</td>
<td>ID of the Live Agent session record.</td>
</tr>
<tr>
<td>Live Agent Session Name</td>
<td>Automatically generated ID of the Live Agent session.</td>
</tr>
<tr>
<td>Login Time</td>
<td>Time and date the agent logged in to the session.</td>
</tr>
<tr>
<td>Logout Time</td>
<td>Time and date the agent logged out of the session.</td>
</tr>
<tr>
<td>Time Idle</td>
<td>Total amount of time in seconds an agent was idle during a session.</td>
</tr>
<tr>
<td>Time Spent at Capacity</td>
<td>Total amount of time in seconds in which an agent’s queue was full.</td>
</tr>
<tr>
<td>Time Spent Away</td>
<td>Total amount of time in seconds an agent spent in “Away” status.</td>
</tr>
<tr>
<td>Time Spent in Chats</td>
<td>Total amount of time in seconds an agent spent engaged in chats.</td>
</tr>
<tr>
<td>Time Spent Online</td>
<td>Total amount of time in seconds an agent spent online.</td>
</tr>
</tbody>
</table>

For more information about creating Live Agent session reports, see “Reporting on Live Agent Sessions” in the Salesforce Help.
New Live Chat Transcript Events Options

Live Agent is available in: **Developer** Edition organizations created after June 14, 2012
Live Agent is available for an additional cost in: **Enterprise** and **Unlimited** Editions

In Summer '13, we expanded the list of options available for Live Chat Transcript Events on the Live Chat Transcript Detail page. These events allow you to track the activities that take place between agents and customers during a chat.

Previously, Live Agent only tracked transfers that occurred during a chat. With this release, you can track and edit the following Live Chat Transcript Events:

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Requested</td>
<td>Visitor requested a chat.</td>
</tr>
<tr>
<td>Queued</td>
<td>Chat request was placed in queue.</td>
</tr>
<tr>
<td>Routed (Push)</td>
<td>Chat request was routed to agent.</td>
</tr>
<tr>
<td>Routed (Choice)</td>
<td>Chat request was routed to all available, qualified agents.</td>
</tr>
<tr>
<td>Accepted</td>
<td>Chat request was accepted by agent.</td>
</tr>
<tr>
<td>Transfer Requested</td>
<td>Agent requested chat transfer.</td>
</tr>
<tr>
<td>Transfer Accepted</td>
<td>Chat transfer was accepted by agent.</td>
</tr>
<tr>
<td>Declined (Manual)</td>
<td>Chat request was declined by agent.</td>
</tr>
<tr>
<td>Declined (Timeout)</td>
<td>Chat request timed out while assigned to agent.</td>
</tr>
<tr>
<td>Canceled (No Agent)</td>
<td>Chat request was canceled because no qualified agents were available.</td>
</tr>
<tr>
<td>Canceled (No Queue)</td>
<td>Chat request was canceled because there was no room in queue.</td>
</tr>
<tr>
<td>Agent Left</td>
<td>Agent left chat.</td>
</tr>
<tr>
<td>Visitor Left</td>
<td>Visitor left chat.</td>
</tr>
<tr>
<td>Ended by Agent</td>
<td>Agent clicked <strong>End Chat</strong>.</td>
</tr>
<tr>
<td>Ended by Visitor</td>
<td>Visitor clicked <strong>End Chat</strong>.</td>
</tr>
<tr>
<td>Other</td>
<td>Another event occurred.</td>
</tr>
</tbody>
</table>
Live Agent Supervisor Page

Live Agent is available in: **Developer** Edition organizations created after June 14, 2012
Live Agent is available for an additional cost in: **Enterprise** and **Unlimited** Editions

In Summer ’13, we added several enhancements to the Live Agent Supervisor page. These additions make it easier for supervisors to monitor their agents’ activity as they chat with customers.

**View Chats Assigned but Not Yet Answered**
Supervisors can now see the number of chats that have been assigned to agents, but not yet answered by those agents. We’ve added two columns to the Agent Status panel on the Live Agent Supervisor page:

- **No. Chats In Progress**—The number of chats in which an agent is actively engaged.
- **No. Requests Assigned**—The number of chats assigned to an agent that the agent has not yet accepted.

These columns help supervisors monitor the number of chats associated with their agents in real time.

**View Ongoing Chat Transcripts**
A window now appears on the right side of the Agent Status panel on the Live Agent Supervisor page that allows supervisors to watch their agents’ chats with customers in real time.

**Send Whisper Messages (Whisper Coaching)**
Supervisors can now send “whisper messages” to agents while agents chat with customers. A supervisor watching an agent’s chat in the Agent Status panel can send chat messages to the agent within that chat window. Customers can’t see these messages, so supervisors can privately chat with their agents as agents interact with customers. These whisper messages appear in the agent’s chat transcript but not in the chat transcript available to the customer.

Multiline Text Input Available in Live Agent Chat Window

Live Agent is available in: **Developer** Edition organizations created after June 14, 2012
Live Agent is available for an additional cost in: **Enterprise** and **Unlimited** Editions

In Summer ’13, we made it possible for an agent to type up to five lines of text in the text input area of a Live Agent chat window in the Service Cloud Console. Previously, the text in the text input area wouldn’t wrap, causing the text to appear in a single line. You can add a line break in your text by pressing **SHIFT + ENTER** as you type.
On-Demand Email-to-Case: Change to Thread ID Handling

On-Demand Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

In Summer '13, we’re changing the way On-Demand Email-to-Case determines which case to associate incoming email messages with. On-Demand Email-to-Case uses a randomly generated string of characters to create a thread ID for incoming messages, and extracts a case ID from this string. Thread IDs use the following format: `[ref:_00Dxx5JSR2._500xxpqwP:ref ]`. Previously, On-Demand Email-to-Case looked for the last occurrence of `ref:` and `:ref` in the thread ID to determine the start and end of the case ID. However, in rare instances, the randomly generated case ID includes `ref` as its last three characters, as in this example: `[ ref:_00D708Np7._50070NYref:ref ]`. In these instances, On-Demand Email-to-Case misread the case IDs and didn’t associate the email messages with the correct cases.

On-Demand Email-to-Case now extracts the case ID from a thread ID by looking for the last occurrence of `[ ref: and :ref ]` (with open and close brackets, respectively). This means that even case IDs whose last three characters are `ref` are identified correctly.

Open CTI (Computer-Telephony Integration)

Open CTI: New Methods

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Open CTI is an API that provides advanced administrators and developers with programmatic access to Salesforce so that they can build computer-telephony integration (CTI) systems. Open CTI lets developers:

• Build CTI systems that integrate with Salesforce without the use of CTI adapters.
• Create customizable SoftPhones (call-control tools) that function as fully integrated parts of Salesforce and the Service Cloud console.
• Provide users with CTI systems that are browser and platform agnostic, for example, CTI for Microsoft® Internet Explorer®, Mozilla® Firefox®, Apple® Safari®, or Google Chrome™ on Mac, Linux, or Windows machines.

For information (English only) on customizing and building CTI systems with Open CTI, see the Open CTI Developer’s Guide.

With Summer ’13, the following new methods are available.
### Method Description

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>refreshPage()</td>
<td>Returns <code>true</code> if page refresh is invoked, <code>false</code> otherwise. When this method is called within the Service Cloud console, it refreshes the current active tab.</td>
</tr>
<tr>
<td>refreshRelatedList()</td>
<td>Returns <code>true</code> if the related list with the given <code>listName</code> is refreshed, <code>false</code> otherwise. When this method is called within the Service Cloud console, only the related list with the given list name in the currently focused view will be refreshed.</td>
</tr>
<tr>
<td>searchAndGetScreenPopURL()</td>
<td>Searches objects specified in the SoftPhone layout for a given string. Returns search results and the relative URL to be screen popped. Note that this method does not perform an actual screen pop. This method respects screen pop settings defined in the SoftPhone layout. For more information, see “Designing a Custom SoftPhone Layout” in the Salesforce online help.</td>
</tr>
</tbody>
</table>

In addition, the following method has been updated.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>screenPop()</td>
<td>A new <code>force</code> argument of type boolean has been added. When this argument is set to <code>true</code>, it forces a screen pop.</td>
</tr>
</tbody>
</table>

## SERVICE CLOUD CONSOLE

### Updated User Interface

A Service Cloud console is an app that’s designed for agents in fast-paced environments who need to find, update, and create records quickly. With Summer ’13, we made minor updates to the fonts, spacing, and color scheme of the console to provide more prominent push notifications and to increase screen real estate:
1. Fonts
2. Spacing
3. Color Scheme

Note that administrators and developers can customize a console, so any customizations you have in your console might not match the examples above. If your organization customized a console, consider updating your customizations to match the console’s upgraded user interface. For more information, see “Setting Up a Service Cloud Console” in the Salesforce Help.

### New Keyboard Shortcuts

Available in: **Enterprise**, **Unlimited**, and **Developer** Editions with the Service Cloud

Keyboard shortcuts let you perform actions by pressing a combination of keys instead of having to use a mouse. Keyboard shortcuts can make working with a Service Cloud console more efficient. For example, instead of typing case details and then using a mouse to click Save, an administrator can create a keyboard shortcut so that you can type case details and press CTRL+S to save cases without switching from your keyboard to your mouse.

With Summer '13, the following new keyboard shortcuts are available:

<table>
<thead>
<tr>
<th>Action (Keyboard Shortcut)</th>
<th>Description</th>
<th>Key Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh tab</td>
<td>Refreshes a selected tab.</td>
<td>SHIFT+R</td>
</tr>
<tr>
<td>Get link to share</td>
<td>Opens the Link to Share dialog box on the selected tab.</td>
<td>U</td>
</tr>
</tbody>
</table>
To see a complete list of keyboard shortcuts, see “Customizing Keyboard Shortcuts for a Service Cloud Console” in the Salesforce Help.

**Refresh Specific Tabs**

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

All items in a Service Cloud console display as tabs. Tabs let you see all the information you need on one screen without losing context. Before Summer '13, users could refresh all of a console's primary tabs or subtabs to view recent updates. Now, users have the additional option to refresh specific tabs.

To refresh a specific tab, click and select next to the tab's name. Note that if a tab has any unsaved changes, it won't refresh.

For more information, see “Working with Tabs in a Service Cloud Console” in the Salesforce Help.

**Service Cloud Console Integration Toolkit: New Methods**

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

The Service Cloud Console Integration Toolkit is an API that uses browsers to display pages as tabs in the console. It provides advanced administrators and developers programmatic access to the console so they can extend it to meet your business needs. For example, developers can use the toolkit to open and close tabs in the console to streamline a business process.

With Summer '13, the following new methods are available.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>addToBrowserTitleQueue()</td>
<td>Adds a browser tab title to a list of titles, which rotates every three seconds. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>generateConsoleUrl()</td>
<td>Generates a URL to a tab, or group of related tabs, in the Service Cloud console. If any tabs include external URLs, then add the external URLs to the console's whitelist so that they can display correctly. For more information, see “Whitelisting Domains for a Service Cloud Console” in the Salesforce online help. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>getTabLink()</td>
<td>Retrieves the URL to a tab, or group of related tabs, from the Service Cloud console. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>openConsoleUrl()</td>
<td>Opens a URL created by the generateConsoleUrl() method (a URL to a tab, or group of related tabs, in the console). This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>Method</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>onTabSave()</td>
<td>Registers and calls a callback method when a user clicks <strong>Save</strong> in a subtab’s Unsaved Changes dialog box. When using this method, you must call <code>setTabUnsavedChanges()</code> in the callback method. This notifies the console that the custom save operation completed. In the call to <code>setTabUnsavedChanges()</code>, pass the first parameter as <code>false</code> to indicate a successful save or <code>true</code> to indicate an unsuccessful save. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>removeFromBrowserTitleQueue()</td>
<td>Removes a browser tab title from the list of titles, which rotates every three seconds. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>setTabIcon()</td>
<td>Sets an icon on the specified tab. If a tab is not specified, the icon is set on the enclosing tab. Use this method to customize a tab’s icon. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>setTabLink()</td>
<td>Sets a console tab’s URL attribute to the location of the tab’s content. Use this method to generate secure console URLs when users navigate to tabs displaying content outside of the Salesforce domain. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>setTabStyle()</td>
<td>Sets a cascading style sheet (CSS) on the specified tab. If a tab is not specified, the CSS is set on the enclosing tab. Use this method to customize a tab’s look and feel. This method is only available in API version 28.0 or later.</td>
</tr>
<tr>
<td>setTabTextStyle()</td>
<td>Sets a cascading style sheet (CSS) on a specified tab’s text. If a tab is not specified, the CSS is set on the enclosing tab’s text. Use this method to customize a tab’s text style. This method is only available in API version 28.0 or later.</td>
</tr>
</tbody>
</table>

For more information (English only) about the toolkit, see the *Service Cloud Console Integration Toolkit Developer’s Guide*.

### Turn On Highlights Panels and Interaction Logs

**Available in:** **Enterprise, Unlimited**, and **Developer** Editions with the Service Cloud

Highlights panels let users view key information at a glance in the Service Cloud console; interaction logs let console users write notes on records that appear on primary tabs. Before Summer ’13, both highlights panels and interaction logs were
automatically turned on. Now, after administrators set up a highlights panel or an interaction log for the first time, they must turn them on for users.

**Turning On Highlights Panels**

<table>
<thead>
<tr>
<th>Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To customize page layouts: “Customize Application”</td>
</tr>
<tr>
<td>To view page layouts: “View Setup”</td>
</tr>
</tbody>
</table>

The highlights panel is a table of up to four columns at the top of every primary tab in a Service Cloud console. It lets console users view key information at a glance. Each of its columns has one or two fields that you can customize to suit your business needs. To display highlights panels, you must turn them on.

1. Edit any page layout and click **Layout Properties**.
2. Check **Highlights Panel**, and click **OK**.
3. Click **Save**.

**Turning On Interaction Logs**

<table>
<thead>
<tr>
<th>Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To turn on interaction logs: “Customize Application”</td>
</tr>
</tbody>
</table>

An interaction log lets Service Cloud console users write notes on records that appear on primary tabs. For example, when cases appear on primary tabs, an interaction log can appear so that users can take notes on cases. To display interaction logs, you must turn them on for page layouts assigned to different user profiles.

1. Edit any page layout and click **Layout Properties**.
2. Check **Interaction Log** and click **OK**.
3. Click **Save**.

**Note:** If you turn interaction logs on or off, you must close and reopen records to see the changes.
Tasks Available for Push Notifications

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To customize push notifications: “Customize Application”</td>
</tr>
</tbody>
</table>

Push notifications are visual indicators on lists and detail pages in a Service Cloud console that show when a record or field has changed during a user’s session. For example, if two support agents are working on the same case and one agent changes the Priority, a push notification displays to the other agent so he or she notices the change and doesn’t duplicate the effort.

With Summer ’13, administrators can choose when push notifications display for the Task object and task fields.

The following objects and their fields are available for push notifications:

- Custom objects
- Cases
- Accounts
- Contacts
- Leads
- Campaigns
- Opportunities
- Tasks

To customize push notifications for a Service Cloud console:

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. In Choose How Lists Refresh, select when push notifications occur:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Lists don’t refresh. Push notifications don’t occur.</td>
</tr>
<tr>
<td>Refresh List</td>
<td>The entire list refreshes when there are any changes to it. Records are added to or removed from the list based on the list’s criteria.</td>
</tr>
<tr>
<td>Refresh List Rows</td>
<td>Rows in the list refresh when there are any changes to fields specified for push notifications.</td>
</tr>
</tbody>
</table>

5. In Choose How Detail Pages Refresh, select when push notifications occur:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Refresh</td>
<td>Detail pages don’t refresh. Push notifications don’t occur.</td>
</tr>
</tbody>
</table>
The detail page automatically refreshes when a record is changed.

<table>
<thead>
<tr>
<th>Description</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>The detail page automatically refreshes when a record is changed.</td>
<td>Automatically Refresh</td>
</tr>
<tr>
<td>A message appears on the detail page when a record is changed.</td>
<td>Flag</td>
</tr>
</tbody>
</table>

6. Click **Select objects and fields for notifications**.
7. Click **Edit**.
8. Select the objects you want to trigger push notifications. For example, if you want changes to cases and case fields to trigger push notifications, move Cases from Available Items to Selected Items.
9. Under Fields, click **Edit** to select the object fields you want to trigger push notifications.
10. Click **OK**.
11. Click **Save**.

For more information, see “Setting Up a Service Cloud Console” in the Salesforce online help.

**SOCIAL CUSTOMER SERVICE**

**Social Persona and Social Post Objects—Pilot**

Social personas and posts are available in: **Enterprise**, **Unlimited**, and **Professional** Editions.

With Radian6 for Salesforce.com from the AppExchange, you can listen to social media and manage cases from Twitter.

**Note:** Using Social Personas and Social Posts objects for social customer service is currently available through a pilot program. For information, contact salesforce.com.

**Social Personas Object**

The Social Personas tab or object is a collection of publicly available information about a person or company from Twitter. A persona is relative to the social network and there can be multiple personas attached to a single contact. You can edit or delete a persona but you can’t manually create a social persona from Salesforce. The personas are created from public information on social networking sites. To view and manage your social personas:

1. Click the **Social Personas** tab.
2. Optionally, select a view. The list defaults to those recently viewed. Select All to show all social personas in your organization. You can also create a new view to fit your needs.
3. Click on the social handle you’d like to manage. If you selected a view you can click **Edit** or **Del** (delete) as appropriate.

On the social persona detail page you can:

- View and edit the persons of company’s available information for that social network.
**Note:** The information varies depending on the social network the persona is from.

- Delete the social persona from your organization.
- Create, edit, and delete social posts.

**Social Posts Object**

The Social Posts tab or object is a collection of information about a post from a person or company on a social network, such as Twitter. The available information for a post varies depending on the social network. To view and manage social posts:

1. Click the **Social Posts** tab.
2. Optionally, select a view. The list defaults to those recently viewed. Select All to show all social posts in your organization. You can also create a new view to fit your needs.
3. Click on the social post name you’d like to manage or click **New Social Post** to create a post. If you selected a view you can click **Edit** or **Del** (delete) as appropriate.

**Note:** On the Social Post tab, you can only create, edit, and delete posts in your Salesforce organization, not on the social networks.

On the social post detail page you can:

- View, edit, and create the post’s content and information.

  **Note:** The information varies depending on the social network the persona is from.

  Don’t forget to click **Save** to save changes or create a new post.
- Delete the post from your organization.
Fine-Grained Sharing for Report and Dashboard Folders

Users and administrators get more detailed control over access to folders that contain reports or dashboards.

Available in: **Enterprise, Unlimited, and Developer Editions**

💡 You asked for it! This enhancement addresses these ideas on the IdeaExchange:

- **Stricter Permissions on Report Folders**
- **Reports and Dashboard Folders to USERS Too**

Reports and dashboards are shared through folders. You share the folder, not the report or dashboard itself. To let others work with your report or dashboard, give them Viewer, Editor or Manager access to the folder where the report or dashboard is stored.

**Viewer**

With Viewer access you can see the data in a report or dashboard, but you can’t make any changes, except by cloning it into a new report or dashboard. All users have at least Viewer access to report and dashboard folders that have been shared with them. (Some users may have administrative user permissions that give them greater access.)

**Editor**

When you are an Editor on a folder, you can view and modify the reports and dashboards it contains, and move them to and from any other folders you have Editor or Manager access to.

**Manager**

With Manager access, you can do everything Viewers and Editors can do, plus control other users' access to it, change its properties, or delete it.

Why Switch to the New Way of Sharing Reports and Dashboards?

You could already share reports and dashboards, but now you can do it better. The enhanced analytics folder sharing model lets your users define more precisely who can see or edit which reports or dashboards, while minimizing the maintenance burden of keeping those access levels up to date.

Here are a few things you can do when you turn on enhanced analytics folder sharing.

- Give everyone in a group read-only access to the reports in one folder and read-write access to the reports in another folder.
  For example, say your team’s bonuses are calculated according to a leader-board report that you run quarterly. Put that...
report in a folder called “Sales Leaders” and give the “All Sales” group Viewer access. Meanwhile, give the “All Sales” group Editor access to a folder called “Team Milestones,” where each member of the group can create reports and edit the reports they have created themselves.

- Share a folder with an individual user. For example, create a dashboard folder for each territory, with Editor access for the account exec in charge of that territory and Manager access for the sales manager.
- Share a folder with a portal user. For example, for a high-priority support customer, create a folder named for their account. Give Viewer access to the customer’s representative and Editor access to the support agent responsible for that customer.

And here are a few things you may have wished users couldn’t do. The new sharing model makes them impossible.

- Edit a report that you officially can’t see, because you know the URL and have the Manage Public Reports permission. (The Manage Public Reports permission no longer gives a user the right to edit any folder anywhere.)
- Change the name or sharing rules for a reports folder that you officially can’t see, because you know the URL and have the Manage Public Reports permission.
- Lose the ability to edit a report, even if you created it, because you saved it in a folder you can’t edit.

### Turn On Enhanced Sharing for Reports and Dashboards

When you enable analytics sharing, Salesforce converts your users’ existing folder access levels to use new, more detailed access levels.

**Available in:** All editions except Database.com

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view the analytics folder sharing setting:</td>
</tr>
<tr>
<td>To modify the analytics folder sharing setting:</td>
</tr>
</tbody>
</table>

When analytics sharing is in effect, all users in the organization get Viewer access by default to report and dashboard folders that are shared with them. Users may have more access if they are Managers or Editors on a given folder, or if they have more administrative user permissions. Each user’s access to folders under the new capability is based on the combination of folder access and user permissions they had before enhanced folder sharing was enabled.

1. From Setup, click **Reports & Dashboards > Folder Sharing**.
2. Select **Enable Analytics Sharing**.
3. Click **Report and Dashboard Folder Sharing**.

**Important:** If you go back to the old folder sharing model, pre-existing report and dashboard folders go back to the state they were in before.

- If a folder existed before analytics folder sharing was enabled, its properties and sharing settings are rolled back to their previous state.
- If a folder was created while enhanced analytics folder sharing was in effect, it is hidden from the folder list and all its sharing settings are removed. Administrative user permissions are still in effect.
Prepare for Enhanced Analytics Folder Sharing

Before you switch to the new, more detailed sharing model for reports and dashboards, make sure your users know what to expect. You can help them make the transition by designing your new access levels to match existing user patterns as closely as possible.

When you switch to enhanced analytics folder sharing, pay attention to two kinds of changes.

- The folders in which users keep reports and dashboards are subject to newly detailed constraints on sharing.
- User permissions change to better support the new access levels.

Each of these will affect how users experience the switch to the new sharing model.

Some users may be used to being able to do things you didn’t explicitly allow them to do. Those users may experience this change as a loss of permissions. For example, under the old folder sharing model, any user with Manage Public Reports permission could edit any other user’s reports or dashboards. Some users may have come to rely on that ability over time, even if it wasn’t explicitly intended.

Plan For the Transition

To reduce surprises, determine the different user profiles your users already display and think about how to model that in terms of the new access levels. Which users already have access to a given folder, and what kind of access is it? Which of those users really need this access?

Tip: Pay special attention to users who have the Manage Public Reports permission but do not have the View All Data permission. These users will have become accustomed to wide-open access to report folders and may unexpectedly find that they can’t access some reports.

This exercise is especially useful in the case of individual users. After you roll out the change, revising access levels for individual users adds up to much more administrative work than fixing access for a role or a group.

Consider taking a survey of your organization’s individual users, user groups, and roles, to validate who actually uses which folders and how. You might create a table like this to collect the data.

<table>
<thead>
<tr>
<th>I read things in this folder. I’ll need Viewer access.</th>
<th>I set up reports or dashboards in this folder. I’ll need Editor access.</th>
<th>I care about who can do what in this folder. I’ll need Manager access.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Dashboards folder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Reports folder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Operations folder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Daily Leaders folder</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Even after you have designed access levels to match existing behaviors, some users may still run into surprises. Prepare your users for a period during which they may need to ask for restored access to a folder they had previously had access to.
Some Common Permissions and How to Handle Them

When analytics folder sharing is enabled, existing combinations of user permissions automatically migrate to new sets of equivalent permissions. Here are some combinations that frequently appear in Salesforce organizations, and how to manage the transition from there to the new combinations of permissions.

See the table for a more detailed account of how specific sets of user permissions translate into enhanced folder sharing permissions.

Full permissions: Manage Public Reports, Create and Customize Reports, View All Data

Before enhanced folder sharing is enabled, people with this set of permissions can view, customize, run, edit, and delete reports in any folder except My Personal folders that belong to other users.

Under enhanced analytics folder sharing, users with this set of permissions cannot edit other people's reports. To bring back that ability, consider assigning these users the Manage Reports in Public Folders permission. Be aware that this will enable users to view and edit folders and reports they previously could not see, although they could get to them with the URL.

Partial permissions: View All Data, Create and Customize Reports

Before enhanced folder sharing, people with this set of permissions can customize any report that is visible to them, and can see the contents of all folders, except other users’ My Personal folders.

Under enhanced folder sharing, these users can also save their own reports into the Unfiled Public Reports folder. These users have View access to any folder they had access to previously. Any shares added after enhanced folder sharing is enabled are fully respected (View/Edit/Manage).

To restore these users’ previous capabilities, remove their Create and Customize Reports permission. Be aware that they will no longer be able to customize, edit, or save reports, even in their own My Personal Reports.

Partial permissions: Manage Public Reports, Create and Customize Reports

Before enhanced folder sharing, users with these permissions can view, customize, run, edit, and delete reports in any folder except My Personal folders belonging to other users, if they can see the folder in the tree or they know the URL. They can also edit or delete any folder.

Under enhanced folder sharing, these users can only edit or delete their own reports in folders shared with them. They cannot edit other users’ reports. These users have View access to any folder they had access to previously, and any shares added after enhanced folder sharing is enabled are fully respected (View/Edit/Manage).

To get these users back to their previous state, assign them the Manage Reports in Public Folders permission. Be aware that they will be able to view and edit reports in folders that they could not see before, although they could get to them with the URL.

User Permissions for Sharing Reports and Dashboards

Each level of access to a report or dashboard folder consists of a combination of specific user permissions. As an administrator, you can further fine-tune users’ access to dashboards and reports by assigning or removing one or more permissions.
When analytics folder sharing is enabled, all users get Viewer access to report and dashboard folders except users with higher administrative permissions. To give users broader privileges, assign Editor or Manager folder access and give report and dashboard user permissions as needed.

<table>
<thead>
<tr>
<th>User Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and Customize Dashboards</td>
<td>Create, edit, and delete dashboards in My Personal Dashboards folder. Create dashboards and save into any shared folder if sharing rights allow.</td>
</tr>
<tr>
<td>Create and Customize Reports</td>
<td>Create, edit, and delete reports in My Personal Custom Reports folder. Create reports and save into any shared folder if sharing rights allow.</td>
</tr>
<tr>
<td>Create Dashboard Folders</td>
<td>Create dashboard folders and manage them if sharing rights allow.</td>
</tr>
<tr>
<td>Create Report Folders</td>
<td>Create report folders and manage them if sharing rights allow.</td>
</tr>
<tr>
<td>Edit My Dashboards</td>
<td>Edit, move, save, and delete dashboards you created in shared folders.</td>
</tr>
<tr>
<td>Edit My Reports</td>
<td>Edit, move, save, and delete reports you created in shared folders.</td>
</tr>
</tbody>
</table>
| Manage Dashboards in Public Folders    | Create, edit, delete dashboards¹, and manage their sharing in all public dashboard folders, which does not include others’ personal folders. This permission allows users to edit and share dashboards in all folders, including hidden folders. They also get these permissions:  
  • Create and Customize Dashboards  
  • Create Dashboard Folders  
  • Edit My Dashboards  
  • View Dashboards in Public Folders  
  (¹ To edit a dynamic dashboard, users also need Manage Dynamic Dashboards and View My Team’s Dashboards.) |
| Manage Reports in Public Folders       | Create, edit, delete reports, and manage their sharing in all public report folders, which does not include others’ personal folders. This permission allows users to edit and share reports in all folders, including hidden folders. They also get these permissions:  
  • Create and Customize Reports  
  • Create Report Folders  
  • Edit My Reports  
  • View Reports in Public Folders |
| View Dashboards in Public Folders      | View dashboards in public dashboard folders, which does not include others’ personal folders.            |
| View Reports in Public Folders         | View reports in public report folders, which does not include others’ personal folders.                 |
View Dashboards in Salesforce Touch on iPhone Devices

In the previous release of Salesforce Touch, dashboards were available for Apple iPad tablets. With Summer ’13, dashboards are now available for iPhone devices too. If Salesforce Touch is enabled and dashboards are available, your users can access dashboards in both the Salesforce Touch mobile browser and downloadable apps.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Users can view dashboards but Salesforce Touch doesn’t support creating or editing dashboards. Here's a complete list of what users can do on iPhone devices:

- Find dashboards
- View dashboard data by component
- See component chart values
- Fetch the latest data
- Get dashboard information
- View dashboards in the full site

**Note:** Using dashboards in Salesforce Touch is a little different from the full Salesforce site. Source reports, dashboard filters, and Visualforce components aren’t displayed. Dynamic dashboards let you see data as yourself only. And Chatter posts and feed tracking for dashboards aren’t available.

See Salesforce Touch for other enhancements, how to enable Salesforce Touch, and a complete list of the differences from the full Salesforce site.

Find Dashboards

On the Dashboards tab, the list pane initially shows up to 15 of your most recently viewed dashboards. Each item includes the dashboard’s name and the folder where it’s stored. To see more in the list, tap Show More. You can pull the list downward to update it.

If you don’t see a dashboard in the list, use the Dashboards search to find it. The Dashboards tab shows only dashboards that you have permissions to access.
To search for a dashboard, type at least two characters of the dashboard’s name in the search box. Dashboards search doesn’t support smart search, wildcards, or operators.

**View Dashboard Data by Component**

Tap an item in the Dashboards list to open the dashboard in a detail pane. You can see data one component at a time. Swipe across or down in the detail pane to see other charts on the dashboard.
See Component Chart Values

To see the values for a dashboard chart component, tap on the component. Within the detailed component view:
• Tap on each shaded area to see its value. On metric, gauge, and table components, values are directly displayed on the dashboard for you.
• Pinch to zoom, or swipe to see all of the data

Fetch the Latest Data

Tap 🔄 on the dashboard to see the most recent data. The pull-to-refresh gesture on other tabs isn't available for dashboards. If you're using the Salesforce Touch mobile browser app, the browser refresh button doesn’t update your dashboard with the latest data.

Get Dashboard Information

Tap ⌚️ on the dashboard to see the date and time it was last refreshed, the running user as whom you're viewing the data, and the full name of the folder that stores the dashboard.

View Dashboards in the Full Site

You can open dashboards in the full Salesforce site to do tasks that aren’t available when using Salesforce Touch on a phone, such as filtering dashboard data. On a dashboard, tap 🔄 and select View in Full Site.

The full site opens in a new web browser page. And when you're finished working in the full site, it's easy to switch back to Salesforce Touch. For the mobile browser app, use the Go to Touch link in the full site's footer or for the downloadable app, tap the Touch icon on your mobile device’s Home screen or in your device’s recents list.
The link to the full site is provided as a convenience but using the full site from Salesforce Touch isn’t officially supported.

**Dashboards in Chatter 4.0 for iPhone and iPad Devices**

Dashboards are available in the Chatter 4.0 app for iPhone and iPad. If you have access to dashboards in the full site, you can view them in the app and see snapshots in the feed if posted from the full site.

In the pane of the app, you can:

- Browse the recently viewed dashboards list or search
- View data by component
- Refresh for latest data and get dashboard information
- Zoom into components for details

**Note:** Viewing dashboards in the Chatter app is different from the full Salesforce site. Source reports, dashboard filters, and Visualforce components aren’t displayed. Dynamic dashboards let you see data as yourself only.

**Sticky Dashboard Filters**

Dashboards with filter options remember your last filter choices. This means that a dashboard will always filter data based on your previous view.

<table>
<thead>
<tr>
<th>Available in: <strong>Professional, Enterprise, Unlimited</strong>, and <strong>Developer</strong> Editions</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>User Permissions Needed</strong></th>
</tr>
</thead>
</table>

| To view and refresh dashboards: | “Run Reports” AND access to dashboard folder |

You asked for it! This enhancement is from an idea on the IdeaExchange.

In this example, a rep filters a sales dashboard to show information for partner accounts in the Northeast with over 100K in revenue.
The sales rep will continue to see the dashboard filtered by this view unless she changes or clears the highlighted filters. To unfilter, click **Clear Filter** in each dashboard filter drop-down.

When the sales rep posts the filtered snapshot of won accounts to Chatter, viewers that navigate to the dashboard from Chatter see data as filtered by the sales rep. But if they view the same dashboard from elsewhere, they will see data based on their own filtering.

**Advantage of Using Filters**

Filters on a dashboard allow you to choose different views of data. As an administrator, you don’t need to clone dashboards along with source reports for each subset of data. With a single filtered dashboard, you can serve data needs for a wider audience. Filters are available to both dynamic and standard single-user dashboards.

To learn about dashboard filters, see Filter Dashboard Data in the online help.

**Scatter Charts Default Dashboards Behavior**

On dashboards, scatter charts by default show summary data if available from the source report.

---

**Available in:** Professional, Enterprise, Unlimited, and Developer Editions
Starting with this release, the first summary in the report will be shown by default on the chart axes. However, you can manually override these choices and pick the summaries you want to show instead. Edit the chart and pick different summary values for the X and Y-axis drop-downs.

Use scatter charts in reports and dashboards to show meaningful information using one or two groups of report data plus summaries. See Scatter Charts in the online help.

External Users Can View Reports and Dashboards in Communities

If your organization has communities, external users in those communities can analyze data through reports and dashboards.

Available in: Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view reports and dashboards:</td>
</tr>
</tbody>
</table>

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

If the Reports and Dashboards tabs are exposed in the community, external users with Partner Community, Gold Partner, Customer Portal Manager Standard, and Customer Portal Manager Custom (for Enterprise Administration users) licenses can access reports and dashboards with some limitations. External users can’t:

- Make copies of, edit, or delete reports and dashboards
- Schedule reports or dashboards for email and refresh at a specific date and time
- Refresh dashboards to see latest data

External users with Customer Community, High Volume Portal User, Service Cloud Portal, and Authenticated Website licenses don’t have access. To learn more, see Salesforce Communities—Generally Available.
## Salesforce Mobile Apps Overview

Learn about all of the Salesforce mobile apps that are available, so your users can stay connected and productive while on the go.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
<th>Supported Salesforce Editions</th>
<th>Supported Mobile Devices</th>
<th>Offline Support?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chatter Mobile</strong></td>
<td>Collaborate in Chatter from your mobile device without having to use a browser. You can monitor your feed, post updates and comments, and upload photos, files, and links. You can also email, call, or text people directly from their Chatter profiles. And the app gives you instant notifications to keep you up-to-date on important activities.</td>
<td>Free for customers using:</td>
<td>- Android phones and tablets   - Apple iPad   - Apple iPhone   - Apple iPod Touch   - BlackBerry smartphones</td>
<td>No. However, Android and Apple devices retain a cached version of your feed. You can also access any data previously downloaded from the app.</td>
</tr>
<tr>
<td><strong>Mobile Dashboards for iPad</strong></td>
<td>Access your dashboards and their source reports from your iPad. You can see any dashboard you have access to, as well as view individual dashboard components, highlight their values, and drill into reports for each. You can also email a dashboard or component to others, and post and comment</td>
<td>Free for customers using:</td>
<td>- Enterprise Edition   - Unlimited Edition   - Developer Edition   - Any organization with REST API enabled</td>
<td>Limited. Dashboards and reports that you access from the app are cached and available for offline viewing only.</td>
</tr>
<tr>
<td>Product</td>
<td>Description</td>
<td>Supported Salesforce Editions</td>
<td>Supported Mobile Devices</td>
<td>Offline Support?</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------------------------------</td>
<td>--------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Salesforce Classic</td>
<td>Access and update Salesforce data from your smartphone. You can view your dashboards, run simple reports, log calls and emails, keep track of your activities, and create, edit, and delete records. Most standard Sales objects and some Service objects are available. And if you're using the full version, custom objects and configurations are also supported.</td>
<td>A free, limited version is available for all Salesforce customers except for Database.com organizations Full version requires mobile licenses and is available for: • Professional Edition • Enterprise Edition • Unlimited Edition • Developer Edition</td>
<td>• Android phones and tablets • Apple iPhone • BlackBerry smartphones</td>
<td>Yes</td>
</tr>
<tr>
<td>Salesforce Touch</td>
<td>Access and update Salesforce data from an interface that's optimized for navigating and working on your touchscreen mobile device. You can view, edit, and create records, manage your activities, view your dashboards, and use Chatter. Salesforce Touch supports many standard Sales and Service objects and all of your organization's custom objects. And you can change between apps, just like in the full Salesforce site.</td>
<td>Free for customers using: • Contact Manager Edition • Group Edition • Professional Edition • Enterprise Edition • Unlimited Edition • Developer Edition</td>
<td>• Apple iPad • Apple iPhone</td>
<td>Limited. A Salesforce Touch pilot feature allows you to view your recently accessed records when your device isn't connected.</td>
</tr>
</tbody>
</table>
Salesforce Touch

Available in: **Group, Professional, Enterprise, Unlimited, Contact Manager**, and **Developer** Editions.

Salesforce Platform licenses are also supported.

Salesforce Touch is a version of Salesforce that’s designed specifically for touchscreen mobile devices. Using Salesforce Touch, you have real-time access to the same information that you see in the office, but organized for working while on the go.

Salesforce Touch provides these benefits over using the full Salesforce site on your mobile device:

- An intuitive interface that is optimized for easy navigation and data interaction on a touchscreen, so you can scroll, tap, and swipe through records to quickly find the information you need
- Automatic updates and enhancements, so you’re always using the most current version
- Support for many of your organization’s Salesforce customizations

In Summer ’13, there are several versions of Salesforce Touch that are generally available.

- A downloadable app that’s available from the Apple® App Store or AppExchange Mobile and installs directly on touchscreen mobile devices. In this release, the downloadable app is available for Apple iPad® and iPhone® devices.
- A mobile browser app that runs in the Safari® web browser on iPad and iPhone devices.

The downloadable app offers the convenience and time savings of maintaining your Salesforce session, so you don’t need to log in every time you access Salesforce Touch. Use the mobile browser version if you don’t want to bother with installing an app on your device.

**Note:**

In general, Salesforce Touch doesn’t have all of the functionality of the full Salesforce site. See **Salesforce Touch Differences from the Full Salesforce Site** for details.

---

**Salesforce Touch Enhancements**

In Summer ’13, the Salesforce Touch mobile browser and downloadable apps are generally available for Apple iPad and iPhone devices. Salesforce Touch now requires that these devices use iOS 6 or later.

**Note:** The Salesforce Touch downloadable app v1.1 or later is supported. Earlier releases of the downloadable app should be updated.

The Summer ’13 release of Salesforce Touch includes these new and enhanced features:

<table>
<thead>
<tr>
<th>Enhancement</th>
<th>Mobile Browser App for iPad</th>
<th>Mobile Browser App for iPhone</th>
<th>Downloadable App for iPad</th>
<th>Downloadable App for iPhone</th>
</tr>
</thead>
<tbody>
<tr>
<td>See your contacts' Twitter pictures and profiles.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Enhancement</td>
<td>Mobile Browser App for iPad</td>
<td>Mobile Browser App for iPhone</td>
<td>Downloadable App for iPad</td>
<td>Downloadable App for iPhone</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------</td>
<td>-------------------------------</td>
<td>---------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>See a list of all your open tasks (instead of one day at a time). Close tasks by tapping them.</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View dashboards.</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Available as of Spring ‘13)</td>
<td>(Available as of Spring ‘13)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Salesforce Communities (from the My Salesforce pane in the navigation view).</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create, edit, and view these objects:</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>• Campaigns</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>• Contracts</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View and edit these objects:</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>• Live Chat Transcripts</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View data when offline (Pilot).</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Quickly open the tab pane from anywhere in the detail view with a new swipe shortcut.</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Search the Salesforce Touch FAQs to find the help you need.</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

In addition, the performance of Salesforce Touch has been improved in this release.

**Twitter Profiles in Salesforce Touch**

Salesforce Touch now supports viewing your contacts’ Twitter profiles and feeds.

Before you can see a contact’s profile in Salesforce Touch, you must use the full site to associate the contact with their Twitter profile. Once the association has been made, you can view the profile by opening the contact’s detail pane and selecting the Twitter related list.

On an iPhone, first open a contact detail page.
To view a contact’s Twitter profile, tap the Related icon, and then tap Twitter.

On an iPad, open a contact detail page and then tap Twitter.
Viewing and Closing Tasks with Salesforce Touch for iPhone (Touch Tasks)

Whether you’re in the office or traveling, you need to be able to stay on top of your tasks and check them off when you’re done. Now the task list in Salesforce Touch for iPhone (Touch Tasks) shows all your open tasks. (The task list in Salesforce Touch for iPad still shows just the tasks due on a single day you select.)
1. To view task details, tap the subject.
2. To close a task, tap the checkbox.
3. Closed tasks appear crossed out until you refresh the list.
   (When you refresh, closed tasks drop off the list.)
4. If your organization has multiple options for closing a task, a menu opens when you tap the checkbox. To close the task, tap your choice in the menu. To leave the task open, tap once outside the menu.

Viewing Records Offline with Salesforce Touch (Pilot)

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

Salesforce Touch now supports viewing records when:

- A Wi-Fi® or cellular network connection isn’t available
- Airplane mode is enabled
- The user’s mobile device can’t access Salesforce for another reason

**Note:** This feature is currently offered through a pilot program and is available only in the Salesforce Touch downloadable app v2.0 or later. For information on enabling or disabling offline support in Salesforce Touch, contact salesforce.com.

When offline access is enabled for your organization, the feature is available to anyone using the downloadable app on iPad or iPhone devices. To make it possible to keep working if a network connection isn’t available, Salesforce Touch automatically
stores recently accessed records each time a user logs in to the downloadable app; Salesforce Touch then refreshes the offline backup each hour during an active session.

A user who loses connectivity during an active Salesforce Touch session can access tabs, see the most recently viewed records for each object, and switch to different Salesforce apps. It's not possible to create or edit records when there's no connection, and Dashboards, Chatter, Communities, and Visualforce tabs aren't available. It's also not possible to start a new Salesforce Touch session while offline.

Salesforce Touch encrypts all of the data that it stores for offline use. The stored data is cleared whenever a user's downloadable app session ends. A session ends when:

- The user manually logs out
- The user is deactivated
- The user's session expires

**Note:** If a user's session ends when the app isn't running, the stored data is removed from the mobile device the next time the user launches Salesforce Touch.

Salesforce Touch Requirements

These are the requirements for using the downloadable and mobile browser versions of Salesforce Touch.

**App Version:**
- Only v1.1 or later downloadable apps are supported.
- No version restrictions exist for the mobile browser app.

**Devices:**
- Apple iPad® 2 and later models (including the iPad mini), with iOS® 6 or later.
- Apple iPhone® 4 and later models, with iOS 6 or later.

**Browsers:**
- The default Apple browser, Safari®.
- Private Browsing must be turned off. Tap the iPad or iPhone Settings icon, then select Safari and set Private Browsing to Off.

**Salesforce:**
- Salesforce Touch is available in Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions.
- Salesforce Platform licenses are also supported.
- You must have an active Salesforce account with access to accounts and contacts.
- Chatter customers and partner portal users aren't able to use Salesforce Touch.

**Wireless Connection:**
- A Wi-Fi® or cellular network connection is required to communicate with Salesforce. For the best performance, we recommend using Wi-Fi. If you use Salesforce Touch on a 3G cellular network, data rates may apply and you may incur roaming charges while traveling.
Salesforce Touch includes offline support, so you can view recently accessed records when you don’t have a connection. This feature is available through a pilot program—contact salesforce.com to have it enabled.

**Locales and Languages:**
Salesforce Touch works with almost all Salesforce-supported locales and the fully-supported and end user languages. The exception is right-to-left locales and languages (including Arabic and Hebrew), which aren’t currently supported. Advanced currency management isn’t supported in this release.

### Setting Up Salesforce Touch

<table>
<thead>
<tr>
<th><strong>User Permissions Needed</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To view Salesforce Touch settings:</td>
<td>“View Setup and Configuration”</td>
</tr>
<tr>
<td>To modify Salesforce Touch settings:</td>
<td>“Customize Application” “Modify All Data”</td>
</tr>
<tr>
<td>To use the Web Services API:</td>
<td>“API Enabled” “Manage Users”</td>
</tr>
</tbody>
</table>

You can enable access to the Salesforce Touch mobile browser app, the downloadable app or both. If you enable both, users can access either app interchangeably.

To enable and configure Salesforce Touch for your organization:

1. From Setup, click **Mobile Administration > Salesforce Touch > Settings**.
2. In the **Downloadable App Settings** section, enable the Salesforce Touch downloadable app for all users in your organization by selecting the mobile devices that can access the app. (In this release, Apple® iPad® and iPhone® are the available options.) Disable access to this app by deselecting all of the devices in this section.
   
   The downloadable app is enabled by default. If you disable this app, users can still install the app but they can’t use it to log in to their Salesforce accounts.

3. In the **Mobile Browser App Settings** section, enable the Salesforce Touch mobile browser app for all users in your organization by selecting the mobile devices that can access the app. (In this release, iPad and iPhone devices are the available options.) Disable access to this app by deselecting all of the devices in this section.
   
   The mobile browser app is disabled by default. If you enable this option, users who log in to Salesforce from the Safari® browser on iPad and iPhone devices are automatically redirected to Salesforce Touch.

**Note:**

If users prefer to access the full Salesforce site from Safari instead, they can turn off the mobile browser app redirection for themselves, from the app or from the full site by deseleting the **Touch User** checkbox at either **Setup > My Personal Information > Personal Information** or **My Settings > Personal > Advanced User Details**.

Alternately, you can use the Web Services API to quickly turn automatic redirection to the mobile browser app off (or on) for users. When the mobile browser version of Salesforce Touch is enabled, the
UserPreferencesOptOutOfTouch field is added to the User object. By default, this field is set to false—which turns on automatic access to the mobile browser app—for all user records. Change this field to true to turn the redirection off for desired users. See the User section in the Web Services API Developer's Guide for more information.

If automatic redirection to Salesforce Touch is turned off, affected users won’t be able to access the mobile browser app from any of their supported mobile devices.

4. Click **Save**.

You can also enable the use of Visualforce tabs in Salesforce Touch. See Enabling Visualforce Tabs in Salesforce Touch for the details.

### Enabling Visualforce Tabs in Salesforce Touch

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view Salesforce Touch settings:</td>
</tr>
<tr>
<td>To modify Salesforce Touch settings:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>To enable the display of Visualforce Tabs in Salesforce Touch:</td>
</tr>
</tbody>
</table>

You can enable Visualforce tabs to display in both the downloadable and mobile browser versions of Salesforce Touch, allowing users to access associated Visualforce pages directly from the Salesforce Touch interface.

**Note:** Other forms of Visualforce, including inline Visualforce, overridden Visualforce pages, and standard Visualforce buttons and links, aren't supported in this release of Salesforce Touch.

1. Enable Visualforce pages for Salesforce Touch.
   a. From Setup, click **Develop > Pages**.
   b. Edit the desired Visualforce page.
   c. Select **Available in Touch** then click **Save**.

   Any tabs that are associated with the page will display in Salesforce Touch. If the page isn’t associated with a Visualforce tab, users won’t be able to access the page from Salesforce Touch.

2. Turn on Visualforce support in Salesforce Touch.
   a. From Setup, click **Mobile Administration > Salesforce Touch > Settings**.
   b. Select **Enable Visualforce in Salesforce Touch** then click **Save**.

Visualforce tabs in Salesforce Touch are indicated by the icon. Tapping the icon opens the tab—and the associated Visualforce page—in a slightly different way, depending on the version of Salesforce Touch.

- **Downloadable app**—The Visualforce page opens in the Salesforce Touch in-app (child) browser. The Visualforce page is rendered with showHeader=false so all Salesforce header and sidebar navigation is suppressed.
- **Mobile browser app**—The Visualforce page opens in a new mobile browser tab, outside of the Salesforce Touch interface. The Salesforce header and sidebar are displayed and can be used to navigate within Salesforce.
In both cases, the Visualforce page functions the same as if you were viewing it in the full Salesforce site.

Here are some notes about Visualforce tab support in this release of Salesforce Touch:

- Standard object tabs that are overridden with a Visualforce page aren’t supported in Salesforce Touch. The Visualforce page is shown for full site users but Salesforce Touch users will see the default Salesforce Touch page for the entity instead. This restriction exists to maintain the Salesforce Touch experience for standard objects.
- Other Visualforce pages that are accessed from a Salesforce Touch-enabled Visualforce page don’t need to be enabled for Salesforce Touch.
- You can also enable Visualforce pages for Salesforce Touch through the metadata API by editing the isAvailableInTouch field on the ApexPage object.
- The Mobile Ready checkbox on Visualforce Tab setup pages is for the Salesforce Classic app only and has no effect on Visualforce in Salesforce Touch.

### Accessing Salesforce Touch

The way users access Salesforce Touch depends on the versions that you've enabled for your organization.

- **Salesforce Touch Downloadable App**: If you opt to keep the downloadable version of Salesforce Touch enabled, users can download and install the app on iPad and iPhone devices from the Apple App Store or AppExchange Mobile.

  Once installed, users can launch the app from their Home screen and log in to their Salesforce accounts as they would normally. By default, the downloadable app connects to your production environment.

  **Note**: If you disable the downloadable version of Salesforce Touch, your users aren’t blocked from downloading or installing the app. Any attempts to log in to Salesforce from the app, however, will fail with an error message.

- **Salesforce Touch Mobile Browser App**: If you enable the mobile browser version of Salesforce Touch, users simply access the mobile browser app by logging in to their Salesforce accounts from the Safari mobile web browser. Login sessions from iPad and iPhone devices are automatically redirected to the mobile browser app.

  **Note**: If a user sees the full site instead of the mobile browser app, verify that the Touch User checkbox in the user’s personal settings is selected. You can access this information by going to Setup, selecting Manage Users > Users, then clicking Edit next to the user’s name.

If you enable both versions of Salesforce Touch, users can access either option interchangeably.

### Using Salesforce Touch

To learn about using Salesforce Touch, see the Salesforce Touch FAQ that’s available in the app, on the My Salesforce pane in the navigation view.
Salesforce Touch Differences from the Full Salesforce Site

Salesforce Touch doesn’t have all of the functionality of the full Salesforce site. There are key differences in these areas of the app:

- Viewing and working with Salesforce data
- Limits on the amount of data that is displayed
- Creating and editing records
- Chatter feeds and lists
- Salesforce Communities
- Salesforce customizations

Differences Working with Salesforce Data

In this release, users can work with:

- Accounts and Person Accounts
- Campaigns
- Cases
- Contacts
- Contracts
- Events that are accessible from Open Activities or Activity History related lists
- Dashboards
- Leads
- Live Chat Transcripts
- Opportunities and Opportunity Line Items
- Tasks
- User records
- All custom tabs
- Chatter data, including People, Groups, and feeds
- Salesforce Communities (mobile browser app only)

With a few exceptions, all of the standard and custom fields for the objects supported in Salesforce Touch are available.

**Note:** Salesforce Touch uses user profiles and permission sets, so assuming it’s supported in Salesforce Touch, users have access to the same tabs, record types, fields, page layouts, and object permissions that they do when working in the full site.

Currently, Salesforce Touch doesn’t include support for the following:

- Objects other than those mentioned here
- Standard list views and custom object lists
- A few record fields, including:
  - Divisions fields
  - Rich text area fields
◊ Territory management fields

• Some related lists and some related list fields; all related lists are read-only
• Editing dashboards, opportunity line item records, or user records
• Cloning or deleting records
• Submitting records for approval
• Links in formula fields (downloadable apps only)
• Search on objects other than those supported in Salesforce Touch
• Shared Activities for tasks or events
• Archived activities
• Advanced currency management

**Note:**
Unsupported fields, links to unsupported objects, and unsupported related lists include links to the full Salesforce site, where you can see the missing information. In addition, the **Actions** menu on a record detail pane allows you to switch to the full site so you can perform tasks not currently available in Salesforce Touch.

Salesforce.com provides these links for your convenience but using the full site from Salesforce Touch isn’t officially supported.

### Campaigns

When working with Campaigns in Salesforce Touch:

• Campaign Hierarchy is available only as a related list. The option to View Hierarchy from a link on the campaign detail page isn’t available. When viewing a parent campaign, the Campaign Hierarchy related list shows only the child campaigns, while in the full site, both the parent and child campaigns are displayed.
• The Campaign Members related list isn’t available.
• Custom Links to campaign member and campaign influence reports aren’t available.

### Cases

When working with Cases in Salesforce Touch:

• Web-to-case fields, including **Web Email**, **Web Name**, **Web Company**, and **Web Phone**, are always displayed on case detail pages in Salesforce Touch. In the full Salesforce site, these fields aren’t included on the detail page if the record doesn’t include web-to-case data.
• The Solutions related list isn’t available in Salesforce Touch. The Case History and Content Deliveries related lists are displayed on the Related Lists drop-down but you can’t see any of the records on these lists in Salesforce Touch. In addition, some related lists for cases—including the Case Milestones, Case Team, Emails, and Entitlements related lists—have links to records that can’t be viewed in Salesforce Touch. In these situations, Salesforce Touch prompts you to switch to the full site to see your data.
• If your organization has predefined case teams, the Case Team related list individually lists each team member instead of displaying a row for the team itself, as is done in the full site. If a user is a member of multiple predefined teams, that user is only listed once in the related list. View the Case Team related list in the full site to see an accurate list of predefined case teams.
• Some options for working with Cases aren’t available in this release of Salesforce Touch. You can’t:
  ◊ View the hierarchy for a case
  ◊ Submit cases for approval
Close cases

Contacts
When working with Contacts in Salesforce Touch, you can’t set up associations between contacts records and Twitter profiles. If you do the associations in the full site, however, you can see your contacts’ Twitter information directly in the app.

Contracts
When working with Contracts in Salesforce Touch, you can’t update the status of your contracts.

Dashboards
When working with Dashboards in Salesforce Touch:
- Dashboards don’t display filters, source reports, or Visualforce components.
- Dynamic dashboards let you see data as yourself only.
- Chatter feeds for dashboards aren’t available, nor can you post dashboards or components to Chatter.

Leads
When working with Leads in Salesforce Touch, you can’t:
- Convert or share leads
- Find duplicate leads

Live Chat Transcripts
When working with Live Chat Transcripts in Salesforce Touch, you can’t:
- Create live chat transcript records
- View the Body field in transcript records

Limits on How Much Data is Displayed
Salesforce Touch caps the number of items that display in various types of lists. These limits are:
- Chatter Groups and People: 15 records displayed initially, expandable to 200 maximum
- Recent Items: 15 records displayed initially, expandable to 100 maximum
- Related Lists: 30 records displayed initially, not expandable
- Search Results: top 5 results per object displayed, not expandable
- Tasks: 15 records displayed initially; expandable to 100 maximum

Differences Creating and Editing Records
There are some differences from the full site when creating or editing records in Salesforce Touch:

<table>
<thead>
<tr>
<th>Category</th>
<th>Issue</th>
<th>Creating Records</th>
<th>Editing Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Record</td>
<td>You can’t modify a record’s owner or its record type.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>You can’t enter data in geolocation custom fields.</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Category</td>
<td>Issue</td>
<td>Creating Records</td>
<td>Editing Records</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Combo boxes</td>
<td>Combo boxes, which combine a picklist with a text field, aren't available. Typically the text field is available but the picklist is not.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>If territory management is enabled, you can't assign or modify a record's territory rules.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Accounts and</td>
<td>The <strong>Copy Billing Address to Shipping Address</strong> and <strong>Copy Mailing Address to Other Address</strong> links aren't available.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Contacts</td>
<td>If territory management is enabled, the <strong>Evaluate this account against territory rules on save</strong> option isn't available when editing account records.</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Events</td>
<td>You can't create or edit event records in Salesforce Touch.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Opportunities</td>
<td>You can't edit the <strong>Probability</strong> or <strong>Forecast Category</strong> fields. However, values are automatically added to these fields (based on the value of the <strong>Stage</strong> field) when you save the record. You can manually override the values for these fields by editing the record in the full site.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>If you make an opportunity private, you don't get a warning that you're removing all sharing from the record.</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Tasks</td>
<td>The <strong>Subject</strong> field doesn't include a picklist of previously defined subjects.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>If you set the <strong>Name</strong> field to <strong>Lead</strong>, the <strong>Related To</strong> field shouldn't be available but it's editable in Salesforce Touch. You'll get a validation error if there's data in <strong>Related To</strong> when you save the record.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>The <strong>Email</strong> and <strong>Phone</strong> fields for an associated contact aren't displayed.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>You can't use Shared Activities to relate multiple contacts to a task.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>You can't create recurring tasks or change the details for recurring tasks.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>Spell-checking the <strong>Comments</strong> fields isn't available.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>You can't add attachments.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>You can't send notification emails.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>You can't set task reminders.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Lookup Fields</td>
<td>Enhanced lookups aren't supported, so you can't use wildcards in lookup searches and you can't sort, filter, and page through search results.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>Dependent lookups aren't supported.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td></td>
<td>Lookup filters aren't respected, so lookup search results aren't restricted in any way. You may wind up selecting an item that isn't valid for your organization, resulting in an error message when you save your record.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Salesforce Touch doesn't apply any formatting to numbers entered in phone number fields, so if you enter 4155551212, that's how the phone number is displayed when you view the record.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Fields</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Differences Using Chatter**

When using Chatter in Salesforce Touch, you can’t:

- Create or update your profile information, or upload profile pictures
- See the Followers, Following, Groups, and Files Owned lists on profiles
- See Chatter activity statistics or Chatter influence status
- Receive Chatter recommendations
- See trending topics
- Invite coworkers to sign up for Chatter
- Update group settings and information
- Create new groups
- View members of groups or lists of group files
- Invite Chatter customers to join private groups, see that a private group includes Chatter customers, or get a warning that you’re posting to a group with Chatter customers
- Upload, share, or preview files
- View or download files that were uploaded via the Files tab at the full Salesforce site or that were uploaded to a comment. You can, however, view files that are attached to a post on a Chatter feed. (The Salesforce Touch downloadable app can display these file types only: `.doc`, `.docx`, `.pdf`, `.ppt`, `.pptx`, `.xls`, `.xlsx`, and all image files, including `.gif`, `.jpg`, and `.png` formats.)
- Find or follow files
- Send or view Chatter messages
- Use publisher actions
- Bookmark posts
- View the list of people who like a Chatter update
- Share public posts
- Add or view Chatter favorites
- Use topics. (You can enter hashtag topics, however. They’ll appear as plain text in Salesforce Touch but work correctly when viewed in the full site.)
- Search for data in any Chatter feeds, including Groups, People, and Files
- View the full Chatter feed (as with the **Feed** filter in the full site)
- Filter or follow records
- Use Chatter as a moderator

---

<table>
<thead>
<tr>
<th>Category</th>
<th>Issue</th>
<th>Creating Records</th>
<th>Editing Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picklist Fields</td>
<td>Controlling and dependent picklists are supported, but Salesforce Touch doesn’t display indicators on create and edit pages for these fields. To determine if a picklist field is dependent, and which picklist field controls it, switch to the full site.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text Area Fields</td>
<td>Text area fields aren’t scrollable in this release. To access text that isn’t visible in the field, tap the field to display the keyboard, then touch and hold to bring up the magnifying glass. Slowly drag the magnifying glass through the field until you see the desired text.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
In addition, when using Chatter on iPhone devices:

- The **People** and **Groups** subtabs aren’t available; however, you can access individual profiles and groups from links in the main Chatter feed.
- You can’t do any filtering of the main Chatter feed.

**Differences Using Salesforce Communities**

These features aren’t available when using Communities in Salesforce Touch:

- Customizations using Site.com and Force.com
- Self-service support using Chatter Answers
- Ideas communities
- Objects, related lists, and fields that aren’t supported in this release of Salesforce Touch

**Availability of Salesforce Customizations**

Salesforce Touch displays custom Visualforce tabs, which allow users to open associated Visualforce pages in a new browser window.

All other programmatic customizations to the Salesforce interface, however, aren’t currently supported in Salesforce Touch, including:

- Custom buttons and links
- Web tabs
- Visualforce components other than Visualforce tabs
- S-controls

**Chatter for Android – Version 3.3 Generally Available**

Chatter for Android v3.3 is now generally available. This release includes a new user interface so you can navigate faster, and several enhancements to the Chatter mobile app:

**New Navigation Pane**

In Chatter for Android, the navigation pane along the left side of the app lets you quickly switch between Chatter feeds, Salesforce records and files, and everything that matters to you most. Swipe from left to right on any page to open the navigation pane.

**Folder Support for Files (Supported Organizations)**

- Easily create a folder to store and organize your files.
  1. From the Chatterbox view, tap **Add**....
  2. Tap **New Folder**.
  3. Enter a name for the folder.
  4. Tap **Add**.
Note: Folders are only available if Chatterbox is enabled for your organization.

Bookmark Feed Posts
Bookmarking a post lets you keep track of posts you’re interested in. The post you bookmarked appears in the Bookmarked view of your feed.

Installing the App
Salesforce Chatter is available for download from Google Play. To use the Chatter for Android v3.3 mobile app, your Android device must be running Android OS version 2.2 or greater, and it must be connected to a WiFi or cellular network.

Upgrading the App
You can upgrade to the latest version of Chatter for Android by installing the pending update that appears in Google Play on your Android device.

Chatter for iPhone and iPad – Version 4.1 Generally Available
Chatter for iPhone and iPad v4.1 is generally available on September 2013. This release includes a new user interface so you can navigate faster, and several enhancements to the Chatter mobile app:

Global Search
Chatter’s global search searches a variety record types, including documents, products, custom objects, files, groups, and people. Global search keeps track of which objects you use and how often you use them, and arranges the search results accordingly. Search results for the objects you use most frequently appear at the top of the list.

To search:
1. Tap 📊.
2. Tap Search Salesforce.
3. Enter your search terms.
4. Tap Search.

Feed Search
You can search for information in feeds on a user’s profile, a record, in a public or private group (if you’re a member).
1. In a feed, drag the page down to reveal the search box.
2. Enter your search terms in the search box.
3. Tap Search.

Note: The feed search box is hidden. You can’t see it until you drag the page down.
Feed Sort

You can sort your feed by **Post Date** to sort most recent posts, or **Most Recent Activity** to sort by posts with the most recent comments, including polls with new comments.

1. In a feed, drag the page down and tap ↓
2. Tap either **Post Date** or **Most Recent Activity**.
3. Tap **Done**.

Bookmarks

Bookmarking a post lets you keep track of posts you’re interested in. There are two ways to bookmark a post.

1. Double-tap a post.

OR

1. Tap 📌 at the top right corner of the post you want to bookmark.
2. Tap **Bookmark Post**.

The post you bookmarked appears in the **Bookmarked** view of your feed. 📌 indicates a bookmarked post.

Installing the App

Salesforce Chatter is available for download in the Apple App Store. To use the Chatter for iOS v4.1 mobile app, your iPhone or iPad must be running iOS 5.0 or higher, and it must be connected to a WiFi or cellular network.

Upgrading the App

You can upgrade to the latest version of Chatter for iOS by installing the pending update that appears in the App Store on your iPhone or iPad.

**Note:** iPad users who have an old version of the Chatter for iPad app – Chatter for iPad v2.0 or earlier – must download the app from the App Store. Those users won’t see a pending update on their device.

Salesforce Mobile Rebrand

Salesforce Mobile is now Salesforce Classic for Android™, BlackBerry® and iPhone® devices. Salesforce Classic continues to help your teams succeed by allowing users to access their latest Salesforce data, whenever and wherever they need it. The Salesforce Classic rebrand may affect your Mobile User administrator settings:

**Mobile Lite**

The Mobile Lite user permission, which is the free version of Salesforce Classic, is disabled by default. To enable the free version of Salesforce Classic:

1. From Setup, click **Mobile Administration** > **Salesforce Classic** > **Settings**.
2. Click **Edit**.
3. Select **Enable Mobile Lite**.
4. Click **Save**.
Mobile User Permission for Unlimited Edition

The Mobile User checkbox is disabled by default for new Unlimited Edition users.
Data.com Product Suite Overview

Watch a Demo (3:19 minutes)

Data.com is the Salesforce solution for delivering leading business data inside your CRM. Your team can spend less time entering and updating data and more time growing your business. Data.com combines crowd-sourced contacts with account information from D&B, managed in the cloud, so you can keep your CRM clean and up to date in real time. Within Data.com, you can search for Data.com accounts and contacts right on the Data.com tab, and if you have a Data.com license, you can add records to Salesforce. You can add your contact search results as either contacts or leads. It’s remarkably easy to find the accounts and contacts you need, and using Data.com is a great way to plan your sales territories, segment campaigns, find new accounts to engage, and get new contacts to quickly expand your sales network. The Data.com product suite includes Data.com Prospector and Data.com Clean, as well as these related Data.com features: Social Key, Reports, and Data Assessments. Let’s learn about them and how they work together.

New in Summer ’13: Data.com Social Key—Beta

Data.com Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads on social networks. Social Key currently provides social handles for LinkedIn, Twitter, and Facebook for contacts and leads in the United States only.

From Social Accounts and Contacts, select the social networks you want. Automated Social Key jobs find and associate the social handles. Users can log in to a social network from a contact or lead’s detail page and view the associated profile right within Salesforce or on the social network site.

Data.com Clean must be enabled to use Social Key.

Social Key Settings

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads on social networks. Social Key currently provides social handles for LinkedIn, Twitter, and Facebook for contacts and leads in the United States only.

Social Key provides social profiles from LinkedIn, Twitter, and Facebook.

Social Accounts and Contacts Settings

Social Accounts and Contacts is enabled. You can edit your settings and preferences on the Social Accounts and Contacts Settings page.

- LinkedIn
- Twitter
- Facebook
- YouTube
- Others
- Unset

Data.com Clean Settings

Check your Data.com Clean settings, preferences, and job schedule if you want to verify that Clean is enabled or change your job setup.
New in Summer ’13: Data.com Data Assessments
How many of your organization’s records can Data.com enrich with more and better data? Data.com Assessments can tell you. It can also identify how many of your records have been marked as Inactive in Data.com, and if you request, how many records in your Salesforce organization appear to be duplicates. Data.com Data assessments also list the fields on accounts, contacts, and leads, and tell you how many are blank within your records and how many have different values from Data.com’s. You can use Data Assessments to help you decide whether to purchase Data.com Clean. If you already use those products, it will show you the value you’re getting. Data Assessments is a free AppExchange package. Work with your salesforce.com sales representative to get it for your organization.

Data.com Prospector
All Salesforce users can search Data.com for accounts and contacts. Users with a Data.com Prospector license can:

• Add accounts and contacts to Salesforce, and add contacts as leads.
• Add contacts for an account directly from the account record.
• Export accounts and contacts from Data.com.
• Manually clean Salesforce account, contact, and lead records, regardless of whether they were added from Data.com.

There are two versions of Data.com Prospector: Corporate Prospector and Premium Prospector. They differ based on the D&B fields that are included when you add or manually clean account or lead records.

<table>
<thead>
<tr>
<th>Data.com Prospector Version</th>
<th>D&amp;B Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Corporate Prospector (known as Data.com Corporate prior to Spring ’13)</td>
<td>Basic set of D&amp;B fields.</td>
</tr>
<tr>
<td>Data.com Premium Prospector (known as Data.com Premium prior to Spring ’13)</td>
<td>Basic set of D&amp;B fields, plus the D&amp;B Company field. This field links to an associated D&amp;B Company record with over 70 additional D&amp;B fields that are accessible on the D&amp;B Companies tab.</td>
</tr>
</tbody>
</table>

Organizations that purchased Data.com prior to December 16, 2011 may still be using an earlier version of the product with a limited set of fields. We’re retiring this version in Summer ’14. For information about upgrading to Data.com Prospector, contact your Salesforce account manager. The Salesforce Help refers to the Data.com Prospector product unless otherwise noted.

Data.com Clean
Data.com Clean is an important part of the Salesforce Data.com product suite, offering both manual and automated cleaning for your account, contact, and lead records. Data.com Clean provides full clean capability for your organization: all Data.com Clean users can manually clean Salesforce accounts, contacts, and leads, and you can configure jobs to flag field value differences on Salesforce records or automatically fill blank fields.

There are two versions of Data.com Clean: Corporate Clean and Premium Clean. They differ based on the D&B fields that are available when you clean account or lead records, either manually or via automated jobs.

<table>
<thead>
<tr>
<th>Data.com Clean Version</th>
<th>D&amp;B Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Corporate Clean</td>
<td>Basic set of D&amp;B fields.</td>
</tr>
<tr>
<td>Data.com Premium Clean</td>
<td>Basic set of D&amp;B fields, plus the D&amp;B Company field. This field links to an associated D&amp;B Company record with over</td>
</tr>
</tbody>
</table>
### Data.com Clean Version

<table>
<thead>
<tr>
<th>D&amp;B Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 additional D&amp;B fields that are accessible on the D&amp;B Companies tab. If the Salesforce record's D&amp;B Company field is blank, a link will be created, if available, when the record is cleaned.</td>
</tr>
</tbody>
</table>

**Note:**
- Prospector or Clean Corporate licences can not be purchased for organizations that already have Prospector or Clean Premium licences. If you want to purchase Corporate licenses, you'll need to convert your Premium licenses.
- Prospector or Clean Premium licences can not be purchased for organizations that already have Prospector or Clean Corporate licences. If you want to purchase Premium licenses, you'll need to convert your Corporate licences.
- Data.com Premium Clean must be purchased 1:1 for Sales Cloud and Service Cloud seats.

### Data.com Reports

Want to analyze the impact of Data.com data on your business? Use the Data.com Reports AppExchange package. It offers several preconfigured Data.com reports and two corresponding impact dashboards. Use these tools to find out how many records are sourced from Data.com, who has added them and when, and how they contribute to your sales forecast and revenue.

### Important Considerations for Organizations Using Jigsaw for Salesforce

Jigsaw for Salesforce is an older version of the product that is no longer for sale. It provides similar search, add, and clean functionality, but it works differently from the Data.com product suite built in to Salesforce. The Salesforce online help and release notes describe the built-in Data.com Corporate and Premium products only, not Jigsaw for Salesforce. If your organization is still using Jigsaw for Salesforce, you should consider migrating to the built-in Data.com product suite for your prospecting and cleaning needs. For information, please contact your Salesforce account manager.

**Important:**
You should not attempt to migrate to the built-in Data.com Clean product without having first purchased it through your Salesforce account manager. If you attempt to enable the built-in Data.com Clean product without purchasing it, you'll see a message: *Your organization does not currently have the permission to run Clean jobs.*

### Data.com Administrator

Setting up and maintaining Data.com has never been easier. In Summer ’13, we bring you the following new features.

- Ability to limit what users can do with Data.com search results
- Data.com Usage Report
Limit What Users Can Do with Data.com Search Results

You can now limit what users can do with Data.com search results by removing the Add to Salesforce and Export Results buttons from the Find Contacts and Find Accounts tabs.

1. From Setup, click Data.com Administration > Preferences.
2. In the Button Preferences section of the page, deselect what you want to remove from the Find Contacts and Find Accounts tabs.

Data.com Usage Report

If your organization has access to custom report types, you can create a report that shows detailed Data.com usage information for up to 12 months, including the number of records added or exported and by which user, as well as the type of records (accounts or contacts) that were added or exported. When you create the custom report type, just select the Data.com Usage object as the primary object and you'll have access to all fields related to Data.com usage.

Data.com User

Data.com offers these enhancements for users in Summer ’13.

- Expanded metro area list in Data.com Location Selector
- Additional fields in Data.com export files

Expanded Metro Area List in Data.com Location Selector

Users can now select from over 900 US metro areas when they use the Data.com Location Selector to search for accounts and contacts. Defined by the United States Office of Management and Budget, these metro areas include both metropolitan and micropolitan statistical areas.
Metro areas are no longer available for Canada.

**Additional Fields in Data.com Export Files**

With Summer ’13, we include additional fields on .csv files when you export account and contact records from your Data.com search results.

<table>
<thead>
<tr>
<th>Data.com Object</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>• Fax</td>
</tr>
<tr>
<td></td>
<td>• FipsMsaCode (Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• Sic</td>
</tr>
<tr>
<td></td>
<td>• SicDesc</td>
</tr>
<tr>
<td></td>
<td>• NaicsCode (Data.com Corporate Prospector or Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• NaicsDesc (Data.com Corporate Prospector or Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• StockExchange (Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• SalesVolumeReliability (Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• EmployeesTotalReliability (Data.com Premium Prospector only)</td>
</tr>
<tr>
<td></td>
<td>• Data.com Last Updated Date</td>
</tr>
<tr>
<td>Contact</td>
<td>• Department</td>
</tr>
<tr>
<td></td>
<td>• Industry</td>
</tr>
<tr>
<td></td>
<td>• Data.com Last Updated Date</td>
</tr>
</tbody>
</table>
DATA.COM CLEAN

Data.com Clean Administrator

Summer ’13 offers an exciting set of new administrator features for Data.com Clean.

- **D&B’s DUNSRight Matching service is now GA!** If you want to clean account records using the D&B DUNSRight™ matching service, select that option on the Clean Preferences page. DUNSRight uses D&B’s Confidence Code system to rank Data.com match candidates based on how similar they are to your record, from 1 (not similar) to 10 (identical or highly similar).

- If you use the D&B DUNSRight matching service (GA in Summer ’13), every 30 days, you can schedule a full sync of your account records with Data.com’s. The full sync will happen when your next scheduled account clean job runs.

If you're considering purchasing Data.com Clean—or you already use the product—you can now run a Data.com Data Assessment. This free AppExchange package can tell you how many of your organizations’ records Data.com can enrich with more and better data. It can also tell you how many of your records have been marked as Inactive, and if you request, how many records in your Salesforce organization appear to be duplicates. Data assessments also list the fields on accounts, contacts, and leads, and tell you how many are blank within your records and how many have different values.
from Data.com’s. Data Assessments is a free AppExchange package. Work with your salesforce.com sales representative to get it for your organization.

The following information is from Data.com’s documentation.

### Defining Your Data.com Clean Job Preferences (Data.com Clean Only)

**Data.com Prospector license available in:** Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions

**Data.com Clean license available in:** Professional, Enterprise, and Unlimited Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To implement Data.com:</td>
</tr>
<tr>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Clean preferences let you specify:

- Which objects’ records to clean with automated jobs
- How you want to clean them

Jobs can either:

- Flag all fields in a Salesforce record whose values are different from those in the matched Data.com record, or
- Flag fields with different values and *also* auto-fill blank fields

You can set flag-only or flag and auto-fill preferences for entire records or field by field. If you use Data.com Premium Clean, you can also clean D&B Company records that are linked to accounts and leads. D&B Company clean jobs automatically fill or overwrite field values on D&B company records, but do not change data on linked account or lead records.

Your preferences take effect when the next scheduled clean job runs, and users will see the flags, as appropriate, when they clean records manually.

**Note:**

- Person accounts are excluded from Account and Contact clean jobs.
- Converted leads are excluded from Lead clean jobs.

1. From Setup, click **Data.com Administration > Clean > Preferences**.
2. Select the **Enable Clean jobs** checkbox for each object whose records you want to clean. (If you clear the **Enable Clean jobs** checkbox, automated jobs will not run for objects of that type.)
3. For each object you’ve enabled, select your clean preference.

   - Flag all differences per record *to only identify* fields whose values are different from Data.com values
   - Flag differences and auto-fill blank fields *to identify* fields whose values are different and *fill blank fields* with values from Data.com.
   - Customize settings *field by field*.

4. If you select the **Customize** option for any object, you can select either Flag or Flag & Auto-Fill for individual fields.
5. If you use Data.com Premium Clean and want to clean D&B Company records, select the Enable Clean jobs for D&B Companies checkbox.

6. If you want to clean account records using the D&B DUNSRight™ matching service, select that option in the account preferences section and adjust your confidence code if needed.

D&B’s Confidence Code ranks Data.com match candidates based on how similar they are to your record, from 1 (not similar) to 10 (identical or highly similar). We won’t automatically match any Data.com record below the code you select here, and if we have multiple records at or above your selection, we’ll match the best quality record. When you manually clean a record, you may be able to select a match between our preset confidence code (5) and the code you select here.

7. When you finish setting clean preferences for all the objects you want to clean, click Save.

Understanding Data.com Clean Account Matching Services

| Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions | Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions |

If you use Data.com Prospector or Data.com Clean, you can select the matching service your organization uses to clean account records. Here are your options:

- **Data.com matching** is the default matching service used by Data.com Clean. Matches are based on the Account Name, Billing Address, Website, and Phone fields.
- **DUNSRight matching** is D&B’s proprietary data-quality technology, which uses a rigorous process to normalize data and match D&B company records to your account records. The process also employs the D&B Confidence Code, which ranks Data.com match candidates based on how similar they are to your record, from 1 (not similar) to 10 (identical or highly similar). D&B also provides letter-coded match grades for individual fields. For details about how D&B DUNSRight matching works, see D&B Entity Matching.

### Matching Service

<table>
<thead>
<tr>
<th>Matching Service</th>
<th>Sync Behavior</th>
</tr>
</thead>
</table>
| Data.com matching | Based on the schedule you select, jobs will process only records of enabled objects that have Not Compared clean status (likely because Salesforce records have changed since the previous job was run). This is called an incremental sync.  
If you schedule jobs for at least one day of the week, the first time jobs run, and two weeks after the previous full sync job finishes, jobs will process all records of enabled CRM objects (accounts, contacts, and leads) even if no records have changed. This type of job is called a full sync, and it will run instead of the incremental sync at the same scheduled time. |
| D&B DUNSRight matching | Based on the schedule you select, jobs will process only records of enabled objects that have Not Compared clean status (likely because Salesforce records have changed since the previous job was run). This is called an incremental sync.  
If you use DUNSRight matching, you can schedule a full sync of your account records with Data.com’s the next time your account clean jobs run. The full sync job will run instead of the incremental sync. After the requested full sync runs, this option is turned off. You can turn it back on and run another full sync once every 30 days. |
Before selecting a matching service, consider the following:

- Changing the matching service might affect your organization's match rates.
- Neither matching service supports person accounts because person accounts are excluded from Clean jobs.
- If you'll be cleaning account records from non–English speaking countries, we recommend that you use D&B DUNSRight matching.
- Data.com Clean always uses the D-U-N-S Number field to match (or look up) accounts records. Any account record without a D-U-N-S Number will be matched using whichever matching service was selected (either Data.com matching or D&B DUNSRight matching).
- If, after changing matching services, you want to do a one-time rematch using the new matching service, you can manually remove the D-U-N-S Number on account records to force the matching service to rematch the records. Be aware that this might affect your match rates.
- If you use DUNSRight matching, for the D-U-N-S Number field you cannot map a custom field or skip mapping. We don't recommend mapping a custom field or skipping mapping for either matching service: Data.com matching or DUNSRight.
- After you select D&B DUNSRight matching, the initial match operation will take approximately one to two seconds per record. If your organization has a large number of account records that do not have a D-U-N-S Number, it may take several days to complete the process.
- To improve match rates when using D&B DUNSRight matching, be sure to include a valid state or province for US- and Canadian-based account records.
- D&B DUNSRight matching provides matching records for over 200 more countries than Data.com matching. DUNSRight matching does not support these countries and regions: Admiralty Islands; Åland Islands; Antarctica; Ascension Island; Bonaire; Bouvet Island; British Indian Ocean Territory; Caroline Islands; Cocos (Keeling) Islands; Cuba; Curacao; French Southern Territories; Guernsey; Heard Island and McDonald Islands; Isle of Man; Jersey; Korea, Democratic People’s Republic of; Mayotte; Micronesia, Federated States of; Midway Islands; Mongolia; Niue; Palau; Palestinian Territory Occupied; Pitcairn; Saint Barthélemy; Saint Eustatius and Saba; Saint Martin (French part); Sint Maarten (Dutch part); South Georgia; South Sandwich Islands; Svalbard and Jan Mayen; Timor Leste; Turkish Cyprus; United States Minor Outlying Islands; Wake Island; Wallis and Futuna; Western Sahara.

Selecting a Data.com Clean Matching Service for Account Records

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To implement Data.com:</td>
</tr>
<tr>
<td>“Customize Application”</td>
</tr>
</tbody>
</table>

Before you begin, make sure you understand the Data.com Clean matching services: what they offer, and how they work.

1. From Setup, click Data.com Administration > Clean > Preferences.
2. Select the matching service your organization will use to clean account records.
3. If you select the D&B DUNSRight matching service, you can adjust the Confidence Code.
The Confidence Code is a numeric code used to group similar quality matches. The higher the code, the better quality matches you'll see.

**Scheduling a Full Sync of Your Salesforce Account Records with Data.com (Data.com Clean Only)**

<table>
<thead>
<tr>
<th>Data.com Prospector license available in:</th>
<th>Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Clean license available in:</td>
<td>Professional, Enterprise, and Unlimited Editions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To schedule Data.com Clean jobs and view job history:</td>
</tr>
</tbody>
</table>

If you use the D&B DUNSRight Matching service, you can schedule a full sync of your account records with Data.com’s the next time your account clean jobs run. The full sync compares all of your account records with records from Data.com, and may find matches for records that were not matched during previous jobs. After the requested full sync has run, the option is turned off. You can turn it back on and schedule another full sync every 30 days. We’ll let you know when your full sync is in progress, or how long it’s been since your last full sync was run.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. Click the button next to Full Sync With Next Job to turn full sync On.

   After the requested full sync runs, the button changes to Off.

**Analyzing Data Quality with Data.com Data Assessments**

<table>
<thead>
<tr>
<th>Data.com Prospector license available in:</th>
<th>Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Clean license available in:</td>
<td>Professional, Enterprise, and Unlimited Editions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To install packages:</td>
</tr>
<tr>
<td>To run a Data.com data assessment:</td>
</tr>
<tr>
<td>To view a Data.com data assessment:</td>
</tr>
</tbody>
</table>

How many of your organization’s records can Data.com enrich with more and better data? Data.com Assessments can tell you. It can also identify how many of your records have been marked as Inactive in Data.com, and if you request, how many records in your Salesforce organization appear to be duplicates. Data assessments also list the fields on accounts, contacts,
and leads, and tell you how many are blank within your records and how many have different values from Data.com’s. (For example, you may have 10 account records in which the Phone field value is blank, or five contacts in which the Account Name field is blank.)

Data.com Data Assessments is a free AppExchange package. Work with your salesforce.com sales representative to get it for your organization.

1. Contact your salesforce.com sales rep to get Data Assessments.
2. Set up and run an assessment.
3. View your assessments.

**Installing and Implementing the Data.com Data Assessments AppExchange Package**

<table>
<thead>
<tr>
<th>Data.com Prospector license available in:</th>
<th>Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Clean license available in:</td>
<td>Professional, Enterprise, and Unlimited Editions</td>
</tr>
</tbody>
</table>

### User Permissions Needed

<table>
<thead>
<tr>
<th>Permission</th>
<th>Required Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>To install packages:</td>
<td>“Download AppExchange Packages”</td>
</tr>
<tr>
<td>To run a Data.com data assessment:</td>
<td>No permissions required</td>
</tr>
<tr>
<td>To view a Data.com data assessment:</td>
<td>No permissions required</td>
</tr>
</tbody>
</table>

1. Install the package using the link you received from salesforce.com. Contact your sales representative if you do not have a link.
2. Let your users know that Data.com Data Assessments is available.
Running Data.com Data Assessments

<table>
<thead>
<tr>
<th>Data.com Prospector license available in:</th>
<th>Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Clean license available in:</td>
<td>Professional, Enterprise, and Unlimited Editions</td>
</tr>
</tbody>
</table>

User Permissions Needed

<table>
<thead>
<tr>
<th>To run a Data.com data assessment:</th>
<th>No permissions required</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view a Data.com data assessment:</td>
<td>No permissions required</td>
</tr>
</tbody>
</table>

To run a data assessment, your organization must have the Data.com Data Assessments AppExchange app installed. Contact your salesforce.com sales rep if you need Data Assessments.

Data.com Data Assessments is a Salesforce AppExchange package that tells you how many of your organization’s records Data.com can enrich with more and better data. It can also tell you how many of your records have been marked as Inactive in Data.com, and if you request, how many records in your Salesforce organization appear to be duplicates. Data assessments also list the fields on accounts, contacts, and leads, and tell you how many are blank within your records and how many have different values from Data.com’s. Your organization can request one assessment every 30 days.

1. From the Force.com app menu, select Data.com Assessment to open the Data Assessment app.
2. Click the Data.com Assessment tab and define your assessment preferences.
3. Click Start My Assessment. We’ll tell you how long we expect it to take.

Viewing and Understanding Data.com Data Assessments

<table>
<thead>
<tr>
<th>Data.com Prospector license available in:</th>
<th>Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data.com Clean license available in:</td>
<td>Professional, Enterprise, and Unlimited Editions</td>
</tr>
</tbody>
</table>

User Permissions Needed

<table>
<thead>
<tr>
<th>To run a Data.com data assessment:</th>
<th>No permissions required</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view a Data.com data assessment:</td>
<td>No permissions required</td>
</tr>
</tbody>
</table>

When your Data.com data assessment is complete, you can take a look, and learn how Data.com can enhance your CRM records. You can also view previous assessments run by you or other users in your organization.

Tip:
- For more information about clean status values, including those provided in data assessments (In Sync, Different, and Inactive) see “Understanding Data.com Clean Status” in the Salesforce Help.
• To learn more about how Data.com matching works, check out our white paper: *Data.com Record Matching in Salesforce*.

1. If you need to, from the Force.com app menu, select *Data.com Assessments*.
2. Click the Data.com Assessment tab, then click the Assessments tab.
3. Click *View Assessments* next to the assessment you want.
4. Click through the assessment tabs. Here’s what you’ll find.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What it Tells You</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Breaks down the set of records we analyzed for the assessment. It tells you how many we can enrich with better data, how many records are likely to be inactive in Data.com and if you requested it when you ran the assessment, how many of your records are likely to be duplicates. We also tell you how many of your records were matched to Data.com records and how many were not.</td>
</tr>
<tr>
<td>Accounts</td>
<td>Breaks down the account records we matched, showing the number and percentage of records by status and identifying the match percentage. Data assessments also list Account fields and for a given field, tell you how many records have blank values for that field and how many have values that are different from Data.com’s. (For example, you may have 10 account records in which the <em>Phone</em> field value is blank.)</td>
</tr>
<tr>
<td>Contacts</td>
<td>Breaks down the contact records we matched, showing the number and percentage of records by status and identifying the match percentage. Data assessments also list Contact fields and for a given field, tell you how many records have blank values for that field and how many have values that are different from Data.com’s. (For example, you may have five contact records in which the <em>Account</em> field value is blank.)</td>
</tr>
<tr>
<td>Leads</td>
<td>Breaks down the lead records we matched, showing the number and percentage of records by status and identifying the match percentage. Data assessments also list Lead fields and for a given field, tell you how many records have blank values for that field and how many have values that are different from Data.com’s. (For example, you may have 12 lead records in which the <em>Title</em> field value is different from Data.com’s.)</td>
</tr>
<tr>
<td>Unmatched</td>
<td>Data.com’s matching algorithm uses key fields to identify matching records. This tab lists those fields, and shows you the number and percentage of blank field values within your unmatched records. Adding valid data to these fields will most likely improve your organization’s match results.</td>
</tr>
</tbody>
</table>

**Data.com Clean User**

Check out these new Data.com Clean user features for Summer ’13.

- **Now you can select a match for your Salesforce record.** If you use D&B’s DUNSRight Matching service (GA in Summer ’13) to match and clean your account records, we automatically match records according to a preset D&B confidence code, which your organization’s administrator selects. If we don’t have a record qualified for an automatic match, but we have identified one or more potential matches, we’ll set your record’s clean status to Select Match. This new clean status
lets you know you need to manually review match candidates and select one. After you select a match, you manually clean your Salesforce record in the usual way.

- **Wrong match?** If your organization uses D&B’s DUNSRight Matching service (GA in Summer ’13), and you believe an account record has been matched incorrectly to a Data.com record, you may be able to match it to a different Data.com record. Start by cleaning the record, then select a different match from the match candidates we show you on the select match page. Then manually clean your Salesforce record in the usual way.

Selecting a Matching Record from Data.com

Data.com Prospector license available in: **Contact Manager** (no Lead object), **Group**, **Professional**, **Enterprise**, and **Unlimited** Editions

Data.com Clean license available in: **Professional**, **Enterprise**, and **Unlimited** Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To clean account records:</td>
</tr>
<tr>
<td>To clean contact records:</td>
</tr>
<tr>
<td>To clean lead records:</td>
</tr>
</tbody>
</table>

**Select a Data.com Match for your Salesforce Account Record** (0:47 minutes)

If your organization uses D&B’s DUNSRight Matching service to match and clean your account records, we automatically match records according to a preset D&B confidence code, which your administrator selects. If we don’t have a record qualified for an automatic match, but we have identified one or more potential matches, we’ll set your record’s clean status to Select Match. This clean status lets you know you need to manually review match candidates and select one. After you select a match, you manually clean your Salesforce record in the usual way.
1. If you need to select an initial match, from the record, click the Select Match clean status value, then click Select Account from Data.com. On the select match page, you’ll see up to five match candidates, with the most similar record at the top.

2. Review the candidates. Hover over any candidate’s gray match grade bar to view the record’s D&B DUNSRight match information, including its confidence code and match grade details (if available). The blue match grade legend shows D&B code letters that correspond to these fields in your account record, in this order left to right:

   Account Name or Tradestyle | Street Number | Street Name | City | State / Province | Mailing Address / PO Box | Phone

3. Click any code letter to see the field name and an explanation.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Values either match exactly or are similar enough that they should be considered to match.</td>
</tr>
<tr>
<td>B</td>
<td>Values are similar. Values are similar. In some cases, when Data.com and D&amp;B data are updated at different times, if a field on the D&amp;B record is blank, the match grade letter will indicate that the field values are similar (B) instead of blank (Z).</td>
</tr>
<tr>
<td>F</td>
<td>Values do not match.</td>
</tr>
<tr>
<td>Z</td>
<td>Value is blank in one or both of the records. Value is blank in one or both of the records. When the State value is blank within a D&amp;B record, the Street field value is normalized to be blank. In these cases, both fields are colored gray in the match grade legend and the match grade for each is Z.</td>
</tr>
</tbody>
</table>

4. Highlight the match you want, then click Select and Proceed to Clean. If you don’t find a match you want, click Cancel; your record’s status will remain Select Match.

5. Clean the record.

The record’s Clean Status field is updated.

For example: your organization’s D&B Confidence Code setting is 9. You open your United Technologies account record to find that its Clean Status field value is Select Match. You click the status value to open the select match page. There you see four match candidates from Data.com. You hover over the match grade bar for the top candidate: United Technologies Corporation. In the popup, you see that the United Technology record’s confidence code is 8. The match grade legend shows these letters: B A A B A A Z. You know that A means the values should be considered to match, so you check out the values that do not.

You click the first B and see that the Account Name field values are similar, but not a clear-cut match: your record’s Account Name value does not include Corporation while the Data.com record’s Account Name value does. You click the second B and find that your record’s City value is Francisco while the Data.com record’s City value is San Francisco. So... similar, but not an exact match. You click Z and see that your record’s Phone value is blank. The Data.com record’s Phone value is +1.415.901.7000.

The Data.com United Technologies Corporation record looks like the one that matches your United Technologies record, so you select it, then click Select and Proceed to Clean. On the comparison page, you click Select All to accept all of the Data.com record’s values, including the Account Name, City, and Phone values that were different or blank in your record. You click Save and your record’s clean status changes to In Sync. Awesome.
Selecting a Different Data.com Match for a Salesforce Account Record

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

To clean account records: “Edit” on accounts

Select a Data.com Match for your Salesforce Account Record (0:47 minutes)

If your organization uses D&B’s DUNSRight Matching service, and you believe an account record has been matched incorrectly to a Data.com record, you may be able to match to a different Data.com record. After you select a new match, you manually clean your record in the usual way.

1. Open the record and click Clean
2. On the comparison page, click Wrong match?
3. Select a different Data.com record, if one or more are available.
4. Click Select and Proceed to Clean

Understanding D&B Match Grades

Use D&B match grades to help you decide which record is the right one when selecting a match. Hover over any candidate’s gray match grade bar to view the record’s D&B DUNSRight match information, including its confidence code and match grade details (if available). The blue match grade legend shows D&B code letters that correspond to these fields in your account record, in this order left to right: Account Name or Tradestyle | Street Number | Street Name | City | State / Province | Mailing address / PO Box | Phone

<table>
<thead>
<tr>
<th>Letter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Values either match exactly or are similar enough that they should be considered to match.</td>
</tr>
<tr>
<td>B</td>
<td>Values are similar. In some cases, when Data.com and D&amp;B data are updated at different times, if a field on the D&amp;B record is blank, the</td>
</tr>
</tbody>
</table>
### Definition

<table>
<thead>
<tr>
<th>Letter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match grade letter will indicate that the field values are similar (B) instead of blank (Z).</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Values do not match.</td>
</tr>
<tr>
<td>Z</td>
<td>Value is blank in one or both of the records. When the State value is blank within a D&amp;B record, the Street field value is normalized to be blank. In these cases, both fields are colored gray in the match grade legend and the match grade for each is Z.</td>
</tr>
</tbody>
</table>

### ADDITIONAL DATA.COM CLEAN ENHANCEMENTS

#### Streamlined and Enhanced Clean Job History

We've streamlined Data.com Clean job history to provide more detail right on the page. You only need to view error logs if you have entity or batch errors, and we've broken out each type of error into its own log. If your organization uses Data.com Social Key (Beta in Summer ’13) to find and associate social handles for your contact and lead records, you’ll find a new Social Key Job Logs column in the Clean Jobs History table.

#### Correct Calculation for Update Rate

We’ve corrected the calculation we use for the Update Rate column on the Clean Metrics and Analytics page. The previous calculation for the update rate was the percentage of matched records. In Summer ’13, the calculation is the percent of processed records. Organizations that previously saw update rates higher than 100% will now see accurate update rates.

#### DATA.COM SOCIAL KEY—BETA

#### Data.com Social Key Overview—Beta

Social Key available in: Professional, Enterprise, and Unlimited Editions

Note:
This release contains a Beta version of Data.com Social Key that is production quality but has known limitations.
Data.com Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to learn more about your contacts and leads right within Salesforce or on social network sites.

From Social Accounts and Contacts, select the social networks you want. From Data.com Clean, enable and schedule automated clean jobs. During Clean jobs, the Social Key process finds and associates social handles for your contacts and leads. Social Key currently provides social handles for LinkedIn®, Twitter®, and Facebook®, for contacts and leads in the United States only.

Users can log in to a social network from a contact or lead’s detail page and view the associated profile from within the Social Accounts and Contacts viewer. There’s no manual search required. If we’ve found more than one potential profile for a contact or lead, we’ll let users view and associate the one they want.

Your organization must have Data.com Clean enabled to use Social Key.

**Note:** Depending on contacts’s and leads’ privacy settings, as well as the permissions set by their friends or connections and the site’s terms of use, users may not see as much information as they would if logged directly into their social network accounts.

## Implementing Social Key

| Social Key available in: Professional, Enterprise, and Unlimited Editions |

<table>
<thead>
<tr>
<th><strong>User Permissions Needed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>To implement Social Key:</td>
</tr>
</tbody>
</table>

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads on social networks. From Social Accounts and Contacts, select the social networks you want. During Clean jobs, the Social Key process finds and associates social handles for your contacts and leads. From a contact or lead’s detail page, you can quickly view their profile within Salesforce or on a social network site. Social Key currently provides social handles for LinkedIn®, Twitter®, and Facebook®, for contacts and leads in the United States only.

If you want to participate in our Beta program, just let us know. When you’re ready to set up Social Key, here’s what you need to do.

1. **Enable Social Key.**
2. If you haven’t yet, enable Social Accounts and Contacts and select the social networks you want to get social profiles from.
3. **Make sure your Data.com Clean settings, preferences, and job schedule are configured for Social Key.**
4. **After jobs have run, you can check out their Social Key job logs.**
Enabling Social Key

Social Key available in: **Professional, Enterprise, and Unlimited Editions**

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To implement Social Key:</td>
</tr>
</tbody>
</table>

1. From Setup, click **Data.com Administration > Social Key > Settings.**
2. Click **Enable Social Key.**

If you also need to enable and set up Social Accounts and Contacts, we’ll let you know after you enable Social Key.

Enabling and Configuring Social Accounts and Contacts

| Business accounts available in: **All Editions except Database.com** |
| Person accounts available in: **Enterprise, Unlimited, and Developer Editions** |
| Contacts available in: **All Editions except Database.com** |
| Leads available in: **Group, Professional, Enterprise, Unlimited, and Developer Editions** |
| Data.com Clean available in: **Developer, Enterprise, and Professional editions** |
| Data.com Clean available for an additional cost in: **Unlimited Edition** |
| Social Key available in: **Developer, Enterprise, and Professional, and Unlimited editions** |

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable, configure, or disable Social Accounts and Contacts:</td>
</tr>
</tbody>
</table>

Enable Social Accounts and Contacts so your users can keep up to date on their accounts’, contacts’, and leads’ social information—right within Salesforce. After you enable the feature, select the networks your organization can use. Your organization’s users can also configure Social Accounts and Contacts for their own use: they can turn the feature on and off and select the networks they want.

If your organization also uses Data.com Social Key (Beta in Summer ’13), enable that feature to get your contacts’ and leads’ social handles automatically when you run Clean jobs.

**Note:** The Social Accounts and Contacts feature is enabled by default for organizations created after the Spring ’12 release. If your organization was created before that, you need to enable the feature yourself.

1. From Setup, click **Customize > Social Accounts and Contacts > Settings.**
2. Select **Enable Social Accounts and Contacts.**
3. Select the social networks that your organization can use. By default, all social networks are selected.
4. Click **Save.**
5. Let your users know they can configure Social Accounts and Contacts for their individual use. Enable Social Key if your organization will use it.

### Configuring Data.com Clean for Social Key

<table>
<thead>
<tr>
<th>Social Key available in: Professional, Enterprise, and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Permissions Needed</td>
</tr>
<tr>
<td>To implement Social Key: “Customize Application”</td>
</tr>
</tbody>
</table>

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads on social networks. From Social Accounts and Contacts, select the social networks you want. The Social Key process runs during your automated Clean jobs, so to use Social Key, you need to make sure Clean is enabled, and select and schedule the jobs you'll need.

When you enable Social Key, the next scheduled Clean job will run a full sync with Data.com for the objects you’ve enabled for clean jobs (contacts, leads, or both). Social Key will provide social handles at regular intervals after that, at the same time as your Clean jobs. For example, if you run your clean jobs once per week, on Wednesday, the Social Key job will do a full sync every other Wednesday.

**Note:** If a Clean job fails, the Social Key process fails, as well. To view Clean job history and Social Key job logs, from Setup, click **Data.com Administration > Clean > Jobs.**

If you need guidance on setting up Data.com Clean or verifying your preferences or settings, just click **Help for this Page** on any Clean setup page.

1. From Setup, click **Data.com Administration > Clean > Settings.**
2. Confirm that Data.com Clean is enabled.
3. From Setup, click **Data.com Administration > Clean > Preferences.**
4. Confirm that Clean jobs are enabled for the objects for which you want to get social handles. We provide them for contacts and leads.
5. From Setup, click **Data.com Administration > Clean > Jobs.**
6. Confirm that Clean jobs are scheduled.
Viewing Social Key Job Logs

Social Key available in: Professional, Enterprise, and Unlimited Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To implement Social Key:</td>
</tr>
</tbody>
</table>

Data.com Social Key runs a process during automated Data.com Clean jobs to find and associate social handles for contacts and leads. You can view Social Key job logs, if any are produced, from the Data.com Clean Jobs page. If a Clean job fails, the Social Key process fails, as well.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. Review general Clean job history if you need to.
3. If the Clean job processed one or more records, with or without errors, click the View link in the Social Key Job Logs column to download the job log .csv file.

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Definition and Troubleshooting Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records</td>
<td>The number of Salesforce records processed by the Clean job.</td>
</tr>
<tr>
<td>Records with Handle</td>
<td>The number of Salesforce records processed for which the job attempted to append one or more social handles.</td>
</tr>
<tr>
<td>Records without Handle</td>
<td>The number of Salesforce records processed for which the job appended no social handles.</td>
</tr>
<tr>
<td>LinkedIn Handles</td>
<td>The number of LinkedIn social handles the job attempted to append to Salesforce records.</td>
</tr>
<tr>
<td>Twitter Handles</td>
<td>The number of Twitter social handles the job attempted to append to Salesforce records.</td>
</tr>
<tr>
<td>Facebook Handles</td>
<td>The number of Facebook social handles the job attempted to append to Salesforce records.</td>
</tr>
<tr>
<td>Errors</td>
<td>The number of errors the job encountered while attempting to find or append social handles to the Salesforce records processed.</td>
</tr>
<tr>
<td>Error Message</td>
<td>An explanation of any error the Social Key process produced.</td>
</tr>
</tbody>
</table>
Defining Your Social Accounts and Contacts User Settings

<table>
<thead>
<tr>
<th>Available in:</th>
<th>All Editions except Database.com</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business</td>
<td>Editions except <strong>Database.com</strong></td>
</tr>
<tr>
<td>Person</td>
<td><strong>Enterprise</strong>, <strong>Unlimited</strong>, and <strong>Developer</strong> Editions</td>
</tr>
<tr>
<td>Contacts</td>
<td>All Editions except <strong>Database.com</strong></td>
</tr>
<tr>
<td>Leads</td>
<td><strong>Group</strong>, <strong>Professional</strong>, <strong>Enterprise</strong>, <strong>Unlimited</strong>, and <strong>Developer</strong> Editions</td>
</tr>
<tr>
<td>Data.com Clean</td>
<td><strong>Developer</strong>, <strong>Enterprise</strong>, and <strong>Professional</strong> editions</td>
</tr>
<tr>
<td>Social Key</td>
<td>in: <strong>Developer</strong>, <strong>Enterprise</strong>, and <strong>Professional</strong>, and <strong>Unlimited</strong> editions</td>
</tr>
</tbody>
</table>

If the Social Accounts and Contacts feature is enabled for your organization, you can customize it so it works the way you want it to. You can also turn the feature off if you don’t want to use it.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select **Setup** or **My Settings**—whichever one appears.
2. From the left pane, select one of the following:
   - If you clicked **Setup**, select **My Social Accounts and Contacts > Settings**.
   - If you clicked **My Settings**, select **Display & Layout > My Social Accounts and Contacts**.
3. Set up Social Accounts and Contacts so it works the way you want it to.
4. Click **Save**.

Viewing and Associating Your Contacts' Social Network Profiles

| Available in:  | All Editions except Database.com |

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To find and link social network profiles to contact records: “Edit” on contacts</td>
</tr>
<tr>
<td>To view a contact's social network profiles: “Read” on contacts</td>
</tr>
</tbody>
</table>

View your contacts’ social network profiles right from a record’s detail page. It’s easy. Social Accounts and Contacts lets you find your customers’ LinkedIn, Twitter, and Facebook profiles (if available) and associate them with your contact records, then view them directly from contact detail pages. Other users who can view the contact record can also view the profile. If your organization uses Data.com Social Key (Beta in Summer ’13), we provide the links automatically (if available) for LinkedIn, Twitter, and Facebook.
Viewing and Associating Your Leads' Social Network Profiles

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To find and link social network profiles to lead records:</td>
<td>“Edit” on leads</td>
</tr>
<tr>
<td>To view a lead’s social network profiles:</td>
<td>“Read” on leads</td>
</tr>
</tbody>
</table>

View your leads' social network profiles right from a record’s detail page. It’s easy. Social Accounts and Contacts lets you find your customers’ LinkedIn, Twitter, and Facebook profiles (if available) and associate them with your lead records, then view them directly from lead detail pages. Other users who can view the lead record can also view the profile. If your organization uses Data.com Social Key (Beta in Summer ’13), we provide the links automatically (if available) for LinkedIn, Twitter, and Facebook.

**Note:** Depending on contacts’s and leads' privacy settings, as well as the permissions set by their friends or connections and the site’s terms of use, users may not see as much information as they would if logged directly into their social network accounts.

1. From the lead’s detail page, click the icon for the social network where you want to view the lead’s profile (LinkedIn, Twitter, Facebook, YouTube, Google+).
2. If you need to, from the Social Accounts and Contacts viewer, sign in to that social network.
3. If you haven’t yet associated a profile for the lead, select the one you want from those we show you. Viewing a profile automatically associates it with the lead. If you use Social Key, your record may have a profile already associated.
4. If you need to associate a different profile, click **Find Different Profile**.

5. If you want to view the lead’s profiles on other social networks, just click their tabs in the viewer.

6. You can also:

   - Click **Show Photo in Salesforce** to display the lead’s profile picture on the lead detail page. When Social Key finds a LinkedIn handle for a lead, it automatically displays that image on the lead’s detail page. You can choose a different photo (including photos from Twitter or Facebook) if you wish.
   - Click **View Full Profile** to see the lead’s complete social network profile directly in the social network.
   - Click **Sign Out** to close the private connection between Salesforce and your social network account. When you do this, you’re unable to see your lead’s social network profiles until you sign in again.
Name and Behavior Changes for User Roles

The “publisher” user role has been renamed “site administrator,” as a user who has this role at the site level can manage all aspects of that site, including adding users, managing domains, and publishing the site.

We’ve also streamlined how user roles are managed. Previously, to add users and assign roles at the site level, you needed the Site.com Publisher feature license and the “Manage Users” permission. Now, the ability to manage Site.com users has changed in two ways:

- A user with the site administrator role at the site level can manage that site’s users, with no need for the “Manage Users” permission.
- A user with the “Manage Users” permission and either a Site.com Publisher or a Site.com Contributor feature license can manage users in any site.

Users can have one of three roles at the site level:

- Site administrator—Site administrators are users who can create and manage all site content. They can create sites, templates, style sheets, and pages, and also set up domains, publish sites, and assign user roles. This role requires the Site.com Publisher feature license.
- Designer—Designers have the same control over site content as site administrators, but they can’t manage domains or publish sites. By default, they can’t assign roles unless they have the “Manage Users” permission. This role requires the Site.com Publisher feature license.
- Contributor—Contributors have the most restricted access to content and can typically just edit page text and images. By default, they can’t assign roles unless they have the “Manage Users” permission. This role requires the Site.com Contributor feature license.

IP Restrictions—Generally Available

Now generally available in Summer ’13, IP restrictions give site administrators control over who can access Site.com sites. Whether you want to restrict access to the entire site or to specific items, IP restrictions let you do just that. Every computer
has a unique IP address that it uses to identify itself. Using the new IP Restrictions view on the Overview tab, you can define a range of permitted IP addresses to limit site visitors’ access to the pages, page templates, folders, and assets in your site.

For example, let’s say you have a site page that lists all employees by department. You don’t want people outside your organization to view this sensitive information. By restricting the permitted IP addresses to your organization’s IP range—say, 112.122.0.1 to 112.122.0.123—you ensure that no other site visitors can view the page.

See “IP Restrictions Overview” in the Salesforce Help.

## Custom Widgets

| Available for purchase in: Enterprise and Unlimited Editions |
| Available (with limitations) in: Developer Edition |

Ever thought about building your own page elements? With the new widgets feature, you can! Save time by combining existing page elements, custom code, and CSS to create completely custom, reusable widgets. We’ve added a new Widgets view to the Overview tab, where you can access and manage the site’s widgets.

When you create a widget, it’s also added to the Page Elements pane, where other site administrators and designers can easily drag it onto the page. And if you edit an existing widget, your changes are automatically reflected in any widgets on the page, saving you even more time.

For example, to ensure a consistent look and feel across all your pages, you could create a corporate header widget comprised of a panel that contains your company logo, a menu, and the company name. Or you could use the custom code page element to create reusable social-plugin widgets, such as Like or Follow buttons from Facebook, or a Twitter feed.

See “Widgets Overview” in the Salesforce Help.
Authorizing Site.com Pages for Communities

You can now control what content is public and private on your Site.com Communities site. New sites are initially set so that all site resources, such as folders and pages, are public. You can change the default setting from the Authorization page found under Site Configuration.

The global site authorization options are:

- **No Authorization** (default)—All resources are public.
- **Requires Authorization**—All resources are private.
- **Custom**—All resources are public by default, but can be made private.

When you select Custom Authorization, you get a great deal of flexibility in controlling access to your site. Not only can you control who has access to top-level resources like folders and pages, but you can also set access at the individual-resource level.

Using Custom Authorization at the folder level is a great way to make a large number of assets private without having to mark them individually. Let's say you periodically run special offers for your paid users. If you drag all the sale pages into a folder you mark for authorization, you don't need to mark them individually. Users will need to log in to access them. Plus, if you decide to make one of the sale pages available to everyone, you can simply drag it back into a public folder, or to the root of the All Site Content area.

Branded Site.com Pages for Communities

When you create a new community, Salesforce automatically creates a new Site.com site for you as well. This associated site includes a branded Community template that you can begin using immediately to create Site.com pages. The site also includes a Community style sheet that contains a set of CSS properties you can use to style Site.com pages.

**Branded Community Template**

Site.com Community sites include a branded template that you can use to create custom pages for your community. The Community Template uses CSS from the CommunityBranding style sheet that's automatically included in all Site.com Community sites. The Community Template is available as an option whenever you create a new page from a template. The CommunityBranding style sheet is listed with all of your other CSS style sheets in the Style Sheets category of the Site.com Overview tab.

Site.com also creates branded community header and footer widgets for you. The community header and footer widgets brand the Community Template. You can also drag the header or footer widgets to any community Site.com page from the Widgets section of the Page Elements pane.
Community Branded CSS Styles

Branded Community styles are available in Site.com through Network namespace expressions. A number of these expressions form the basis of the rules in the CommunityBranding style sheet that's attached to the Community Template. You can also access the full list of Network namespace expressions to create new styles in another CSS style sheet. When you add an expression to a new CSS rule, Site.com “pulls in” the style as it's defined in the community, and displays it on your page.

See “Creating Branded Pages Overview” in the Salesforce Help.

Current Community User Information

<table>
<thead>
<tr>
<th>Available for purchase in:</th>
<th>Enterprise and Unlimited Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available (with limitations) in:</td>
<td>Developer Edition</td>
</tr>
</tbody>
</table>

Community users who create authenticated Site.com pages for a community can display the current user's information by accessing CurrentUser namespace expressions. You can use these expressions to personalize a Site.com community page. For example, you can add the {!CurrentUser.firstName} expression to a content block or a custom code block. You can then type Hello before the expression, so that the page displays “Hello John” as the welcome message.

See “Displaying Current Community User Information” in the Salesforce Help.
Improved Setup User Interface

Available in: All editions except Database.com

💡 You asked for it! This enhancement is from two ideas on the IdeaExchange.

The improved Setup user interface provides a streamlined interface for viewing and managing personal and administrative setup tasks. When the improved Setup user interface is enabled, you’ll see these changes:

- The Setup menu is accessed via the Setup link at the top of any Salesforce page.

  ![Setup menu](image)

  The Setup menu is organized into goal-based categories: Administer, Build, Deploy, Monitor, and Checkout.

  As before, to quickly find a page, type the first few characters of its name in the Quick Find box. For example, to find the Sandbox page in its new location, type sand in the Quick Find box, then select Sandbox.

  - Personal settings, which all Salesforce users can edit, are available in a separate My Settings menu. To access My Settings, click your name at the top of any Salesforce page, then click My Settings.

    The My Settings menu is organized into simple categories that you can expand and collapse to see different settings. The My Settings home page includes quick links for easily accessing the most commonly used personal settings.
Like the Setup menu, the My Settings menu also has a **Quick Find** box so you can easily find the page you want. Type the first few characters of a page name in the **Quick Find** box. As you type, pages that match your search terms appear in the menu. For example, to find the Personal Information page, type `pers` in the **Quick Find** box.

The improved Setup user interface is enabled by default in organizations created in the Summer '13 release or later. It is not enabled by default in existing organizations, but can be enabled by an administrator.

**Note:** If the improved Setup user interface is disabled in a Trialforce source organization, it will also be disabled in any organization created from the Trialforce source organization.

The improved Setup user interface is not supported in Internet Explorer version 6.

### Enabling the Improved Setup User Interface

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To edit user interface settings:</td>
</tr>
</tbody>
</table>

When enabled, the improved Setup user interface is activated for every user in an organization. You can enable or disable the improved Setup user interface; the setting functions as a toggle rather than a permanent switch.
Note: You can’t enable the improved Setup user interface if the new user interface theme is disabled.

1. As appropriate, inform your organization of the planned changes to Setup and personal settings.
2. From Setup, click Customize > User Interface.
3. Select Enable Improved Setup User Interface.
4. Click Save.

Developer Console Redesign

<table>
<thead>
<tr>
<th>Available in: Unlimited, Developer, Enterprise, and Database.com Editions</th>
</tr>
</thead>
</table>

**User Permissions Needed**

| To use the Developer Console: | “View All Data” |

The Developer Console includes the following enhancements in Summer ’13. For detailed information on these enhancements, refer to the Developer Console section in the online help.

Developer Console New Look and Feel

The Developer Console user interface has been completely redesigned in the Summer ’13 release. The new UI is more flexible and easier to use.
The new UI is organized into the following sections:

1. **Menubar** with the following drop-down menus:
   - **File**: Allows you to open and create resources. The menu replaces the Repository tab from previous versions.
   - **Debug**: Provides access to a range of tools and settings. This menu includes the Execute Anonymous functionality that was found in the top bar in previous releases.
   - **Test**: Provides access to testing tools.
   - **Workspace**: Allows you to choose and manage workspaces.
   - **Help**: Includes links to the online help, a reference page of shortcut keys and a collection of guided tours.

2. **Workspace** with a tab for each open item, including:
   - Apex classes and triggers and Visualforce pages and components open in the Source Code Editor.
   - Logs open in the Log Inspector, previously called System Log View.
   - Checkpoints open in the Checkpoint Inspector, previously called Heap Dump Inspector.
   - Organization metadata and other non-code resources open in the Object Inspector, previously called Schema Quick View.

3. **Logs, Tests, and Problems panel** with a collection of useful tabs:
   - The Logs tab displays available logs.
   - The Tests tab displays available tests.
   - The Checkpoints tab displays available checkpoints, called “heap dumps” in previous versions.
   - The Query Editor tab allows you to execute a SOQL query on the data in your organization.
The Progress tab displays all asynchronous requests in real time.
The Problems tab shows the details of any compilation errors.

Apex Code Completion

The Source Code Editor in the Developer Console now provides autocomplete for Apex code. Completions are provided for Apex system objects and methods, user-defined objects and methods, and sObjects and fields.

As you type in the Source Code Editor, click CTRL+SPACE to open a popup window with a list of suggested completions. Keep typing to filter the suggestions, press ENTER to select the top completion, or use the arrow keys or mouse to select a different completion.

Note: Completions are gathered from the object you are currently working on. If you don’t see the completion you expect, save the open object and refresh. The object’s type is determined by the current editor’s symbol table. If there are no symbols that match, cached symbol tables (the last valid save) are also checked. If there is no current object, the autocomplete window shows all system and user classes, as well as sObjects.

Highlighting in the Source Code Editor

The Developer Console Source Code Editor now includes expanded highlighting for JavaScript and comments within a Visualforce page.

Force.com Canvas—Generally Available

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

In this release, Force.com Canvas is generally available. The version of the Force.com Canvas SDK is 28.0.
Force.com Canvas enables you to easily integrate a third-party application in Salesforce. Force.com Canvas is a set of tools and JavaScript APIs that you can use to expose an application as a canvas app. This means you can take your new or existing applications and make them available to your users as part of their Salesforce experience.

Summer ’13 enhancements include the following:

• General availability.
• Support for more Salesforce editions.
• Ability to specify user access to canvas apps by using profiles and permission sets.
• Canvas apps now distributed by using the standard packaging process.
• User permissions are required to create a canvas app and view it in the Canvas App Previewer.
• Profile permissions are required for users to run a canvas app.
• New objects and fields.
• Ability to resize a canvas app.
• Ability for canvas apps on a page to communicate by using events.
• The Force.com Canvas SDK is hosted on Salesforce.
• Ability to specify where a canvas app appears to the user.
• Additional Force.com Canvas enhancements.

For more information, see the Force.com Canvas Developer’s Guide.

### Supported Salesforce Editions

Force.com Canvas supports these Salesforce Editions:

<table>
<thead>
<tr>
<th>Edition</th>
<th>Create a canvas app</th>
<th>Publish a canvas app</th>
<th>Install a canvas app</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlimited Edition</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Enterprise Edition</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Professional Edition</td>
<td>No</td>
<td>No</td>
<td>Yes*</td>
</tr>
<tr>
<td>Professional Edition with API and Force.com Canvas enabled</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Developer Edition</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Professional Edition organizations must have Force.com Canvas enabled in order for a canvas app to appear on the Chatter tab.*
Specify Users That Can Access a Canvas App

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

Administrators now have fine-grained control over which users can access which canvas apps. Regardless of whether a canvas app uses OAuth where the user accepts or denies the canvas app, or it uses a signed request where access is pre-approved for specific users—administrators can explicitly set which users can access a canvas app. You define who can access a canvas app in the app policies by setting the Permitted Users field and then specifying profiles and perm sets.

Warning: All canvas apps created before the Summer '13 release were available by default to all users. After the Summer '13 release, if your canvas app meets certain conditions, users won’t be able to access it until you explicitly set user permissions. Read the following section to verify whether you’ll need to set user access on your existing canvas apps.

Setting User Access

If your existing canvas app meets the following conditions, then users won’t be able to access it after the Summer '13 release.

- It was created before the Summer '13 release.
- It uses signed request authentication.
- The Permitted Users field is set to All users may self-authorize.

If your canvas app meets these conditions, follow these steps to give users access to it.

1. From Setup, navigate to Manage Apps > Connected Apps.
2. Click the name of the canvas app to open the detail screen.
3. Click Edit.
4. In the Permitted Users field, select Admin-approved users are pre-authorized and click Save.
5. In the Profiles and Permission Sets related lists, specify which users can access the canvas app by adding profiles or permission sets.

Canvas Apps Distributed Using Managed Packages

Available in: Developer Editions

Starting in Summer '13, canvas apps are distributed by using managed packages. To distribute a canvas app, you include it as a component in a managed package within a Developer Edition organization. After you include your canvas app in a managed package, you follow the standard packaging process to distribute, upload, install, and manage it. For more information about packaging, see Packaging Connected Apps and the ISVforce Guide.

The ability to include canvas apps in a managed package means you can distribute and sell your canvas apps to customers using the AppExchange.
User Permissions Required

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

The following user permissions are required to create and manage canvas apps, and view them in the Canvas App Previewer:

- Customize Application
- Modify All Data

Note: Professional Edition organizations don’t have custom profiles, so the system administrator is the only user who can create and manage canvas apps, or view them in the Canvas App Previewer.

Profile Permissions Required

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

For a user to run an installed canvas app, the API Enabled field must be selected on the user’s profile. From Setup, navigate to Manage Users > Profiles. The API Enabled field is in the Administrative Permissions section.

SDK Object and Field Changes

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

The following changes have been made to the objects and fields in the Force.com Canvas SDK.

- New Application object that contains information about a specific canvas app.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>applicationId</td>
<td>The ID of the canvas app.</td>
</tr>
<tr>
<td>authType</td>
<td>The access method of the canvas app. You specify this value when you expose the canvas app by creating a connected app.</td>
</tr>
<tr>
<td>canvasUrl</td>
<td>The URL of the canvas app, for example: <a href="http://instance.salesforce.com:8080/canvas_app_path/canvas_app.jsp">http://instance.salesforce.com:8080/canvas_app_path/canvas_app.jsp</a>.</td>
</tr>
<tr>
<td>developerName</td>
<td>The internal name of the canvas app. You specify this value in the API Name field when you expose the canvas app by creating a connected app.</td>
</tr>
<tr>
<td>name</td>
<td>The name of the canvas app.</td>
</tr>
<tr>
<td>namespace</td>
<td>The Salesforce namespace prefix associated with the canvas app.</td>
</tr>
</tbody>
</table>
The version of the canvas app. This value changes after you update and re-publish a canvas app in an organization.

```
"application":
{
   "applicationId":"06Px000000003ed",
   "authType":"SIGNED_REQUEST",
   "canvasUrl":"http://instance.salesforce.com:8080/canvas_app_path/canvas_app.jsp",
   "developerName":"my_java_app",
   "name":"My Java App",
   "namespace":"org_namespace",
   "version":"1.0.0"
}
```

- The Dimensions object now contains `maxHeight` and `maxWidth` fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>version</td>
<td>The version of the canvas app. This value changes after you update and re-publish a canvas app in an organization.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>height</td>
<td>The height of the iFrame in pixels.</td>
</tr>
<tr>
<td>width</td>
<td>The width of the iFrame in pixels.</td>
</tr>
<tr>
<td>maxHeight</td>
<td>The maximum height of the iFrame in pixels.</td>
</tr>
<tr>
<td>maxWidth</td>
<td>The maximum width of the iFrame in pixels.</td>
</tr>
</tbody>
</table>

```
"dimensions":
{
   "height": "900px",
   "width": "800px",
   "maxHeight": "2000px",
   "maxWidth": "1000px"
}
```

- New `displayLocation` field added to the Environment object. This field returns the location in the application where the canvas app is currently being called from.

```
"environment":
{
   "parameters":{},
   "dimensions":
   {
      "height": "900px",
      "width": "800px",
      "maxHeight": "2000px",
      "maxWidth": "1000px"
   },
   "displayLocation": "Chatter",
   "locationUrl": "http://www.salesforce.com/some/path/index.html",
   "uiTheme": "Theme3",
   "version":
   {
      "api": "28.0",
      "season": "SUMMER"
   }
}```
• The `loginUrl` field has been added to the Links object. This field returns the URL of the login server for the instance the context user is logged into.

• The User object now contains these new fields:
  ◊ `isDefaultNetwork`—For the context user, indicates whether the user is in a community (`true`) or not (`false`).
  ◊ `networkId`—The ID of the context user’s currently logged-in community.
  ◊ `siteUrl`—The URL of the context user’s currently logged-in community.
  ◊ `siteUrlPrefix`—The URL prefix of the context user’s currently logged-in community.

```json
"user": {
  "accessibilityModeEnabled":false,
  "currencyISOCode":"USD",
  "email":"admin@6457617734813492.com",
  "firstName":"Sean",
  "fullName":"Sean Forbes",
  "isDefaultNetwork":false,
  "language":"en_US",
  "lastName":"Forbes",
  "locale":"en_US",
  "networkId":"0DBxx000000001r",
  "profileId":"00ex0000000jzpt",
  "profilePhotoUrl": "/profilephoto/005/F",
  "profileThumbnailUrl": "/profilephoto/005/T",
  "roleId":null,
  "siteUrl":"https://mydomain.force.com/",
  "siteUrlPrefix": "/mycommunity",
  "timeZone":"America/Los_Angeles",
  "userId":"005x0000001SyyEAAS",
  "userName":"admin@6457617734813492.com",
  "userType":"STANDARD"
}
```

• The `namespacePrefix` field has been added to the Organization object. This field returns the Salesforce namespace prefix associated with the canvas app.

• The `clientId` field has been removed from the Client object.

### Resize a Canvas App

**Available in:** Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

In this release, there are now new methods for resizing a Force.com Canvas app.

• **autogrow**—Starts or stops a timer that checks the content size of the canvas iFrame and adjusts the frame.

• **resize**—Informs the parent window to resize the canvas iFrame.

• **size**—Returns the current size of the canvas iFrame.

• **subscribe**—Subscribes to parent events. Currently, `canvas.scroll` (of the parent) is the only supported event.
Canvas App Events

Available in: Enterprise, Unlimited, Professional (with API and Force.com Canvas enabled), and Developer Editions

Events provide a JavaScript-based way to send and receive events between canvas apps. Use events to enable communication between multiple canvas apps on a single page.

One scenario might be a page on which you expose two custom apps as canvas apps: a travel and expense app, and an approvals app. You can create an event so that when the status of an expense report changes, that event gets raised and contains data (in JSON format) about that expense report. The approvals canvas app subscribes to that event and specifies a function that’s called when the event is raised. When the status is changed, the approvals app receives the event and the specified function runs.

Event Methods

Force.com Canvas provides methods for implementing custom events in a canvas app. Full reference documentation for these methods can be found in the SDK and here.

- publish—Creates a custom event to which other canvas apps can subscribe. See Creating a Canvas App Event.
- subscribe—Subscribes to a parent event or custom event. This method can be used to subscribe to multiple events. See Subscribing to a Canvas App Event.
- unsubscribe—Unsubscribe from a parent event or custom event. This method can be used to unsubscribe from multiple events. See Unsubscribing from a Canvas App Event.

Canvas App Events Considerations

Keep these considerations in mind when implementing canvas app events:

- It’s recommended that you use a namespace when naming events, but it’s not required.
- The event namespace is different than the organization namespace in Salesforce. However, if you use namespaces, it’s recommended that you make the event namespace the same as the organization namespace.
- The namespace must be a string with no periods in it. For example, my.name.space.statusChanged is invalid. An example of a valid event name with a namespace is mynamespace.statusChanged.
- The following names are reserved and can’t be used as a namespace:
  - canvas
  - chatter
  - force
  - publisher
  - salesforce
  - sfdc
- Events work only between canvas apps on the same page. If you have a canvas app on the Chatter tab, that app won’t be able to subscribe to events published by a canvas app on a Visualforce page.
Creating a Canvas App Event

The following code example shows how to call the `publish` method to create a canvas app event. If you’re using a namespace, the event name must be prefaced by the namespace. For example, `namespace.eventName`.

```javascript
Sfdc.canvas(function() {
  sr = JSON.parse('<%=signedRequestJson%>');
  Sfdc.canvas.client.publish(sr.client,
    {name : "mynamespace.statusChanged", payload : {status : 'Completed'}});
});
```

Subscribing to a Canvas App Event

Subscribing to a Custom Event

The following code example shows how to call the `subscribe` method to subscribe to a canvas app event.

```javascript
// Subscribe to a custom event.
Sfdc.canvas(function() {
  sr = JSON.parse('<%=signedRequestJson%>');
  Sfdc.canvas.client.subscribe(sr.client,
    {name : 'mynamespace.statusChanged', onData : function (event) {
      console.log("Subscribed to custom event ", event);
    }});
});
```

Subscribing to Multiple Custom Events

The following code example shows how to call the `subscribe` method to subscribe to multiple canvas app events. The events you subscribe to can be in different namespaces or might not have a namespace. When a canvas app subscribes to an event, it creates an association between an event (in the other canvas app) and a function (in the subscribing canvas app).

```javascript
// Subscribe to multiple events.
Sfdc.canvas(function() {
  sr = JSON.parse('<%=signedRequestJson%>');
  Sfdc.canvas.client.subscribe(sr.client, [
    {name : 'mynamespace.statusChanged', onData : handler1},
    {name : 'anothernamespace.tripCancelled', onData : handler2},
  ]);
});
```

Using the travel and expense and approval canvas app examples, your approvals canvas app has two functions: `handler1` and `handler2`. That canvas app then subscribes to two events in the travel and expense canvas app: `mynamespace.statusChanged` and `mynamespace.tripCancelled`. When the `mynamespace.statusChanged` event is received by the approvals app, function `handler1` is called. When the `anothernamespace.tripCancelled` event is received by the approvals app, function `handler2` is called.
Unsubscribing from a Canvas App Event

Unsubscribing from a Custom Event

The following code example shows how to call the unsubscribe method to unsubscribe from a canvas app event.

```javascript
// Unsubscribe from a custom event.
Sfdc.canvas(function() {
    sr = JSON.parse('<%=signedRequestJson%>');
    Sfdc.canvas.client.unsubscribe(sr.client, {name : "mynamespace.statusChanged"});
});
```

Unsubscribing from Multiple Custom Events

The following code example shows how to call the unsubscribe method to unsubscribe from multiple canvas app events. The events you subscribe to can be in different namespaces or might not have a namespace.

```javascript
// Unsubscribe from multiple events.
Sfdc.canvas(function() {
    sr = JSON.parse('<%=signedRequestJson%>');
    Sfdc.canvas.client.unsubscribe(sr.client, ['mynamespace.statusChanged', "anothernamespace.tripCancelled"]);
});
```

Force.com Canvas SDK is Hosted on Salesforce

The Force.com Canvas SDK is available on GitHub, and you’ve always been able to download it and host it on your own Web server. Now, the SDK is also available on Salesforce servers. This means you can include files from the SDK in your pages by pointing to the server-hosted version.

For example, here’s what the include statement looks like if you host the SDK on your own Web server:

```html
<script type="text/javascript" src="/sdk/js/canvas-all.js"></script>
```

Here’s what the include statement looks like if you reference the hosted SDK:

```html
<script type="text/javascript" src="https://<instance>.salesforce.com/canvas/sdk/js/28.0/canvas-all.js"></script>
```

The ability to reference the SDK on the Salesforce server is useful when you want to include one of the SDK files in a Web app or from a Visualforce page.
**Canvas App Location Can be Specified**

You can now specify where a canvas app appears to a user. You can do this when you create or edit a canvas app by following these steps:

1. From Setup, click **Create > Apps**.
2. Select **New** to create a new connected app or click the link to your canvas app and click **Edit**.
3. Select one or more locations where the canvas app should appear.
   - **Chatter Tab**—The canvas app appears in the app navigation list on the Chatter tab. If this option is selected, the canvas app appears there automatically.
   - **Visualforce Page**—The canvas app can appear on a Visualforce page. If you add an `<apex:canvasApp>` component to expose a canvas app on a Visualforce page, then be sure to select this location for the canvas app; otherwise, you’ll receive an error.

**Additional Force.com Canvas Enhancements**

You no longer need to add the Salesforce instance as a remote site when you expose a canvas app on a Visualforce page using the `<apex:canvasApp>` component.

You can now expose multiple canvas apps on a Visualforce page. This is done using the `<apex:canvasApp>` component.

**PERMISSION SETS**

**Record Types in Permission Sets**

You asked for it! This enhancement is from an idea on the IdeaExchange.
You can use permission sets to assign custom record types to users. With record types in permission sets, you have the flexibility to layer record type assignments to users as needed, without having to create additional profiles. To illustrate the advantages of this feature, let’s look at the following example.

Suppose you have 20 Tier 2 customer support representatives. When these representatives create a case, they usually use the default Tier 2 record type and page layout. However, two of the representatives also need to create cases with a Defect Cases record type, another two also need to create cases with the Global Issues record type, and one more needs to create cases with either the Global Issues or Defect Cases record type.

In the past, granting this type of access would mean creating four profiles.

- Tier 2 (15 users)
- Tier 2 with Defect Cases (2 users)
- Tier 2 with Global Issues (2 users)
- Tier 2 with Defect Cases and Global Issues (1 user)

But with Summer ’13, you can create just one profile and two permission sets to accomplish the same requirement.

- Tier 2 profile (20 users)
- Defect Cases permission set (3 users)
- Global Issues permission set (3 users)

**Overview of Record Type Access**

Available in: **Enterprise, Unlimited,** and **Developer** Editions

You can assign record types to users in their profile or permission sets, or a combination of both. Record type assignment behaves differently in profiles and permission sets.

- A user’s default record type is specified in their profile. You can’t specify a default record type in permission sets.
- You can assign the **--Master--** record type in profiles, but not permission sets; only custom record types can be assigned in permission sets. Depending on the record types assigned in profiles:
  - If users have **--Master--** on their profile and no custom record types in their permission sets, when they create a record, the Master record type is associated with the new record.
  - If users have **--Master--** on their profile and only one custom record type in their permission sets, when they create a record, the new record is associated with the custom record type. Users won’t have the option to select the Master record type.
  - If users have **--Master--** on their profile and multiple custom record types in their permission sets, when they create a record, they’re prompted to choose a record type. In their personal settings, users don’t have the option to automatically use their default record type.
  - If users have a custom record type on their profile and any custom record types in their permission sets, when they create a record, they’re prompted to choose a record type. In their personal settings, users can set an option to automatically use their default record type and not be prompted to choose a record type.
- Page layout assignments are specified in profiles only—they’re not available in permission sets. When you assign a custom record type in a permission set, users with that permission set get the page layout assignment that’s specified for that record.
type in their profile. (In profiles, page layout assignments are specified for every record type, even when record types aren’t assigned.)

- For lead conversion, the default record type specified in a user’s profile is used for the converted records.
- Users can view records assigned to any record type. As a result, a page layout is assigned to every record type on a user’s profile. A record type assignment on a user’s profile or permission set does not determine whether a user can view a record with that record type; rather, the record type assignment simply specifies that the user can use that record type when creating or editing a record.
- Record types in permission sets aren’t supported in packages and change sets. As a result, any record type assignments in permission sets in a sandbox organization must be manually reproduced in a production organization.

### Assigning Custom Record Types in Permission Sets

**Available in:** Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To assign record types in permission sets: “Manage Users”</td>
</tr>
</tbody>
</table>

1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set, or create one.
3. On the permission set overview page, click Object Settings, then click the object you want.
4. Click Edit.
5. Select the record types you want to assign to this permission set.
6. Click Save.

### User Sharing

When your organization has Communities enabled, User Sharing lets you control which other users Community members can see. You can control community members’ access to both internal and external users.

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.
User Sharing Overview

Available in: Enterprise, Unlimited, and Developer Editions

Note:
User Sharing for external users is enabled by default when communities are enabled in your organization. User Sharing for internal users is also available through a pilot program. For more information on enabling User Sharing for internal users, contact salesforce.com.

User Sharing lets you control how external users in communities can view or access other user records by restricting or extending access to those records. For example, if your organization has a community enabled, you can set the organization-wide default for external user records to Private, and then create a user sharing rule to enable members of the community to see and interact with users who are in the sales representative role.

With user sharing, you can:

• Set the organization-wide default for user records for external users.
• Create user sharing rules based on group membership or other criteria.
• Create manual shares for user records.
• Control the visibility of external users in customer or partner portals and communities.
• If you are in the User Sharing pilot, you can additionally set the organization-wide default for internal users to Private. The pilot is not fully compatible with Chatter.

Understanding User Sharing

Available in: Enterprise, Unlimited, and Developer Editions

Note: User Sharing is enabled by default when your organization has Communities enabled and portal licenses provisioned. User Sharing for internal users is also available through a pilot program. For more information on enabling User Sharing for internal users, contact salesforce.com.

With user sharing, you can set an organization-wide default for external users’ access to internal and external User records, and extend access to user records using sharing rules based on membership to public groups, roles, or territories, and manual sharing to share individual user records with other users or groups.

Review these user sharing considerations before implementing them for your organization.

Organization-wide defaults for user records
This setting defaults to Private for external users. When the default access is set to Private for external users, they can see only their own user record. Users with subordinates in the role hierarchy maintain read access to the user records of those subordinates.
User sharing rules

General sharing rule considerations apply to user sharing rules. User sharing rules are based on membership to a public group, role, or territory. Each sharing rule shares members of a source group with those of the target group. You must create the appropriate public groups, roles, or territories before creating your sharing rules. Users inherit the same access as users below them in the role hierarchy.

Manual sharing for user records

Manual sharing can grant read or edit access, but only if the access is greater than the default access for the target user. Users inherit the same access as users below them in the role hierarchy. Apex managed sharing is not supported.

User sharing for external users

Users with the "Manage External Users" permission have access to external user records for Partner Relationship Management, Customer Service, and Customer Self-Service portal users, regardless of sharing rules or organization-wide default settings for User records. The "Manage External Users" permission does not grant access to guest or Chatter External users.

User Sharing Compatibility

User Sharing does not fully support these features.

- Customizable Forecasts — All users are visible in the user lookup regardless the organization-wide default for the user object.
- Chatter — Setting the organization-wide defaults for internal users to Private is part of a pilot program, which does not fully support Chatter.

Setting the Organization-Wide Sharing Defaults for User Records

Available in: Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set default sharing access:</td>
</tr>
</tbody>
</table>

For user records, you can set the organization-wide sharing default to Private or Public Read Only for access by external users such as community, customer portal, and partner portal users. The setting applies to user records for both internal and external users. The default must be set to Private if there is at least one user who shouldn’t see a record. After setting the defaults, you can open up access by granting Read/Write or Read Only access to selected user records.

Let’s say that your organization has internal users (employees and sales agents) and external users (customers/portal users) under different sales agents or portal accounts, with these requirements:

- Employees can see everyone.
- Sales agents can see employees, other agents, and their own customer user records only.
- Customers can see other customers only if they are under the same agent or portal account.

To meet these requirements, set the default external access to Private, and extend access using sharing rules, manual sharing, or user permissions.
When the feature is first turned on, the default access setting is Private for external users. The default for internal users is Public Read Only and cannot be changed. To change the organization-wide defaults for external access to the user object:

1. From Setup, click **Security Controls > Sharing Settings**.
2. Click **Edit** in the Organization-Wide Defaults area.
3. Select the default external access you want to use for User records.
4. Click **Save**.

**Note:** Changing the organization-wide default to Private for internal users is available as a pilot program. For information on enabling the pilot, contact salesforce.com.

Here is a common scenario for default internal and external access.

<table>
<thead>
<tr>
<th>Default Internal Access</th>
<th>Default External Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Read Only</td>
<td>Private</td>
<td>Internal users have Read access to all internal and external users. External users don’t have Read access to internal or external users, except their subordinates.</td>
</tr>
</tbody>
</table>

External users include community users, including portal users, and guest users.

### Granting Access to Internal User Records

**Available in:** **Enterprise, Unlimited, and Developer** Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To grant access to your own user record:</td>
<td>“Read” on the user with whom you’re sharing</td>
</tr>
<tr>
<td>To grant access to any other user record:</td>
<td>“Manage Users”</td>
</tr>
</tbody>
</table>

You can manually grant access to individual user records. You can do this in combination with or as an alternative to setting up sharing rules. Granting access to a user record makes the user’s detail page visible to others, and the user will be visible in lookups, list views, search, and so on.

You can grant access to your own user record to other users for whom you have Read access. However, you still need the “Manage Users” permission if you are sharing a user record that’s not your own. You have Read access to other users below you in the role hierarchy even if the organization-wide default for external access to the User object is set to Private.

To grant access to a user record:

1. Click **Sharing** on the user record you want to share.
   - The Sharing Detail page lists the users, groups, roles, and territories that have access to the user record.
2. Click **Add**.
3. From the drop-down list, select the group, user, role, or territory to share with.
4. Choose which users will have access by adding them to the Share With list.
5. Select the access level for the record you are sharing.
   Possible values are Read/Write or Read Only, depending on your organization-wide defaults for users. You can only grant a higher access than your organization-wide default.

6. Click Save.

Users inherit the same access as users below them in the role hierarchy. For example, if your subordinate gains Read access to a user who’s not in your role hierarchy, you automatically gain Read access to that user. Additionally, you may gain access to other users through the organization-wide default, user sharing rule, role hierarchy, or the “Manage Users” or “View All Users” permission. The higher level of access is maintained if you gain access through more than one method.

**Controlling Who Community or Portal Users Can See**

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set Community and Portal User Visibility: “Manage Users”</td>
</tr>
</tbody>
</table>

If your organization has enabled a community and has portal licenses provisioned for it, User Sharing is enabled automatically. When User Sharing is on, you can choose which other users community users can see by default. If your organization has Customer or Partner Portals, you can choose a default for them as well. Users who can see one another can interact on all the communities or portals in your organization. For example, if you would like to have a more private community, you can deselect the **Community User Visibility** checkbox and use other sharing features like sharing rules, manual shares, or portal access. For Communities and Portals, you can choose different defaults.

**Communities**

The initial default is to allow community users to be seen by all other internal and external users in communities they are a member of. You can change the default to allow external users in communities to be seen only by themselves and their superiors in the role hierarchy. The setting provides Read access only and applies to all communities in your organization.

Visibility to users as a result of the **Community User Visibility** preference is not inherited through the role hierarchy. If a manager in the role hierarchy is not a member of a community, but their subordinate is, the manager does not gain access to other members of the community.

**Portals**

The initial default is to allow portal users to be seen by other portal users within the same account. You can change the default to allow external users in portals to be seen by only themselves and their superiors in the role hierarchy. The setting provides Read access only and applies to all of the portals in your organization.

*Note:* Partner portal users also have access to their channel manager.

1. From Setup, click **Security Controls > Sharing Settings**.
2. Click **Edit** in the Organization-Wide Defaults area.
3. Deselect the **Portal User Visibility** checkbox to allow users to be seen by only themselves and their superiors. Or select the checkbox to let portal users be seen by all other portal users within the same account.

4. For **Community User Visibility**, deselect the checkbox to allow users to be seen only by themselves and their superiors. Select the checkbox to allow community users to be seen by all other users in their communities.

5. Click **Save**.

Selecting either of these options is a quick way of overriding an organization-wide default setting of Private for external access to the User object for Community or Portal users.

Once you have set these defaults, you can selectively expand access to users.

### Additional Sharing Enhancements

| Available in: Enterprise, Unlimited, and Developer Editions |

Summer ’13 introduces the following additional sharing enhancements.

**Asynchronous Recalculation of Sharing Settings**

For all organizations, sharing recalculations triggered by changes to your organization-wide defaults for sharing are now performed asynchronously. This lets work in your organization to continue while the action is completed and provides better resilience to site operations such as patches, server restarts, etc. Previously, asynchronous recalculations were enabled for new organizations only.

With asynchronous recalculation, when you save a change to your organization-wide defaults, the update runs in the background. You’ll receive an email when the recalculation completes. Refresh the Sharing Settings page to see your updates. If there is a problem with the recalculation, the email provides instructions for fixing it.

To monitor the status of a recalculation, from Setup, go to **Security Controls > View Setup Audit Trail**. On this page, you can see when the change was made, when the recalculation was added to the queue, and when it was completed.

Asynchronous recalculation for sharing rule creation and editing is also available. Contact Salesforce.com to evaluate whether this feature is suitable for your organization.

**Custom Reports Types Respect User Sharing for Portal Users**

When User Sharing is turned on in your organization, portal users who view custom reports that display user information see user details only for users to whom they have access. In this case, the user names appear in the report, but no details, such as email, are shown.

**Guest User Profiles Now Include View All Users Permission**

For backward compatibility of User Sharing, all guest user profiles now include the View All Users permission. This is so guest users will still have access to other guest users when User Sharing is turned on.
Search

Available in: All Editions except Database.com

In Summer ’13, we bring you the following search enhancements.

Accessing SharePoint Data via Sunlight Search — Beta

Available in: Enterprise, Unlimited, Developer Editions

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information on enabling this feature for your organization, contact salesforce.com.

With Sunlight Search, you can search and access SharePoint data in Salesforce via external objects, which function much like custom objects. External objects let you integrate content from separate content systems, providing a single access point for your data. Within the Salesforce interface, you can search across repositories from SharePoint 2010, SharePoint 2007, and SharePoint Online. Authentication options let administrators and users store unique credentials for each system.

To get started with Sunlight Search, complete these essential steps:

1. In SharePoint, configure scope and metadata properties to reveal information you want to access in Salesforce.
2. In Salesforce, define an external data source that connects to your SharePoint instance.
3. Validate the data source to establish the connection, and select the tables you want to access.
4. Sync the data source to automatically create an external object for each selected table.

For detailed instructions, see “Integrating with SharePoint” and “Defining External Data Sources” in the online help.

Important: To include external data in searches, Chatter must be enabled for your organization.
FORMULAS

Owner Fields in Custom Formulas

Available in: All Editions

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

In Summer ’13, we’ve opened up the Owner lookup and made its fields available for cross-object formulas.

For example, if you need owner email and you don’t use queues, your formula would be Owner:User.Email. If you do use queues, your formula could be

```
IF( ISBLANK( Owner:User.Id ), Owner:Queue.QueueEmail, Owner:User.Email )
```

User and Queue objects can be referenced on the Owner lookup, but must be explicitly selected, like in this example:

Formula Editor Now in Monospace Font

Available in: All Editions

To make parsing and debugging your formulas easier, we updated our formula editors to use a monospace font. This change does not apply to the URL field for web tabs, to the email editor, or to the default value fields in the Schema Builder.
Checkbox Formulas

Available in: All Editions

You asked for it! This enhancement is from an idea on the IdeaExchange.

Returns a true or false value. The field appears as a checkbox in record detail pages and reports. Use True for checked values and False for unchecked values.

Security

Summer ’13 introduces several new features that enhance security.

Login Enhancements

Available in: All editions except Database.com

Login and Identity Confirmation pages on mobile devices now take advantage of HTML5 input types for entering values such as your user name and verification code. Now the matching keyboard layouts appear when entering these values.

When logging in with a touch device, there’s a new icon for clearing both User Name and Password.

Connected Apps Enhancements

Connected Apps can be created in: Group, Professional, Enterprise, Unlimited, and Developer Editions
Connected Apps can be installed in: All Editions

Connected Apps is now generally available for new organizations. Existing organizations are being upgraded to add Connected Apps, including existing customers using Remote Access or the Connected Apps Pilot. All old Remote Access applications have been automatically migrated to be Connected Apps.

New features for Connected Apps include:

• Packaging — Connected Apps can be added to a managed package in the same way as other components. You can now push updates to customers, instead of your customers having to uninstall and reinstall the app. See Packaging Connected Apps.

• Easier app management — Developers can package their required OAuth and SAML metadata and push any changes out at a later time, simplifying the experience for administrators.

• Easier user management — Administrators can now assign Connected App access from permission sets and user profiles.
The page for managing a Connected App has been reorganized and expanded:

- The Connected App Detail area at the top of the page has been simplified, with many items relocated to other areas of the page.
- If the Connected App policy for Permitted Users is set to All Users May Authorize, the options to manage profiles and permission sets for the Connected App won’t appear, because those options aren’t needed when users can authorize themselves.
- If you’ve set up an identity provider, you can add SAML attributes for your service provider.
- The previous App Polices area has been expanded into new OAuth Policies and Basic Information sections.

The page for creating a new Connected App has also been reorganized and expanded:

- SAML service providers — SAML service provider settings can now be defined as part of Connected App, leveraging the new packaging and management features of Connected Apps. You can give the service provider a federation ID, user ID, or user name to identify your user — whichever value the service provider requires.
- New target URL — In addition to the Start (desktop) URL, there’s now a Mobile URL, so you can direct your users to different landing pages depending upon their device type.
- An API name — Formerly called the Developer Name, and used when referring to the Connected App from a program.
- Improved OAuth scope descriptions — It’s now easier for developers to select the correct OAuth scopes as the scope name used in the protocol is listed in parentheses along with the descriptive name.

### CSRF Protection

**Available in:** All Editions

There are new settings for protection against Cross Site Request Forgery (CSRF) attacks with GET and POST requests. When set, a random string is included as a hidden form in each page or as URL parameters. Then with each request, the application checks the string for validity and doesn’t execute the command if the check fails. From Setup, click Security Controls > Session Settings to select Enable CSRF protection on GET/POST requests on non-setup pages.

### Multi-Provider Single Sign-On

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

**Available in:** Professional, Enterprise, Unlimited, Developer, and Database.com Editions

You can now specify multiple SAML SSO configurations for your organization. This requires using SAML 2.0. You can also create the first configuration before enabling SAML in your organization. With multiple SAML SSO configurations you can have multiple Identity Providers (IdP). For example, you could create two SAML SSO configurations and use one with an IdP for customers and the second for your sales team. You will need to update the Assertion Consumer Service (ACS) URL used for Salesforce in your Identity Provider. Make this change when you begin using multiple SAML single sign-on configurations to avoid down time for users currently using single sign-on. The setup process will notify you of this requirement, and ask you to confirm the change.
These changes will appear after the Summer ’13 release has been rolled out to all customers, but you can create your first SAML SSO configuration now. From Setup, click Security Controls > Single Sign-On Settings and click New. Once your configuration is ready, click Edit on the same page and select SAML Enabled.

New Login Page Look and Feel

Available in: All editions except Database.com

Login pages are changing for Summer ’13. In addition to redesigning the existing login page, we’re adding new login pages for Touch and pop-up use. These changes will appear after the Summer ’13 release has been rolled out to all customers. These changes do not apply to pages with custom branding developed using Trialforce.

Support for JWT HMAC Removed

Available in: All Editions

The OAuth 2.0 JSON Web Token (JWT) token flow no longer supports the HMAC SHA256 algorithm and consumer secret for validation. Only the RSA SHA256 algorithm and a certificate are used now.

Inbound Two-Way SSL/TLS—Pilot

Available in: Enterprise, Unlimited, and Developer Editions

In Summer ’13 the capability to support mutually authenticated two-way SSL/TLS on inbound connections is available in pilot. This allows secure server-to-server connections initiated by a client using client certificate authentication. Previously, the ability to secure outbound calls was supported by using mutually authenticated SSL/TLS connections. An overview of how this feature works, using Web Service callouts as an example, is at http://wiki.developerforce.com/page/Making_Authenticated_Web_Service_Callouts_Using_Two-Way_SSL. Standard one-way SSL/TLS was supported when making inbound calls.

This feature includes:

- Client certificates uploaded and stored in the database, where they are used for verification.
- New Virtual IPs listening on port 8443 and a mechanism to prevent users from falling back to port 443 for standard SSL.
- A new rule on the load balancer to extract certificate details (Issuer, Serial ID, Subject, SSL Session ID) and pass them to the application server in an X-Client-Cert header for processing and validation.

For information on enabling this feature for your organization, contact salesforce.com.
**MY DOMAIN**

**My Domain Subdomain Availability**

Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

When you create a custom domain name, there’s a delay between when you make the request and when you receive email telling you that your new domain name is registered. For Summer ’13 the target for this delay has been shortened from 24 hours to ten minutes.

**Old Bookmarks Continue to Work When Moving to My Domain**

Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

To help existing organizations make the transition to My Domain, old bookmarks without My Domain in the URL will continue to work even after transitioning to My Domain. When deployed, you have options for how you want to handle page requests that don’t use the new domain name.

- Redirected to the same page within the domain—Automatically redirects to the new URL.
- Redirected with a warning to the same page within the domain—Automatically redirects to the new URL with a message explaining the redirection.
- Not redirected (Recommended)—No redirection. Instead, the user must enter the new URL. This is the default option.

Redirected users are automatically warned to bookmark the new URL as they get redirected from an old- to new-style URL.

**SANDBOXES**

**Sandbox Templates—Generally Available**

Available in: Enterprise, Unlimited, and Database.com Editions.

Sandbox templates provide control over the objects copied to your sandbox. You create a sandbox template that defines the object data you want in your sandbox. When you create or refresh a Full sandbox, you’ll have the option to use your sandbox template.
Sandbox templates are only available for use with a Full sandbox. For more information, see “Sandbox Overview” in the Salesforce online help.

**Sandbox User Interface Enhancements**

*Available in: Enterprise, Unlimited, and Database.com Editions*

The user interface for sandboxes has several improvements to help you manage your sandboxes. The interface leverages step-by-step instructions, tabs, and detail pages to present sandbox information clearly. It also includes the number of sandbox licenses in use, and the total number of sandbox licenses available for your account.

However, you can no longer change a sandbox’s type while you are refreshing it. For example, if you are refreshing a Configuration Only sandbox, you cannot change the sandbox type during that process.

**Custom Settings Copied to All Sandbox Types**

💡 You asked for it! This enhancement is from an idea on the IdeaExchange.

*Available in: Enterprise, Unlimited, and Database.com Editions*

In this release, Custom Settings data is now copied to Developer and Configuration Only sandboxes. Previously, Custom Settings data was only copied to Full sandboxes. For more information about what Custom Settings include, see “Custom Settings Overview” in the Salesforce online help.
CHANGE SETS AND DEPLOYMENT

Approval Process Deployment Enhancements

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Enterprise, Unlimited, and Developer Editions

Approval processes are now available in change sets and are exposed in the Metadata API. Approval processes are not supported in managed or unmanaged packages.

Restrictions for Approval Processes in Change Sets

Understand these restrictions before you include approval processes in change sets.

- If the approval page fields include any custom fields on standard objects, you need to manually add those custom fields to outbound change sets. The View/Add Dependencies option for selecting change set components won’t include these fields.
- Post templates for Approvals in Chatter can’t be uploaded to another organization via change sets. Either remove references to post templates from the approval process before upload, or recreate the post templates in the destination organization before deploying the approval process.
- If you change the Unique Name (fullName) of an approval process that was previously included in a change set and deployed in another organization, and you resend the approval process via a change set, a new approval process will be created upon deployment in the other organization. The previously deployed approval process will not be modified.

Publisher Actions Available in Packages and Change Sets

Publisher actions, new for Summer ‘13, are available in change sets and are supported in both managed and unmanaged packages.

When you add an action to a package, these components might be automatically included: Action target object (if it’s a custom object), action target field, action record type, predefined field values, action layout; and any custom fields that the action layout or predefined values refer to on the target object.
More Rules Available in Change Sets

Auto-Response Rules and Escalation Rules are now available in change sets. However, these are not supported in managed or unmanaged packages.

Assignment Rules are now available in change sets. However, these are not supported in managed or unmanaged packages.

User References Transfer during a Deployment

Salesforce matches users from your development environment (such as a sandbox) to your production organization. If a component in a deployment refers to a user, such as a recipient of workflow email notifications or a dashboard running user, then Salesforce attempts to locate a matching user in the destination organization by comparing usernames. Previously, a change set deployment changed all user references with the user performing the deployment.

For more information, see “Change Sets Implementation Tips” in the Salesforce online help or “Using Metadata” in the Metadata API Developer's Guide.

Visualforce

Visualforce includes the following enhancements in Summer ’13. For detailed information on these enhancements, refer to the Visualforce Developer's Guide.

Visualforce Pages and Components Sort Order

Setup list views for Visualforce pages, Visualforce components, and static resources have a new default sort order in Developer Edition and sandbox organizations. The new sort order is by modification date (descending), and is intended to make it easier for developers to quickly access recently-modified Visualforce pages and components, and related static resources.

To change the sort order of any of these list views, click the column header for the field to sort by.

The default sort order is unchanged in production organizations.
Upload Photos to ChatterProfile with a Visualforce Component

Summer ’13 introduces a new Visualforce component, chatter:userPhotoUpload that lets users upload a photo to their Chatter profile page. Using this Visualforce component, you can create a custom page that lets users in your Ideas community upload a profile picture in either a cropped format or as a full image.

To use this component, you must enable Chatter in the organization. Users must belong to either Standard User, Portal User, High Volume Portal User, or Chatter External User profiles.

support:clickToDial Component

Summer ’13 introduces a new computer-telephony integration (CTI) Visualforce component—support:clickToDial.

The support:clickToDial component lets you add a phone field to custom Visualforce detail and edit pages. When users in organizations with Open CTI or Salesforce CRM Call Center click on the phone field, the phone number is dialed automatically and connects to the SoftPhone. Use this to, for example, specify which phone fields on custom pages users can click to automatically call customers.

For more information about using this component, see the Visualforce Developer’s Guide.

profileId Attribute for chatteranswers:registration Component

Summer ’13 introduces a new attribute, profileId, to the chatteranswers:registration Visualforce component.

The profileId represents the profile ID of the self-registered user if the chatteranswers:registration component is accessed through a Chatter community. This profile is used only for Salesforce Communities site registration and not for Force.com site registration.

For more information about using this component, see the Standard Component Reference in the Visualforce Developer’s Guide.

HTML5 and Output Tag Generation Options

There are several new options for controlling the HTML tags that Visualforce renders automatically, as well as changes in rendering behavior for pages set to the latest API versions. These options and changes make it easier to develop HTML5 applications using Visualforce.

Existing Behavior

By default, Visualforce automatically adds required HTML tags to a page to ensure that the result is a valid HTML (and XML) document. It does this in two contexts: a simpler GET request context, when a page is initially loaded and rendered; and a POSTBACK context, when an <apex:form> is submitted back, an Ajax request is made using an <apex:actionXXX> tag, and so on.

In a GET context, the HTML rendered by Visualforce is somewhat relaxed. It adds <html> tags to wrap the page, <head> tags to wrap the page’s title and any stylesheets or scripts added to the page using <apex:stylesheet> or <apex:includeScript>, and <body> tags to wrap the page’s content, among other things.
HTML generated by other Visualforce tags will be complete and valid HTML, and you can’t save a Visualforce page with invalid static XML. However, HTML added by expressions that access controller methods, sObject fields, and so on isn’t validated by Visualforce before it’s returned. It’s therefore possible to return an invalid XML document via a GET request.

In a POSTBACK context, Visualforce is more strict. Because the contents of the request might need to be inserted into an existing DOM, the response HTML is post-processed to ensure it’s valid. This “tidying” fixes missing and unclosed tags, removes invalid tags, and otherwise cleans up invalid HTML so that it will insert cleanly into the DOM of any page it’s returned back to. This ensures that tags that update an existing DOM, such as `<apex:actionHandler>`, work reliably.

**Rendering Changes for the HTML5 DocType**

In Summer ’13, the tidying behavior for Visualforce pages with `docType="html–5.0"` has changed for the POSTBACK context, so that HTML5 tags and attributes aren’t stripped away. Visualforce continues to validate the XML correctness of every page when it’s saved, and requires that the page be well-formed XML, but the post-process tidying no longer removes unknown elements for POSTBACK requests. This should make it much easier to work with HTML5 and JavaScript frameworks that use HTML attributes extensively.

This change is versioned. You must update your page to API version 28.0 or later, and set the `docType` to “html–5.0” to enable the new behavior.

Additionally, the scope of how the `docType` is determined for a page has changed. When child pages are added to a root page using `<apex:include>`, if any page in the hierarchy is set to `docType="html–5.0"` and the root page is set to API version 28.0 or later, the entire page hierarchy is rendered in html–5.0 mode.

It’s worth remembering that while modern browsers are very good at doing their own tidying, that behavior is less consistent than rendering valid markup. Reduced HTML tidying in html–5.0 mode represents a reduced safety net, in return for significantly increased flexibility. With great power comes great responsibility. We recommend you initially enable the new behavior only on HTML5-specific pages that need it, and with HTML validation and debugging tools in hand.

**Suppress Automatic `<html>` and `<body>` Tag Generation**

`applyHtmlTag` and `applyBodyTag` are new attributes for the `<apex:page>` tag that provide manual control over how these specific HTML tags are generated by Visualforce. Use them to suppress the automatic generation of `<html>` and `<body>` tags, in favor of static markup you add to your markup. Here’s an example that illustrates this:

```xml
<apex:page showHeader="false" sidebar="false" standardStylesheets="false"
   applyHtmlTag="false" applyBodyTag="false" docType="html-5.0">
  <html>
    <body>
      <header>
        <h1>Congratulations!</h1>
      </header>
      <article>
        <p>This page looks almost like HTML5!</p>
      </article>
    </body>
  </html>
</apex:page>
```

The attributes act independently of each other; you can use them in any combination of `true`, `false`, or unset. When both attributes are set to `true`, the default, existing behavior for the automatic generation of `<html>` and `<body>` tags is preserved. When either is set to `false`, you are fully responsible for adding the corresponding tags to your markup. In this mode Visualforce won’t prevent you from creating nonsense tag combinations or attributes that give even modern browsers fits.
Note: A `<head>` section is always generated if required, regardless of the values for `applyHtmlTag` and `applyBodyTag`. For example, a `<head>` tag is generated if you use `<apex:includeScript>` or `<apex:stylesheet>` tags, set the page title, and so on.

There’s one exception to this rule. If `applyHtmlTag` is set to `false` and there are no other elements in the page except for `<apex:includeScript>`, no `<head>` is generated. For example, the following code will automatically add `<body>` tags, but won’t add a `<head>` section:

```html
<apex:page showHeader="false" applyHtmlTag="false">
  <html>
    <apex:includeScript value="/ajax.googleapis.com/ajax/libs/jquery/1.9.1/jquery.min.js"/>
  </html>
</apex:page>
```

This behavior shouldn’t cause problems for real-world pages.

The `applyHtmlTag` attribute is available on the `<apex:page>` tag for Visualforce pages set to API version 27.0 or higher. The `applyBodyTag` attribute is available on the `<apex:page>` tag for Visualforce pages set to API version 28.0 or higher. They both have the following additional restrictions:

- The `showHeader` attribute must be set to `false` for the page, for example, `<apex:page showHeader="false">`.
- The `contentType` attribute must be set to “text/html” (the default).
- The values for the top level, or outermost, `<apex:page>` tag are used; `applyHtmlTag` and `applyBodyTag` attributes on pages added using the `<apex:include>` tag are ignored.

**Support for Offline Caching Using HTML5 `manifest` Attribute**

`manifest` is another new attribute for the `<apex:page>` tag, which allows you to set an HTML5 cache manifest for offline caching of a page’s critical resources. The value of the `manifest` attribute is passed through to the generated HTML. For example:

```html
<apex:page showHeader="false" sidebar="false" standardStylesheets="false" docType="html-5.0" manifest="/apex/CacheManifest">
  <header>
    <h1>Congratulations!</h1>
  </header>
  <article>
    <p>This page looks almost like HTML5!</p>
  </article>
</apex:page>
```

Renders the following `<html>` tag:

```html
<html manifest="/apex/CacheManifest">
```

The `manifest` attribute is available on the `<apex:page>` tag for Visualforce pages set to API version 28.0 or higher, and also requires that the `applyHtmlTag` is set to `true` (the default).

Although not part of this enhancement, it’s worth noting that you can use Visualforce to provide a page’s cache manifest. For example:

```html
<apex:page contentType="text/cache-manifest" applyHtmlTag="false" standardStylesheets="false" showHeader="false">
  CACHE MANIFEST
```

224
OAuth 2.0 Authentication for JavaScript Remoting

JavaScript remoting requests can use OAuth 2.0 for authentication, instead of requiring a standard username and password login process. OAuth allows cross-application and cross-org integrations that aren’t possible to do securely with standard authentication.

A Visualforce page that uses OAuth for authentication configures it at the page level, and uses OAuth for all JavaScript remoting requests. Other than configuration, using JavaScript remoting is exactly the same.

Configuring OAuth for JavaScript remoting from a Visualforce page takes the following form:

```javascript
<script type="text/javascript">
    Visualforce.remoting.oauthAccessToken = <access_token>;
    // ...
</script>
```

Once `oauthAccessToken` is set, all JavaScript remoting requests use OAuth. The rest of your JavaScript remoting code can remain the same.

`oauthAccessToken` is an OAuth authentication token obtained by your page’s code. Obtaining and updating an access token is straightforward OAuth, with one addition. JavaScript remoting OAuth authentication requests the “visualforce” scope, so your token must be generated with this or a scope that contains it, including “web” or “full”. Set `scope=visualforce` (or “web” or “full”) in your OAuth request.

For information about obtaining access tokens, and using OAuth with the Force.com platform, see Authenticating Remote Access Applications in the Salesforce online help and wiki.developerforce.com/page/Digging_Deeper_into_OAuth_2.0_on_Force.com. For additional details of using OAuth with JavaScript remoting, see “JavaScript Remoting for Apex Controllers” in the Visualforce Developer’s Guide.

Configurable Timeout for JavaScript Remoting Requests

You asked for it! This enhancement is from an idea on the IdeaExchange.

In Summer ’13 the timeout period for JavaScript remoting requests is configurable. In prior releases, the timeout was fixed at 30 seconds, and this remains the default. If your request needs longer to complete, configure a longer timeout, up to 120 seconds.
**Configuring JavaScript Remoting Requests**

Configure a remoting request by providing an object with configuration settings when you declare the remoting request. For example, the default configuration parameters look like this:

```
{ buffer: true, escape: true, timeout: 30000 }
```

These configuration parameters aren’t ordered, and you can omit parameters you don’t want to change from the default. JavaScript remoting supports the following configuration parameters:

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>buffer</td>
<td>Boolean</td>
<td>Whether to group requests executed close to each other in time into a single request. The default is true. JavaScript remoting optimizes requests that are executed close to each other in time and groups the calls into a single request. This buffering improve the efficiency of the overall request-and-response cycle, but sometimes it’s useful to ensure all requests execute independently.</td>
</tr>
<tr>
<td>escape</td>
<td>Boolean</td>
<td>Whether to escape the Apex method’s response. The default is true.</td>
</tr>
<tr>
<td>timeout</td>
<td>Integer</td>
<td>The timeout for the request, in milliseconds. The default is 30000 (30 seconds). The maximum is 120000 (120 seconds, or 2 minutes).</td>
</tr>
</tbody>
</table>

The request timeout can also be configured for all requests made by a page, by setting the timeout using the Visualforce remoting object:

```javascript
<script type="text/javascript">
    Visualforce.remoting.timeout = 120000; // Set timeout at page level

    function getRemoteAccount() {
        var accountName = document.getElementById('acctSearch').value;

        // This remoting call will use the page's timeout value
        Visualforce.remoting.Manager.invokeAction(
            '{!$RemoteAction.AccountRemoter.getAccount}',
            accountName,
            handleResult
        );
    }

    function handleResult(result, event) { ... }
</script>
```

Override a page-level timeout configuration on a per-request basis by setting the timeout in the configuration object for that request, as described above.
**CSRF Protection for Objects That Override the Standard Delete Link with a Visualforce Page**

The Visualforce create and edit pages have a new checkbox, *Require CSRF protection on GET requests*, to add Cross Site Request Forgery (CSRF) protection to GET requests for the page (POST requests already have CSRF protection). When checked, it protects against CSRF attacks by modifying the page to require a CSRF confirmation token, a random string of characters in the URL parameters. With every GET request, Visualforce checks the validity of this string of characters and doesn't load the page unless the value found matches the value expected.

Check this box if the page performs any DML operation when it's initially loaded. When checked, all links to this page need a CSRF token added to the URL query string parameters. This checkbox is available for pages set to API version 28.0 and later.

*Note:* In Summer '13, the only way to add a valid CSRF token to a URL is to override an object's standard Delete link with a Visualforce page. The Delete link will automatically include the required token. Don’t check this box for any page that doesn’t override an object’s standard Delete link.

CSRF confirmation tokens are, if present, always checked for validity. If a CSRF confirmation token fails verification, an error is displayed, whether *Require CSRF protection on GET requests* is enabled for the page or not.

**Relaxed Compile-Time Checking of Custom Component Attribute Names**

In Spring ‘13 a new compile-time check was enabled that prevents giving custom Visualforce component attributes the same name as the `assignTo` value. This compile-time check was enabled if either the component or a page that contains it was updated to API version 27.0.

In Summer ‘13 this compile-time check is relaxed to perform the check only if both the component and page that contains it are set to API version 27.0 or later. As a relaxed restriction, this change has no impact on existing pages.

**Apex Code**

| Available in: Unlimited, Developer, Enterprise, and Database.com Editions |

Apex includes the following enhancements in Summer ’13. For detailed information on these enhancements, refer to the *Force.com Apex Code Developer’s Guide*.

**Chatter in Apex—Generally Available**

Chatter in Apex exposes many Chatter API resources as Apex classes in the `ConnectApi` namespace. Use Chatter in Apex to build Chatter integrations and custom UIs without making HTTP callouts.

Chatter in Apex is now documented in the *Apex Code Developer’s Guide*. 
• **Using Chatter in Apex to Display Two Chatter Feeds in a Visualforce Page** (6:00 minutes)

Learn how easy it is to use Chatter in Apex to get Chatter feeds for your Salesforce Communities and display them side
by side in Salesforce. Use the Developer Console to create an Apex custom controller, a Visualforce custom component,
and a Visualforce page.

• Migrating Chatter in Apex Code from Pilot

• **New and Changed ConnectApi Classes**

• **New and Changed ConnectApi Input Classes**

• **New and Changed ConnectApi Output Classes**

• **New and Changed ConnectApi Enums**

  **Note:** When Chatter in Apex was a pilot program, it was called “Connect in Apex.”

---

**Migrating Chatter in Apex Code from Pilot**

The only supported version for Chatter in Apex is v28.0. When migrating pilot code to v28.0, you will encounter the following
changes:

- All lists in input objects, such as the messageSegments list in a ConnectApi.MessageBodyInput object, are now
  initialized to null instead of to an empty list.
- The ConnectApi.BasicTemplateAttachment.subtype property has been deprecated. It contains None for clients
  using an older API version.
- The ConnectApi.ChatterGroup class is now abstract. Its children are ConnectApi.ChatterGroupDetail and
  ConnectApi.ChatterGroupSummary.
- These methods now return ConnectApi.ChatterGroupDetail objects and are not available in pilot code:
  ◊ ConnectApi.ChatterGroups.getGroup
  ◊ ConnectApi.ChatterGroups.updateGroup

  - The ConnectApi.ChatterGroupPage.groups property contains a list of ConnectApi.ChatterGroupDetail
    objects instead of ConnectApi.ChatterGroup objects.
  - ConnectApi.ChatterGroupSummary no longer has a fileCount property.
  - The ConnectApi.ChatterUsers.getUser method now returns a ConnectApi.UserDetail object instead of a
    ConnectApi.UserSummary object and is not available in pilot code.
  - The ConnectApi.CommunityStatus enum Active value has been changed to Live.
  - The ConnectApi.FeedAttachmentType enum now contains only output values.
  - ConnectApi.User is a new abstract class with two child classes: ConnectApi.UserDetail and
    ConnectApi.UserSummary. When a ConnectApi.UserDetail object is returned, properties that the context user
doesn’t have permission to view are set to null.
  - The ConnectApi.UserGroupPage.groups property contains a list of ConnectApi.ChatterGroupSummary objects
    instead of a list of ConnectApi.ChatterGroup objects.
  - The ConnectApi.UserPage.users property contains a list of ConnectApi.UserDetail objects instead of a list of
    ConnectApi.UserSummary objects.
New and Changed **ConnectApi Classes**

- `ConnectApi.ChatterFavorites.addRecordFavorite` is a new method that adds a topic as a favorite.
- There are two new `ConnectApi.ChatterFavorites.setTestGetFeedItems` methods to match the two existing `getFeedItems` methods. Use these set test methods to register outputs to be returned in a test context.
- The `ConnectApi.ChatterFeeds.searchFeedItems` method has two new signatures with `sortParam` arguments that sort results by `CreatedDateDesc` (default) or `LastModifiedDateDesc`.
- The `ConnectApi.ChatterFeeds` class has a new `searchFeedItemsInFilterFeed` method that searches feed items in a feed filtered by key prefix.
- These methods now return `ConnectApi.ChatterGroupDetail` objects and are not available in pilot code:
  - ◊ `ConnectApi.ChatterGroups.getGroup`
  - ◊ `ConnectApi.ChatterGroups.updateGroup`
- The `ConnectApi.ChatterGroups` class has a new `updateGroup` method that updates the “Information” section in a group. In the Web UI, this section is above the “Description” section. If the group is private, this section is visible only to members. It returns a `ConnectApi.ChatterGroupDetail` object.
- There are two new `ConnectApi.ChatterGroups.setTestSearchGroups` methods to match the two existing `searchGroups` methods. Use these set test methods to register outputs to be returned in a test context.
- The `ConnectApi.ChatterUsers.searchUsers` method has a new signature for @mention completion. Passing a feed item ID to `searchContextId` matches users already mentioned in the thread earlier in the returned collection. When using this argument, you can't query more than 500 results and you can’t use wildcards in the search term.
- There are three new `ConnectApi.ChatterUsers.setTestSearchUsers` methods to match the three existing `searchUsers` methods. Use these set test methods to register outputs to be returned in a test context.
- `ConnectApi.Organization` is a new class that exposes a method that contains information about the supported features in an organization.

New and Changed **ConnectApi Input Classes**

- All lists in input objects, such as the `messageSegments` list in a `ConnectApi.MessageBodyInput` object, are now initialized to `null` instead of to an empty list.
- `ConnectApi.GroupInformationInput` is a new input class that contains `text` and `title` properties for the “Information” section of a group. In the Web UI, the “Information” section is above the “Description” section. If the group is private, this section is visible only to members.
- `ConnectApi.ChatterGroupInput` is a new input class that contains an `information` property containing a reference to the `ConnectApi.GroupInformationInput` class.

New and Changed **ConnectApi Output Classes**

- The `ConnectApi.ApprovalAttachment` class has a new `postTemplateFields` property, which is a collection of `ConnectApi.ApprovalPostTemplateField` classes.
- The `ConnectApi.ApprovalPostTemplateField` class describes a field in an approval post template. The properties are: `displayName`, `displayValue`, and `record`.  

229
• The `ConnectApi.BasicTemplateAttachment` class has a new `linkRecordId` property. If the `linkUrl` property contains a Salesforce record, the `linkRecordId` property contains the record ID.
• The `ConnectApi.BasicTemplateAttachment.subtype` property has been deprecated. It contains `None` for clients using an older API version.
• The `ConnectApi.ChatterGroup` class is now abstract. Its children are `ConnectApi.ChatterGroupDetail` and `ConnectApi.ChatterGroupSummary`.
• The new `ConnectApi.ChatterGroupDetail` class is a child class of the newly abstract `ConnectApi.ChatterGroup` class. It has a `fileCount` property, which returns the number of files posted to the group. It also has an `information` property that returns a `ChatterApi.GroupInformation` object.
• The `ConnectApi.ChatterGroupPage.groups` property contains a list of `ConnectApi.ChatterGroupDetail` objects instead of `ConnectApi.ChatterGroup` objects.
• The new `ConnectApi.ChatterGroupSummary` class is a child class of the newly abstract `ConnectApi.ChatterGroup` class. The `fileCount` property is no longer exposed.
• The `ConnectApi.Comments` class and the `ChatterApi.FeedItem` class have a new `relativeCreatedDate` property that contains the created date in a relative, localized format that’s perfect for displaying on a mobile device or tablet: for example, “17m ago” or “Yesterday.”
• `ConnectApi.Features` is a new output class containing properties that indicate which features are available to the context user:
  ◊ `chatter`—Indicates whether Chatter is enabled for an organization.
  ◊ `chatterActivity`—Indicates whether user details include information about Chatter activity.
  ◊ `chatterGlobalInfluence`—Indicates whether user details include information about global Chatter activity.
  ◊ `chatterMessages`—Indicates whether Chatter private messages are enabled for the organization.
  ◊ `chatterTopics`—Indicates whether Chatter topics are enabled.
  ◊ `dashboardComponentSnapshots`—Indicates whether the user can post dashboard snapshots.
  ◊ `defaultCurrencyIsoCode`—When the `multiCurrency` property is `false`, this property indicates the ISO code of the default currency.
  ◊ `feedPolling`—Indicates whether feed polling is enabled. If it is, you can call `ConnectApi.ChatterFeeds.isModified` to determine whether a news feed has been updated.
  ◊ `files`—Indicates whether files can act as Chatter REST API resources.
  ◊ `filesOnComments`—Indicates whether files can be attached to comments.
  ◊ `groupsCanFollow`—Reserved for future use.
  ◊ `multiCurrency`—Indicates whether the user’s organization uses multiple currencies.
  ◊ `publisherActions`—Indicates whether publisher actions are enabled.
  ◊ `thanksAllowed`—Reserved for future use.
  ◊ `trendingTopics`—Indicates whether trending topics are enabled.
  ◊ `viralInvitesAllowed`—Indicates whether existing Chatter users can invite people in their company to use Chatter.

• A new `ConnectApi.GroupInformation` class has two properties, `text` and `title`, that contain the “Information” section of the group. In the Web UI, this section is above the “Description” section. If the group is private, this section is visible only to members.
• `ConnectApi.HashtagSegment` has a new `topicUrl` property that contains a Chatter REST API Topics resource with a query string that searches for the topic in the segment, for example, `/services/data/v28.0/chatter/topics?exactMatch=true&q=topic`.
• `ConnectApi.OrganizationSettings` is a new output class containing properties that indicate the settings of an organization:
  ◊ `accessTimeout`—Amount of time after which the system prompts users who have been inactive to log out or continue working
  ◊ `features`—Information about features available in the organization. A `ConnectApi.Features` object.
name—Organization name
orgId—18-character ID for the organization
userSettings—Information about the organization permissions for the user. A ConnectApi.UserSettings object.

- ConnectApi.User is a new abstract class with two child classes: ConnectApi.UserDetail and ConnectApi.UserSummary. When a ConnectApi.UserDetail object is returned, properties that the context user doesn’t have permission to view are set to null.
- ConnectApi.UserSettings is a new output class containing properties that indicate the settings of a user:
  ◊ approvalPosts—User can approve workflows from Chatter posts.
  ◊ canFollow—User can follow users and records
  ◊ canModifyAllData—User has “Modify all Data” permission
  ◊ canOwnGroups—User can own groups
  ◊ canViewAllData—User has “View all Data” permission
  ◊ canViewAllGroups—User has “View all Groups” permission
  ◊ canViewAllUsers—User has “View all Users” permission
  ◊ canViewFullUserProfile—User can see other user’s Chatter profiles
  ◊ canViewPublicFiles—User can see all files marked as public
  ◊ currencySymbol—Currency symbol to use for displaying currency values. Applicable only when the ConnectApi.Features.multiCurrency property is false.
  ◊ externalUser—User is a Chatter customer
  ◊ hasAccessToInternalOrg—User is a member of the internal organization
  ◊ hasFileSync—Reserved for future use.
  ◊ userDefaultCurrencyIsoCode—The ISO code for the default currency. Applicable only when the ConnectApi.Features.multiCurrency property is true.
  ◊ userId—18-character ID of the user
  ◊ userLocale—Locale of user

- The ConnectApi.UserSummary class is a child class of ConnectApi.User and inherits all the ConnectApi.User properties. In addition, ConnectApi.UserSummary has one unique property, isActive. The value is true if the user is active; the value is false otherwise.

New and Changed ConnectApi Enums

- The ConnectApi.CommunityStatus enum Active value has been changed to Live.
- The ConnectApi.FeedAttachmentType enum now contains only output values.
- The ConnectApi.FeedItemType enum has a new CreateRecordEvent value, which indicates that the feed item was created when a record was created using the publisher.
- The ConnectApi.FeedItemType enum has a new CollaborationGroupUnarchived value, which indicates that the feed item was created when an archived group was unarchived.
- The ConnectApi.FeedType enum has a new Topics value that identifies the feed of a specific topic.
- The ConnectApi.UserType enum has a new ChatterOnly value that identifies Chatter Free customers.
Consolidated Limits for Asynchronous Apex

The 24-hour limits for asynchronous Apex executions, which include batch Apex, scheduled Apex, and future methods, have been consolidated. All asynchronous Apex calls now share the same limit. This change makes it easier for you to manage the different types of asynchronous Apex jobs. The following is a comparison of the old and new execution limits.

<table>
<thead>
<tr>
<th>Asynchronous Apex</th>
<th>Old execution limit per 24-hour period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Apex</td>
<td>250,000 batch executions (This limit applied to <code>execute</code> methods only, not to <code>start</code> and <code>finish</code> methods.)</td>
</tr>
<tr>
<td>Scheduled Apex</td>
<td>No daily execution limit</td>
</tr>
<tr>
<td>Future methods</td>
<td>The number of full Salesforce and Force.com App Subscription user licenses multiplied by 200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Asynchronous Apex</th>
<th>New execution limit per 24-hour period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Apex, scheduled Apex, and future methods all share the following limit</td>
<td>250,000 method executions or the number of user licenses in your organization multiplied by 200, whichever is greater</td>
</tr>
<tr>
<td></td>
<td>The licenses that count toward this limit are full Salesforce user licenses or Force.com App Subscription user licenses.</td>
</tr>
<tr>
<td></td>
<td>Method executions for batch Apex include executions of the <code>start</code>, <code>execute</code>, and <code>finish</code> methods.</td>
</tr>
</tbody>
</table>

Higher Concurrently Scheduled Apex Jobs Limit

The maximum number of Apex jobs that can be scheduled concurrently has increased from 25 to 100.

**Note:** Scheduled jobs now appear on the Apex Jobs page in addition to the Scheduled Jobs page.

Scheduled jobs can't be aborted from the Apex Jobs page; use the Scheduled Jobs page to manage or delete scheduled jobs.

Even though a scheduled job appears on both the Apex Jobs and Scheduled Jobs pages, it counts only once against the asynchronous Apex execution limit.

Test Methods Defined in Test Classes

Starting in Summer '13, test methods can be defined only in test classes (classes annotated with `@isTest`). You can no longer add a test method in a non-test class. This change applies to new Apex code saved using Salesforce.com API version 28.0 and later. Apex code saved using earlier API versions isn’t affected.

This change is in line with the Apex coding best practice of including test methods in test classes. Test classes don’t count toward your organization’s code size limit, so separating the test code from the product code enables you to write more Apex code. Also, Apex testing will be enhanced in future releases and this is a prerequisite for those planned enhancements.
This example shows how to add test methods in a separate test class. The `RecordManager` class contains an instance method and a static method. The test class, `RecordManagerTest`, provides a test method for each.

This is the class containing product code for which tests are provided in the next example.

```java
public class RecordManager {
    private Integer recordInventory = 100;

    // Instance method
    public String DisplayStatus() {
        String status = 'Current inventory status: ' + recordInventory + ' records.';
        System.debug(status);
        return status;
    }

    // Static method
    public static Id InsertRecord(String aName, String bCity) {
        Account a = new Account(Name=aName, BillingCity=bCity);
        insert a;
        return a.Id;
    }
}
```

This is the test class containing the test methods for the `RecordManager` class.

```java
@isTest
private class RecordManagerTest {
    static testmethod void testDisplayStatus() {
        // To call the instance method, you must first create
        // an instance of the class.
        RecordManager m = new RecordManager();
        String s = m.DisplayStatus();

        // Verify status message
        System.assertNotEquals(null, s);
    }

    static testmethod void testInsertRecord() {
        // Call the static method
        Id accountID = RecordManager.InsertRecord('Acme','New York');

        // Verify record got inserted
        System.assert(accountID != null);
        Account a = [SELECT Name,BillingCity FROM Account WHERE Id=:accountID];
        System.assertEquals('Acme',a.Name);
        System.assertEquals('New York',a.BillingCity);
    }
}
```

**TestVisible Annotation**

Use the `TestVisible` annotation to allow test methods to access private or protected members of another class outside the test class. These members include methods, member variables, and inner classes. This annotation enables a more permissive access level for running tests only. This annotation doesn’t change the visibility of members if accessed by non-test classes.

With this annotation, you don’t have to change the access modifiers of your methods and member variables to public if you want to access them in a test method. For example, if a private member variable isn’t supposed to be exposed to external classes but it should be accessible by a test method, you can add the `TestVisible` annotation to the variable definition.
This annotation can also be handy when you upgrade the Salesforce.com API version of existing classes containing mixed test and non-test code. Because test methods aren’t allowed in non-test classes starting in API version 28.0, you must move the test methods from the old class into a new test class (a class annotated with `@isTest`) when you upgrade the API version of your class. You might run into visibility issues when accessing private methods or member variables of the original class. In this case, just annotate these private members with `@TestVisible`.

This example shows how `@TestVisible` is used with private member variables, a private inner class with a constructor, a private method, and a private custom exception. All these can be accessed in the test class because they’re annotated with `@TestVisible`. The class is listed first and is followed by a test class containing the test methods.

```java
public class VisibleSampleClass {
    // Private member variables
    @TestVisible private Integer recordNumber = 0;
    @TestVisible private String areaCode = '(415)';
    // Public member variable
    public Integer maxRecords = 1000;

    // Private inner class
    @TestVisible class Employee {
        String fullName;
        String phone;

        // Constructor
        @TestVisible Employee(String s, String ph) {
            fullName = s;
            phone = ph;
        }
    }

    // TestVisible private String privateMethod(Employee e) {
        System.debug('I am private.');
        recordNumber++;
        String phone = areaCode + ' ' + e.phone;
        String s = e.fullName + 's phone number is ' + phone;
        System.debug(s);
        return s;
    }

    // Public method
    public void publicMethod() {
        maxRecords++;
        System.debug('I am public.');
    }

    // TestVisible private class MyException extends Exception {}
}

// Test class for VisibleSampleClass
@isTest
private class VisibleSampleClassTest {

    // This test method can access private members of another class
    // that are annotated with @TestVisible.
    static testmethod void test1() {
        VisibleSampleClass sample = new VisibleSampleClass();

        // Access private data members and update their values
        sample.recordNumber = 100;
        sample.areaCode = '(510)';

        // Access private inner class
```
VisibleSampleClass.Employee emp =
    new VisibleSampleClass.Employee('Joe Smith', '555-1212');

    // Call private method
    String s = sample.privateMethod(emp);

    // Verify result
    System.assert(
        s.contains('(510)') &&
        s.contains('Joe Smith') &&
        s.contains('555-1212'));

    // This test method can throw private exception defined in another class
    static testmethod void test2() {
        // Throw private exception.
        try {
            throw new VisibleSampleClass.MyException('Thrown from a test.');
        } catch(VisibleSampleClass.MyException e) {
            // Handle exception
        }
    }

    static testmethod void test3() {
        // Access public method.
        // No @TestVisible is used.
        VisibleSampleClass sample = new VisibleSampleClass ();
        sample.publicMethod();
    }
}

**New Classes and Methods**

The following are new Apex classes and methods.

- New `System.scheduleBatch` Method
- New Classes and Methods for Publisher Actions
- Additional `sObject.addError` Methods
- New `String.hashCode` Method
- New `String.stripHtmlTags` Method
- New Type Methods
- New `URL.getFileFieldURL` Method
- New `System.Limits` Methods

**New `System.scheduleBatch` Method**

The new `System.scheduleBatch` method is handy for scheduling a batch job to run once at a future time. The only prerequisite is creating your batch class that implements the `Database.Batchable` interface. You don’t need to deal with the scheduling details, such as implementing the `Schedulable` interface or constructing a time and date (CronTrigger) expression.

The `System.scheduleBatch` method takes the following parameters.
• An instance of a class that implements the Database.Batchable interface.
• The job name.
• The time interval, in minutes, after which the job should start executing.
• An optional scope value. This parameter specifies the number of records that should be passed into the execute method. Use this parameter when you have many operations for each record being passed in and are running into governor limits. By limiting the number of records, you are thereby limiting the operations per transaction. This value must be greater than zero. If the start method returns a QueryLocator, the optional scope parameter of Database.scheduleBatch can have a maximum value of 2,000. If set to a higher value, Salesforce chunks the records returned by the QueryLocator into smaller batches of up to 2,000 records. If the start method returns an iterable, the scope parameter value has no upper limit; however, if you use a very high number, you may run into other limits.

The System.scheduleBatch method returns the scheduled job ID (CronTrigger ID).

This example schedules a batch job to run one minute from now by calling System.scheduleBatch. The example passes this method an instance of a batch class (the reassign variable), a job name, and a time interval of one minute. The optional scope parameter has been omitted. The method call returns the scheduled job ID, which is used to query CronTrigger to get the status of the corresponding scheduled job.

```apex
String cronID = System.scheduleBatch(reassign, 'job example', 1);
CronTrigger ct = [SELECT Id, TimesTriggered, NextFireTime
    FROM CronTrigger WHERE Id = :cronID];

// TimesTriggered should be 0 because the job hasn't started yet.
System.assertEquals(0, ct.TimesTriggered);
System.debug('Next fire time: ' + ct.NextFireTime);
// For example:
```

**Note:** Some things to note about System.scheduleBatch:

• When you call Database.scheduleBatch, Salesforce schedules the job for execution at the specified time. Actual execution might be delayed based on service availability.
• The scheduler runs as system—all classes are executed, whether or not the user has permission to execute the class.
• All scheduled Apex limits apply for batch jobs scheduled using System.scheduleBatch. After the batch job starts executing, all batch job limits apply and the job no longer counts toward scheduled Apex limits.
• After calling this method and before the batch job starts, you can use the returned scheduled job ID to abort the scheduled job using the System.abortJob method.

### New Classes and Methods for Publisher Actions

**Note:** In the application, QuickActions are referred to as actions.

The following classes and methods are new and available to use with Chatter Publisher Actions.

• **QuickAction**: Use Apex to request and process publisher actions on objects that allow custom fields, on objects that appear in a Chatter feed, or are available globally.
• **QuickAction.QuickActionRequest**: Use the `QuickAction.QuickActionRequest` Class for providing action information for quick actions to be performed by `QuickAction` Class methods. Action information includes the action name, parent record ID, and record.

• **QuickAction.QuickActionResult**: After you initiate a publisher action with the `QuickAction` Class, use the `QuickAction.QuickActionResult` Class for processing action results.

• **sObject.getQuickActionName** method: Retrieves the name of a publisher action associated with this `sObject`. Typically used in triggers.

**QuickAction**

The following are static methods of the `QuickAction` class.

<table>
<thead>
<tr>
<th>Method</th>
<th>Arguments</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>performQuickAction</td>
<td><code>QuickAction.QuickActionRequest</code></td>
<td><code>QuickAction.QuickActionResult</code></td>
<td>Performs the quick action specified in the quick action request and returns the action result.</td>
</tr>
<tr>
<td></td>
<td><code>performQuickAction</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>QuickAction.QuickActionRequest</code></td>
<td><code>QuickAction.QuickActionResult</code></td>
<td>Performs the quick action specified in the quick action request with the option for partial success, and returns the result.</td>
</tr>
<tr>
<td></td>
<td><code>performQuickAction</code></td>
<td><code>QuickAction.QuickActionResult</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>allOrNothing</code></td>
<td>Boolean</td>
<td></td>
</tr>
<tr>
<td>performQuickActions</td>
<td><code>LIST&lt;QuickAction.QuickActionRequest&gt;</code></td>
<td><code>LIST&lt;QuickAction.QuickActionResult&gt;</code></td>
<td>Performs the quick actions specified in the quick action request list and returns action results.</td>
</tr>
<tr>
<td></td>
<td><code>performQuickActions</code></td>
<td><code>LIST&lt;QuickAction.QuickActionResult&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>allOrNothing</code></td>
<td>Boolean</td>
<td></td>
</tr>
</tbody>
</table>

**QuickAction.QuickActionRequest**

The following are instance methods of the `QuickAction.QuickActionRequest` class.
<table>
<thead>
<tr>
<th>Method</th>
<th>Arguments</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getParentId</td>
<td>Id</td>
<td>String</td>
<td>Returns this QuickAction’s parent record ID.</td>
</tr>
<tr>
<td>getQuickActionName</td>
<td>String</td>
<td>String</td>
<td>Returns this QuickAction’s name.</td>
</tr>
<tr>
<td>getRecord</td>
<td>SObject</td>
<td>Void</td>
<td>Returns the QuickAction’s associated record.</td>
</tr>
<tr>
<td>setParentId</td>
<td>Id</td>
<td>Void</td>
<td>Sets this QuickAction’s parent ID. Returned by getParentId.</td>
</tr>
<tr>
<td>setQuickActionName</td>
<td>String</td>
<td>Void</td>
<td>Sets this QuickAction’s name. Returned by getQuickActionName.</td>
</tr>
<tr>
<td>setRecord</td>
<td>SObject</td>
<td>Void</td>
<td>Sets a record for this QuickAction. Returned by getRecord.</td>
</tr>
</tbody>
</table>

**QuickAction.QuickActionResult**

The following are instance methods of the QuickAction.QuickActionResult Class.

<table>
<thead>
<tr>
<th>Method</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getErrors</td>
<td>List&lt;Database.Error&gt;</td>
<td>If an error occurs, an array of one or more database error objects, along with error codes and descriptions, is returned. For more information, see Database.Error Class.</td>
</tr>
<tr>
<td>getIds</td>
<td>List&lt;Id&gt;</td>
<td>The IDs of the QuickActions being processed.</td>
</tr>
<tr>
<td>isSuccess</td>
<td>Boolean</td>
<td>Returns true if the action is created; otherwise, false.</td>
</tr>
<tr>
<td>isSuccess</td>
<td>Boolean</td>
<td>Returns true if the action completes successfully; otherwise, false.</td>
</tr>
</tbody>
</table>

**Additional sObject.addError Methods**

New addError methods have been added with an additional Boolean argument for sObjects and sObject fields. This additional argument allows you to specify whether or not to escape the custom error message displayed in the Salesforce user interface. The existing addError methods without the additional escape argument escape custom error messages in the Salesforce user interface by default for Apex saved using Salesforce.com API version 27.0 and later. If the Apex addError Method Default Behavior Change critical update has been activated in your organization, the existing methods escape the error message for all versions of Apex.

The characters that are escaped are: \n, <, >, &, ,, \u2028 , \u2029, and \u00a9. Escaping those characters results in the HTML markup not being rendered and to be displayed as text in the Salesforce user interface. Use the new methods with a false escape argument if you want the error message to be unescaped in the user interface.

**Warning:** Be cautious if you specify false for the escape argument for these methods. Unescaped strings displayed in the Salesforce user interface can represent a vulnerability in the system because these strings might contain harmful code. If you want to include HTML markup in the error message, call the addError method with a false escape argument.
argument and make sure you escape any dynamic content, such as input field values. Otherwise, specify true for the escape argument or call the existing addError method without the additional escape argument.

The following table lists the new methods and their descriptions.

<table>
<thead>
<tr>
<th>Name</th>
<th>Arguments</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>addError</td>
<td>String errorMsg, Boolean escape</td>
<td>Void</td>
<td>Marks a record with a custom error message, specifies whether or not the error message should be escaped, and prevents any DML operation from occurring. The errorMsg argument is the error message to mark the record with. The escape argument indicates whether the custom error message should be escaped (true) or not (false). This method is similar to addError(String errorMsg) except that it allows you to specify whether the custom error message should be escaped or not.</td>
</tr>
<tr>
<td>addError</td>
<td>Exception e, Boolean escape</td>
<td>Void</td>
<td>Marks a record with a custom exception error message, specifies whether or not the exception error message should be escaped, and prevents any DML operation from occurring. The exception argument is an Exception object or a custom exception object that contains the error message to mark the record with. The escape argument indicates whether the custom error message should be escaped (true) or not (false). This method is similar to addError(Exception e) except that it allows you to specify whether the custom error message should be escaped or not.</td>
</tr>
<tr>
<td>field.addError</td>
<td>String errorMsg, Boolean escape</td>
<td>Void</td>
<td>Places the specified error message, which can be escaped or unescaped, on the field in the Salesforce user interface, and prevents any DML operation from occurring. The errorMsg argument is the error message to mark the record with. The escape argument indicates whether the custom error message should be escaped (true) or not (false).</td>
</tr>
</tbody>
</table>
This method is similar to
field.addError(String errorMsg)
except that it allows you to specify whether the
custom error message should be escaped or not.

New System.Limits Methods

The Limits methods return the specific limit for the particular governor, such as the number of calls of a method or the amount
of heap size remaining. The following two methods are new in Summer '13.

<table>
<thead>
<tr>
<th>Name</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getInteractionQueries</td>
<td>Integer</td>
<td>Returns the total number of interactions performed.</td>
</tr>
<tr>
<td>getLimitInteractionQueries</td>
<td>Integer</td>
<td>Returns the total number of interactions that can occur.</td>
</tr>
</tbody>
</table>

New String.hashCode Method

The String class has this new instance method.

<table>
<thead>
<tr>
<th>Name</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hashCode</td>
<td>Integer</td>
<td>Returns a hash code value for this string.</td>
</tr>
</tbody>
</table>

A common use of this method is to simplify the computation of a hash code for a custom type that contains String member
variables. You typically add hash code methods when using custom types in map keys and sets. You can compute your type’s
hash code value based on the hash code of each String variable.

This example shows a custom class with two String member variables, x and y. The class provides a custom hashCode method,
which provides a unique value for this class instance. The formula used to compute the hash code value contains calls to the
String hashCode method for each String member variable.

```java
public class MyCustomClass {
    String x, y;

    public MyCustomClass(String a, String b) {
        x = a;
        y = b;
    }

    public Integer hashCode() {
        return (31 * x.hashCode()) ^ y.hashCode();
    }

    public Boolean equals(Object obj) {
        if (obj instanceof MyCustomClass) {
            MyCustomClass p = (MyCustomClass)obj;
```
New **String.stripHtmlTags Method**

The `String` class has the following new instance method:

<table>
<thead>
<tr>
<th>Name</th>
<th>Arguments</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stripHtmlTags</code></td>
<td><code>String htmlInput</code></td>
<td><code>String</code></td>
<td>Removes HTML markup from the input string and returns the plain text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>String s1 = '&amp;lt;b&amp;gt;hello world&amp;lt;/b&amp;gt;';</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>String s2 = s1.stripHtmlTags();</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>System.assertEquals('hello world', s2);</code></td>
</tr>
</tbody>
</table>

New **Type Methods**

The following new instance methods have been added to the `Type` class:

<table>
<thead>
<tr>
<th>Method</th>
<th>Arguments</th>
<th>Return Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>equals</code></td>
<td><code>Object toCompare</code></td>
<td><code>Boolean</code></td>
<td>Returns <code>true</code> if the specified type is equal to the current type; otherwise, returns <code>false</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The <code>toCompare</code> argument is the type to compare with the current type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>Type t1 = Account.class;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>Type t2 = Type.forName('Account');</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>System.assertEquals(t1.equals(t2));</code></td>
</tr>
<tr>
<td><code>hashCode</code></td>
<td></td>
<td><code>Integer</code></td>
<td>Returns a hash code value for the current type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The returned hash code value corresponds to the type name hash code.</td>
</tr>
</tbody>
</table>
New URL.getFileFieldURL Method

The URL class has the following new instance method:

```
getFileFieldURL  String entityId  String
  String fieldName

Returns the download URL for a file attachment.

The entityId argument specifies the ID of the entity that holds the file data.

The fieldName argument specifies the API name of a file field component, such as AttachmentBody.
```

Example:

```
String fileURL = URL.getFileFieldURL('087000000000123', 'AttachmentBody');
```

DML Operations Support Before Mock Callouts in Test Methods

In Winter ’13, support for testing callouts was added for Apex. This support helps increase test code coverage for Apex code that made callouts and simplified the testing process. In this release, Apex adds support for DML operations before mock callouts in test methods, which previously wasn’t possible because DML operations result in pending uncommitted work that prevents callouts from executing. With this added support, test methods can insert test data using DML before performing mock callouts.

To perform DML operations in test methods before mock callouts, enclose the portion of your code that performs the callout within `Test.startTest` and `Test.stopTest` statements. The `Test.startTest` statement must appear before the `Test.setMock` statement. Also, the calls to DML operations must not be part of the `Test.startTest/Test.stopTest` block.

DML operations that occur after mock callouts are allowed and don’t require any changes in test methods.

The DML operations support works for imported WSDLs and for callouts made using the `Http` class. It applies for all implementations of mock callouts using: the `WebServiceMock` interface, the `HttpCalloutMock` interface, and static resources (`StaticResourceCalloutMock` or `MultiStaticResourceCalloutMock`). The following example makes a callout using the `Http` class and uses an implemented `HttpCalloutMock` interface, but you can apply the same technique when using static resources or the `WebServiceMock` interface.

Performing DML Before Mock Callouts

This example shows how to use `Test.startTest` and `Test.stopTest` statements to allow DML operations to be performed in a test method before mock callouts. The test method (testCallout) first inserts a test account, calls `Test.startTest`, sets the mock callout mode using `Test.setMock`, calls a method that performs the callout, verifies the mock response values,
Force.com

Apex Code

and finally, calls Test.stopTest. The CalloutClass and the MockHttpResponseGenerator classes that this example
depends on are listed immediately after this example.
@isTest
private class CalloutClassTest {
@isTest static void testCallout() {
// Perform some DML to insert test data
Account testAcct = new Account(Name='Test Account');
insert testAcct;
// Call Test.startTest before performing callout
// but after setting test data.
Test.startTest();
// Set mock callout class
Test.setMock(HttpCalloutMock.class, new MockHttpResponseGenerator());
// Call method to test.
// This causes a fake response to be sent
// from the class that implements HttpCalloutMock.
HttpResponse res = CalloutClass.getInfoFromExternalService();
// Verify response received contains fake values
String contentType = res.getHeader('Content-Type');
System.assert(contentType == 'application/json');
String actualValue = res.getBody();
String expectedValue = '{"foo":"bar"}';
System.assertEquals(actualValue, expectedValue);
System.assertEquals(200, res.getStatusCode());
Test.stopTest();
}
}
public class CalloutClass {
public static HttpResponse getInfoFromExternalService() {
HttpRequest req = new HttpRequest();
req.setEndpoint('http://api.salesforce.com/foo/bar');
req.setMethod('GET');
Http h = new Http();
HttpResponse res = h.send(req);
return res;
}
}
@isTest
global class MockHttpResponseGenerator implements HttpCalloutMock {
// Implement this interface method
global HTTPResponse respond(HTTPRequest req) {
// Optionally, only send a mock response for a specific endpoint
// and method.
System.assertEquals('http://api.salesforce.com/foo/bar', req.getEndpoint());
System.assertEquals('GET', req.getMethod());
// Create a fake response
HttpResponse res = new HttpResponse();
res.setHeader('Content-Type', 'application/json');
res.setBody('{"foo":"bar"}');
res.setStatusCode(200);
return res;
}
}

243


Asynchronous Apex and Mock Callouts

Similar to DML, asynchronous Apex operations result in pending uncommitted work that prevents callouts from being performed later in the same transaction. Examples of asynchronous Apex operations are calls to future methods, batch Apex, or scheduled Apex. These asynchronous calls are typically enclosed within `Test.startTest` and `Test.stopTest` statements in test methods so that they execute after `Test.stopTest`. In this case, mock callouts can be performed after the asynchronous calls and no changes are necessary. But if the asynchronous calls aren’t enclosed within `Test.startTest` and `Test.stopTest` statements, you’ll get an exception because of uncommitted work pending. To prevent this exception, do either of the following:

- Enclose the asynchronous call within `Test.startTest` and `Test.stopTest` statements.

  ```
  Test.startTest();
  MyClass.asyncCall();
  Test.stopTest();
  Test.setMock(..); // Takes two arguments
  MyClass.mockCallout();
  ```

- Follow the same rules as with DML calls: Enclose the portion of your code that performs the callout within `Test.startTest` and `Test.stopTest` statements. The `Test.startTest` statement must appear before the `Test.setMock` statement. Also, the asynchronous calls must not be part of the `Test.startTest/Test.stopTest` block.

  ```
  MyClass.asyncCall();
  Test.startTest();
  Test.setMock(..); // Takes two arguments
  MyClass.mockCallout();
  Test.stopTest();
  ```

Asynchronous calls that occur after mock callouts are allowed and don’t require any changes in test methods.

Triggers for ChatterAnswersActivity

Triggers are now available for the ChatterAnswersActivity object. You can create the triggers in the Salesforce user interface: from Setup, click Customize > Chatter Answers > Activities > Triggers, and then click New.

Apex Web Services Endpoint Change

The API endpoint hostname has changed from `instance-api.salesforce.com` to `instance.salesforce.com`. This may affect the endpoint URL you use to call your Apex SOAP Web Services. See API Endpoint Changes for more details.

Versioned Changes

The following is a description of differences in behavior for Apex methods when saved using Salesforce.com API version 28.0 and later.
• The serialization of a queried sObject using `JSON.serialize` with additional fields set after the sObject has been queried results in a JSON string that includes the additional fields. For Apex saved using earlier API versions, the serialized JSON string doesn’t include the additional fields.
• For Apex saved using API version 27.0, the serialization of aggregate query results using `JSON.serialize` doesn’t include the returned fields due to a regression in Apex. This has been fixed for Apex saved using API version 28.0 and later—the serialized JSON string now includes the aggregate query result fields.
• Map keys returned by `Schema.getGlobalDescribe` now always include the namespace prefix, if any.
• When calling `describeSObject`, the `RecordTypeInfo.isAvailable` method returns true for all record types assigned to users through their profile and all associated permission sets. Starting in Summer ’13 (API version 28.0), a user’s profile can assign the Master record type and a permission set can assign a custom record type, thus granting users access to both.

API

Summer ’13 (API version 28.0) improvements:

Changes across the API layer:
• API Endpoint Changes
• New and Changed Objects
  ◊ Chatter API Objects
• SOQL
• SOSL

Changes to individual APIs:
• SOAP API
• REST API
• Metadata API
• Tooling API on page 258

API Endpoint Changes

Prior to Summer ’13, API endpoints for Web services used a hostname in the form `instance-api.salesforce.com`. API endpoints now use a hostname of the form `instance.salesforce.com`. An example API endpoint from the `serverUrl` portion of a SOAP API `login()` response might look like:

https://nal.salesforce.com/services/Soap/c/28.0/00DU000000Q4f0. This means for all instances the hostname seen in `serverUrl` will match your Salesforce hostname, which includes the following scenarios:

• If your Salesforce hostname is `ap.salesforce.com`, `emea.salesforce.com`, or `ssl.salesforce.com`, the hostname portion of `serverUrl` will be `ap.salesforce.com`, `emea.salesforce.com`, or `ssl.salesforce.com` respectively, instead of `ap0.salesforce.com`, `eu0.salesforce.com`, or `na0.salesforce.com`.
• If your organization uses My Domain, the hostname portion of `serverUrl` will match your My Domain hostname, with a format of `mycompany.my.salesforce.com`. If you are using My Domain with a sandbox, your hostname will be of the form `mycompany--sandboxname.instance.my.salesforce.com`. 
The previous instance-api.salesforce.com endpoints will continue to work, so this change should be completely transparent.

As a best practice, we recommend never hard-coding API endpoints in your code. Instead, use SOAP API `login()` requests to appropriate login endpoints (such as https://login.salesforce.com/services/soap/u/28 or https://test.salesforce.com/services/soap/u/28), and use the `serverUrl` in the login response as your API endpoint. An example of proper login and endpoint handling can be found here: http://www.salesforce.com/us/developer/docs/api/Content/sforce_api_quickstart_steps.htm

New and Changed Objects

For information about new and changed Chatter objects, see Chatter API Objects.

New Objects

These objects are new in API version 28.0.

- The ClientBrowser object represents a cookie added to the browser upon login.
- The IdeaReputation object represents a collection of statistics and scores derived from a user’s activity with an Ideas zone.
- The IdeaReputationLevel object represents a reputation level within an Ideas zone or an internal organization.
- The LiveAgentSession object is automatically created for each Live Agent session and stores information about an agent’s live chat session.
- The LiveAgentSessionHistory object is automatically created for each Live Agent session and stores information about changes made to a session.
- The LiveAgentSessionOwnerSharingRule object represents the sharing rules for a session record for users other than the record owner.
- The LiveAgentSessionShare object is automatically created for each Live Agent session and stores information about which users and groups can view and edit Live Agent session records.
- The LoginIp object represents a validated IP address.
- The Pricebook2History object represents the history of a change to the standard fields of the associated Pricebook2 object, or to any custom fields with history tracking enabled.
- The OpportunitySplit object represents split data for an opportunity team member, including their split percentage and split type.
- The OpportunitySplitType object labels and enables two types of splits: those that must total 100%, and those that can total any percentage.
- The RecentlyViewed object represents records that the logged-in user has recently viewed or referenced.

Changed Objects

These objects have changed in API version 28.0 and affect earlier API versions.

- For all objects that include the `OwnerID` field, changing record ownership by updating the `OwnerID` field now requires the user making the change to have both the “Transfer Record” permission and Read access to the new record owner. This change supports the new User Sharing feature and affects all previous versions of the API. For more information, see User Sharing Overview.

These objects have changed in API version 28.0.

- The `ActivityHistory` and `OpenActivity` objects now include the fields `ConnectionReceivedID` and `ConnectionSentID`. 

246
• In the SetupEntityAccess object, the SetupEntityType field has these additional valid values:
  ◊ ConnectedApplication for OAuth Connected Apps
  ◊ ServiceProvider for service providers
  ◊ TabSet for apps

• (Pilot) In the Account, Contact, Contract, Lead, Organization, Quote, Service Contract, and User standard objects, latitude and longitude fields have been added for all addresses. These geolocation fields are in pilot release and are automatically available in all organizations, but they can be turned off by contacting salesforce.com support. Geolocation fields for standard objects are available in the API only. They are not available in the Salesforce user interface.

  **Note:** Geolocation fields for standard objects are currently available through a pilot program. Any unreleased services or features referenced in this or other press releases or public statements are not currently available and may not be delivered on time or at all. Customers who purchase our services should make their purchase decisions based upon features that are currently available.

• The LastReferencedDate field has been added to these standard objects: Account, Campaign, Contact, Case, CollaborationGroup, Contact, ContentDocument, Contract, ContractLineItem, DandBCompany, Dashboard, Document, Entitlement, Idea, IdeaTheme, KnowledgeArticle, Lead, LiveChat Transcript, LiveChat Transcript Event, LiveChatVisitor, Name, Opportunity, Question, QuickText, Quote, Report, Service Contract, Solution, and User.

• The LastViewedDate field has been added to these standard objects: Account, Campaign, Contact, Case, CollaborationGroup, Contact, ContentDocument, Contract, ContractLineItem, Dashboard, Document, Entitlement, Idea, KnowledgeArticle, Lead, LiveChat Transcript, LiveChat Transcript Event, LiveChat Visitor, Name, Opportunity, Question, QuickText, Quote, Report, Service Contract, Solution, and User.

• In the ForecastingAdjustment object, the AdjustedQuantity, CurrencyIsoCode, IsAmount, and IsQuantity fields have been added.

• In the ForecastingItem object, the ForecastQuantity, IsAmount, IsQuantity, OwnerOnlyQuantity, QuantityWithoutAdjustments, and QuantityWithoutManagerAdjustments fields have been added.

• In the ForecastingQuota object, the ForecastQuantity, IsAmount, IsQuantity, OwnerOnlyQuantity, and QuantityWithoutAdjustments, and QuantityWithoutManagerAdjustments fields have been added. CurrencyIsoCode has been removed.

• In the Ideas object, the CreatorFullPhotoURL, CreatorName, and CreatorSmallPhotoURL fields have been added.

• In the IdeaComments object, the CreatorFullPhotoURL, CreatorName, and CreatorSmallPhotoURL fields have been added.

• The NetworkProfile object was renamed to NetworkMemberGroup. Additionally, this object now supports addition of network members using permission sets.

• In the Network object, the CaseCommentEmailTemplateId and OptionsSelfRegistrationEnabled fields have been added.

• In the SlaProcess object, the IsVersionDefault, NameNorm, VersionMaster, VersionNotes, and VersionNumber fields have been added.

• In the User object, the maximum size of the Email field has been increased from 80 to 128 characters.

• In the User object, these fields have been added.
  ◊ UserPreferencesShowCityToExternalUsers
  ◊ UserPreferencesShowCityToGuestUsers
  ◊ UserPreferencesShowCountryToExternalUsers
  ◊ UserPreferencesShowCountryToGuestUsers
- In the User object, behavior of the following fields changes when Communities is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>New Behavior</th>
<th>Old Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsPartner</td>
<td>Field is visible if partner portals is enabled in your organization OR you have partner portal user licenses.</td>
<td>Field is visible if partner portals is enabled in your organization.</td>
</tr>
<tr>
<td>PortalRole</td>
<td>Field is visible if Customer Portals is enabled in your organization OR Communities is enabled and you have either partner portal, Customer Portal, or High-Volume Portal User licenses.</td>
<td>Field is visible if Customer Portals is enabled in your organization.</td>
</tr>
<tr>
<td>IsPortalEnabled</td>
<td>Field is visible if Customer Portals or partner portals is enabled in your organization OR if you have partner portal, Customer Portal, or High-Volume Portal User licenses.</td>
<td>Field is visible if you have Customer Portals or partner portals enabled in your organization.</td>
</tr>
</tbody>
</table>

- In the Account object, behavior of the following fields changes when Communities is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>New Behavior</th>
<th>Old Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsPartner</td>
<td>Field is visible if partner portals is enabled in your organization OR if Communities is enabled and you have partner portal user licenses.</td>
<td>Field is visible if partner portals is enabled in your organization.</td>
</tr>
<tr>
<td>IsCustomerPortal</td>
<td>Field is visible if Customer Portals is enabled in your organization OR if Communities is enabled and you have Customer Portal licenses.</td>
<td>Field is visible if Customer Portals is enabled in your organization.</td>
</tr>
</tbody>
</table>
• In the Event and Task objects, behavior of the following field changes when Communities is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>New Behavior</th>
<th>Old Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>IsVisibleInSelfService</td>
<td>Field is visible if Customer Portals is enabled in your organization OR if Communities is enabled and you have partner portal or Customer Portal user licenses.</td>
<td>Field is visible if Customer Portals is enabled in your organization.</td>
</tr>
</tbody>
</table>

• In the Lead and Opportunity objects, behavior of the following field changes when Communities is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>New Behavior</th>
<th>Old Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartnerAccountId</td>
<td>Field is visible if partner portals is enabled in your organization OR if Communities is enabled and you have partner portal user licenses.</td>
<td>Field is visible if partner portals is enabled in your organization.</td>
</tr>
</tbody>
</table>

• In the ChatterAnswersActivity object, the CommunityId field has been added.
• In the LiveChatTranscript object, the SupervisorTranscriptBody field has been added.
• In the LiveChatTranscriptEvent object, the AgentId, Detail, and LastReferencedDate fields have been added.
• In the User object, the EmailPreferencesAutoBcc, EmailPreferencesAutoBccStayInTouch, EmailPreferencesStayInTouchReminder, SenderEmail, SenderName, Signature, StayInTouchNote, StayInTouchSignature, and StayInTouchSubject fields have been added.
• In the ApexPage object, the IsConfirmationTokenRequired field has been added.
• In the Community (Zone) object, the API object label has changed to Zone, but the API type is still Community.
• In the Community (Zone) object, the NetworkId field has been added.
• In the Idea object, the AttachmentBody, AttachmentContentType, AttachmentLength, and AttachmentName fields have been added.

**Chatter API Objects**

**New Objects**

These objects are new in API version 28.0.
• The Topic object represents a topic on a Chatter post.
• The TopicAssignment object represents the assignment of a topic to a specific feed item.

**SOQL**

Use the Salesforce Object Query Language (SOQL) to construct query strings used in Salesforce APIs. For a full description of the SOQL query syntax, see the Force.com SOQL and SOSL Reference.
**Increased Query Size Limit**

The maximum size for a SOQL query has been increased to 20,000 characters.

**UPDATE VIEWSTAT**

The new `UPDATE VIEWSTAT` clause is used in a `SELECT` statement to report on Salesforce Knowledge article searches and views. It allows developers to update an article’s view statistics.

You can use this syntax to increase the view count for every article you have access to online:

```sql
SELECT Title FROM KnowledgeArticleVersion
WHERE PublishStatus='online'
UPDATE VIEWSTAT
```

**Additional Comparison Operators Supported For Primary Key Fields**

The less than (<), less or equal (<=), greater than (>) and greater or equal (>=) comparison operators are now supported on ID (primary key) fields. Previously, only equals (=), not equals (!=), `IN`, and `NOT IN` were supported on ID fields. As an example, the following query is now allowed:

```sql
SELECT Name from MyObject__c WHERE Id > '001000000000abc'
```

**FOR VIEW and FOR REFERENCE SOQL Clauses**

Update objects with information about when they were last viewed or referenced using the `FOR VIEW` and `FOR REFERENCE` clauses, respectively. A record is considered viewed when the user sees the details associated with it, but not when the user sees it in a list with other records. A record is considered referenced when a related record is viewed. You can use these clauses when objects are viewed in a custom interface, such as a mobile application or a custom page.

- **Note:**
  - Use these clauses only when you are certain that the retrieved records will definitely be viewed by the logged-in user, else the clause falsely updates the usage information for records. Also, the user won’t recognize any falsely updated records when they display in the Recent Items and the global search auto-complete lists.
  - The RecentlyViewed object is updated every time the logged-in user views or references a record. It is also updated when records are retrieved using the `FOR VIEW` or `FOR REFERENCE` clause in a SOQL query. To ensure that the most recent data is available, RecentlyViewed data is periodically truncated down to 200 records per object.

This is an example of a SOQL query that retrieves one contact to show to the current user and uses `FOR VIEW` to update the last viewed date of the retrieved contact. The same statement both retrieves the record and updates its last viewed date.

```sql
SELECT Name, ID FROM Contact LIMIT 1 FOR VIEW
```

This is an example of a SOQL query that retrieves a contact and uses `FOR REFERENCE` to update the `LastReferencedDate` field of the retrieved contact. The same statement both retrieves the record and updates its last referenced date value.

```sql
SELECT Name, ID FROM Contact LIMIT 1 FOR REFERENCE
```

**Change in Behavior of User Lookups for Portal Users**

There is a change in the behavior of queries that look up to the User object. When requested by portal users, queries such as `owner.name` or `owner.email` might no longer return values when the portal user making the request does not have Read access to the User record being queried.
The behavior depends on the number of domains associated with the lookup field. If the object can lookup to more than one domain, \texttt{owner.name} returns a value, but other detail fields do not. For example, Case owner can lookup to the User or Queue objects. In this case, portal users can see only the value of \texttt{owner.name}. Other User detail fields, such as \texttt{owner.email} or \texttt{owner.phone} do not return a value. This is new behavior.

If the object can lookup to only a single domain, such as Account owner, then no detail fields return values, including \texttt{owner.name}. This is existing behavior.

This change supports the User Sharing feature. For more information, see User Sharing Overview on page 208.

\section*{SOSL}

Use the Salesforce Object Search Language (SOSL) to perform text searches using Salesforce APIs.

\subsection*{Increased Limit for SOSL Query Results}

SOSL now supports up to 2000 results for each query instead of the previous limit of 200 results per query.

\subsection*{Increased Query Size Limit}

The maximum size for a SOSL query has been increased to 20,000 characters.

\section*{UPDATE TRACKING}

The new \texttt{UPDATE TRACKING} clause is used to report on Salesforce Knowledge article searches and views. It allows developers to track the keywords used in the Salesforce Knowledge article search.

You can use this syntax to track a keyword used in Salesforce Knowledge article search:

\begin{verbatim}
FIND {Keyword}
RETURNING KnowledgeArticleVersion (Title WHERE PublishStatus="Online" and language="en_US")
UPDATE TRACKING
\end{verbatim}

\section*{UPDATE VIEWSTAT}

The new and optional \texttt{UPDATE VIEWSTAT} clause is used to report on Salesforce Knowledge article searches and views. It allows developers to update an article's view statistics.

You can use this syntax to increase the view count for every article you have access to online in US English:

\begin{verbatim}
FIND {Title}
RETURNING KnowledgeArticleVersion (Title WHERE PublishStatus="Online" and language="en_US")
UPDATE VIEWSTAT
\end{verbatim}

\section*{REST API}

\subsection*{Support for Pinned Objects in \texttt{scopeOrder}}

The \texttt{scopeOrder} call in the REST API now supports any pinned objects on the user's search results page.
Assignment Rule Header

A new header that controls whether or not active assignment rules are applied is now available. You use this header by setting Sforce-Auto-Assign to either TRUE, FALSE, or a valid AssignmentRule ID in the HTTP headers for your REST API request. If the header is set to TRUE, active assignment rules are applied if a Case or Lead is created or updated in your request. If the header is set to FALSE, the assignment rules are not applied. If a valid AssignmentRule ID is provided, that AssignmentRule is applied. By default the active assignment rules are applied if the header is not provided.

Recently Viewed Items Resource

Use the Recently Viewed Items resource to get a list of the most recently accessed items that were viewed or referenced by the current user. The resource uses a URI of the format services/data/v28.0/recents.

Search Layouts

Use the Search Layouts resource to get layout information for objects on the search results page, including the columns and number of rows returned. The resource uses a URI of the format services/data/v28.0/search/layout/?q=Comma \ delimited object list.

Publisher Quick Actions

These resources are new in API version 28.0 and available to use with Chatter Publisher Actions. Use the Publisher Quick Actions resource to return a list of publisher actions as well as custom fields and objects that appear in the Chatter feed. The resource uses a URI of the format services/data/v28.0/quickActions/.

Additionally, to return:

- Global actions, use services/data/v28.0/quickActions/.
- A specific object’s actions, as well as global actions, use services/data/v28.0/sobjects/object/quickActions/.
- A specific action, use services/data/v28.0/sobjects/object/quickActions/{action name}.
- A specific action’s descriptive detail, use services/data/v28.0/sobjects/object/quickActions/{action name}/describe/.
- A specific action’s default values, including default field values, use services/data/v28.0/sobjects/object/quickActions/{action name}/defaultValues/.
- The default values for an action, use /services/data/v28.0/subjects/object/quickActions/{action name}/defaultValues/{parent id}.

Note: In the application, QuickActions are referred to as actions.

Describe Layouts

Use the global describe layouts resource to get global layout information for objects, including publisher action objects. The resource uses a URI of the format services/data/v28.0/sobjects/Global/describe/layouts/.

Use the describe layouts resource to obtain a description of a layout for a specific object, including publisher action objects. The resource uses a URI of the format services/data/v28.0/sobjects/object/describe/layouts/.
SOAP API

New Calls

These calls are new in API version 28.0 and available to use with Chatter Publisher Actions.

• describeSearchLayouts(): Retrieves search layout information for the queried list of objects, such as column names and maximum number of results returned.
• describeQuickActions(): Retrieves details about specified publisher actions. This information is returned via a DescribeQuickActionResult.
• describeAvailableQuickActions(): Describes details about publisher actions available for a specified parent. This information is returned via a DescribeAvailableQuickActionResult.
• performQuickActions(): Executes quick actions of type create. This information is returned via a PerformQuickActionResult.

Updates

These calls have been updated in API version 28.0.

• describeLayout():quickActionList is a new field that shows the list of actions associated with a page layout.
• describeLayout(): As part of the DescribeLayoutResult metadata returned, VisualforcePage is a new value available for the LayoutComponentType type. Where available, VisualforcePage represents a Visualforce component on the page layout.
• describeLayout(): As part of the DescribeLayoutResult metadata returned, associated QuickAction details are provided in:
   ◊ DescribeQuickActionResultListResult—Represents a list of actions assigned to the page layout.
   ◊ DescribeQuickActionResultListItemResult—Represents a QuickAction assigned to the actions list for a page layout.
• describeSearchScopeOrder(): This call now supports any pinned objects on the user's search results page.
• describeSObject():searchLayoutable is a new field that indicates whether search layout information is available for an object (true) or not (false).

Metadata API

Metadata Deployment Changes

This release introduces the following changes to the deployment process:

User references are maintained

When a component in your deployment refers to a specific user, such as a recipient of a workflow email notification or a dashboard running user, then Salesforce attempts to locate a matching user in the destination organization by comparing usernames during the deployment. For more information, see “Maintaining User References” in the Metadata API Developer’s Guide.

Metadata deployments can be canceled while in progress

On the Monitoring Deployments page, you can cancel a deployment while it’s in progress. To cancel a deployment, click Abort. The deployment then has the status “Abort Requested” until the deployment is completely canceled.
New Metadata Types
These metadata types are new in API version 28.0.

ActivitiesSettings (Metadata API for Activities)
Represents an organization’s activity settings, and its user interface settings for the calendar.

ApprovalProcess
Represents the metadata associated with an approval process. An approval process is an automated process your organization can use to approve records in Salesforce. An approval process specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the actions to take when a record is approved, rejected, recalled, or first submitted for approval.

ForecastingSettings
Represents the Forecasts settings options.

InstalledPackage
Represents a package to be installed or uninstalled. Deploying a newer version of a currently installed package upgrades the package.

LiveAgentSettings
Represents an organization’s Live Agent settings, such as whether or not Live Agent is enabled.

LiveChatAgentConfig
Represents the configuration of an organization’s Live Agent deployment, such as how many chats can be assigned to an agent and whether or not chat sounds are enabled.

LiveChatButton
Represents a Live Agent deployment’s settings for the button that customers click to chat with an agent and the chat window, such as the label that appears on the button and the pre-chat form that appears before a live chat begins.

LiveChatDeployment
Represents the configuration settings for a specific Live Agent deployment, such as the branding image for the deployment and whether or not chat transcripts are automatically saved.

Network
Represents a community. Communities are branded spaces for your employees, customers, and partners to connect. You can customize and create communities to meet your business needs, then transition seamlessly between them. Use the Network component for a Salesforce.com Community. If you want to create zones that contain Chatter Answers and Ideas, use the Community (Zone) component.

OpportunitySettings
Represents organization preferences for features such as automatic opportunity updates and similar-opportunity filters.

ProductSettings
Represents organization preferences for quantity schedules, revenue schedules, and active flag interaction with prices.

QuickAction
Represents a specified create or update action for an object that then becomes available in the Chatter publisher. For example, you can create an action that, on the detail page of an account, allows a user to create a contact related to that account from the Chatter feed on that page. QuickAction can be created on objects that allow custom fields.
Note: In the application, QuickActions are referred to as actions.

**QuoteSettings**
Enables or disables Quotes, which show proposed prices for products and services.

**SamlSsoConfig**
Represents a SAML Single Sign-On configuration.

**Skill**
Represents the settings for a skill used to route chats to agents in Live Agent, such as the name of the skill and which agents the skills are assigned to.

**Updated Metadata Types and Fields**
These metadata fields have been added or changed in API version 28.0.

**AddressSettings (beta)**

Note: This release contains a beta version of state and country picklists that is production quality but has known limitations. To provide feedback on state and country picklists, go to IdeaExchange.

The following fields have been added:

- **orgDefault**
  Sets a country as the default value for new records in the Salesforce organization.

- **standard**
  Standard states and countries are those that are included with Salesforce. You can’t edit the `standard` attribute.

- **visible**
  Makes the state or country available to users in Salesforce. States or countries that are `visible` must also be `active`.

**ApexPage**
The following field has been added:

- **isConfirmationTokenRequired**
  Indicates whether GET requests for the page require a CSRF confirmation token. If you change this field’s value from `false` to `true`, links to the page require a CSRF token to be added to them, or the page will be inaccessible.

**Community (Zone)**

Note: Starting with the Summer ’13 release, Chatter Answers and Ideas “communities” have been renamed to “zones.” In API version 28, the API object label has changed to Zone, but the Metadata API type is still Community.

The following fields have been added:
emailNotificationUrl
The URL that’s included in email notifications. This field is available when Chatter Answers is enabled in the organization.

chatterAnswersReputationLevels
Contains the name and value pair that describes the reputation level for Chatter Answers.

ideaReputationLevels
Contains the name and value pair that describes the reputation for Ideas.

The following fields have been changed:

portalEmailNotificationUrl
This field has been replaced by emailNotificationUrl in API version 28.0 and later.

reputationLevel
This field has been renamed chatterAnswersReputationLevels.

CustomApplication
The following fields have been added:

enableKeyboardShortcuts
Indicates if a Service Cloud console app has keyboard shortcuts enabled, which let users perform actions by pressing a combination of keys instead of having to use a mouse. After keyboard shortcuts are enabled, several default shortcuts are available for customization. Before you can create custom shortcuts, a developer must define the shortcut’s action with the addEventListener() method in the Service Cloud Console Integration Toolkit. You can’t create keyboard shortcuts for actions performed outside of the console. This field is required if isServiceCloudConsole is true.

keyboardShortcuts
Represents the keyboard shortcuts for a Service Cloud console app. Keyboard shortcuts let users perform actions by pressing a combination of keys instead of having to use a mouse.

liveAgentConfig
Represents the configurations for using Live Agent in the Service Cloud Console.

pushNotifications
Represents push notifications for a Service Cloud console app. Push notifications are visual indicators on lists and detail pages that show when a record or field has changed during a user’s session. For example, if two support agents are working on the same case and one agent changes the Priority, a push notification displays to the other agent so he or she notices the change and doesn’t duplicate the effort.

saveUserSessions
Indicates if a Service Cloud console app saves user sessions automatically, so that when console users close their browsers or log out of Salesforce, any previously open tabs will display when users log in again. Required if isServiceCloudConsole is true.

CustomObject
The following field has changed:

enableEnhancedLookup
In addition to custom objects, this field can now be used for the Account, Contact, and User objects.
The following subtype has changed:

**ActionOverride**

Now applies to both standard and custom objects.

**EntitlementProcess**

The following fields have been added:

- **isVersionDefault**
  
  Indicates whether the entitlement process is the default version (`true`) or not (`false`).

- **versionMaster**
  
  Identifies the sequence of versions to which this entitlement process belongs. This field’s contents can be any value as long as it is identical among all versions of the entitlement process.

- **versionNotes**
  
  The description of the entitlement process version.

- **versionNumber**
  
  The version number of the entitlement process. Must be 1 or greater.

The following field has been changed:

**name**

The `name` field continues to represent what displays in the user interface for an entitlement process. However, if entitlement versioning is enabled, that name might be shared among multiple versions of the same entitlement process. To support this versioning, EntitlementProcess file names in package uploads and downloads no longer use only the value of the `name` field for ID purposes. Instead, file names use the `name` with a version appended (for example, “gold_support_v2.entitlementProcess”), which corresponds to the value of `slaProcess.NameNorm` in the SOAP API for a specific version of the entitlement process.

**EntitlementSettings**

The following field has been added:

**enableEntitlementVersioning**

Indicates whether entitlement versioning is enabled (`true`) or not (`false`).

**FieldSet**

The following field has been added:

**isFieldManaged**

Read-only. Denotes whether the field was added to the field set via a managed or unmanaged package.

**Folder**

The following subtype has been added:

**FolderShare**

Represents the settings for enhanced analytics folder sharing. Users can control access to reports or dashboards by giving others Viewer, Editor or Manager access to the folder that contains the report or dashboard.

**IdeasSettings**

The following field has been added:
enableIdeasReputation

Indicates whether Reputation is enabled (true) or not (false). You can’t enable IdeasReputation without enabling the Ideas Reputation permission in your organization.

KnowledgeSettings

The following field has been added:

languages

A list of languages enabled for Salesforce Knowledge with two new sub-field types that represent the metadata used to manage those languages.

Layout

The following field has been added:

quickActionList

The list of actions associated with the page layout.

The following Layout types have been available since version 25.0. New documentation has been added:

SummaryLayout

Controls the appearance of the highlights panel, which summarizes key fields in a grid at the top of a page layout, when Case Feed is enabled.

SummaryLayoutItem

Controls the appearance of an individual field and its column and row position within the highlights panel grid, when Case Feed is enabled.

Tooling API

In version 28.0, Tooling API includes expanded functionality to retrieve symbol tables, raw logs, and checkpoints, and create custom fields.

For details, see the Force.com Tooling API Developer’s Guide.

ISVFORCE

Improved AppExchange Security Review

The AppExchange security review has been redesigned to make the process simpler and easier. When you initiate the security review, you’re presented an online questionnaire that prompts you for all the information required to test your application. This makes it easier for you to plan and prepare for the review. It also minimizes the need for us to contact you for missing information, so we can test and approve your app more quickly.

The questionnaire consists of a series of screens that guide you through the information required, depending on the type of components in your application (that is, Force.com, web-based, hybrid, or mobile).
1. Preparation
   Overview of the steps in the questionnaire and pointers to helpful information.

2. General Information
   Your name and contact information.

3. Policies and Certifications
   Details of your company’s information security policy and any certifications. You have the option of uploading a policy document.

4. Components
   The components and technologies used by your application. You can select relevant items in a checklist based on the type of application. Some examples are:
   - Force.com — Apex, Visualforce, API, SSO
   - Web app — frameworks/languages (Java, .NET, Rails, etc.), SSO, Heroku
   - client app — desktop app, browser plugin, Salesforce CTI toolkit implementation
   - mobile app — iOS, Android, Blackberry, Windows

5. Test Environments
   Access details such as login credentials, install links, and sample data for fully configured, working test environments. These depend on the type of application.
   - Force.com — usernames and passwords for all user levels (admin, end user, etc.) in a test organization
   - Web application — URLs, usernames, and passwords for all user levels, API keys, SSO, and OAuth/SAML settings
   - client app — install URLs, configuration data and instructions; include any required license files, associated sample data, config guides, credentials
   - mobile app — separate install link for each type of mobile app

6. Reports
   Upload reports from your previous testing, for example:
   - Web application — Web App Scanner report
   - Other — other report or documentation

   **Note:** The code scanner results should be clean before you submit for the review. If you’re aware of any issues in the scanner report that are false positives, please provide the details.

7. Review Details
   This consolidates all the information you’ve provided, so you can verify it’s correct and complete. You can return to any previous screen to modify its information.

8. Payment
   This enables you to pay for the security review, using the Recurly payment service. Payment information is saved, so you only need to provide it once. If your app is free, no payment is required.
Environment Hub—Pilot

Note: Environment Hub is currently available through a pilot program. For information on enabling it for your organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set up and configure the Environment Hub: “Manage Environment Hub”</td>
</tr>
<tr>
<td>To connect an organization to the Environment Hub: “Connect Organization to Environment Hub”</td>
</tr>
</tbody>
</table>

The Environment Hub lets you view, connect, and access multiple Salesforce organizations from one location. This simplifies switching between organizations, and can be especially convenient if you use a large number of organizations for business, development, and testing.

You must choose one organization as the Environment Hub (or hub organization), and can then connect all your other organizations (or spoke organizations) to the hub. You can establish single sign-on between the hub and spoke organizations, enabling users to seamlessly navigate between them without having to log into each organization separately.

When you connect an organization to the hub, related organizations are automatically discovered so you don’t have to manually connect them. The following types of related organizations are auto-discovered.

- For a release organization, all its related patch organizations.
- For a Trialforce Management Organization, all Trialforce Source Organizations created from it.
- For a License Management Organization (LMO), that is, an organization with the License Management App (LMA) installed, any release organization (and therefore all its associated patch organizations) that has a managed package registered in the LMO.

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

The Environment Hub main page displays a list of all organizations that are connected to the hub. For each organization, its name, description, organization ID, single sign-on status, and other details are displayed. From the Environment Hub, you can perform these actions.

- Click Connect Organization to add another organization.
- Click the name of any organization to view details about it, including other organizations related to it.
- Click Edit next to an organization to update its details.
- Click Del next to an organization to delete it from the Environment Hub.
- Click SSO next to an organization to log in without having to sign in (if single sign-on has been enabled).
- Click Login next to an organization to go to its login page (if single sign-on hasn’t been enabled).
Connecting an Organization to the Environment Hub

To connect an organization to the Hub:

1. On the Environment Hub main page, click **Connect Organization**.
2. Enter your username for the organization.
3. Click **Connect Organization**.
4. Enter your username and password in the popup window, then click **Login**.
5. Click **Allow** in the next popup window.

The organization is now connected to the hub and its detail page displays. From this page, you can:

- Click **Edit** to provide a meaningful name and description for the organization. This lets you easily identify it in the list of organizations displayed in the Environment Hub.
- Click **Delete** to remove the organization from the Environment Hub.
- Click **Enable SSO** to enable single sign-on between this organization and the Environment Hub. This lets linked users log into this organization from the Environment Hub without providing credentials.
- Click **New SSO User Mapping** to add a new linked user, that is, a user who can access both the hub and spoke organizations.

Viewing Organization Details

Click the name of any organization in the Environment Hub to view details about it, such as its name, description, organization ID, related organizations, and linked users.

The detail page has the following sections.

- Hub Member Details
- Parent Organizations
- Child Organizations
- Single Sign-On User Mappings

From the Organization Details page, you can do any of the following.

- Click **Edit** to edit information about this organization.
- Click **Delete** to remove this organization from the Environment Hub.
- Click **Enable SSO** to enable single sign-on for this organization.

**Hub Member Details**

This section displays the following attributes (in alphabetical order).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A brief description of this organization.</td>
</tr>
<tr>
<td>Refresh Failure Reason</td>
<td>The reason why this page could not be refreshed.</td>
</tr>
<tr>
<td>Origin</td>
<td>The method by which this organization was added to the Environment Hub. Possible values include User Added and Auto Discovered.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Organization</td>
<td>The name of this organization.</td>
</tr>
<tr>
<td>Organization ID</td>
<td>The organization ID of this organization.</td>
</tr>
<tr>
<td>SSO Status</td>
<td>If single sign-on has been enabled for this organization. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• On—Single sign-on is enabled.</td>
</tr>
<tr>
<td></td>
<td>• Off—Single sign-on is disabled.</td>
</tr>
<tr>
<td></td>
<td>• Pending—Single sign-on is in the process of being enabled.</td>
</tr>
<tr>
<td></td>
<td>• Failed—Single sign-on enablement failed. Contact salesforce.com support for assistance.</td>
</tr>
</tbody>
</table>

**Parent Organizations and Child Organizations**

When you connect an organization to the Environment Hub, the following types of related organizations are automatically discovered and connected.

- For a release organization, all its related patch organizations.
- For a Trialforce Management Organization, all Trialforce Source Organizations created from it.
- For a License Management Organization (LMO), that is, an organization with the License Management App (LMA) installed, any release organization (and therefore all its associated patch organizations) that has a managed package registered in the LMO.

These sections display a list of the organizations related to this organization. For each organization in the list, its name and relationship to this organization are displayed.

**Single Sign-On User Mappings**

This section displays a list of common users in this organization and the hub organization who have been previously linked. If single sign-on has been enabled for this organization, all linked users can log into it from the Environment Hub without needing to provide credentials.

From this section, you can do any of the following:

- Click **New SSO User Mapping** to add a new linked user.
- Click **Edit** next to any user to edit their information.
- Click **Del** next to any user to disable their single sign-on access. To disable single sign-on for multiple users, select them and then click **Del** next to any of them.

**Editing Organization Details**

To edit details of an organization in the Environment Hub:

1. Click **Edit** next to that organization’s name in the Environment Hub main page or on its detail page.
2. In the page that displays, edit the name, login credentials, or type for the organization.
3. Click **Save**.

It's helpful to provide a meaningful name and description for the organization. This lets you easily identify it in the list of organizations displayed in the Environment Hub.
Enabling Single Sign-On

To enable single sign-on for an organization:

1. On the Environment Hub main page, click the name of the organization.
2. Click Enable SSO on the organization's detail page.
3. On the page that displays, click Enable SSO.

You're taken to the detail page of the organization. Its single sign-on status displays both at the top of the page, and next to the SSO field in the Organization Details section.

Adding a New Linked User to the Environment Hub

To add a new linked user to a spoke organization in the Environment Hub:

1. On the Environment Hub, click the name of the organization.
3. In the page that appears, specify that user's username for both the spoke and hub organizations.
4. Click Save (or Save & New to save and add a new linked user).

Note: To find out the hub organization for any spoke organization, from Setup, click Company Profile > Company Information. The organization ID of the hub organization is listed in the Organization Details section.

Installing Managed Packages using the API

You asked for it! This enhancement is from an idea on the IdeaExchange.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Starting in Summer ’13, you can install, upgrade, and uninstall managed packages using the API. Automating these repeated tasks can help you work more efficiently and to speed up application development.

The list of metadata types has been expanded to include a new type called InstalledPackage. You can use this with the Metadata API deploy() call to install, upgrade, or uninstall packages. The following operations are supported.

• Deploying an InstalledPackage installs the package in the deploying organization.
• Deploying a newer version of a currently installed package upgrades the package.
• Deploying an InstalledPackage using a manifest called destructiveChanges.xml, instead of package.xml, uninstalls it from the organization.

Note: You can’t deploy a package along with other metadata types. Hence, InstalledPackage must be the only metadata type specified in the manifest file.
This is a typical project manifest (package.xml) for installing a package. The manifest must not contain a fullName or namespacePrefix element.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Package xmlns="http://soap.sforce.com/2006/04/metadata">
  <types>
    <name>InstalledPackage</name>
  </types>
  <version>28.0</version>
</Package>
```

The package is specified in a file called `MyNamespace.installedPackage`, where `MyNamespace` is the namespace prefix of the package. The file must be in a directory called `installedPackages`, and its contents must have this format.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<InstalledPackage xmlns="http://soap.sforce.com/2006/04/metadata">
  <versionNumber>1.0</versionNumber>
  <password>optional_password</password>
</InstalledPackage>
```

To uninstall a package, deploy this `destructiveChanges.xml` manifest file in addition to the `package.xml` file.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Package xmlns="http://soap.sforce.com/2006/04/metadata">
  <types>
    <members>MyNamespace</members>
    <name>InstalledPackage</name>
  </types>
</Package>
```

Retrieving an `InstalledPackage`, using the `retrieve()` call creates an XML representation of the package installed in an organization. If the installed package has a password, the password isn’t retrieved. Deploying the retrieved file in a different organization installs the package in that organization.

For more information on the `deploy()` and `retrieve()` commands, see the Metadata API Developer’s Guide.

### Packaging Connected Apps

**Available in: Developer Edition**

Starting in Summer ’13, Connected Apps are distributed using managed packages. You can add a Connected App to a managed package in the same way as, and along with, other components such as custom objects, Visualforce pages, or Apex classes. This makes it easy to distribute a Connected App to users in any organization. As a packageable component, Connected Apps can also take advantage of all other features of managed packages, such as listing on the AppExchange, push upgrades, post-install Apex scripts, license management, and enhanced subscriber support.

Pushing an upgrade of a managed package containing a new version of a Connected App is a convenient way to upgrade a Connected App in a customer organization. For example, suppose an iOS certificate used in your existing Connected App expires. You can get a new certificate, update your Connected App, include it in a package, and then push the upgraded package to all subscriber organizations. This ensures all your customers can continue to use your Connected App without any disruption.
Here are some special considerations when packaging a Connected App.

- Subscribers or installers of a package can’t delete a Connected App by itself; they can only uninstall its package. A developer can delete a Connected App after a package is uploaded as Managed - Released. The Connected App will be deleted in the subscriber’s organization during a package upgrade.
- If you update a Connected App and include it in a new package version, upgrading that package in a customer organization updates the existing Connected App.
- If you push upgrade a package containing a Connected App whose OAuth scope or IP ranges have changed from the previous version, the upgrade will fail. This is a security feature, to block unauthorized users from gaining broad access to a customer organization by upgrading an installed package. A customer can still perform a pull upgrade of the same package; this is allowed because it’s with the customer’s knowledge and consent.
- You can add an existing Connected App (that is, one created prior to Summer ’13) to a managed package. You can also combine new and existing Connected Apps in the same managed package.
- For Connected Apps created prior to Summer ’13, the existing install URL continues to be valid until you package and upload a new version. Once you upload a new version of the package with an updated Connected App, the install URL will no longer work.

Attributes of Connected Apps in a Package

This section shows which attributes of a Connected App are editable after installation from a managed package.

**Developer Editable**

The developer can edit these attributes. They’re locked in the subscriber’s organization.

- Access Method
- Canvas App URL
- Callback URL
- Connected App Name
- Contact Email
- Contact Phone
- Description
- Icon URL
- Info URL
- IP Ranges
- Locations
- Logo Image URL
- OAuth Scopes

**Subscriber and Developer Editable**

The subscriber and developer can edit these attributes. However, they’re not upgradeable; only new subscribers receive the latest changes.

- ACS URL
- Entity ID
- IP Restrictions
- Manage Permission Sets
- Manage Profiles
- Mobile Start URL
- Permitted Users
- Require Users to Log In
Creating Signups using the API—Generally Available

In Summer ’13, you can make API calls to the SignupRequest object to create trial organizations for prospective customers. Before this feature was piloted in Spring ’13, you could only create trial organizations (or signups) using a web form and there was no way to customize the signup process or track its status. Using the API enables you to collect and analyze information on all signups from your business organization. This gives you more control over the signup process and enhanced visibility into your prospective customers. For example, you can:

- Run reports and collect metrics, such as the number of signups per day or the number of signups in different countries.
- Customize the SignupRequest object to add fields of special interest to your company.
- Create triggers to initiate specific actions, such as sending an email notification, whenever a new signup request is made.
- Enable signups from a wide range of client applications and devices, so you have additional channels for customer acquisition.

**Note:** Although you can create new signups from any organization (with the appropriate permissions), we recommend doing so from your business organization. You can then easily integrate data and metrics on all signups with your existing business processes.

To start creating new signups using the API:

1. Create a Trialforce Source Organization (TSO) from your Trialforce Management Organization.
2. Install your app in the TSO, along with any sample data that might be useful for the trial.
3. Configure the TSO as you want your customers to experience it, including specifying any custom branding.
4. Create a Trialforce template from the TSO.
5. File a case in the Partner Portal, specifying the Organization ID of your TSO and the template ID of the Trialforce template.

You’ll be notified by email once the template is approved. It can then be used to create new signups by making API calls to the SignupRequest object. See below for details of the SignupRequest object and a code sample demonstrating its use.
Note: For more information on working with objects, see the *Object Reference for Salesforce and Force.com*.

## SignupRequest

Represents a request for a new Trialforce signup. This object is available in API version 27.0 and later.

### Supported Calls

create(), delete(), describeLayout(), describeSObjects(), getDeleted(), getUpdated(), query(), retrieve(), undelete()

### Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company</strong></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>string</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
</tr>
<tr>
<td></td>
<td>Create, Filter, Group, Sort</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>The name of the company requesting the trial signup.</td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>string</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
</tr>
<tr>
<td></td>
<td>Create, Filter, Group, Sort</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>The two-character, upper-case ISO-3166 country code. You can find a full list of these codes at a number of sites, such as: <a href="http://www.iso.ch/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html">www.iso.ch/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html</a></td>
</tr>
<tr>
<td><strong>CreatedOrgId</strong></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>string</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
</tr>
<tr>
<td></td>
<td>Filter, Group, Nullable, Sort</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>The 15-character Organization ID of the trial organization created. This is a read-only field provided by the system once the signup request has been processed.</td>
</tr>
<tr>
<td><strong>ErrorCode</strong></td>
<td>Type</td>
</tr>
<tr>
<td></td>
<td>string</td>
</tr>
<tr>
<td>Field Name</td>
<td>Details</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Filter, Group, Nillable, Sort</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The error code if the signup request isn’t successful. This is a read-only field provided by the system to be used for support purposes.</td>
</tr>
<tr>
<td><strong>FirstName</strong></td>
<td><strong>Type</strong> string</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Create, Filter, Nillable, Sort</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The first name of the admin user for the trial signup.</td>
</tr>
<tr>
<td><strong>LastName</strong></td>
<td><strong>Type</strong> string</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Create, Filter, Group, Sort</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The last name of the admin user for the trial signup.</td>
</tr>
<tr>
<td><strong>SignupEmail</strong></td>
<td><strong>Type</strong> email</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Create, Filter, Group, Sort</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The email address of the admin user for the trial signup.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td><strong>Type</strong> picklist</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Filter, Group, Sort, Update</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The status of the request. Possible values are New, In Progress, Error, or Success. The default value is New.</td>
</tr>
<tr>
<td><strong>TemplateDescription</strong></td>
<td><strong>Type</strong> string</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Filter, Group, Nillable, Sort</td>
</tr>
<tr>
<td>Field Name</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the approved Trialforce template that is the basis for the trial signup.</td>
</tr>
<tr>
<td>TemplateId</td>
<td>Type string&lt;br&gt;Properties Create, Filter, Group, Sort&lt;br&gt;Description The 15–character ID of the approved Trialforce template that is the basis for the trial signup. The template is required and must be approved by salesforce.com.</td>
</tr>
<tr>
<td>TrialDays</td>
<td>Type anyType&lt;br&gt;Properties Create, Defaulted on create, Filter, Group, Sort&lt;br&gt;Description The duration of the trial signup in days. Must be equal to or less than the trial days for the approved Trialforce template. If not provided, it defaults to the trial duration specified for the Trialforce template.</td>
</tr>
<tr>
<td>TrialSourceOrgId</td>
<td>Type string&lt;br&gt;Properties Filter, Group, Nillable, Sort&lt;br&gt;Description The 15–character Organization ID of the Trialforce Source Organization from which the Trialforce template was created.</td>
</tr>
<tr>
<td>Username</td>
<td>Type string&lt;br&gt;Properties Create, Filter, Group, Sort&lt;br&gt;Description The username of the admin user for the trial signup. It must follow the address convention specified in RFC822: <a href="http://www.w3.org/Protocols/rfc822/#z10">www.w3.org/Protocols/rfc822/#z10</a></td>
</tr>
</tbody>
</table>

**Usage**

The Java class below uses the REST API to create a SignupRequest object. It authenticates to the Trialforce Management Organization and then posts a request to the SignupRequest object.

Here are the variables you need to specify in this example.
• SERVER — The name of the host server for the Trialforce Management Organization (TMO), for example, “na1.salesforce.com.”
• USERNAME — The admin username for the TMO.
• PASSWORD — The concatenation of the admin password and the security token for the TMO. To get an email with the security token, from your personal settings in Salesforce select Reset My Security Token and click Reset Security Token.
• CLIENT_ID — From Setup in Salesforce, click Create > Apps and click New under Connected Apps. Enter values for the required fields (the Callback URL is required but can initially be set to any valid URL as it’s not used), grant full access for the OAuth scopes in the “Selected OAuth Scopes” selector, and click Save. Then copy the value of “Consumer Key” and use it for this variable.
• CLIENT_SECRET — On the same page, click Click to reveal. Then copy the value of "Consumer Secret" and use it for this variable.

public class IsvSignupDriver {
    private static final String SERVER = server_name:port;
    private static final String USERNAME = tmo_username;
    private static final String PASSWORD = tmo_passwordsecurity_token;
    private static final String CLIENT_ID = consumer_key;
    private static final String CLIENT_SECRET = consumer_secret;

    private static SignupRequestInfo signupRequest = null;

    public static String createSignupRequest (SignupRequestInfo sr)
    throws JSONException, IOException {
        JSONObject createResponse = null;
        signupRequest = sr;
        JSONObject loginResponse = login(SERVER, USERNAME, PASSWORD);
        String instanceUrl = loginResponse.getString("instance_url");
        String accessToken = loginResponse.getString("access_token");
        createResponse = create(instanceUrl, accessToken);
        System.out.println("Created SignupRequest object: " + createResponse + ",
        return createResponse.toString();
    }

    /* Authenticates to the TMO using the required credentials */
    private static JSONObject login(String server, String username, String password)
    throws ClientProtocolException, IOException, JSONException {
        String authEndPoint = server + "/services/oauth2/token";
        HttpClient httpClient = new DefaultHttpClient();
        try {
            HttpPost post = new HttpPost(authEndPoint);
            List<NameValuePair> params = new ArrayList<NameValuePair>();

            params.add(new BasicNameValuePair("grant_type", "password"));
            params.add(new BasicNameValuePair("client_id", CLIENT_ID));
            params.add(new BasicNameValuePair("client_secret", CLIENT_SECRET));
            params.add(new BasicNameValuePair("username", username));
            params.add(new BasicNameValuePair("password", password));

           (post.setEntity(new UrlEncodedFormEntity(params, Consts.UTF_8));

            BasicResponseHandler handler = new BasicResponseHandler();
            String response = httpClient.execute(post, handler);
            return new JSONObject(response);
        } finally {
            httpClient.getConnectionManager().shutdown();
        }
    }

    /* Posts a request to the SignupRequest object */
    private static JSONObject create(String instanceUrl, String accessToken)
    throws ClientProtocolException, IOException, JSONException {

HttpClient httpClient = new DefaultHttpClient();
try {
    HttpPost post = new HttpPost(instanceUrl +
        "/services/data/v27.0/sobjects/SignupRequest/");
    post.setHeader("Authorization", "Bearer " + accessToken);
    post.setHeader("Content-Type", "application/json");
    JSONObject requestBody = new JSONObject();
    requestBody.put("TemplateId", signupRequest.getTemplateID());
    requestBody.put("SignupEmail", signupRequest.getEmail());
    requestBody.put("username", signupRequest.getUsername());
    requestBody.put("Country", "US");
    requestBody.put("Company", signupRequest.getCompanyName());
    requestBody.put("lastName", signupRequest.getLastName());
    StringEntity entity = new StringEntity(requestBody.toString());
    post.setEntity(entity);
    BasicResponseHandler handler = new BasicResponseHandler();
    String response = httpClient.execute(post, handler);
    return new JSONObject(response);
} finally {
    httpClient.getConnectionManager().shutdown();
}
1. In your Trialforce Management Organization, from Setup, click Customize > Signup Requests > Fields.
2. Click New.
3. Specify the details of the custom field and click Save.

To see the custom field in a list of existing SignupRequest records, create a custom view containing that field on the Signup Requests tab.

**Running Reports on Signup Requests**

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or view signup requests: “Signup Request API”</td>
</tr>
</tbody>
</table>

Once a few SignupRequest records have been created, you can run custom reports on them.

1. In your Trialforce Management Organization, from Setup, click Create > Report Types and click Custom Report Types.
2. Select Signup Requests as the Primary Object.
3. Enter a label, name, description, and store in a category such as Administrative Reports.
4. Finish the wizard, and save the Report Type.
5. Configure the report with the fields you’re interested in and click Save.
6. Select the Reports tab and click New Report to create a Report from your new Report Type.
7. Select your report type name and click Create.

Once you’ve created the report, you can run it periodically to see trends in the data.

**Using Triggers with Signup Requests**

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or view signup requests: “Signup Request API”</td>
</tr>
</tbody>
</table>

You can set up triggers to initiate specific actions, each time a signup request is submitted.

1. In your Trialforce Management Organization, from Setup, click Customize > Signup Requests > Triggers.
2. Click New.
3. Add the code for the trigger, and click Save.

For example, this trigger inserts a new lead based on information in the signup request.

```java
trigger SignupRequestTrigger on SignupRequest (after insert) {
    private SignupRequest[] sr = Trigger.new;
    Lead l = new Lead(
        LastName = sr[0].LastName,
        FirstName = sr[0].FirstName,
        Company = sr[0].Company,
        Email = sr[0].SignupEmail,
    )
    l.save();
}
```
You can verify that a Lead record is created, each time you create a SignupRequest. To easily find a specific lead, you can sort leads by email.

**Signup Request Home**

<table>
<thead>
<tr>
<th><strong>User Permissions Needed</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or view signup requests:</td>
<td>“Signup Request API”</td>
</tr>
</tbody>
</table>

Clicking the Signup Requests tab displays the signup requests home page. In the **Recent Signup Requests** section:

- Click **New** to create a new signup.
- Click the number of any signup request to see details about it, including its history and approval status.
- Select an item from the drop-down list to display a list of the signup requests matching that criterion. From the list, you can click any signup request name to go directly to the signup request detail.
- To show a filtered list of items, select a predefined list from the **View** drop-down list, or click **Create New View** to define your own custom views. To edit or delete any view you created, select it from the **View** drop-down list and click **Edit**.

**Note:** You must get your Trialforce template approved, by filing a case in the Partner Portal, before you can create new signups from this page.

**Creating a Signup Request**

<table>
<thead>
<tr>
<th><strong>User Permissions Needed</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or view signup requests:</td>
<td>“Signup Request API”</td>
</tr>
</tbody>
</table>

1. Select **Signup Request** from the Create New drop-down list in the sidebar, or click **New** next to **Recent Signup Requests** on the signup requests home page.
2. Enter the information for the signup request.
3. Click **Save** when you’re finished, or click **Save & New** to save the current signup request and add another.
Viewing Signup Request Details

**User Permissions Needed**

| To create or view signup requests: | “Signup Request API” |

From the Signup Request detail page:

- Click **Delete** to delete the signup request
- Click **Clone** to create a new signup request with the same attributes as this one

The detail page has the following sections.

- **Signup Request Detail**
- **Signup Request History**

**Signup Request Detail**

This section displays the following attributes (in alphabetical order).

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>The name of the company requesting the trial signup.</td>
</tr>
<tr>
<td>Country</td>
<td>The two-character, upper-case ISO-3166 country code. You can find a full list of these codes at a number of sites, such as: <a href="http://www.iso.ch/iso/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html">www.iso.ch/iso/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html</a></td>
</tr>
<tr>
<td>Created Org</td>
<td>The 15-character Organization ID of the trial organization created. This is a read-only field provided by the system once the signup request has been processed.</td>
</tr>
<tr>
<td>Email</td>
<td>The email address of the admin user for the trial signup.</td>
</tr>
<tr>
<td>Error Code</td>
<td>The error code if the signup request isn’t successful. This is a read-only field provided by the system to be used for support purposes.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the admin user for the trial signup.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the admin user for the trial signup.</td>
</tr>
<tr>
<td>Source Org</td>
<td>The 15-character Organization ID of the Trialforce Source Organization from which the Trialforce template was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the request. Possible values are New, In Progress, Error, or Success. The default value is New.</td>
</tr>
<tr>
<td>Template</td>
<td>The 15-character ID of the approved Trialforce template that is the basis for the trial signup. The template is required and must be approved by salesforce.com.</td>
</tr>
<tr>
<td>Template Description</td>
<td>The description of the approved Trialforce template that is the basis for the trial signup.</td>
</tr>
<tr>
<td>Trial Days</td>
<td>The duration of the trial signup in days. Must be equal to or less than the trial days for the approved Trialforce template. If not provided, it defaults to the trial duration specified for the Trialforce template.</td>
</tr>
</tbody>
</table>
### Attribute Description

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The username of the admin user for the trial signup. It must follow the address convention specified in RFC822: <a href="http://www.w3.org/Protocols/rfc822/#z10">www.w3.org/Protocols/rfc822/#z10</a></td>
</tr>
</tbody>
</table>

### Signup Request History

This section shows the date the signup request was created, the user who created it, and the actions that have been performed on it.

### Creating Proxy Signups for OAuth and API Access

<table>
<thead>
<tr>
<th>User Permissions Needed</th>
<th>“Signup Request API”</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create or view signup requests:</td>
<td></td>
</tr>
</tbody>
</table>

In Summer '13, you can programmatically create a new organization without any system-generated emails being sent to the user. You can then obtain an OAuth access token to log into the organization and make API requests from it, without any action by the user. This is called proxy signup as it enables you to create and operate the organization on the user’s behalf, without their knowledge that you’re using Salesforce behind the scenes.

In the traditional signup process, when you create a new organization, the user receives a system-generated email containing the login URL and initial password for logging into the organization. The user then has to log in and explicitly grant you API access to make calls into the organization on his behalf. With proxy signup, no user emails are generated and no action is required by the user to provide you API access.

The ability to create and manage organizations by proxy expands your options for integrating Salesforce with external applications on other platforms. It enables you to incorporate any feature of the Force.com platform into your own application, without exposing the Salesforce user interface (UI). In effect, all features of Salesforce can be decoupled from the UI and are available to integrate into any other application runtime or UI in a seamless and invisible way.

For example, suppose an ISV has a web application, built on the .NET platform, that helps companies manage travel expense reporting and reimbursement for employees. The ISV might want to integrate Chatter into its application, so all employees of a company can share feedback and tips about their travel experiences with each other. The ISV can do this by using the appropriate Salesforce APIs to implement the following solution.

1. Use proxy signup to create a Salesforce organization for each of its customers.
2. Create users in each customer organization for all employees of that company.
3. Set up and maintain a Chatter group for sharing travel information.
4. Monitor each user’s Chatter feed and extract information from individual posts.
5. Insert the information into its application, and display it in the existing UI.

This enables the ISV to provide its customers access to Chatter functionality, without having to develop it from scratch. The ISV’s customers experience Chatter as a natural extension of the existing application, in an interface they’re familiar with, and without needing to know about or log into Salesforce. The same approach can be extended to any other feature of Salesforce, including standard and custom objects, Apex, and Visualforce. In effect, proxy signup gives ISVs the ability to consume Salesforce as a service, integrating its features into applications on any platform, without exposing the Salesforce UI. The potential applications are limited only by the ISV’s imagination.

Here are the steps for creating a proxy signup.
1. Log into a Developer Edition organization (which has the Connected Apps user permission enabled by default).
2. In the Setup menu, click Create > Apps and click New under Connected Apps.
3. Enter values for the required fields. You must specify an X.509 certificate and grant full access for the OAuth scopes in the "Selected OAuth Scopes" selector. The callback URL is required but can initially be set to any valid URL as it’s not used. Click Save when you’re done.
4. Record the value of Consumer Key on the same page. Also, click Click to reveal and record the value of Consumer Secret.
5. Package the Connected App by adding it as a component to a new package. Record the Installation URL value for the package.
6. Log into your Trialforce Management Organization and create a new Trialforce Source Organization from it.
7. Log into your Trialforce Source Organization and install the package containing the Connected App, using the installation URL from step 5.
8. Once the Connected App is installed in the Trialforce Source Organization, you can customize it by going to Setup > Manage Applications. You can see the Connected App and can edit its attributes. Specify the appropriate profiles and permission sets, and choose the option “Admin approved users are pre-authorized” in the OAuth policies section. This ensures you can authenticate into the organization on behalf of users with these criteria.
9. Once you’ve configured the Trialforce Source Organization to your requirements, create a Trialforce template from it. Select the All Setup and Data radio button when creating the Trialforce template.
10. File a case in the Partner Portal to get approval for creating new signups using the template.
11. Once the template is approved, you can sign up a new organization using the SignupRequest object. You will need to specify the OAuth values necessary to connect to the newly-created organization, that is: Consumer Key and Callback URL.

```json
POST https://mycompany-tmo.salesforce.com/services/data/v27.0/objects/SignupRequest/
Authorization Bearer 00Dxx0000001gR6ARcAQAS3U6brlY8g8TRwR1_u1THtUGmSAP
XrksNlyyjom9kXfDac4U.P.m9FapjTw9ukJFrqWuD8pA9meeLaltRmNFvPq Un7
Content-Type: application/json

Body: 
{ "TemplateId": "0T000000000000001", 
"SignupEmail": "john.smith@mycompany.com", 
"Username": "gm@trial1212.org", 
"Country": "US", 
"Company": "salesforce.com", 
"LastName": "Smith", 
"ConnectedAppConsumerKey": "3MVG9AOp4kbr1Z0LFsvjG2Fxa3cJ_nOkwhxL1J1AuV22u8bm82FtDwFVv__Vs6mvqoVbAnwsChp9YT4bfrYu", 
"ConnectedAppCallbackUrl": "https%3A%2F%2Fwww.mysite.com%2Fcode_callback.jsp" }
```

When the ConnectedAppConsumerKey and ConnectedAppCallbackUrl fields are specified in the SignupRequest object, a proxy signup flow is triggered to automatically approve an existing Connected App for use in this new organization. In that flow, no signup-related emails are sent to the user. With knowledge of the admin username, consumer key and consumer secret, you now have all the information required to:

- make API requests to the newly-created organization as an admin user of that organization.
- request an updated access token at any time in the future.
ADDITIONAL FORCE.COM ENHANCEMENTS

Data Import Wizard — Pilot

Available in: Enterprise, Unlimited, and Developer Editions

The Data Import Wizard is currently available through a pilot program. It is automatically enabled for all Developer Edition organizations. To enable the wizard for Enterprise and Unlimited Edition organizations, contact salesforce.com.

The Data Import Wizard provides a unified interface that lets you import a number of standard Salesforce objects, including accounts, contacts, leads, and solutions. The wizard also lets you import custom objects.

To start using the new wizard, from Setup click Data Management > Data Import Wizard.

Note: The separate import wizards for accounts, contacts, leads, solutions, and custom objects are still available during the pilot. Their functionality hasn’t changed. To see a list of differences between the old and new wizards, review the import wizards comparison table.

Custom State and Country Picklists—Beta

Available in: All Editions except Database.com

State and country picklists allow users to select states and countries from predefined, standardized lists, instead of entering state and country data into text fields. State and country picklists allow for faster and easier data entry and help to ensure cleaner data that can be leveraged for other uses—in reports and dashboards, for example—with more dependable results. The states and countries in the picklists are based on ISO-3166 standard values, making them compatible with other applications as well.

Note: This release contains a beta version of state and country picklists that is production quality but has known limitations. To provide feedback on state and country picklists, go to IdeaExchange.

State and country picklists are available in the shipping, billing, mailing, and “other” address fields in the account, campaign members, contact, contract, lead, person accounts, quotes, and service contracts standard objects. The picklists are also available for managing users and companies in Administration Setup. To use the picklists, first choose the country and then choose from the options that automatically populate the state or province picklist.

In this beta release, you can use the new picklists in most places that state and country fields are available in Salesforce, including:

• Record edit and detail pages
• List views, reports, and dashboards
• Filters, functions, rules, and assignments

You can also search state and country picklists using Advanced Search.
New in the Summer ‘13 beta for state and country picklists:

• A configuration wizard in Setup that allows you to specify which states and countries you want to be available in your organization, assign an organization-wide default country, and customize state and country values.
• The ability to add new countries to your Salesforce organization.
• Support for Translation Workbench.
• States and provinces for Australia, Brazil, China, India, Ireland, Italy, and Mexico in addition to the United States and Canada.

**Force.com App Menu Label Changes**

| Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions |

The Force.com app menu is a drop-down list that displays in the upper-right corner of every application page. The following app menu labels have changed.

• Add AppExchange Apps... is now AppExchange
• Create New Apps... is now Developer Community

**Updates to the Buttons and Links Page**

We’ve enhanced the Buttons and Links page to make it more usable, and to add support for publisher actions. Here’s what’s different:

• We renamed the page “Buttons, Links, and Actions”.
• All buttons and links, both standard and custom, are now in one list, along with actions.
• The New button is now **New Button or Link**, and we added a **New Action** button.
• We added a search feature so you can quickly find things if you have a very long list.
• We added two new columns: Description and Icon. These columns are populated only for actions, not for buttons or links.
• We removed the Modified By and Display columns, and moved the Overridden column to the far right.
• Two columns have new names:
  ◊ The Display Type column is now simply Type.
  ◊ The Content column is now Content Source and also includes the content of the old Display column.

For more information about publisher actions, see Add and Customize Actions in the Chatter Publisher on page 56.
Field History Tracking Deletion

Earlier this year, salesforce.com announced that it would enable a feature in its Summer ’13 release to automatically delete field history data older than 18 months for certain organizations (those created after 12:00 a.m. on June 2, 2011). As a result of customer feedback, we have decided to suspend this feature. Salesforce.com is now working on a future service that will give you the ability to retain your field history for longer periods of time. To date, we have not deleted any field history data from any customer organization.

In the future, you will have the option to define the field history data you would like to retain and the length of time you would like to retain it. For customers who do not specify any criteria around keeping field history data, salesforce.com will enable automatic removal of data older than 18 months to optimize system performance.

Contact your account team or Customer Support for more information.

New Time Zones

Salesforce adds support for the following time zones, listed in chronological order:

- Azerbaijan Time (Asia/Baku)
- Armenia Time (Asia/Yerevan)
- Eastern European Time (Asia/Beirut)
- East Greenland Time (America/Scoresbysund)
- Azores Time (Atlantic/Azores)
- Mountain Standard Time (Mexico/BajaSur)
- Pitcairn Standard Time (Pacific/Pitcairn)
- Gambier Time (Pacific/Gambier)
- Marquesas Time (Pacific/Marquesas)
- Hawaii-Aleutian Standard Time (America/Atka)

Parenthetical Currency Conversion Now Optional

You asked for it! Optional parenthetical currency conversion addresses an idea on IdeaExchange.
Salesforce organizations with multiple currencies enabled can now choose whether to display the user’s personal currency on records.

On records in multi-currency organizations, the primary currency—typically the corporate currency—is followed by a second amount in parentheses. The amount in parentheses is the user’s personal default currency, calculated based on the conversion rate settings defined in your organization. Prior to Summer ’13, this second, converted amount always appeared if the user’s currency was different from the primary currency. Starting in Summer ’13, however, displaying the secondary, converted amount is optional. You can control whether the converted amount appears from Setup by clicking Company Profile > Manage Currencies and choosing to enable or disable parenthetical currency conversion.

Field Level Security Defaults “On” for New Custom Fields in Schema Builder

Available in: All Editions

You asked for it! This enhancement is from an idea on the IdeaExchange.

With Summer ’13, when an administrator adds a custom field to an object in the Schema Builder, the field level security is now set to visible and editable by default for internal profiles—those not cloned from Partner User or Customer Portal Manager. (Fields that are not normally editable, such as formulas and roll-up summary fields, are visible and read-only.) This way, after creating new custom fields, you can automatically see and edit them without having to make them visible.

Record Type Description Text Now Wraps

Available in: All editions

You asked for it! This enhancement is from an idea on the IdeaExchange.

Long Description field text for Record Type now wraps instead of displaying all on the same line.

Contract Fields Enabled for Workflow Time Triggers

Administrators can now add workflow time triggers based on the Contract: End Date and Contract: Activated Date fields. Here’s an example workflow rule based on Contract: End Date.

Follow Up Before Contract Expires

<table>
<thead>
<tr>
<th>Object</th>
<th>Contract</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Send an email reminder to the renewal manager 20 days before a contract’s end date.</td>
</tr>
</tbody>
</table>
HTML Editor Upgrade for Text Area (Rich) Fields

The rich text area editor was upgraded to improve compatibility with modern browsers and to fix bugs. The functionality remains largely the same, with no changes to documented features.

Within the editor, the Insert Link button is enhanced to make it easier to insert various kinds of links, such as email addresses or links to sections within the text area itself. It’s also now possible to set links to open in the same or new windows or frames.

- To insert a Web link:
  1. Choose **Link Type** “URL”.
  2. Paste or type the link into the **URL** field.
  3. If necessary, change **Protocol** to match the service type (HTTPS, FTP, and so on).
  4. To open the link in a different window, click the **Target** tab, and choose a window or frame from the **Target** controls.
  5. Click **OK**.

- To link to another section of the text field:
  1. Choose **Link Type** “Link to anchor in the text”.
  2. Select a location in the text field to link to by choosing an item in the **Select an Anchor** controls.
  3. Click **OK**.

- To create a link that creates an email message:
  1. Choose **Link Type** “E-mail”.
  2. Fill in the email address, subject, and message body.
  3. Click **OK**.

Domain Management

Available in: **Unlimited, Enterprise, Developer, Professional**, and **Group** Editions.

The new Domain Management page allows you to configure domains and their site associations with a high degree of flexibility. Sites and domains can have a many-to-many relationship. Each domain can have up to 50 sites, and each site can be associated with up to 10 domains. For example, you might want to set up a single domain to host your Communities, Force.com, and

---

**Evaluate the rule when a record is:** created, and any time it’s edited to subsequently meet criteria

<table>
<thead>
<tr>
<th>Rule Criteria (Filter)</th>
<th>Run this rule if the following criteria are met:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Contract: Status equals Activated)</td>
</tr>
</tbody>
</table>

| Immediate Actions     | None                                           |
| Time-Dependent Actions| 20 Days Before Contract: End Date—**Email Alert**: Send an email reminder to the renewal manager to confirm whether the client would like an extension. |
Site.com sites. This simplifies your domain requirements. For Site.com sites, you might want to host them on the same domain as your Force.com sites because you can access Visualforce pages and have easier access to Apex code.

There are also reasons why you would have a site on more than one domain. For example, let’s say you have a parent company with two distinct brands. Each brand has its own registered domain, but you want them both to point to the parent website. Because you can have a site exist on more than one domain, you can point both brand domains to a single parent website.

If you plan to host more than one site on a domain, you’ll need to set up custom URLs for each site. Custom URLs are the way to uniquely distinguish the sites within that domain. Let’s say you have a domain called www.ourdomain.com and you want to host two sites called siteone and sitetwo. You’ll need to create custom URLs by associating ourdomain.com to each site using a custom path. This will result in two custom URLs: http://ourdomain.com/siteone and http://ourdomain.com/sitetwo. When a web user accesses the domain using one of the URLs, the custom path determines which site within the domain they see.

**New CNAME Requirement for Sites**

Starting with Summer ’13, new domains for Force.comSites require that the CNAME uses your domain name plus live.siteforce.com on your DNS server. For example, www.mycompany.com must point to www.mycompany.com.live.siteforce.com.

You don’t need to change the DNS name on currently active domains, but if you modify the name in any way, you must use the new live.siteforce.com standard.

**Visual Workflow Runtime Behavior for Empty String and Null Values**

Flow runtime behavior was modified to consistently handle null values and empty strings, which are separate, distinct values in resources of data type text.

Previously, a null value was sometimes incorrectly treated as an empty string during runtime execution of Assignment and Decision elements. Text variables would resolve to different values, depending on whether they were left blank or specifically set to null, for example, by querying a null field in the database.

Starting in Summer ’13:

- If you leave a text field or resource value blank, that value is null at runtime. If you instead want the value to be treated as an empty string, set it to {!$GlobalConstant.EmptyString}.
- For a condition in a Decision element, use the is null operator to check whether a value is null. If the condition compares two text variables, make sure their default values are correctly either set to {!$GlobalConstant.EmptyString} or left blank (null).

We recommend verifying that your existing Decision and Assignment elements—and their referenced text fields and resources—are set to correctly use null and {!$GlobalConstant.EmptyString} values. Otherwise, these elements may behave differently than in previous releases.
**CRITICAL UPDATES**

**SMS Identity Confirmation Requirement**

| Available in: All Editions |

This critical update puts greater security measures in place by enabling Short Message Service (SMS) verification codes as the default identity confirmation feature instead of email. Email identity confirmation can leave data vulnerable if email credentials are compromised and will therefore be automatically disabled. For verified mobile users, they will only receive SMS identity confirmation after the critical update is activated.

Once the critical update is activated, an organization-level default is set that enables users with verified mobile numbers in their user details page to default to SMS-based identity confirmation codes instead of email. Users without mobile numbers populated in their user profile are prompted to submit a mobile number. If a user doesn’t have a mobile device, they can decline the option to submit a mobile number and will continue using email identity confirmation.

A system administrator can continue to provide the email identity confirmation option by assigning the Allow email-based identity confirmation permission to a profile or permission set that can then be assigned to users as desired. An administrator can also reduce the user impact by proactively setting user mobile phone numbers. This ensures your unverified mobile users aren’t prompted to enter a mobile number on their first login after the critical update.

**Apex addError Method Default Behavior Change**

| Available in: Unlimited, Developer, Enterprise, and Database.com Editions |

A critical update for changing the default escaping behavior of the Apex addError methods for all versions of Apex code is available. After this update has been activated in your organization, addError methods escape any HTML characters in the specified error message displayed in the Salesforce user interface for all versions of Apex. The characters that are escaped are: \n, <, >, s, \, \u2028, \u2029, and \u00a9. Escaping those characters results in the HTML markup not being rendered and to be displayed as text in the Salesforce user interface. Without this critical update, addError methods escape HTML characters in the error message only for Apex saved using Salesforce.com API version 27.0 and later, but not for earlier versions.

If you want to keep your addError messages unchanged in the user interface, call the corresponding new addError method with the additional Boolean parameter set to false (see Additional sObject.addError Methods). For example, change the following:

```java
myAccount.addError('<i>Message in italics.</i>');
```

To this method call:

```java
myAccount.addError('<i>Message in italics.</i>', false);
```
Note: Be aware that unescaped strings displayed in the Salesforce user interface can represent a vulnerability in the system because these strings might contain harmful code. If you want to include HTML markup in the error message, in addition to calling the `addError` method with a `false escape` argument, make sure you escape any dynamic content, such as input field values.

After you've made any necessary modifications to affected Apex code, activate this critical update to enable consistent behavior for `addError` methods.

**Require Secure Connections (HTTPS)**

*Available in: All Editions*

This update turns on the preference to require secure (HTTPS) connections to a Salesforce organization.

Turning on the `Require secure connections (HTTPS)` preference makes secure connections required for your organization. To check this preference, from Setup click Security Controls > Session Settings. If an organization administrator has already checked `Require secure connections (HTTPS)` on the Session Settings page, no changes will occur. Otherwise, activating this update automatically turns on the preference for the organization.
Other salesforce.com Products

**desk.com**
Desk.com is an all-in-one customer support app for small businesses and growing teams.
For information on new features, go to the Desk.com Product Updates Blog.

**do.com**
Do.com is a social productivity platform for organizing, tracking, and creating project-based tasks.
For information on new features, go to the do.com New Features Help page.

**Heroku**
Heroku is a cloud-based application platform for building and deploying web apps.
For information on new features, go to the Heroku Changelog.

**Salesforce Marketing Cloud**
Salesforce Marketing Cloud is a unified social marketing suite that allows companies to listen to and engage customers, publish content, optimize social advertising, measure campaigns, and integrate social insights with customer data.
For information on new features, go to the Salesforce Marketing Cloud Facebook page.

**Work.com**
Work.com is a social performance-management tool that helps managers and teams learn faster and perform better.
For information on new features, read the Work.com Release Notes.
Help and Training

Videos

• Setting Up Your Salesforce Community (5:59 minutes)
  Learn about basic setup of Salesforce Communities, including creating a community, adding members and tabs, customizing the interface and emails, and previewing and publishing.

• Forecast Accurately With Collaborative Forecasts (4:48 minutes)
  See how to maneuver around Collaborative Forecasts so that you can reach your sales goals.

• Discover and Organize with Chatter Topics (3:41 minutes)
  Use Chatter topics to see what people are talking about, organize the conversations you want to be a part of, and discover people and groups that are interested and knowledgeable in the same areas.

• Using Chatter in Apex to Display Two Chatter Feeds in a Visualforce Page (6:00 minutes)
  Learn how easy it is to use Chatter in Apex to get Chatter feeds for your Salesforce Communities and display them side by side in Salesforce. Use the Developer Console to create an Apex custom controller, a Visualforce custom component, and a Visualforce page.

• Introducing the Service Cloud Console (2:00 minutes)
  The Service Cloud console uses tabs to help you find and update records quickly.

• Setting Up a Service Cloud Console (2:20 minutes)
  How to set up a Service Cloud console for support agents.

• Getting Ready to Integrate Microsoft® Outlook® and Salesforce (3:00 minutes)
  If you want to sync contacts, events, and tasks between Microsoft® Outlook® and Salesforce, as well as add emails to Salesforce records, you’ll use Salesforce for Outlook. Learn how to download and install it.

• Using the Salesforce Side Panel to Work with Records in Microsoft® Outlook® (2:18 minutes)
  Learn how you can work with Salesforce records directly in Outlook. In addition, learn about adding Outlook emails to the Salesforce records of your choice.

• Splitting Credit across Your Sales Team (1:44 minutes)
  Learn how to add revenue and overlay splits to opportunities.

• Activating Your Computer (1:29 minutes)
  Learn how to activate your computer so you can log in to Salesforce outside the office.

• How to Merge Contacts in Salesforce (1:48 minutes)
Learn how you can merge duplicate contact records in Salesforce.

**Tip Sheets and Implementation Guides**

- The *Tips for Reducing Formula Size* tip sheet gives you strategies to reduce the size of your formulas, whether they're too long or the compile size is too large.